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Chapter 1: Introduction
Ansys Aqwa provides an engineering toolset for the investigation of the effects of wave, wind and
current on floating and fixed offshore and marine structures, including: spars; floating production,
storage, and offloading (FPSO) systems; semi-submersibles; tension leg platforms (TLPs); ships; renewable
energy systems; and breakwater design.

Aqwa Hydrodynamic Diffraction provides an integrated environment for developing the primary hydro-
dynamic parameters required for undertaking complex motions and response analyses. Three-dimen-
sional linear radiation and diffraction analysis may be undertaken with multiple bodies, taking full account
of hydrodynamic interaction effects that occur between bodies. While primarily designed for floating
structures, fixed bodies such as breakwaters or gravity-based structures may be included in the models.
Computation of the second-order wave forces via the full quadratic transfer function matrices permits
use over a wide range of water depths.

Aqwa Hydrodynamic Response provides dynamic analysis capabilities for undertaking global performance
assessment of floating structures. A wide range of physical connections, such as mooring lines, fenders,
and articulations, are provided to model the restraining conditions on the vessels. In addition, sea-
keeping simulation may be undertaken with the inclusion of forward speed effects. Slow-drift effects
and extreme-wave conditions may be investigated, and damage conditions, such as line breakage, may
be included to study any transient effects that may occur.

Aqwa Hydrodynamic Diffraction and time domain Hydrodynamic Response calculations can also generate
pressure and inertial loading for use in a structural analysis as part of the vessel hull design process.
The results from a diffraction or time response analysis can be mapped onto an Ansys Mechanical finite
element model for further structural assessment and detailed design. Since the mapping function
automatically accounts for mesh differences between the hydrodynamic and finite element models,
they do not have to be topologically identical.
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Chapter 2:The Ansys Product Improvement Program
This product is covered by the Ansys Product Improvement Program, which enables Ansys, Inc., to collect
and analyze anonymous usage data reported by our software without affecting your work or product
performance. Analyzing product usage data helps us to understand customer usage trends and patterns,
interests, and quality or performance issues. The data enable us to develop or enhance product features
that better address your needs.

How to Participate

The program is voluntary. To participate, select Yes when the Product Improvement Program dialog
appears. Only then will collection of data for this product begin.

How the Program Works

After you agree to participate, the product collects anonymous usage data during each session. When
you end the session, the collected data is sent to a secure server accessible only to authorized Ansys
employees. After Ansys receives the data, various statistical measures such as distributions, counts,
means, medians, modes, etc., are used to understand and analyze the data.

Data We Collect

The data we collect under the Ansys Product Improvement Program are limited. The types and amounts
of collected data vary from product to product. Typically, the data fall into the categories listed here:

Hardware: Information about the hardware on which the product is running, such as the:

• brand and type of CPU

• number of processors available

• amount of memory available

• brand and type of graphics card

System: Configuration information about the system the product is running on, such as the:

• operating system and version

• country code

• time zone

• language used

• values of environment variables used by the product

17
Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.



Session: Characteristics of the session, such as the:

• interactive or batch setting

• time duration

• total CPU time used

• product license and license settings being used

• product version and build identifiers

• command line options used

• number of processors used

• amount of memory used

• errors and warnings issued

Session Actions: Counts of certain user actions during a session, such as the number of:

• project saves

• restarts

• meshing, solving, postprocessing, etc., actions

• times the Help system is used

• times wizards are used

• toolbar selections

Model: Statistics of the model used in the simulation, such as the:

• number and types of entities used, such as nodes, elements, cells, surfaces, primitives, etc.

• number of material types, loading types, boundary conditions, species, etc.

• number and types of coordinate systems used

• system of units used

• dimensionality (1-D, 2-D, 3-D)

Analysis: Characteristics of the analysis, such as the:

• physics types used

• linear and nonlinear behaviors

• time and frequency domains (static, steady-state, transient, modal, harmonic, etc.)

• analysis options used
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Solution: Characteristics of the solution performed, including:

• the choice of solvers and solver options

• the solution controls used, such as convergence criteria, precision settings, and tuning options

• solver statistics such as the number of equations, number of load steps, number of design points,
etc.

Specialty: Special options or features used, such as:

• user-provided plug-ins and routines

• coupling of analyses with other Ansys products

Data We Do Not Collect

The Product Improvement Program does not collect any information that can identify you personally,
your company, or your intellectual property. This includes, but is not limited to:

• names, addresses, or usernames

• file names, part names, or other user-supplied labels

• geometry- or design-specific inputs, such as coordinate values or locations, thicknesses, or other
dimensional values

• actual values of material properties, loadings, or any other real-valued user-supplied data

In addition to collecting only anonymous data, we make no record of where we collect data from. We
therefore cannot associate collected data with any specific customer, company, or location.

Opting Out of the Program

You may stop your participation in the program any time you wish. To do so, select Ansys Product
Improvement Program from the Help menu. A dialog appears and asks if you want to continue parti-
cipating in the program. Select No and then click OK. Data will no longer be collected or sent.

The Ansys, Inc., Privacy Policy

All Ansys products are covered by the Ansys, Inc., Privacy Policy.

Frequently Asked Questions

1. Am I required to participate in this program?

No, your participation is voluntary. We encourage you to participate, however, as it helps us create
products that will better meet your future needs.

2. Am I automatically enrolled in this program?

No. You are not enrolled unless you explicitly agree to participate.
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3. Does participating in this program put my intellectual property at risk of being collected or discovered
by Ansys?

No. We do not collect any project-specific, company-specific, or model-specific information.

4. Can I stop participating even after I agree to participate?

Yes, you can stop participating at any time. To do so, select Ansys Product Improvement Program
from the Help menu. A dialog appears and asks if you want to continue participating in the program.
Select No and then click OK. Data will no longer be collected or sent.

5. Will participation in the program slow the performance of the product?

No, the data collection does not affect the product performance in any significant way. The amount
of data collected is very small.

6. How frequently is data collected and sent to Ansys servers?

The data is collected during each use session of the product. The collected data is sent to a secure
server once per session, when you exit the product.

7. Is this program available in all Ansys products?

Not at this time, although we are adding it to more of our products at each release. The program
is available in a product only if this Ansys Product Improvement Program description appears in the
product documentation, as it does here for this product.

8. If I enroll in the program for this product, am I automatically enrolled in the program for the other Ansys
products I use on the same machine?

Yes. Your enrollment choice applies to all Ansys products you use on the same machine. Similarly,
if you end your enrollment in the program for one product, you end your enrollment for all Ansys
products on that machine.

9. How is enrollment in the Product Improvement Program determined if I use Ansys products in a cluster?

In a cluster configuration, the Product Improvement Program enrollment is determined by the host
machine setting.

10. Can I easily opt out of the Product Improvement Program for all clients in my network installation?

Yes. Perform the following steps on the file server:

a. Navigate to the installation directory: [Drive:]\v251\commonfiles\globalsettings

b. Open the file ANSYSProductImprovementProgram.txt.

c. Change the value from "on" to "off" and save the file.

Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.20

The Ansys Product Improvement Program



Chapter 3: Running Aqwa using RSM
The Ansys Remote Solve Manager (RSM) allows you to configure and monitor job submission to HPC
resources. This chapter describes how to use RSM to solve Aqwa models.

As a brief introduction, you have an option to install RSM when you install your Ansys software. Every
RSM installation contains a default Ansys RSM Cluster (ARC) that can be used on the local machine or
configured on a remote machine. RSM must be configured to define the resources where the jobs will
be run, and the queues associated with those resources.

Generally, when you submit a job to RSM from a client application, job input files are transferred from
the client working directory to an HPC staging directory. When the job has finished, all output files
produced by the solver are transferred back to the client application.

3.1. Run Configurations

RSM works on individual systems in Workbench. This means that in the example below, System A will
be solved independently from System B. Since B depends on the output of A, you must ensure that A
finishes solving before B begins. Likewise, the solving method configuration for System A can be different
from System B (foreground vs remote, or each system is set to run remotely on different queues).

3.1.1. Configuring Individual Systems to Solve

Because the solve is driven by Workbench, the queues need only to be defined once.
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Solving Options

When you select the Solution cell in a system and open the Properties, these 3 choices are available
for Update Option (running the solution) under Solution Process:

• Run in Foreground - (default) any properties you enter here will be superseded by the processing
options specified in each Aqwa system.

• Run in Background - the solution runs in the background on the local machine. This option is ap-
propriate for solutions that fit within the resources of your workstation but will take longer to ex-
ecute.

Note:

The Aqwa editor will open to generate the input data file and store the results into the
project following the completion of a run, similar to a normal RSM job. Therefore,
background solutions can only be run on Windows machines.

This mode requires that the RSM utilities are installed on your machine.

• Submit to Remote Solve Manager - this system will be solved using RSM.

To update the solution, right-click the Solution cell and select Update. This will trigger the solving
mechanism that you specified, creating the input files, running the solve and bringing the results
back into the project directory if the solution was remote.

For more information on submitting a system for solution in Workbench, see Submitting Solutions
in the Workbench User's Guide.

Solving Mechanism and Expectations

To enable RSM for a system, the Update Option of the solution process should be set to Submit to
Remote Solve Manager.
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1. Select and/or refresh the RSM Queue (the list of configured queues is directly read from your
RSM configuration).

2. Set the Execution Mode to Serial or Parallel and set the number of physical cores you want to
use to run Aqwa remotely. See Setting Aqwa Parallel Processing Options (p. 265) and The
NUM_CORES Data Record in the Aqwa Reference Manual for more information on setting the
number of cores. To find the number of cores in a cluster, see ????.

• Serial will run with 1 core (default).

• Parallel allows you to set the number of cores you want to use. Default is 2.

Note:

You need to ensure that the requested number of physical cores matches the host
queue's properties. If you request more cores than the remote host has available, the
job will fail.

Update the Solution cell to initiate the solve.
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If it is closed, the Aqwa editor will open to generate the solver input files. After the files are generated,
the editor closes and is locked in this mode until the end of the solving process.

Meanwhile, the input files will be transferred to the remote host to start the solution.

Progress on the whole process can be followed by opening the Job Monitor window (at the bottom
of the Workbench window).

When the solve is complete, the results files are transferred back into the project. The Aqwa editor
can now be opened in order to read the messages issued by the solver and visualize the results when
a run is successful.

Troubleshooting

If your project is not set up correctly, you may get errors when you try to solve.

What if there is no mesh?

The setup cell is out of date and the editor will open as part of the solving process and generate
the mesh if found missing.

What if there is no point mass and my model is incomplete?

You will need to set a point mass if your structure is exclusively made of diffracting panels. If
there is no point mass and the application runs in the foreground, the Aqwa editor will throw an
error. If Aqwa runs through RSM, the application will attempt an RSM run but will fail. The following
error message will be issued, requiring you to investigate the log files (SOLVE.RSM or *.MES
files) in your project directory for further details or open the Aqwa editor to see the error message.
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What if I ask for more cores than the host machine can provide?

• You need to ensure that the requested number of physical cores matches the host queue's
properties. One way to check the number of available physical cores is by using RSM Cluster
Monitoring, found under your Ansys installation on the Start Menu.

• To determine the properties of a specific queue, first run a test job on it. Open the RSM Con-
figuration application from your Ansys installation on the Start Menu and submit a test job
from the Queues tab.
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• Then you can query its core and memory information. Open RSM Cluster Monitoring and select
the queue you wish to submit your job to.

• If you require more cores than the remote host has available, the job will fail with the following
error message:
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Supported Operating Systems

• Windows remote host

• Linux remote host

3.1.2. Configuring Parametric Studies

In Ansys applications, you can define key simulation properties to be parameters. The complete
documentation on parametric studies in Workbench can be found in Working with Parameters and
Design Points in the Workbench User's Guide:

To summarize, you can set input and output parameters corresponding to a series of "what-if" scen-
arios. The parameters are listed in a table, and you can interact with them through the project
schematic.

The schematic is also responsible for the update process, which consists of taking a snapshot of your
project with a given parameter set. Meaning, injecting into your project the input parameters and
collecting the corresponding outputs.

This process can be carried out in 2 ways:

• Run in Foreground (local to the host machine, whether it is the user's or a remote machine)

• Run with Remote Solve Manager
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Since the program will need to open the Aqwa editor, the update of the design points can only take
place on a Windows system, whether it is local or remote. This does not affect the solving configuration
defined for each system as detailed in Configuring Individual Systems to Solve (p. 21).

There is one exception, though, which is when the whole parametric study is handled remotely via
RSM, and RSM is also requested as the solving process for the individual system(s). This type of con-
figuration is not permitted.

Review the examples (p. 28) of how to solve using the 2 different methods for more clarification.

Note:

The submission of a parametric study to the Design Point Service (DPS) is not supported
for Aqwa at this time.

Supported Operating System and Configurations

Solving Process for a
System

LinuxWindowsParametric Study
UpdateProcess

YYRun in Foreground

NYRSM

n/an/aDPS

Examples of Possible Configurations

Run in Foreground

The update of the parameters takes place in the foreground (that is, on the local machine) so all
the possible configurations for the remote solve of the systems A and B can be used as detailed
in Configuring Individual Systems to Solve (p. 21). In this example, the Aqwa solve for the systems
A and B is happening remotely on Linux and Windows, respectively.
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Solve configuration for System A:

Solve configuration for System B:

Remote Solve Manager

The update of the parameters must be submitted to a Windows RSM queue. A a result, the only
Solve Option that can be used for the update of systems A and B is Run in Foreground (meaning,
locally on the remote machine).
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3.2. Limitations and Unsupported Features

• Presolve and postsolve commands: these commands are supported as long as when running on a
remote host, they do not use non-Ansys software, non-standard versions of applications installed
with Ansys software, or files that are located outside the project directory.

• External user force: not supported.

• Aqwa Editor on Linux: not supported.
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Chapter 4: Aqwa Workflow and Systems
Hydrodynamic systems can be dragged from the Analysis Systems Toolbox to the Project Schematic to
create your analysis. See Create a Hydrodynamic Analysis System (p. 39) for more detailed information
on creating your analysis using the Project Schematic.

Many tasks in the Schematic can be performed using Context Menu Options that display when you
right-click a cell in a Hydrodynamic system in the Project Schematic.

Figure 4.1: Hydrodynamic Context Menu Options in the Project Schematic
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Refer to Context Menu Options for more information on all of the available options, such as Update,
Refresh, Rename, Properties, and Quick Help. Duplicate and Reset operations are not supported for
Hydrodynamic Diffraction or Hydrodynamic Response systems.

Note:

The Hydrodynamics systems in Workbench support the import of elements from Aqwa
models defined using the Aqwa Solver input format contained in files with the .DAT exten-
sion. See Aqwa Model Data Import (p. 246) for more information.

Note:

If your Geometry includes Moonpools that you wish to explicitly include in your analysis, you
can only obtain results from the Hydrodynamic Diffraction system.

The Stability, Time Response, and Frequency Domain analyses, which are analyses available
in the Hydrostatic Response system, do not support solving models where parts include
active Moonpool objects.

4.1. Hydrodynamic Diffraction Workflows

There are two primary workflows in Aqwa to set up the Hydrodynamic Diffraction System which involve
using the meshing tool provided internally in the Aqwa editor, or using the external Ansys Meshing
tool.

When using the meshing tool provided internally by the Aqwa editor, you can access Ansys meshing
capability with limited controls. For simple models, this tool may be sufficient, eliminating the need to
add a separate meshing system in Workbench.

When using a Mesh system linked to a Hydrodynamics system in the Project Schematic in Workbench,
you can access the Ansys Meshing Application. In this application, you may set the Physics Preference
to Hydrodynamics, giving you similar settings as the internal Aqwa tool, but also providing access to
the entire suite of features in the Meshing Application.

The following table describes the two workflows.

Note:

• Some of the data is only used in subsequent Hydrodynamic Response analyses and may
be defined either before or after the Hydrodynamic Diffraction analysis is performed.

• A hydrodynamic add-on is provided which facilitates the transfer of hydrodynamic pressures
calculated in a Hydrodynamic Diffraction system or time domain Hydrodynamic Response
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to a Static Structural finite element analysis. For information on using this extension see
Hydrodynamic Add-ons (p. 273).

Table 4.1: Aqwa Hydrodynamic Diffraction Workflows

Using External MesherUsing Internal Mesher

1a. Create mesh system1. Import/create Hydrodynamic Diffraction
system (p. 39) 1b. Attach geometry

2a. Mesh using external tool2. Attach geometry (p. 40)

2b. Link Hydrodynamic Diffraction system (p. 33)

3. Configure the geometry (p. 42)

4. Configure mesh (p. 46) (if using Ansys Meshing tool, mesh is read-only in Aqwa)

5. Add project information and options (p. 52)

6. Define parts behavior (p. 54)

7. Define connections (p. 100)

8. Establish analysis settings (p. 129)

9. Apply ocean environment and forces (p. 143)

10. Solve and postprocess (p. 191)

Aqwa Approach (p. 39) provides details on all procedures to perform an Aqwa analysis.

See Editing Objects (p. 256) for more information on interacting with objects in the tree view.

The following sections describe the hydrodynamic systems provided by Aqwa in Workbench:

• Hydrodynamic Diffraction System (p. 33)

• Hydrodynamic Response System (p. 35)

4.2. Hydrodynamic Diffraction System

Hydrodynamic Diffraction systems can be standalone systems, or attached to an upstream mesh system,
depending on the analysis workflow (p. 31). In the external meshing workflow, the Hydrodynamic Dif-
fraction system shares the Mesh of the Mesh system with the Model of the Hydrodynamic Diffraction
system.

To share these systems in the Project Schematic, you must initially create two independent systems,
then manually link the two relevant cells. The cell list updates once the link has been established.
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Create Mesh and
Hydrodynamic
Diffraction systems in
the Project Schematic

Manually link the Mesh
cell to the Model cell

Hydrodynamic
Diffraction system
updates to reflect the
connection

After the geometry has
been imported and the
mesh is generated,
update the Mesh cell
from the Project
Schematic

There are two analysis options for a Hydrodynamic Diffraction analysis: either to calculate the Hydrostatics
only (Aqwa stages 1 and 2), or to calculate the full Hydrodynamic results.

When the full hydrodynamic diffraction analysis is performed, Aqwa generates a database of hydro-
dynamic coefficients for each structure (or group of interacting structures) in the model. Generating
this database is often the most computationally expensive part of the hydrodynamic workflow. Motion
response amplitude operators (RAOs) and force/moment quadratic transfer functions (QTFs) are included
in the database. These are derived from Aqwa's calculations of the first-order wave loads, frequency-
dependent added mass, and radiation damping matrices.

After doing a full Hydrodynamic Diffraction analysis, you may occasionally need to modify a property
of the model that affects the RAOs and QTFs, but has no effect on the wave loads or frequency-dependent
added mass/radiation damping. For example, you may choose to introduce additional frequency-inde-
pendent damping to a structure to tune the calculated RAOs to some experimental data. In these cases,
the Aqwa Workbench editor re-uses the existing hydrodynamic database as much as possible to reduce
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the computational cost of re-solving the hydrodynamic diffraction analysis. A notification appears in
the Messages panel to indicate when this has happened.

4.3. Hydrodynamic Response System

In a set of linked systems, the first Hydrodynamic Response system must be connected to an upstream
Hydrodynamic Diffraction system.

For internal meshing, the Hydrodynamic Response system must share the Geometry, Model, and Solution
cells of the Hydrodynamic Diffraction system (see Figure 4.2: Connected Hydrodynamic Systems (p. 36)
with internal meshing).

For external meshing, the geometry cell is not available in the Hydrodynamic Diffraction system, so
only the Model and Solution cells are shared (see Figure 4.2: Connected Hydrodynamic Systems (p. 36)
with external meshing).

Note:

When you drop the Hydrodynamic Response system on the Hydrodynamic Diffraction system
in the Project Schematic, you are given different options of sharing cells with the Hydro-
dynamic Response system. Only connect the systems to include transferring the Solution
from the Hydrodynamic Diffraction system. If this cell is not shared, the subsequent analysis
will not work.

Hydrodynamic Response systems can be configured for a number of different analysis types using the
Computation Type option. See Hydrodynamic Response Settings (p. 133) for more details on computation
types. Changing the Computation Type setting for a Hydrodynamic Response analysis affects the types
of systems to which you can share data downstream. Table 4.2: Valid System Connections (p. 35) shows
how computation types can be connected.

Table 4.2: Valid System Connections

NotesValid Downstream SystemsUpstream System

When two Hydrodynamic Diffraction
systems are connected, only the

Hydrodynamic
Diffraction (p. 130)

Hydrodynamic
Diffraction (p. 130)

Geometry and Model information is
Hydrodynamic Response:
Time Response (p. 135)

shared (only Model information if
external meshing is used).

Hydrodynamic Response:
Frequency Domain
Analysis (p. 140)

Hydrodynamic Response:
Stability Analysis (p. 134)

If you are performing a Stability Analysis
and connect a downstream Stability

Hydrodynamic
Response: Stability
Analysis (p. 134)

Hydrodynamic Response:
Time Response (p. 135)

Analysis, the downstream system uses
Hydrodynamic Response:
Frequency Domain
Analysis (p. 140)

the position computed in the upstream
system as the starting position.
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NotesValid Downstream SystemsUpstream System

Hydrodynamic Response:
Stability Analysis (p. 134)

If you are performing a Time Response
Analysis and connect a downstream

Hydrodynamic
Response: Time
Response (p. 135)

Hydrodynamic Response:
Time Response (p. 135)

Time Response Analysis, the downstream
system begins its simulation at the end
time step of the upstream system.

Hydrodynamic
Response: Frequency
Domain Analysis (p. 140)

None

Figure 4.2: Connected Hydrodynamic Systems

Internal Meshing

External Meshing
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Chapter 5: Aqwa Approach
This chapter provides details on the procedures required to setup a hydrodynamic analysis.

5.1. Create a Hydrodynamic Analysis System

5.2. Attach Geometry

5.3. Mesh

5.4. Add Project Information and Options

5.5. Define Parts Behavior

5.6. Attachment Point Groups

5.7. Dynamic Point Structures

5.8. Line Body Data

5.9. Define Connections

5.10. Establish Analysis Settings

5.11. Applying Ocean Environment and Forces

5.12. Solution

5.13. Aqwa Model Data Import

5.1. Create a Hydrodynamic Analysis System

Each analysis type is represented by an analysis system that includes the individual components of the
analysis such as the associated geometry and model properties. Most analyses are represented by one
independent analysis system. However, an analysis with data transfer can exist where results of one
analysis are used as the basis for another analysis. In this case, an analysis system is defined for each
analysis type, where components of each system can share data.

• To create an analysis system, expand the Analysis Systems section in the Toolbox and drag an
analysis object template onto the Project Schematic. The analysis system is displayed as a vertical
array of cells (schematic) where each cell represents a component of the analysis system. Address
each cell by right-clicking on the cell and choosing an editing option.

• To create an analysis system with data transfer to be added to an existing system, drag the object
template representing the upstream analysis directly onto the existing system such that red boxes
enclose cells that will share data between the systems. After you release the mouse button, the two
systems are displayed, including an interconnecting link and a numerical designation as to which
cells share data.
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See Working Through a System for more information.

Note:

In hydrodynamic analysis systems, the Geometry cell is the only cell that can share data with
other types of analysis systems.

5.2. Attach Geometry

There are no geometry creation tools in the Aqwa application so geometry must be attached to the
hydrodynamic system. You can create the geometry from either of the following sources:

• From within Workbench using DesignModeler or Discovery Modeling. For details on the use of the
creation tools, refer to the DesignModeler Help  or Discovery Help.

• From a CAD system supported by Workbench. See the CAD Integration section for a complete list of
the supported systems.

Note:

It is possible to import geometry from SpaceClaim. However, to edit a .scdoc file, you
must install SpaceClaim from the Customer Portal, as it is no longer included in the
unified installer.

Before attaching the geometry from either of these sources, you can specify several options that de-
termine the characteristics of the geometry you choose to import by right-clicking the Geometry cell
and choosing Properties. See the CAD Integration section for more details about the options, most of
which do not apply in hydrodynamic analyses. Also see the General Modeling Requirements (p. 42)
section for more information about the implications of Geometry import properties.

Note:

Aqwa only processes the Line Bodies and Surface Bodies in a geometry. Make sure that the
boxes are checked for both of these Geometry options in the Properties view. You can attach
a geometry that has no line or surface bodies, but Aqwa will not process the geometry.

Related Procedures

Procedural StepsConditionProcedure

Optional task that can be
done before attaching
geometry.

Specifying
geometry
options

1. In an analysis system schematic, perform either of
the following:

• Right-click the Geometry cell and choose Proper-
ties

OR
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Procedural StepsConditionProcedure

• Select the Geometry cell in the schematic for a
standard analysis, the from the Workspace toolbar
dropdown menu, choose any option that includes
Properties or Components.

2. Check boxes to specify Default Geometry Options
and Advanced Geometry Defaults.

Double-click the Model cell in the same analysis system
schematic. The Aqwa application opens and displays
the geometry.

DesignModeler is running
in an analysis system.

Attaching
DesignModeler
geometry to
a DesignModeler is not

running. Geometry is
stored in an agdb file.

1. Select the Geometry cell in an analysis system
schematic.hydrodynamic

system

2. Browse to the agdb file from the following access
points:

• Right-click the Geometry cell in the Project
Schematic, Import Geometry and choose
Browse.

3. Double-click the Model cell in the schematic. The
Aqwa application opens and displays the geometry.

CAD system is running.Attaching
CAD

1. Select the Geometry cell in an analysis system
schematic.

geometry to
2. Right-click the Geometry cell listed there.a

hydrodynamic
system 3. Double-click the Model cell in the same analysis

system schematic. The Aqwa application opens and
displays the geometry.

4. If required, set geometry options in the Aqwa
application by highlighting the Geometry object
and choosing settings under Preferences in the
Details view.

CAD system is not
running. Geometry is

1. Select the Geometry cell in an analysis system
schematic.

stored in a native CAD
2. Browse to the CAD file from the following access

points:
system file, or in a CAD
"neutral" file such as
Parasolid or IGES.

• Right-click the Geometry cell in the Project
Schematic and choose Import Geometry.

3. Double-click the Model cell in the Project Schemat-
ic. The Aqwa application opens and displays the
geometry.
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CAD Interface Terminology

The CAD interfaces can be run in either plug-in mode or in reader mode.

• Attaching geometry in plug-in mode: requires that the CAD system be running.

• Attaching geometry in reader mode: does not require that the CAD system be running.

5.2.1. General Modeling Requirements

DesignModeler and Discovery Modeling are the Ansys tools used to create geometry for hydrodynamic
systems. For information on importing geometry created in DesignModeler or Discovery Modeling,
see the Attach Geometry (p. 40) section. When using either of these tools to define the geometry,
there are a number of aspects that you should consider to ensure that your model is suitable for
analysis with Aqwa, such as:

• The waterline must lie at Z = 0 on the XY plane. Import or create each structure, then use Translate
or Move operations to set the correct draft or depth for each structure.

• When using lines to create beams, only tubular sections are supported in Aqwa. All other sections
will result in a slender tube element being formed and you will need to define additional information
in the Aqwa application.

• Each vessel/structure should be a part, so all the bodies that you have should be grouped via the
multibody part facility.

• The model is oriented with its Z axis vertical up.

• External surfaces must have normals pointing outward.

• Internal Tank surfaces must have normals pointing inward.

• Moonpool wall surfaces must have normals pointing inward, towards the enclosed fluid volume.

• The matching surface that corresponds to the hole in the hull should have its normal pointing

upward (towards the enclosed sea surface so that . >0).

• The free surface (which is the area where the sea surface would cross the Moonpool at the waterline
z=0) should have its normal pointing upwards (away from the enclosed sea surface so that

. >0).

Hydrodynamic analysis systems only process the Line Bodies and Surface Bodies in a geometry. You
can attach a geometry that has no Line Bodies or Surface Bodies, but note that this is not appropriate
for an Aqwa analysis.

5.2.2. Configuring the Geometry

On opening a hydrodynamics analysis system, the Aqwa Editor will automatically attach the geometry.
Each part becomes a separate structure in Aqwa.

The hydrodynamics systems assume the still water surface lies on the XY plane, and Z is positive up.
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All structures are located in a global analysis space. Note that Hydrostatic Results (p. 193) and Hydro-
dynamic Graphical Results (p. 195) are also presented in global directions.

Within the geometry, you can select the types of bodies that will be attached.

Once attached, the diffracting behavior of surface geometry can be selected. Lines can be set to be
Tubular or Slender Tube and additional Aqwa specific objects can be added, such as Point Mass (p. 60),
Point Buoyancy (p. 63) and Disc (p. 63).

The Details panel provides you with options for setting up the sea geometry’s Water Depth and size
(Water Size X, Water Size Y), which can be used to alter the graphical view. The sea level lies at Z=0
in the XY plane.

It is important that the correct water depth is specified, especially with shallow water conditions,
since the sea bed acts as a boundary condition to the diffraction analysis. The Water Size in the X
and Y directions only modifies the extent of the graphical display of the water surface and sea bed.

The Water Density and Gravity  can also be changed.

Note:

It is not yet possible to employ symmetry in the Aqwa Editor, hence the full model must
be meshed.

5.2.2.1. Stability/Time Response Specific Options

The Tube Drag Coefficients and Scale Factor for Model Test Simulation options apply to all
Morison (TUBE and STUB) elements within your Geometry. These options affect only Stability and
Time Response analyses; they are not used in Hydrodynamic Diffraction or Frequency Statistical
analyses.

The Seabed Inline/Lateral Friction Coefficient options only affect Time Response analyses which
include Cable Dynamics; they are not used in Hydrodynamic Diffraction, Stability, or Frequency
Statistical analyses.

It is also possible to define the depth of the mud on the seabed onto which the cables lay. The
default value is 2 meters (in SI and for a gravity value of 9.806m/s^2). See The SMUD Data Record
- Seabed Mud Layer Depth for information on how it is defined.

Tube Drag Coefficients

While this option is set to Defined in Line Body Details, Aqwa calculates drag forces on Morison
elements using the Drag Coefficients of the Line Body objects (via their associated Beam Sec-
tion (p. 99) objects) in the Geometry. Alternatively, if set to Reynolds Number Dependent,
drag coefficients will be calculated using the Wieselburger graph of drag coefficient versus
Reynolds Number.
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Scale Factor for Model Test Simulation

This option is only available while Tube Drag Coefficients is set to Reynolds Number Depend-
ent. Set the Scale Factor to unity (default) to provide simple Reynolds Number-dependent
drag calculations using the Wieselburger curve. If comparisons against scale-model tests are to
be undertaken, then provide the scale factor of the model in this field (for example, if the scale-
model is 1:10, then specify a factor of 10).

The scale factor ( ) is used as follows:

Local Reynolds Number = 

where:

 = local velocity transverse to the axis of the TUBE

 = diameter of the TUBE

 = kinematic viscosity of water

Seabed Inline/Lateral Friction Coefficient

These options allow you to specify global inline and lateral seabed friction coefficients, which
are applied for the calculation of seabed friction forces acting on any dynamic cables in a Time
Response analysis.

5.2.2.2. Composite Cable Seabed Definition

In analyses employing Nonlinear Catenary Cables, it is possible to define a Composite Cable Seabed
which may be used for any such cables that are expected to touch down. The Composite Cable
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Seabed is never used in a Hydrodynamic Diffraction analysis, and is not used in any Hydrodynamic
Response analysis that features only Linear, Nonlinear Polynomial, or Nonlinear Steel Wire Cables.

The behavior depends on whether a cable is dynamic or not.

5.2.2.2.1. For a Cable not Using Cable Dynamics

For a Nonlinear Catenary Cable which does not use Cable Dynamics, or in a Hydrodynamic Re-
sponse analysis in which the Use Cable Dynamics option is set to No, the Composite Cable
Seabed is used to create a quasi-static load/extension database for each Cable, which can take
into account a Global Seabed Slope, if defined.

While Seabed Type is set to No Composite Cable Seabed, any Nonlinear Catenary Cables with
Structure to Structure connectivity are treated as if they lie in infinite depth water. For Nonlinear
Catenary Cables with Fixed Point to Structure connectivity, the seabed depth for each cable is
considered as the depth of the selected Fixed Point.

Setting Seabed Type to Use Sea Geometry creates a horizontal Composite Cable Seabed at a
depth equal to the Sea Geometry Water Depth. A Nonlinear Catenary Cable with Structure to
Structure connectivity will only contact this seabed if the Seabed Touchdown Expected option
of that cable is set to Yes. For Nonlinear Catenary Cables with Fixed Point to Structure connectivity,
the depth of the Fixed Point must be equal to the Sea Geometry Water Depth.

Changing Seabed Type to Manual Definition allows the following options to be defined: the
Water Depth at Reference Point option sets the depth of the seabed at the position specified
by the X-Position and Y-Position of Reference Point fields, while the Global Seabed Plane
Azimuth sets the (uphill) direction of the Composite Cable Seabed slope, and the Global Seabed
Slope sets the slope angle.

5.2.2.2.2. For a Cable Using Cable Dynamics

When Seabed Type is set to No Composite Cable Seabed, a Nonlinear Catenary Cable with
Structure to Structure connectivity may contact a horizontal seabed at the Sea Geometry Water
Depth if any part of the line exceeds this depth. For Nonlinear Catenary Cables with Fixed Point
to Structure connectivity, the seabed depth for each cable is considered as the depth of the se-
lected Fixed Point.

Setting Seabed Type to Use Sea Geometry creates a horizontal Composite Cable Seabed at a
depth equal to the Sea Geometry Water Depth. A Nonlinear Catenary Cable with Structure to
Structure connectivity may contact this seabed if any part of the line exceeds this depth. For
Nonlinear Catenary Cables with Fixed Point to Structure connectivity, the depth of the Fixed Point
must be equal to the Sea Geometry Water Depth.

Changing Seabed Type to Manual Definition allows the following options to be defined: the
Water Depth at Reference Point option sets the depth of the seabed at the position specified
by the X-Position and Y-Position of Reference Point fields, while the Global Seabed Plane
Azimuth sets the (uphill) direction of the Composite Cable Seabed slope, and the Global Seabed
Slope is ignored, however, the Fixed Point of a Dynamic Nonlinear Catenary Cable with Fixed
Point to Structure connectivity must still lie at the depth of the Composite Cable Seabed at the
Fixed Point position.
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The Global Seabed Plane Azimuth and Global Seabed Slope can be previewed by selecting
View Sea Surface and Composite Cable Seabed from the View menu, or by clicking the corres-

ponding icon from the View toolbar ( ).

5.2.3. Add Fixed Points

A Fixed Point is a non-moving attachment point defined as part of your geometry. Fixed Points are
defined in the Details panel by entering coordinates in global space or specifying an offset from a
vertex on a structure. The coordinates defining the Fixed Point can be parameterized. A Fixed Point
does not move with any structure (even if it is initially defined as offset from a point on a structure).
A Fixed Point can be used by more than one object (cable, fender, etc.), if required. The option to
choose a Fixed Point vs. Connection Points on structures is controlled by the Connectivity field in the
Details panel of the object using the attachments points.

To add a Fixed Point:

1. Select the Fixed Points object in the tree view.

2. Right-click the Fixed Points object and select Add > Fixed Point, or click the Fixed Point icon
in the Fixed Points toolbar.

3. Click the Fixed Point object and configure it with one of the following sets of information:

• Set Definition of Position to X, Y, and Z Coordinates, and set the Position Coordinates (X, Y,
Z) in the Details panel.

• Set Definition of Position to X and Y Coordinates, Z on Composite Cable Seabed, and set the
Position Coordinates (X, Y) in the Details panel. The Z coordinate is automatically determined
from the Composite Cable Seabed definition in Geometry, so the Composite Cable Seabed
Type must be set to Use Sea Geometry or Manual Definition for this option to be used.

• Set Definition of Position to Vertex Selection. Click Select a Single Vertex in the Vertex field,
select a vertex on a structure, and click Apply. You can then set an X Offset, Y Offset, or Z
Offset from the vertex if needed.

Note:

For a catenary cable connected to a Fixed Point, it is assumed that the seabed for that
cable is at the same depth as the Fixed Point (even if this does not match the Water Depth
defined in Geometry). A catenary cable will typically not lie lower than the depth of the
Fixed Point, unless there is a local negative seabed slope, in which case the cable section
can be lower than the anchor node location.

5.3. Mesh

If the external Mechanical Mesh component is part of your workflow on the Workbench Project
Schematic, you will find that the Aqwa Workbench Mesh object is read-only, and any changes to the
mesh must be made in the upstream Mesh component.
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If you have imported an Aqwa input file using the Insert from Aqwa Model Data File operation, and
there are no other active Parts in the model, then the Aqwa Workbench Mesh object is read-only. There
is no function to modify the mesh imported from an Aqwa input file, currently.

Otherwise, the options in the Details panel of the Aqwa Workbench Mesh object are applied to all un-
suppressed Parts and Bodies in your model. Local Mesh Sizing objects can be added to override the
global Mesh settings on selected Parts or Bodies.

Mesh elements are not generated for any suppressed Parts or Bodies, and they will not appear in any
mesh-based results such as Pressures and Motions, Internal Tank Pressures, or Time Domain Pressures.

To generate the mesh:

1. Select the Mesh object in the Outline tree.

2. Right-click Generate Mesh or click the Generate Mesh button from the Mesh toolbar.

Note:

It is not yet possible to employ symmetry in Aqwa, hence the full model must be meshed.

The mesh controls available in the Aqwa Workbench editor are described in the following sections:

5.3.1. Global Mesh Options

5.3.2. Local Mesh Sizing Controls

Once a mesh has been generated successfully, the Generated Mesh Information section shows the
Total Nodes and Total Elements in the mesh. These totals do not include elements that are generated
by the Aqwa solver when a Part's Generate Internal Lid option is set to Program Controlled. By default,
the Graphical window displays the mesh nodes and elements in a simple grey tone:
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If you change the Display Mesh Metric option from None to Element Types, the Generated Mesh
Information shows the breakdown of nodes and elements into:

• External Surface Diffracting Nodes

• External Surface Diffracting Elements

• External Surface Non-Diffracting Nodes

• External Surface Non-Diffracting Elements

• Internal Tank Diffracting Nodes

• Internal Tank Diffracting Elements

• Internal Tank Non-Diffracting Nodes

• Internal Tank Non-Diffracting Elements

• Abstract Lid Nodes

• Abstract Lid Elements

• Line Body Nodes

• Line Body Elements

• Field Points

• Moonpool Wall Surface Diffracting Nodes
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• Moonpool Wall Surface Diffracting Elements

• Moonpool Wall Surface Non-Diffracting Nodes

• Moonpool Wall Surface Non-Diffracting Elements

• Moonpool Free and Matching Surfaces Nodes

• Moonpool Free and Matching Surfaces Elements

In the Graphical window, the elements are colored according to their type:

If you change the Display Mesh Metric option to Failing Panels, the Generated Mesh Information will
display the Diffracting Element Minor Failure Rate. This is the percentage of diffracting panel elements
that fail the mesh quality checks described in Mesh Quality Check, but whose failures can be avoided
by turning on the Ignore Modeling Rule Violations option in the Hydrodynamic Diffraction Set-
tings (p. 130). Generally, it is recommended that this percentage must be as small as possible. Reducing
the Element Size usually helps, though naturally, this also increases the computational cost of the hy-
drodynamic analysis.

The Details panel also shows the breakdown of panel failures into:

• Aspect Ratio Failures – where the aspect ratio of an element is less than 0.333

• Adjacent Element Area Ratio Failures – where the area ratio of adjacent elements is greater than 3

• Shape Factor Failures – where the shape factor of the element is less than 0.2

• Centroid Proximity Failures – where the distance between a pair of elements in the same interacting
group is less than the effective radius of either of those elements
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• Centroid Proximity Failures (FATAL) – as above, but with a stricter limit of 0.1x effective radius

• Element-Seabed Proximity Failures (FATAL) – where a diffracting element is less than half of its effective
radius above the seabed

• Mesh Connectivity Failures (FATAL) – where an element edge is shared by more than two elements
(so-called ‘T’ connectivity)

• Elements Cutting Fluid Surface (FATAL) – where diffracting elements cross the waterline or Internal
Tank fluid level, as applicable

Note:

A field is not shown in the Details panel if there are no elements failing for that mesh quality
check. You will not be able to run the Hydrodynamic Diffraction analysis if there are any
fatally-failing elements in the mesh.

In the Graphical window, the elements suffering minor quality check failures are displayed in orange,
while fatally-failing elements are shown in red, and all other elements are shown as transparent:

Note:

By default, the mesh information is displayed for all active Parts. However, where there are
multiple active Parts in the Geometry, use the Display Information For option to display
mesh information for a single Part.
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5.3.1. Global Mesh Options

The following are global mesh options which are available in Aqwa Workbench:

5.3.1.1. Mesh Parameters

The overall density of the generated mesh is based on the Element Size parameter. The larger the
Element Size is, the less accurate the results will be. However, the computational cost and memory
requirement of the Hydrodynamic Diffraction calculation will scale with the square of the number
of diffracting elements. This means that you may need to find a balance between accuracy and
computational cost. The 64-bit version of the Aqwa solver is limited to 60,000 nodes and 40,000
elements, of which 30,000 may be diffracting.

Once the mesh has been generated, the Maximum Allowed Frequency field will display the
maximum wave frequency that can be included in the Hydrodynamic Diffraction analysis. This is
based on the Aqwa solver requirement of no less than 7 elements over the shortest wavelength in
the hydrodynamic database.

5.3.1.2. Waterline Node Generation

Previously, it was mandatory to use the Geometry editor to split or slice your geometry over the
waterline (at Z = 0 in the XY plane) to ensure that diffracting panel elements do not cross it. Internal
Tank surfaces also had to be split or sliced at the internal tank fluid level. Now, you can generate
a mesh which includes waterline and internal tank fluid level nodes automatically, by setting Create
Automatic Waterline Nodes to Yes. When this option is on, you can adjust the Connection Tolerance
between the water surface (or internal tank fluid surface) and the real vessel surfaces in your
model, which is sometimes required to get a satisfactory mesh.

If the Create Automatic Waterline Nodes option is set to No, the meshing Engine Selection option
is displayed. You can switch between AnsMeshing and PRIME, though in practice, the meshes
created by these two engines are often similar. Without automatic waterline node generation, it is
still required to split or slice your geometry at the waterline and internal tank fluid levels in the
Geometry editor.

When Create Automatic Waterline Nodes is set to No, and the Engine Selection is set to An-
sMeshing, the Aqwa Workbench mesh will be equivalent to a Mechanical Mesh with the Physics
Preference set to Hydrodynamics and the Batch Connections option set to No. When using the
AnsMeshing engine, you can adjust the Defeature Size to control how small details are treated in
the mesh. For example, if a geometry detail is smaller than the Defeature Size, a single element
may span over it. You can also choose to apply Advanced Options for sizing and defeaturing – for
more information, see Sizing Group in the Meshing User's Guide.

When Create Automatic Waterline Nodes is set to No, and the Engine Selection is set to PRIME,
the Aqwa Workbench mesh will be equivalent to a Mechanical Mesh with the Physics Preference
set to Hydrodynamics and the Batch Connections option set to Yes. However, for an Aqwa ana-
lysis, you must still group rigidly-connected Bodies into a single Part with shared topology in the
Geometry editor.

When Create Automatic Waterline Nodes is set to Yes, the PRIME meshing engine is always used.
The Aqwa Workbench mesh will be equivalent to a Mechanical Mesh under these conditions:

• The Physics Preference is set to Hydrodynamics.
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• The Batch Connections option is set to Yes.

• A mesh Connect object created between a flat face representing the water surface and the
Surface Bodies in your model (with additional Connect objects for any Internal Tank Surface
Bodies and their corresponding fluid surfaces).

In the configuration above, the fluid Surface Height (in Global Axes) for an Internal Tank can be
defined directly and marked as an input parameter for a Design Point study.

Note:

There is no issue with turning on Create Automatic Waterline Nodes for a model, which
has already been split or sliced at the waterline.

5.3.2. Local Mesh Sizing Controls

To add a Mesh Sizing object, follow these steps:

1. Select the Mesh in the Outline tree.

2. Right-click and select Add Sizing Control, or click the Add Sizing Control button from the
Mesh toolbar.

3. Use the Select Geometry option to choose the Parts, Bodies or Faces desired for local Mesh
Sizing.

4. Define the Local Element Size and Local Defeature Size for your geometry selection. The
Local Element Size can be larger than the global Element Size defined in the Mesh details.

Any number of Mesh Sizing objects can be added to the tree as required. You cannot mix topology
types in the Mesh Sizing selection – create separate Mesh Sizing objects, if you want to apply the
same local sizing to surface bodies and line bodies.

Note:

Mesh Inflation Controls and Mesh Pinching Controls have now been withdrawn from Aqwa
Workbench. Use the external Mesh component on the Project Schematic, if you need to
apply more advanced mesh controls for your hydrodynamic analysis.

5.4. Add Project Information and Options

Selecting Project in the tree view displays basic project information and settings in the Details pane.

Details of Project

For convenience and identification, you can record basic details such as the Author, Reference, Project
Title, and Description. The Data Root Folder shows where the project files are stored.

The Hydrodynamic Solver Unit System field allows you to change the unit system that the Aqwa
solver will use for the solution. This is independent of the units currently defined in the Aqwa editor
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for input and results presentation. A selection of consistent Metric and U.S. Customary unit systems is
available. Note that modifying this field will clear any existing Solution. The default is Metric (kg, m)
units, with the derived force unit as Newtons.

The Export CSV Separator Definition field allows you to specify the field separator to use when ex-
porting. The default option corresponds to your Windows Regional settings. The Manual Definition
option allows you to manually enter a single non-digit value as the Separator Value to be used in the
project when exporting.

Date Details

The Date of Creation and Last Modified fields indicate when a project was originally created and
when it was last saved.

Graphics Size Factors

Objects displayed in the graphical window that are not sized according to their defined geometry are
scaled appropriately for a large seafaring vessel or offshore installation.

In same cases, the default object sizing may be too large or too small for the given geometry. The
Graphics Size Factors allow you to re-scale the objects. There are four controls:

• Global Control applies to all objects.

• Geometric Features applies to Fixed/Connection Points, Point Masses/Buoyancies, and Structure
Axes.

Note:

Graphics properties such as size and color for the Fixed/Connection Points and Point
Masses can be customized in the Graphics properties of each object's Details panel.
However, if these Points are further used as a certain Connection type (such as a
Connection Failure or a pulley), they will revert to their default color set in the Aqwa
Editor. Their customized size will not be affected.

• Connections applies to Cable Thicknesses, Joints, Fender Contact Planes, and Joint/Fender Axes.

• Environment Features applies to Wave Directions, Current, Wind, Waves, and Structure Forces.

Each control consists of a slider with a range of 1-100 and a default of 50. Figure 5.1: Objects Drawn
with Default Sizing (p. 54) and Figure 5.2: Objects After Re-Scaling (p. 54) show how the controls can
be used to improve the display of a 1.5 m x 0.8 m buoy with catenary moorings in 20 m of water.
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Figure 5.1: Objects Drawn with Default Sizing

Figure 5.2: Objects After Re-Scaling

5.5. Define Parts Behavior

A part is a group of geometric entities that form a ship or other structure that is to be analyzed in Aqwa.
The name is read in from the geometry database and the graphical view will show the part; the appro-
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priate structure will be highlighted when the part in the tree is selected. Each part will be assigned a
structure number for the analysis. The parts can be included or excluded from the analysis using the
Structure Selection (p. 143).

For each imported part, a set of local structure axes is created. These axes are drawn at the part's center
of gravity.

A number of options can be set for each part in the Details panel.

To help visualization, it is possible to show or hide specific parts using the Part Visibility option, while
the Part Color option can be used to define the color of the surface bodies which make up each part.
The Part Activity option is used to decide what structures are used in the analysis.

Note:

If a part is suppressed, it cannot be used in the analysis. However, when a part is unsup-
pressed, it must be added to the Structure Selection (p. 143) in order for it to be included in
the analysis.

The Mass Properties section displays the Total Mass, the Center of Gravity X, Y, and Z, and the Moment
of Inertia Ixx, Ixy, Ixz, Iyy, Iyz, and Izz for the Part. If the Part includes Internal Tanks, the Total
Structural Mass and Total Internal Tank Mass will also be displayed; the Center of Gravity shown
in the Details panel will be the combined center of gravity including the internal tank fluid. If the Part
includes at least one Program Controlled Point Mass and the Mesh is not up-to-date, the Total Mass
field will display Generate Mesh to Update and all other Mass Properties will be hidden.

If an internal lid is required to prevent irregular frequency problems then Generate Internal Lid can
be set to Yes and it will be automatically generated during the Aqwa analysis. Note that an automatically
generated lid will not be displayed. When Lid Element Size Definition is set to Program Controlled,
the size of the internal lid elements will be set to the mean mesh size of the corresponding structure.
Alternatively, the Lid Element Size can be defined manually by setting Lid Element Size Definition
to Manual Definition.

A manually generated lid may also be used: create an appropriate plane surface as a Surface Body (p. 58);
set Structure Type to Abstract Geometry and Abstract Type to Internal Lid. If you have a structure
with a Moonpool where large resonant waves may occur, then you can form an external lid using a
predefined geometry Surface Body with Structure Type set to Abstract Geometry and Abstract Type
to External Lid.

Note:

The lid normal should be pointing up (away from the fluid). Aqwa will account for an improp-
erly defined normal but will generate a warning.

Hull drag loads may either be accounted for by defining a 6 x 6 matrix of Morison Hull Drag Coefficients,
or by including a table of Current Force Coefficients. Where Morison Hull Drag Coefficients are used,
the current velocity is always measured at the structure center of gravity. Where Current Force Coefficients
are used, a Current Calculation Position should be defined, at which the current velocity is measured
for the hull drag loading calculation. When the Current Calculation Position is set to At Fixed Depth,
a constant Current Calculation Depth can be set. Alternatively, when the Current Calculation Position
is set to Moves with Structure, the Current Calculation Position Definition can be switched between
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Vertex Selection and Manual Definition. If the position definition is set to Vertex Selection, you should
select a Current Calculation Vertex from the geometry and (optionally) define a Vertex X, Y, and Z
Offset. The Vertex X, Y, and Z Position will be read-only. If the position definition is set to Manual
Definition, you should enter the Current Calculation X, Y, and Z Position directly.

By default the structure is set to be free to move. Alternatively, the whole structure can be fixed by
setting Structure Fixity to Structure is Fixed in Place. Fixity primarily affects the results of a hydrodynamic
diffraction analysis by affecting the structure's RAOs. It therefore also has an effect on a hydrodynamic
time response result as the calculated drift forces depend on these RAOs. It is therefore necessary to
impose the coherence between the setup of the two analyses by fixing the structure in the time response
analysis. Since you can create joints to be used in a time response analysis, it is your responsibility to
create a rigid joint when it is connected to a fixed point on any Part marked as Fixed in the Details
dialog. Not doing so will result in an error when solving the time response analysis.

The Mass Multiplying Factor and Drag Multiplying Factor provide a way of modifying the added
mass and drag coefficients defined for any Line Bodies (via their associated Beam Section objects) and
Discs associated with this part. The Added Mass and Transverse Drag are multiplied by these factors
after they have been calculated by Aqwa (the total coefficient applied for each quantity is the cumulative
product of the factor specified by these settings with the factor specified for each Line Body or Disc).
These factors may be used for parametric studies where the effects of Morison drag on Line Bodies and
Discs are considered important (for example, simulating tests at model scale). These factors have no
effect on any other object type in the part.

The Slam Multiplying Factor provides a way to enable the computation of slamming loads on Line
Bodies. By default a factor of zero is specified which disables this computation. Any positive non-zero
value will cause the program to compute the slam coefficient for each Line Body, based on the premise
that the slam force is equal to the rate of change of the added mass tensor (with time) multiplied by
the velocity. The resulting coefficient is then multiplied by this factor. This may be used for parametric
studies where the effects of slamming loads on Line Bodies are considered important (for example,
simulating tests at model scale).

Note:

Slamming loads are not calculated on Morison Disc elements, or on any other object type
in the Part.

Slamming loads can also be included for slender tube elements by setting the Slam Factor to a positive
non-zero value, but the magnitude of the factor is immaterial in this case because a value of unity is
always employed in the analysis.

Note:

The method for computing the slam coefficient requires that the time-step used in a time
history analysis must be sufficiently small to accurately represent the added mass at each
stage of immersion/emergence. In general this will depend on the geometry of each element
and its orientation to the water surface. In practice, this severe restriction of the size of the
time-step means that this facility is only used when specifically investigating the effects of
slam forces on individual elements during critical stages of the simulation period, as the
momentum change due to slam forces are normally small and have little effect on the
overall motion of the structure.
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In analyses containing a single structure only, you may calculate the (static or RAO-based) shear forces
and bending moments (p. 205) acting on that structure under different wave load conditions. Such cal-
culations require the Neutral Axis of the structure to be defined, which can be any one of the Fixed
Reference Axes (FRA) as well as the position of this axis in the perpendicular plane. By default, the
Neutral Axis is assumed to pass through the center of gravity (COG) of the structure. Changing Neutral
Axis Position Definition from Through COG to Manual Definition allows you to define the position
manually. For example, if Neutral Axis is set to Global X, you should also specify the positions Neutral
Axis Y and Neutral Axis Z.

Submerged Structure Detection is Program Controlled by default, and Aqwa will detect the highest
point (greatest Z coordinate) and check whether it is below the water level; alternatively this automatic
detection can be overridden.

The Metacentric Heights can be overridden about both the global X (Override Calculated GMX = Yes)
or Y (Override Calculated GMY = Yes) axes to modify the hydrostatic stiffness of the vessel. When
these are overridden, Aqwa first calculates the hydrostatic stiffness matrix based only on the cut water
plane and displaced volume properties. It then adjusts the second moments of area IXX, IYY and recal-
culates its associated properties, PHI (principal axis), GMX/GMY, BMX/BMY etc. to give the required GM
values. The associated additional hydrostatic stiffness is calculated automatically and stored in the hy-
drodynamic database. If the GM value input is less than that based on the geometry alone, the resulting
additional stiffness will be negative. This would be the case if ballast tanks were being modeled, making
the structure less stable, statically.

A number of Aqwa-specific elements and properties may be added to a Part:

5.5.1. Surface Body

5.5.2. Line Body

5.5.3. Point Mass

5.5.4. Distributed Mass

5.5.5. Point Buoyancy

5.5.6. Disc

5.5.7. Internal Tank

5.5.8. Moonpool

5.5.9. Additional Hydrodynamic Stiffness

5.5.10. Additional Added Mass (Frequency Independent)

5.5.11. Additional Damping (Frequency Independent)

5.5.12. Nonlinear Roll Damping

5.5.13. Current Force Coefficients

5.5.14.Wind Force Coefficients

5.5.15. Morison Hull Drag Coefficients

5.5.16.Yaw-Rate Drag

5.5.17. Structure Connection Points

5.5.18. External Lid

5.5.19. Part Transform

You can remove any of these objects by right-clicking them in the tree and selecting Delete from the
context menu.
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5.5.1. Surface Body

Surface bodies are areas that can be meshed (p. 46) to create diffracting or non-diffracting elements
for the Aqwa analysis. The name of the surface body will be obtained from that given in DesignModel-
er/Discovery Modeling.

If a body is not required for the analysis it can be suppressed (Body Activity). Suppressed bodies will
not be meshed and will be excluded from the analysis. You can hide the body in the graphic window
(Body Visibility), in which case it will not be shown but will be included in the analysis. By default,
each surface body inherits its color from the parent part. You can override this behavior by changing
Body Color Definition to Manual Definition, which allows you to set the Body Color manually.

It is possible to change the type of surface from a Physical Geometry to an Abstract Geometry
(Structure Type). For physical geometry, Program Controlled Surface Type will set all surface bodies
below the water surface as diffracting and those above will be non-diffracting. If required, those below
the water surface can be manually defined as non-diffracting elements for the analysis. This may be
required, for instance, when part of the structure is in contact with the sea bed, or where contact
occurs underwater between adjacent parts.

For an abstract geometry, Abstract Type provides a number of options to select how this geometry
is to be used. If an area is of particular interest, then the Field Point Positions option enables a mesh
to be applied and each node of the mesh will form a field point element; additional information will
be available at these points. Alternatively, Internal Lid and External Lid can be used to suppress
standing waves either between structures or within structures.

Note:

Automatic internal lids can be selected using the Part (p. 54) option.

If the generation of an external lid is specified, two additional parameters are required. The first is a
Lid Damping Factor, set between 0 and 1. The factor represents how effective the lid is to be; 0 will
result in no effect, while 1 will prevent any vertical water surface velocity under the lid.

The second parameter is the Gap for Lid. It is a representative size for the lid; typically the distance
between the two vessels or the width of a moon-pool. It enables the lid properties to be tuned to
the resonant frequency of waves in the gap.

5.5.2. Line Body

Line Bodies are used to create line elements for Aqwa. How they are interpreted depends on the
cross section of the line; if it has a circular or circular tube cross section, then it will be automatically
converted into a standard tubular (TUBE) element. All other sections with dual symmetry will create
slender tube (STUB) elements. Cross sections which are not dual-symmetric are not permissible in
Aqwa, as the centroid and geometric center of the cross section are required to be coincident.

Beam Properties

Each Line Body should be assigned a cross section and an orientation in DesignModeler/Discovery
Modeling. In the Aqwa editor, when importing the geometry, each valid cross sectionis automatically
paired with a Beam Section (p. 99) object. Beam Sections are created under the Line Body Data (p. 99)
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object in the Outline tree. Apart from storing the geometric properties of the cross section, a Beam
Section object also allows mass and hydrodynamic properties to be defined.

Once the geometry has been imported, the name of the cross section assigned to a Line Body in the
geometry editor is provided for reference in the Cross Section field of the Line Body details.

Each Line Body has a Beam Section associated with it. The Line Body inherits geometric, mass and
hydrodynamic properties from the Beam Section. The cross section storedin the Beam Section must
match the Cross Section of the Line Body.

Where multiple Line Bodies have the same cross section but different mass or hydrodynamic properties,
a Beam Section can be Duplicated. The duplicate Beam Section will retain the same cross section
geometry, but can have different mass or hydrodynamic properties defined. In the Line Body details,
the Beam Section field can then be used to select which Beam Section the Line Body inherits its
properties from.

Note:

It is not possible to change the geometric properties of a Line Body in the Aqwa editor.
To do his you must edit the cross section in DesignModeler/Discovery Modeling and re-
import the geometry.

For Line Bodies with circular tube cross sections, the Tube Type field allows you to make the tube
Sealed or Floodable. By default, the tube is sealed, and in this case the tube is buoyant; however, the
tube does not have longitudinal drag or added mass unless discs are created at the ends.

For Line Bodies with circular or circular tube cross sections, discs can automatically be applied at
either (Created at End A Only, Created at End B Only) or both (Created at Both Ends) ends with the
Tube End Discs option; if you choose one of these options, default disc parameters are used. If you
require different parameters, discs can be excluded here and added manually. You cannot automat-
ically add discs to Line Bodies with non-circular cross sections, but you can add them manually if
needed.

Note:

All non-circular cross sections are graphically represented as solid rectangles in Aqwa.

Beam Mass Properties

The mass properties of the Line Body (Mass and X, Y, Z Position of Body COG) are displayed for
information. The mass of the Line Body is determined from the cross section area and material
density of its associated Beam Section, and its center of gravity is calculated from the positions of
the nodes along the Line Body length.

Line Body Axes

The Local Tube Axes (LTA) are defined with their origin at the position of the first node of the element.
The LTA X-axis points from this origin toward the second node of the element. If the orientation of
the Line Body has not otherwise been defined in DesignModeler/Discovery Modeling, the LTA Y-axis
is parallel to the Fixed Reference Axes (FRA) XY plane, and at right-angles to the LTA X-axis; where
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the LTA X-axis is vertical in the FRA, the LTA Y-axis is parallel to the FRA Y-axis. The LTA Z-axis follows
the right-hand rule. For more information, see Morison Equation in the Aqwa Theory Manual.

5.5.3. Point Mass

Surface bodies do not have a mass directly associated with them. In order to include the mass effects
of a surface body, one or more point mass elements should be included.

To add a Point Mass element:

1. Select a Part in the tree view.

2. Right-click the Part and select Add > Point Mass, or click the Point Mass icon in the Parts toolbar.

3. Select the Point Mass object in the tree and set the properties manually, or select Program Con-
trolled.

If Mass Definition is set to Manual, you must input all the properties for the point mass (Mass, X, Y,
and Z Position coordinates)

Alternatively, if a Program Controlled point mass is used, the mass and the horizontal position are
calculated from the panel elements and any manually-defined point masses, distributed masses, point
buoyancies, or Line Bodies in the structure. The total structure mass equals the mass of water displaced,
and the horizontal position of the Program Controlled point mass is calculated such that the structure
center of gravity lies on the same vertical line as the center of buoyancy.

If the point mass is Program Controlled, its horizontal position and mass will not be displayed until
a mesh has been generated; the Mass field will show an informational message Generate Mesh to
Update.

The moments of inertia (or radii of gyration) and vertical position Z Position cannot be determined
by the program and must always be input. Moments of inertia can be defined directly or by inputting
radii of gyration. If Define Inertia Values By is set to via Radius of Gyration, you need to enter Kxx,
Kyy, and Kzz. If you select Direct Input of Inertia, you must enter the Ixx, Iyy, and Izz values. The off-
diagonal terms Ixy, Ixz, and Iyz may optionally be entered.

If the point mass is Program Controlled, the inertia properties which are not entered by the user will
not be displayed until the Mass has been updated. For example: if Define Inertia Values By is set
to Radius of Gyration, the inertia components Ixx, Iyy, and Izz will not be shown until the mass is
determined.

5.5.4. Distributed Mass

If you intend to perform calculations of Shear Forces/Bending Moments or Splitting Forces for a Part,
it is necessary to define a distribution of mass across that Part. You can do this by defining multiple
Point Masses, but it is usually more convenient to create a Distributed Mass object.

A mass distribution can be defined directly in a table, or by importing the information from an existing
.MSD or .SFM file.

To add a Distributed Mass:

1. Select a Part in the tree view.
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2. Right-click the Part and select Add → Distributed Mass, or click the Distributed Mass icon in the
Parts toolbar. To define data directly in a table, select Add → Distributed Mass → Manual Input.
To read data from a file, select Add → Distributed Mass → Import MSD File or Add → Distributed
Mass → Import SFM File.

Note:

After the data is imported from a .MSD or .SFM file, no record of the file used to import
the data is retained.

The Distributed Mass Definition Data table allows you to define the mass and inertia properties of
any number of mass contributions across the Part. Each contribution is defined by its:

• Mass

• X/Y/Z Start, defining the minimum location of the mass contribution

• X/Y/Z CoG, defining the center of gravity of the mass contribution

• X/Y/Z End, defining the maximum location of the mass contribution

• Inertia terms Ixx, Ixy, Ixz, Iyy, Iyz, Izz

Each mass contribution is evenly distributed over its defined extents (from X/Y/Z Start to X/Y/Z End).

The usage of this data depends on the type of calculation that you are performing. For a Splitting
Forces calculation all of the mass, center of gravity, and inertia terms are used, but the extents of the
mass contribution (X/Y/Z Start and X/Y/Z End) are not relevant. For a Shear Forces/Bending Moments
calculation the extents are used, but only the inertia term about the Part’s Neutral Axis is required.

Note:

If the Calculate Shear Force/Bending Moment option under the Details of the Part is set
to No, the extents of each mass contribution (X/Y/Z Start and X/Y/Z End) will be hidden
in the Distributed Mass Definition Data table, as only Splitting Forces calculations will be
permitted.

5.5.4.1. Importing from a .MSD File

When a mass distribution is imported from a .MSD file, that file will also contain a neutral axis dir-
ection which defines how the imported data is interpreted. The data will only include the extents
of each mass contribution in the neutral axis direction, and the principal inertia term for each
contribution about that neutral axis. The extents in other directions will be assumed from the di-
mensions of the Part, and other inertia terms should be defined manually.

The unit system of the data in the .MSD file is assumed to match the display unit system of the
project. However, the imported data can be modified by setting the Length Unit for Imported
Data and Mass Unit for Imported Data to the required unit system.
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5.5.4.2. Importing from a .SFM File

When a mass distribution is imported from a .SFM file, the data will only include the mass, center
of gravity position and inertia terms for each mass contribution. The extents of each mass contribu-
tion will be assumed from the dimensions of the Part.

The unit system of the data in the .SFM file is assumed to match the display unit system of the
project. However, the imported data can be modified by setting the Length Unit for Imported
Data and Mass Unit for Imported Data to the required unit system.

5.5.4.3. Inputting Data Manually

Distributed Mass data can be entered directly in the Distributed Mass Definition Data table, can be
copied and pasted from an external source (for example, an Excel spreadsheet), or can be imported
from a comma-separated values (.CSV) file using the Import CSV File option. For the Import CSV
File option, the file must meet the following requirements:

• Has the .CSV extension

• Contains values separated by commas, tabs, or single spaces (not multiple spaces)

• Contains exactly 16 columns, which are (1) Mass, (2-4) X/Y/Z Start, (5-7)X/Y/Z CoG, (8-10) X/Y/Z
End and (11-16) Inertia terms Ixx, Ixy, Ixz, Iyy, Iyz, Izz

The unit system of the data in the .CSV file is assumed to match the display unit system of the
project. However, the imported data can be modified by setting the Length Unit for Imported
Data and Mass Unit for Imported Data to the required unit system.

Note:

Imported .CSV data should still include columns for mass contribution extents (X/Y/Z
Start and X/Y/Z End) even if the Part's Calculate Shear Force/Bending Moment option
is set to No.

5.5.4.4. Representation in the Graphical Window

The graphical representation of a Distributed Mass depends on the Part’s Calculate Shear
Force/Bending Moment option. If this is set to Yes, each mass contribution will be drawn as a
colored cuboid over its defined extents (X/Y/Z Start and X/Y/Z End):
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If the Part's Calculate Shear Force/Bending Moment option is set to No, each mass contribution
will be drawn as a dark green sphere at its defined center of gravity position:

5.5.5. Point Buoyancy

If additional buoyancy is required for a part, then Point Buoyancy elements may be included.

To add a Point Buoyancy element:

1. Select a Part in the tree view.

2. Right-click the Part and select Add > Point Buoyancy, or click the Point Buoyancy icon in the
Parts toolbar.

3. Select the Point Buoyancy object in the tree and set the properties. Point Buoyancy objects require
a position (X, Y, Z) and a Volume.

5.5.6. Disc

Disc elements can be used to create an area that has drag and added mass in the direction perpen-
dicular to the disc.
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To add a Disc element:

1. Select a Part in the tree view.

2. Right-click the Part and select Add > Disc, or click the Disc icon in the Parts toolbar.

3. Select the Disc object in the tree and set the properties.

The Diameter of the disc is required along with the centroid and the definition of the normal direction.
If the centroid is at the position of an existing vertex, set Centroid Definition to Select Vertex and
click Pick in the Vertex field; then select the vertex on the model and click Apply. To enter the co-
ordinates of the vertex directly, set Centroid Definition to Specify Coordinates, and enter the X, Y,
and Z values.

You can specify the normal by picking a second vertex or specifying the direction of a normal vector.
To use an existing vertex to define the normal, set Normal Definition to Select Second Vertex and
click Pick in the Normal Vertex field; then select the vertex on the model and click Apply. To enter
the vector for the normal directly, set Normal Definition to Specify Vector Components, and enter
the Normal X, Normal Y, and Normal Z component values.

The default values of the added mass (Added Mass Coefficient) and viscous drag coefficients (Drag
Coefficient) can be modified if desired. See Properties of Typical Morison Elements in the Aqwa Theory
Manual to see how these coefficients are used in the program.

Note:

Drag is not used in Hydrodynamic Diffraction (p. 130) or Frequency Statistical Analyses (p. 140)
unless the Linearized Morison Drag option is used from the Common Analysis Options.

5.5.7. Internal Tank

Internal tanks are filled with fluid for storage purposes or stability, particularly in marine structures
such as ships and submarines. Ballast tanks, oil tanks and fresh water tanks are examples of internal
tanks. Aqwa Workbench can define and simulate internal tanks for hydrostatic and hydrodynamic
analyses.

To include an Internal Tank object in your model:

1. Select a Part in the tree view.

2. Right-click the Part and select Add → Internal Tank, or click the Internal Tank icon in the Parts

toolbar .

3. Select the Internal Tank object in the tree.

4. Select a Fluid Level Definition Mode (p. 65) and set the properties described in Internal Tank
Properties (p. 67).

You must define the Internal Tank geometry by selecting the Internal Tank Surfaces in the Graphical
Window, where those surfaces must be selected from the Surface Bodies that make up the associated
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Part. Both the diffracting and non-diffracting internal tank surfaces should be selected here. The surface
normals should point inwards into the internal tank fluid.

At this point, the selected Surface Bodies are now linked with the Internal Tank. The name of the In-
ternal Tank is appended to the name of the Surface Body in the tree view to indicate this. If you
change the Activity of the Internal Tank, the activity of any linked Surface Bodies will also be changed.
If the Surface Bodies are deselected from the Internal Tank Surfaces or the Internal Tank object is
deleted, this linkage is removed.

5.5.7.1. Fluid Level Definition Mode

The Internal Tank definition requires you to specify the level of the fluid surface inside the tank.
Previously, it was mandatory to use the Geometry editor to split or slice your internal tank surfaces
at the fluid level, to ensure that diffracting panel elements do not cross it. However, you can now
generate a mesh which automatically includes internal tank fluid level nodes for some modes. The
corners of the elements are known as nodes, so the nodes on the fluid level are named as the fluid
level nodes. In relation to the fluid level, note that all mesh nodes:

• Must lay on or below the fluid level for diffracting elements.

• Must lay on or above the fluid level for non-diffracting elements.

This is illustrated below, where the fluid level is shown by a yellow line:

The following are the various modes you can set to determine the fluid level within the internal
tank:

Edge Selection

This defines the fluid surface height by picking a horizontal edge in the Graphical Window, from
the selected internal tank geometry. The Aqwa Workbench editor uses the vertical position of the
edge as the fluid surface height. You can define the position of the internal tank fluid free surface
by selecting an edge at the interface between the diffracting and non-diffracting surfaces of the
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internal tank, using the Fluid Level Definition. You do not need to select a closed loop of edges;
a single edge is sufficient. The selected edge must be horizontal (parallel to the XY plane) and must
be connected to at least one of the selected Internal Tank Surfaces. The Surface Height (in
Global Axes) field shows the Global Z position of the free surface.

To set Edge Selection:

1. Select your Internal Tank of choice in the Graphical Window.

2. Click Apply for Internal Tank Surfaces in the Details Panel.

3. Change the Fluid Level Definition Mode to Edge Selection.

4. Click Fluid Level Definition, select an edge on the model, and click Apply.

Note:

Once a surface is associated with the Moonpool, it stays linked to this object, whether
it is supressed or not. If you want to use the surface as part of your active model for
further analysis, you must release this surface from your Moonpool object by carrying
out a new surface selection that excludes this particular surface. Then, your surface be-
comes ready for further use, and you can suppress your Moonpool object.

Surface Height

This measures the vertical depth of the fluid in the internal tank. You can set the Fluid Level
Definition Mode to Surface Height and enter a value directly into the Surface Height (in Global
Axes) field. This can also be marked as an input parameter for a Design Point study.

To set Surface Height:

1. Select your Internal Tank of choice in the Graphical Window.

2. Click Apply for Internal Tank Surfaces in the Details Panel.

3. Change the Fluid Level Definition Mode to Surface Height.

4. Provide a numerical value in the Surface Height (in Global Axes) field.

Note:

To automatically include fluid level nodes, set Mesh>Waterline Node Generation>Create
Automatic Waterline Nodes to Yes before setting the Fluid Level Definition Mode to
Surface Height.

Fluid Volume

This capability allows you to set a target fluid volume for the internal tank. When a value is entered
in the Fluid Volume (Target) field, Aqwa Workbench produces an estimate in the Surface Height
(in Global Axes) and Total Capacity (Estimated) fields. This mode considers the varying shapes
of marine structures which can make it more complex to calculate the surface height of the fluid
level.
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To set Fluid Volume:

1. Select your Internal Tank of choice in the Graphical Window.

2. Click Apply for Internal Tank Surfaces in the Details Panel.

3. Change Fluid Level Definition Mode to Fluid Volume.

4. Provide a numerical value in the Fluid Volume (Target) field.

Fluid Volume can also be set as a parameter when observing the hydrostatic behavior and hydro-
dynamic properties of marine structures to measure their stability. This can be done by setting the
Fluid Volume as an input parameter and the Metacentric Height as an output parameter, such
that the Metacentric Height is directly affected when the Fluid Volume is modified.

You can find the Parameter Set in the Project Schematic. The Outline of All Parameters displays
a table which contains all defined input and output parameters. The Table of Design Points enables
you to list multiple values under Fluid Volume and Aqwa Workbench will produce the corresponding
metacentric heights for each of these values.

Note:

To automatically include fluid level nodes, set Mesh>Waterline Node Generation>Create
Automatic Waterline Nodes to Yes before setting the Fluid Level Definition Mode to
Fluid Volume.

5.5.7.2. Internal Tank Properties

The following are properties of the internal tank and its contained fluid that must be defined in
Aqwa Workbench:

• Permeability: This is the empty proportion of the defined space, accounting for stiffeners, baffles
etc. that may not have been included in the hydrodynamic model. It typically takes a value of
0.95 or higher.

• Fluid Density: This is used to set the density of the fluid contained in the internal tank.

• Damping Factor: Due to the linear potential theory used in the Hydrodynamic Diffraction ana-
lysis, which does not account for fluid viscosity in the solution, a damping model is applied to
attenuate any unphysical resonant liquid motion. This property usually takes a value in the range
[0, 0.1].

The Internal Tank hydrostatic properties are automatically determined from the mesh and the in-
ternal fluid density and tank permeability. The Internal Tank Fluid Mass, Fluid Center of Gravity
X, Y and Z and the Fluid Center of Floatation X and Y are displayed once a mesh has been gen-
erated; otherwise, the Fluid Mass field will show an informational message, "Generate Mesh to
Update".
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5.5.8. Moonpool

Moonpools are features of marine structures such as drilling platforms, drill ships, diving support
vessels as well as some marine and underwater exploration/research vessels. In underwater habitats,
they are also known as a wet porch.

Simply described, a moonpool is an opening in the floor or base of the hull, platform, or chamber,
which gives sheltered access to the water body below to enter or leave the water in a more protected
environment compared to the deck.

Note:

Active Moonpool objects are only supported when performing Hydrodynamic Diffraction
analyses.

Hydrodynamic Response analyses (Stability, Time Response, and Frequency Domain analyses)
will not solve if they are active in the Project tree. In addition, you cannot transfer the
pressure distribution field to a Mechanical system via the ACT load mapping.

To include a Moonpool object in your model:

1. Select a Part in the tree view.

2. Right-click the Part and select Add > Moonpool, or click the Moonpool icon in the Parts

toolbar .

3. Select the Moonpool object in the tree.

You can define up to 10 Moonpool objects per structure, and each object's Details panel must be
populated.

Figure 5.3: Moonpool Object Details Panel

5.5.8.1. Geometry

Following the model definition of a Moonpool described in Prescribed Oscillatory Pressure Distribu-
tion Approach, you must define the Moonpool geometry by selecting the Moonpool Surfaces in
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the Graphical Window, where those surfaces must be selected from the Surface Bodies that make
up the associated Part.

Your Moonpool should contain at least three types of surfaces:

• The wall surfaces that physically correspond to the Moonpool location.

If a portion of the surfaces was made at the waterline in the Geometry editor, both the dif-
fracting and non-diffracting Moonpool wall surfaces should be selected here. Alternatively,
the water nodes can be automatically created if the Create Automatic Waterline Nodes
option is turned on in the Mesh (see Waterline Node Generation (p. 51)). This prevents cutting
the wall surface. The surface normal should point toward the enclosed sea volume.

• The free surface is an abstract surface which corresponds to the surface of the Moonpool at
the water level. By default, the Moonpool Free Surfaces option displays Program Controlled,
and the free surface is automatically created when the mesh is generated. However, you
can still manually select a free surface, in which case the surface normal should point upwards

so that . >0. In the case of a normal pointing downward, the application flips the
normal in the background when generating the mesh, so that the normal of the panels for
this surface is pointing upward as required by the solver.

• The matching surface is also an abstract surface and corresponds to the portion of the
Moonpool walls through the structure's hull. The surface normal should point towards the

enclosed sea volume, which will be upwards in most cases so that . >0. Similar to
the free surface, if the normal is pointing downward, a flip is performed in the background
when creating the mesh, so that the normal of each panel for this surface is pointing upward.

When selecting a surface:

1. Ensure that your target surface is visible or it will not be displayed.

2. Enter the selection mode and/or select the Moonpool. A bright green color will appear and
indicate the direction the normal to the surface is pointing to.

For example, normal vectors are added to the free and wall surfaces, as indicated by the pointers
in Figure 5.4: Moonpool Walls and Free Surface with Normal Vectors Pointing Inward (Wall Surfaces)
and Upward (Free Surface) (p. 69).

Figure 5.4: Moonpool Walls and Free Surface with Normal Vectors Pointing Inward (Wall
Surfaces) and Upward (Free Surface)
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Selecting and Releasing Moonpool Surfaces

To select your bodies:

1. Click Moonpool Wall Surfaces (whose field may contain No Geometry Selected or the
number of bodies previously selected) to enter the selection mode.

2. Select your target surfaces in your model in the Graphical editor.

3. Click Apply once your selection is made.

Any new valid selection will replace the previous one. If you need to add a body to your previous
selection, add and group the pre-associated bodies.

Moonpool surfaces must belong to the same Part. They must also be associated to one unique
Moonpool  and  one type of surface, once selected.

To release the surface selection associated to a type of surface:

1. Enter the selection mode (as you would to select new bodies).

2. Click the Graphical editor background.

3. Click Apply.
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This will clear your current selection, and the Moonpool Wall Surfaces field with No Geometry
Selected will turn yellow.

At this point, the selected Surface Bodies are now linked with the Moonpool. The Surface Bodies
are grouped under the Moonpool in the tree view to indicate this. If you change the activity of the
Moonpool, the activity of any linked Surface Bodies also changes. If the Surface Bodies are
deselected from the Moonpool Surfaces or the Moonpool object is deleted, this linkage is removed.

Note:

Once a surface is associated with the Moonpool, it stays linked to this object, whether
it is supressed or not. If you want to use the surface as part of your active model for
further analysis, you must release this surface from your Moonpool object by carrying
out a new surface selection that excludes this particular surface. Then, your surface be-
comes ready for further use, and you can suppress your Moonpool object.

Moonpool Properties

The following Moonpool properties must be defined in Aqwa Workbench:

• Pressure Modes: They correspond to the pressure distribution on the mean free surface inside
the Moonpool. You can define up to 20 pressure modes per Moonpool. Each must be unique
within their associated Moonpool. A comprehensive definition of the possible non-dimensional
pressure distribution model shapes is found in Prescribed Oscillatory Pressure Distribution Ap-
proach.

In Figure 5.3: Moonpool Object Details Panel (p. 68), Mode X and Mode Y values must be of a
non-negative integer, corresponding to the modal number n in X-direction and the modal
number m in Y-direction respectively in Equation 4.125 through Equation 4.127 in the Aqwa
Theory Manual.

The default definition corresponds to the piston mode defined as a combination of sine and cosine
functions. Piston-type pressure modes are also defined as:

– A Legendre function where the x and y  values equal 0.

– A Bessel function where the x value equals 0.

No more than one piston definition is allowed in a Moonpool model, regardless of their formula-
tion.

Note:

Results selection based on Moonpool pressure modes (whether as a SubType or
Component) becomes invalid if the number of pressure modes is modified for any
Moonpool. Manually select a new pressure mode to use to query the line results.

• Damping Factor: Due to the linear potential theory used in the Hydrodynamic Diffraction ana-
lysis, which does not account for fluid viscosity in the solution, a damping model is applied to
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attenuate any unphysical standing wave motion within the restricted fluid region. The default
value is set to 0.1.

5.5.9. Additional Hydrodynamic Stiffness

This object may be used to input an additional linear hydrostatic stiffness matrix using tabular input
in the Matrix Definition Data window. The linear stiffness matrix relates to the hydrostatic forces
contributing to the equations of static equilibrium of a structure. Specifically, the net linear hydrostatic
forces , acting at the center of gravity of a structure, when the structure is at an arbitrary position
X, are given by:

where:

 = stiffness matrix

 = additional hydrodynamic stiffness matrix input on this object

 = equilibrium position

 = buoyancy force at equilibrium

If additional hydrodynamic stiffness is used it should be checked that the above expression, which
is used to calculate the linear hydrostatic forces throughout the Aqwa suite, produces the forces on
the structure intended by the user.

Note:

In this context, hydrostatic forces can act in all 6 degrees of freedom.

In the equation above, the term X(e) is the diffraction analysis defined position. If the initial position
in a subsequent motions analysis is not as defined in the diffraction run, then there will be restoring
forces which will try to return the structure to the diffraction defined position.

To add an Additional Hydrodynamic Stiffness Matrix:

1. Select a Part in the tree view.

2. Right-click the Part and select Add > Additional Hydrodynamic Stiffness, or click the Hydro-
dynamic Properties icon in the Parts toolbar and select Additional Hydrodynamic Stiffness
from the dropdown menu.

Matrix Definition Data can be entered manually, can be copied and pasted from an external source
(for example, an Excel spreadsheet), or can be imported from a comma-separated values (.CSV) file
using the Import CSV File option. For the Import CSV File option, the file must meet the following
requirements:

• Has the .CSV extension.

• Contains values separated by commas, tabs, or single spaces (not multiple spaces).

• Contains exactly 6 columns and 6 rows.
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The unit system of the data in the .CSV file is assumed to match the display unit system of the project.
However, the imported data can be modified by setting the Length Unit for Imported Data, Force
Unit for Imported Data, and Rotation Unit for Imported Data to the required unit system.

5.5.10. Additional Added Mass (Frequency Independent)

This object may be used to input frequency independent additional added mass in global directions
using tabular input. Only one definition of Additional Added Mass per structure can be active or not
suppressed for the analysis and the values are added to those calculated automatically during the
analysis.

To add Additional Added Mass:

1. Select a Part in the tree view.

2. Right-click the part and select Add > Additional Added Mass, or click the Hydrodynamic Prop-
erties icon in the Parts toolbar and select Additional Added Mass from the dropdown menu.

Matrix Definition Data can be entered manually, can be copied and pasted from an external source
(for example, an Excel spreadsheet), or can be imported from a comma-separated values (.CSV) file
using the Import CSV File option. For the Import CSV File option, the file must meet the following
requirements:

• Has the .CSV extension.

• Contains values separated by commas, tabs, or single spaces (not multiple spaces).

• Contains exactly 6 columns and 6 rows.

The unit system of the data in the .CSV file is assumed to match the display unit system of the project.
However, the imported data can be modified by setting the Length Unit for Imported Data, Mass
Unit for Imported Data, and Rotation Unit for Imported Data to the required unit system.

5.5.11. Additional Damping (Frequency Independent)

This object may be used to input frequency independent additional damping in global directions
using tabular input. Only one definition of Additional Damping per structure can be active or not
suppressed for the analysis and the values are added to those calculated automatically during the
analysis.

To add Additional Damping:

1. Select a Part in the tree view.

2. Right-click the Part and select Add > Additional Damping, or click the Hydrodynamic Properties
icon in the Parts toolbar and select Additional Damping from the dropdown menu.

Matrix Definition Data can be entered manually, can be copied and pasted from an external source
(for example, an Excel spreadsheet), or can be imported from a comma-separated values (.CSV) file
using the Import CSV File option. For the Import CSV File option, the file must meet the following
requirements:

• Has the .CSV extension.
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• Contains values separated by commas, tabs, or single spaces (not multiple spaces).

• Contains exactly 6 columns and 6 rows.

The unit system of the data in the .CSV file is assumed to match the display unit system of the project.
However, the imported data can be modified by setting the Length Unit for Imported Data, Force
Unit for Imported Data, and Rotation Unit for Imported Data to the required unit system.

5.5.12. Nonlinear Roll Damping

Nonlinear roll damping moment can be calculated in Time Response and Frequency Statistical analyses
to take into account the effect of vortex shedding from the bilges and bilge keels of a vessel.

To add Nonlinear Roll Damping properties:

1. Select a Part in the tree view.

2. Right-click the Part and select Add > Nonlinear Roll Damping, or click the Nonlinear Roll
Damping icon in the Parts toolbar.

3. Select the Nonlinear Roll Damping object in the tree and set the properties.

The method for bilge vortex shedding is based on "An Engineering Assessment of the Roll of Non-
linearities in Transportation Barge Roll Response," Robinson and Stoddart, Trans. R.I.N.A., 1986.

The method for bilge keel roll damping is based on "ITTC recommended procedures 7.5-02-07-04.5
- Numerical estimation of roll damping", 2011.

Whether vortex shedding is occurring or not is calculated by the program based on the relative flow
velocity at the bilge, Keulegan-Carpenter number, roll natural frequency of the vessel, and the radius
of the bilge. The roll damping coefficient used in the nonlinear roll damping force calculation is also
calculated by Aqwa based on a database stored within the program.

To compute the effects of nonlinear roll damping, select one of the following options from the
Nonlinear Roll Damping drop-down menu:

• Use a Coefficient

• Define Bilge Parameters

• Combine Coefficient and Bilge Parameters

For all three options, you must define an axis on which the damping moment is applied. A central
line must be defined by an Aft End Position and a Forward End Position; each has an End Position
Definition which can be switched between Vertex Selection and Manual Definition. If the End Position
Definition is set to Vertex Selection, you should select an End Vertex from the geometry and (op-
tionally) define the End Vertex X Offset and End Vertex Y Offset. The End X Position and End Y
Position will be read-only. If the End Position Definition is set to Manual Definition, you should
enter the End X Position and End Y Position directly.

When defining a coefficient (Use a Coefficient or Combine Coefficient and Bilge Parameters), use the
Quadratic Roll Damping Coefficient field.
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When defining bilge parameters, it is assumed that the two bilges have symmetric properties about
the center line of the vessel. The Bilge Type field allows you to control the type of damping calculated.
By default, this field is set to Vortex Shedding Only. You can also select Bilge Vortex Shedding and
Bilge Keel Roll Damping to calculate the roll damping effects of the bilge keel. The Bilge Radius
defines the local radius of the bilge corner. The Depth to Bilge is the vertical position of the bilge
corner on the vessel in the global axis system. The Offset of Bilge from Central Line is the lateral
offset of the bilge corner from the center line of the vessel in the global axis system.

Note:

When an End Position Definition is set to Vertex Selection, the vertical position of the
vertex selected for that central line end point is irrelevant; the vertical position of the
central line is always set by Depth to Bilge.

75
Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Define Parts Behavior



If you set Bilge Type to Bilge Vortex Shedding and Bilge Keel Roll Damping, the Bilge Keel Details
submenu becomes available. You can set the Bilge Keel Length and Bilge Keel Breadth. Changing
Advanced Bilge Keel Options to Manual Definition allows you to set the Draft of Vessel and Breadth
of Vessel.
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5.5.13. Current Force Coefficients

This object may be used to include the viscous drag of the current on the hull of a fixed or floating
structure, using tabular input in the Current Force Coefficients window. The term current force coef-
ficient is used to differentiate these coefficients from traditional drag coefficients and from coefficients
of wind force.

To add a Current Force Coefficients object:

1. Select a part in the tree view.

2. Right-click the Part and select Add > Current Force Coefficients, or click the Force Coefficients
icon in the Parts toolbar and select Current Force Coefficients from the dropdown menu.

3. Select the Current Force Coefficients object in the tree view and enter the coefficients in the
Coefficient Data window that appears below the model. Enter the Direction of the current (-180
to +180 degrees), the X force coefficient (Translation X), Y force coefficient (Translation Y), Z
force coefficient (Translation Z), Rotation about X coefficient (Rotation X), Rotation about Y
coefficient (Rotation Y), and Rotation about Z coefficient (Rotation Z). The number of rows is
increased as each entry is made, up to a maximum of 41 rows.

The current force coefficients are defined as the force or moment per unit velocity squared. The mo-
ment is about the center of gravity of the structure. These forces are a function of the relative velocity
between the structure and the water. This means that the current coefficient should still be input
even when there is no current present, as the relative velocity is generally non-zero for a dynamic
analysis.

The Coefficient Data table must include an entry for the direction of -180 degrees. The coefficients
defined for -180 degrees are automatically copied to the +180 degrees row, and these copied values
cannot be modified (but will update if the -180 degree values are subsequently modified). Direction
entries outside the range of -180 to +180 degrees are automatically adjusted to this range, and rows
are sorted in ascending order of Direction. Duplicate Direction entries are not valid and may be re-
moved by selecting the entire row and pressing the Delete key.

Coefficient Data can be entered manually, can be copied and pasted from an external source (for
example, an Excel spreadsheet), or can be imported from a comma-separated values (.CSV) file using
the Import CSV File option. For the Import CSV File option, the file must meet the following require-
ments:

• Has the .CSV extension.

• Contains values separated by commas, tabs, or single spaces (not multiple spaces).

• Contains exactly 7 columns, and no more than 41 rows.

The unit system of the data in the .CSV file is assumed to match the display unit system of the project.
However, the imported data can be modified by setting the Length Unit for Imported Data, Rotation
Unit for Imported Data , and Force Unit for Imported Data to the required unit system.

Note that the forces are in the directions of the axes, not in the direction of the current. For example,
for relative current velocity V in direction ϕ:
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force in X direction = CUFXϕ.V2

force in Y direction = CUFYϕ.V2

moment about Z axis = CURZϕ.V2

where CUFX, CUFY and CURZ are the coefficients. Similar equations apply for force in Z and moments
about X and Y.

The coefficients are applied in a moving axis system; that is, the axes move with the structure. Since
there is no structure local axis system available, the initial coefficient data must be defined relative
to the global coordinate system when the structure is in the position as defined in the geometry. For
example:
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Note:

• Only one active Current Force Coefficient object may be included for each structure.

• There is a limit of 41 unique directions for the enabled Wind Force Coefficient and Current
Force Coefficient tables combined. Each table may have an entry for the same Direction
value.

• If a direction is specified for Wind Force Coefficients that does not exist for Current Force
Coefficients then linearly interpolated values will be utilized for the Current Force Coef-
ficients for that direction, based upon adjacent defined directions.
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5.5.14. Wind Force Coefficients

This object may be used to include the viscous drag of the wind on the superstructure of a fixed or
floating structure using tabular input in the Wind Force Coefficients window. The term wind force
coefficient is used to differentiate these coefficients from traditional drag coefficients and from coef-
ficients of current force.

To add a Wind Force Coefficients object:

1. Select a Part in the tree view.

2. Right-click the Part and select Add > Wind Force Coefficients, or click the Force Coefficients
icon in the Parts toolbar and select Wind Force Coefficients from the dropdown menu.

3. Select the Wind Force Coefficients object in the tree view and enter the coefficients in the Wind
Force Coefficients window that appears below the model. Enter the Direction of the wind (-180
to +180 degrees), the X force coefficient (Translation X), Y force coefficient (Translation Y), Z
force coefficient (Translation Z), Rotation about X coefficient (Rotation X), Rotation about Y
coefficient (Rotation Y), and Rotation about Z coefficient (Rotation Z). The number of rows is
increased as each entry is made, up to a maximum of 41 rows.

The wind force coefficients are defined as the force or moment per unit velocity squared. The moment
is about the center of gravity of the structure. These forces are a function of the relative velocity
between the structure and the air. This means that the wind coefficient should still be input even
when there is no wind present, as the relative velocity is generally non-zero for a dynamic analysis.

The Coefficient Data table must include an entry for the direction of -180 degrees. The coefficients
defined for -180 degrees are automatically copied to the +180 degrees row, and these copied values
cannot be modified (but will update if the -180 degree values are subsequently modified). Direction
entries outside the range of -180 to +180 degrees are automatically adjusted to this range, and rows
are sorted in ascending order of Direction. Duplicate Direction entries are not valid and may be re-
moved by selecting the entire row and pressing the Delete key.

Coefficient Data can be entered manually, can be copied and pasted from an external source (for
example, an Excel spreadsheet), or can be imported from a comma-separated values (.CSV) file using
the Import CSV File option. For the Import CSV File option, the file must meet the following require-
ments:

• Has the .CSV extension.

• Contains values separated by commas, tabs, or single spaces (not multiple spaces).

• Contains exactly 7 columns, and no more than 41 rows.

The unit system of the data in the .CSV file is assumed to match the display unit system of the project.
However, the imported data can be modified by setting the Length Unit for Imported Data, Rotation
Unit for Imported Data , and Force Unit for Imported Data to the required unit system.

Note that the forces are in the directions of the axes, not in the direction of the wind. For example,
for relative wind velocity V in direction ϕ:

force in X direction = WIFXϕ.V2
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force in Y direction = WIFYϕ.V2

moment about Z axis = WIRZϕ.V2

where WIFX, WIFY and WIRZ are the coefficients. Similar equations apply for force in Z and moments
about X and Y.

The coefficients are applied in a moving axis system. This means that the axes move with the structure.
Since there is no structure local axis system available, the initial coefficient data must be defined rel-
ative to the global coordinate system when the structure is in the position as defined in the geometry.
For example:
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Note:

• Only one active Wind Force Coefficient object may be included for each structure.

• There is a limit of 41 unique directions for the enabled Wind Force Coefficient and Current
Force Coefficient tables combined. Each table may have an entry for the same Direction
value.

• If a direction is specified for Current Force Coefficients that does not exist for Wind Force
Coefficients then linearly interpolated values will be utilized for the Wind Force Coeffi-
cients for that direction, based upon adjacent defined directions.
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5.5.15. Morison Hull Drag Coefficients

This object may be used to input a Morison Hull Drag Coefficients matrix using tabular input in the
Matrix Definition Data window. In a Hydrodynamic Response analysis these coefficients are used to
calculate hull drag forces and moments in a similar way to that for a Morison element. Specifically,
the drag forces and moments acting at the center of gravity of the structure, when the structure ex-
periences a relative fluid velocity, are given by:

Where  is the 6 x 6 Morison Hull Drag Coefficient matrix. The relative fluid velocity is determined
as the difference between any current velocity and the structure velocity; the fluid particle velocity
due to waves is not included.

Note:

Morison Hull Drag Coefficients are not used in a Hydrodynamic Diffraction analysis, even
when the Linearized Drag option has been turned on.

In a Frequency Statistical Analysis, Morison hull drag forces can be included using the
Linearized Drag option.

The relative fluid velocity is always evaluated at the structure's center of gravity; the Part
Current Calculation Position has no effect on this drag calculation.

To add a Morison Hull Drag Coefficients matrix:

1. Select a Part in the tree view.

2. Right-click the Part and select Add > Morison Hull Drag Coefficients, or click the Hydrodynamic
Properties icon in the Parts toolbar and select Morison Hull Drag Coefficients from the dropdown
menu.

3. Select the Morison Hull Drag Coefficients object in the tree and enter the matrix coefficients in
the Matrix Definition Data window that appears below the model.

Matrix Definition Data can be entered manually, can be copied and pasted from an external source
(for example, an Excel spreadsheet), or can be imported from a comma-seperated values (.CSV) file
using the Import CSV File option. For the Import CSV File option, the file must meet the following
requirements:

• Has the .CSV extension.

• Contains values seperated by commas, tabs, or single spaces (not multiple spaces).

• Contains exactly 6 columns and 6 rows.

The unit system of the data in the .CSV file is assumed to match the display unit system of the project.
However, the imported data can be modified by setting the Length Unit for Imported Data, Force
Unit for Imported Data, and Rotation Unit for Imported Data to the required unit system.
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5.5.16. Yaw-Rate Drag

Although current and wind loads on a structure can be modeled in Aqwa by including Current Force
Coefficients (p. 77) and Wind Force Coefficients (p. 80), these loads have no dependence on the yaw
rotational velocity. The yaw-rate drag moment can be modeled separately by the addition of a Yaw-
Rate Drag object to the Part.

To add Yaw-Rate Drag properties:

1. Select the Part in the tree view.

2. Right-click the Part and select Add > Yaw-Rate Drag, or click the Yaw-Rate Drag icon in the
Parts toolbar.

3. Select the Yaw-Rate Drag object in the tree and set the properties.

The yaw-rate drag calculation requires the definition of a geometric central line for the structure, and
a Yaw-Rate Drag Force Coefficient. The yaw-rate drag loads are calculated from the input properties
using the approach described in Yaw Rate Drag Force in the Aqwa Theory Manual.

The central line must be defined by an Aft End Position and a Forward End Position; each has an End
Position Definition which can be switched between Vertex Selection and Manual Definition. If the
End Position Definition is set to Vertex Selection, you should select an End Vertex from the geometry
and (optionally) define the End Vertex X Offset and End Vertex Y Offset. The End X Position and
End Y Position will be read-only. If the End Position Definition is set to Manual Definition, you
should enter the End X Position and End Y Position directly.

Note:

• Only one active Yaw-Rate Drag object may be included for each structure.

• As Yaw-Rate Drag depends on the relative structure velocity, it is used in time domain
Hydrodynamic Response analyses. It is not included in a Hydrodynamic Diffraction cal-
culation, a stability Hydrodynamic Response analysis, or a frequency statistical Hydro-
dynamic Response analysis if Linearized Morison Drag is set to No.

5.5.17. Structure Connection Points

A structure Connection Point is defined as an attachment point connected to a Part that moves with
the Part. Connection Points are defined in the Details panel by entering coordinates in global space
or specifying an offset from a vertex on a structure. The coordinates defining the Connection Point
can be parameterized. A structure Connection Point can be used by more than one object (cable,
fender, etc.), if required. The option to choose a Fixed point vs. Connection points on structures is
controlled by the Connectivity field in the Details panel of the object using the connection points.

To add a Connection Point:

1. Select a Part in the tree view.

2. Right-click the Part and select Add > Connection Point, or click on the Connection Point icon
in the Parts toolbar.
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3. Select the Connection Point object in the tree and set the initial position by doing one of the
following:

• Set Definition of Position to X, Y, and Z Coordinates, and set the Position Coordinates (X, Y,
Z) in the Details panel.

• Set Definition of Position to X and Y Coordinates, Z on Composite Cable Seabed, and set the
Position Coordinates (X, Y) and a positive Z Offset from the Composite Cable Seabed Water
Depth at the given X, Y position.

• Set Definition of Position to Vertex Selection. Click Select a Single Vertex in the Vertex field,
select a vertex on a structure, and click Apply. You can then set an X Offset, Y Offset, or Z
Offset from the vertex if needed.

Note:

Even if you define the initial position of the Connection Point using Coordinates, or with
an offset from a vertex on the Part, the Connection Point is "attached" to the part and will
move with the part, maintaining the relative position that you defined when you created
it.

The Include in Results option controls whether the Connection Point is available to be used as a
Reference Point in a Hydrodynamic Frequency result, or as a Reference Point for Wave Surface El-
evation or with motions relative to the wave surface in a Hydrodynamic Time Response result.

Note:

In a Hydrodynamic Equilibrium result, or a Hydrodynamic Time Response result where the
requested motion is not relative to the wave surface, the Include in Results option is not
required for the Connection Point to be used as a Reference Point.

You may have up to 99 Connection Points in which the Include in Results option is set to Yes.

Important:

When resuming a project that has been created with a version of Aqwa prior to Ansys
Release 17.0, the first 17 Connection Points appearing in the Outline will have the Include
in Results option set to Yes. Any subsequent Connection Points will have Include in
Results default to No. If you wish to add Hydrodynamic Frequency results at a Connection
Point, or Hydrodynamic Time Response result for Wave Surface Elevation or at a Connection
Point with motions relative to the wave surface, you will need to perform a fresh Solve of
the analysis.

When creating a new project, the Include in Results option of newly-created Connection Points will
default to Yes as long as the limit of 99 has not been reached. Any Connection Points created after
the first 99 will have the Include in Results default to No.
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5.5.18. External Lid

External Lids attenuate or suppress the standing waves that form in a gap between hydrodynamically
interacting structures. They consist of a flat surface of panel elements, positioned at the mean water
level (Z=0 in the XY plane).

Standing waves are a physical effect that is necessary to capture in our hydrodynamic analysis, but
the absence of fluid viscosity in the solution means that these waves may become unrealistically
large. External Lids are therefore used to model the dampening effect of fluid viscosity on the wave
surface. They may also affect the radiation properties of the hydrodynamically interacting structures
by removing any non-physical spikes in the radiation damping and added mass around the standing
wave resonant frequency.

To illustrate the effect of an External Lid, consider the Hydrodynamic Diffraction analysis of a barge
positioned next to a pier. Here are the sway-sway (Y-Y) radiation damping (red) and added mass
(blue) values without an External Lid:

Here is the same analysis, now with an External Lid included, where the sharp peaks and troughs in
the plots have been reduced:
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In this way, External Lids are used to improve the accuracy of the Hydrodynamic Diffraction results
and any linked Hydrodynamic Response calculations.

External Lids can be created as Surface Bodies (p. 90) in the geometry editor. However, it may be
more convenient to add them directly in the Aqwa Workbench editor — for example, when a Part
Transform (p. 88) will be applied, and the transform translates or rotates the structure out of the
horizontal plane. This cannot be done with an External Lid which is modeled as geometry because
the lid surface must always be positioned on the mean water surface (Z=0 in the XY plane).

To add an External Lid in the Aqwa Workbench editor:

1. Select a Part in the Outline tree view.

2. Right-click the Part and select Add > External Lid, or click the External Lid icon in the Parts
toolbar.

3. Select the External Lid object in the Outline tree and set the properties.

An External Lid that is added in the Aqwa Workbench editor may be triangular or quadrilateral in
shape. In the Details panel, use the External Lid Surface Definition to specify the points that make up
the corners of the surface. Each point can be defined manually, where X and Y coordinates are entered
directly or by selecting a vertex from the geometry, with an optional X or Y offset.

The defined points are automatically sorted into anti-clockwise order by the Aqwa Workbench editor.
To create a triangular External Lid, set two of the points to share the same location. For more complex
shapes, create multiple External Lids on the same Part.

Finally, two External Lid Hydrodynamic Properties must be defined. The first is the Lid Damping
Factor, set between 0.0 and 1.0, which represents how effective the lid will be: 0.0 will result in no
effect, while 1.0 will prevent any diffracted or radiated component of vertical water surface velocity
under the lid. The second parameter is the Gap, which is a representative size for the lid: this is typ-
ically the distance between the two interacting vessels or the width of a moonpool. The Aqwa solver
uses this value to tune the lid damping properties to the resonant frequency of waves in the gap.
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5.5.19. Part Transform

When vessel geometry is first imported from Discovery Modeling or DesignModeler into the Aqwa
Workbench editor, the positions of the imported Parts are consistent with the positions defined in
the geometry editor. However, adding a Part Transform to a Part in Aqwa Workbench allows you to
modify the position or rotation of that Part, without modifying and re-importing from the geometry
editor. This makes it simpler to configure your model, and allows parametric studies of vessel draft
or trim (for example) to be performed directly in Aqwa Workbench.

To include a Part Transform object in your model:

1. Select a Part in the Outline tree view.

2. Right-click the Part and select Add > Part Transform, or click the Part Transform icon in the

Parts toolbar .

3. Select the Part Transform object in the tree.

4. Define the Reference Point and Transform properties, as described in Reference Point Defini-
tion (p. 88) and Transform Definition (p. 88).

5. Right-click the Part Transform and select Apply, or click the Apply icon in the Part Transform

toolbar . At this point, any up-to-date Mesh or Solution data will be cleared.

5.5.19.1. Reference Point Definition

The Reference Point represents the position in space that the rotations of the Part Transform are
applied about. Setting Reference Point to Manual Definition allows you to define directly the
Reference PointX/Y/Z coordinates. In this mode, you can also use the Move Reference Point to
Center of Gravity option to automatically position the Reference Point at the Part's center of
gravity position.

Note:

If the Part has a Program Controlled Point Mass, or it includes one or more Internal Tanks,
and the Mesh has not yet been generated, the Move Reference Point to Center of
Gravity option will not have any effect as the Part's center of gravity has not yet been
determined by the program.

Alternatively, you can set Reference Point to Vertex Selection, then use the Vertex option to select
a vertex from the geometry in the Graphical Window. The Reference Point X/Y/Z values will be
updated to show the position of the selected vertex.

5.5.19.2. Transform Definition

The transformation to be applied to the Part is defined by entering the Translation X/Y/Z and
Rotation about Reference Point X/Y/Z values into the appropriate fields. The translations are also
applied to the Reference Point. For example, if you want to modify both the draft and the trim of
the Part, the trim angle is applied about the translated Reference Point position (not the initial
Reference Point position).
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As the transform is modified, a preview of the Part's transformed position is shown as a blue
bounding box in the Graphical Window, while the original position is shown by a red bounding
box:

5.5.19.3. Application of a Part Transform

Once the Part Transform has been applied, the Surface Bodies and Line Bodies in Aqwa Workbench
are transformed so that the generated Mesh reflects the new Part position, including the adjusted
location of the waterline on the Part (provided that the Mesh Create Automatic Waterline Nodes
option is set to Yes).

Note:

The Part Transform in Aqwa Workbench does not have any effect on the original geometry
defined in Discovery Modeling or DesignModeler.

The Part Transform is also applied to any unsuppressed (active) Aqwa-specific features under the
Part in the Outline tree, as well as some properties of the Part itself. However, there are some ex-
ceptions; the applicability of the Part Transform is described in detail here.

Note:

Suppressed (inactive) features are not modified by the Part Transform. For all other
properties that are not modified by the Part Transform, the Aqwa Workbench editor will
issue a warning message in the Output window.

5.5.19.3.1. Part

When the Current Calculation Position is set to Moves with Structure, the Current Calculation
X/Y/ZPosition is transformed. However, when Current Calculation Position is set to At Fixed
Depth, the Current Calculation Depth is not modified by the Part Transform.
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When either of the Override Calculated GMX or Override CalculatedGMY options are set to
Yes, the user-defined GM about Global X/Y Axis  values are not modified by the Part Transform.

When the Calculate Shear Force/Bending Moment option is set to Yes, and the Neutral Axis
Position Definition is set to Manual Definition, the Neutral Axis X/Y/Z Positions are not modified
by the Part Transform.

5.5.19.3.2. Surface Body

Surface Bodies are always transformed, but if any surface has its Structure Type set to Abstract
Geometry and its Abstract Type set to Internal Lid or External Lid, the Part Transform is restric-
ted to translations and rotation in the horizontal XY plane only. If you want to change the draft,
list, or trim of the vessel, and an Internal or Exterrnal Lid is included, then you will need to
modify the geometry in Discovery Modeling or DesignModeler. (This restriction does not apply
to the automatic internal lid, which is created when the Part's Generate Internal Lid option is
set to Yes.)

5.5.19.3.3. Line Body

Line Bodies are always transformed.

5.5.19.3.4. Point Mass

When the Mass Definition  is set to Manual Definition, the mass X/Y/Z position and the inertia
matrix values Ixx, Ixy, Ixz, Iyy, Iyz, and Izz are transformed. If the Define Inertia Values By option
is set to Radius of Gyration, the leading diagonal terms of the inertia matrix are determined,
the matrix is transformed, and the radius of gyration values Kxx, Kyy, and Kzz are re-calculated
from the transformed inertia matrix and the defined Mass value.

Note:

The radius of gyration values are defined about the Global Axes, rather than the Part
principal axes.

However, when the Mass Definition is set to Program Controlled, none of the properties is
modified by the Part Transform.

If you want the program to determine the Point Mass Properties automatically, and then apply
a Part Transform without the Point Mass Properties being recalculated, you must:

• Generate Mesh with the Part in its original position, so that the Program Controlled Point Mass
is determined by the program;

• Change the Mass Definition of the Point Mass to Manual Definition, which retains the existing
Point Mass Properties;

• Apply the Part Transform, which moves the Point Mass with the Part (without changing the
Mass value).

If any of the Point Mass X/Y/Z position values are selected as a parameter , none of the X/Y/Z
position values will be modified by the Part Transform. You must parameterize all of the X/Y/Z
position values in this case.

Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.90

Aqwa Approach



Similarly, if any of the Point Mass Inertia Properties are selected as a parameter , none of the
Inertia Properties is modified by the Part Transform. You must parameterize all of the Inertia
Properties in this case.

5.5.19.3.5. Distributed Mass

When the Part's Calculate Shear Force/Bending Moment option is set to No, the Distributed
Mass data is considered as a sequence of discrete point masses, and the mass X/Y/Z positions
and inertia terms are transformed.

However, if the Calculate Shear Force/Bending Moment option is set to Yes, the Distributed
Mass data is considered as a sequence of continuous masses, and the Distributed Mass Definition
Data table also includes the X/Y/Z extents of each mass. In this case, the mass and inertia prop-
erties are not transformed, as the mass extents are not meaningful if the Part’s principal axis is
not aligned with one of the Global Axis directions.

5.5.19.3.6. Point Buoyancy

Point Buoyancy X/Y/Z positions are always transformed, unless any of the X/Y/Z values are selected

as a parameter , in which case none of the properties will be modified by the Part Transform.

5.5.19.3.7. Disc

Disc X/Y/Z positions and Normal X/Y/Z values are always transformed.

5.5.19.3.8. Internal Tank

When the Fluid Level Definition Mode is set to Fluid Volume, the Surface Height estimate is
updated when the Part Transform is applied.

When the Fluid Level Definition Mode is set to Surface Height, the user-defined Surface Height
is not modified by the Part Transform. The height value is still defined in the Global Axes.

When the Fluid Level Definition Mode is set to Edge Selection, the selected edge is transformed
as an entity within the geometry, but the Fluid Level Definition becomes invalid if the edge is
no longer horizontal.

5.5.19.3.9. Moonpool

Moonpools are also transformed alongside their associated Part, but the Part Transform for this
object is restricted to translations and rotation in the horizontal XY plane only.

5.5.19.3.10. Additional Hydrodynamic Stiffness, Added Mass and Damping, and
Morison Hull Drag Coefficients

Any 6x6 matrices defined under the Part in the Outline tree are always transformed, where the
rotation matrix associated with the Part Transform is applied to each 3x3 quadrant of the 6x6
matrix.
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5.5.19.3.11. Nonlinear Roll Damping and Yaw-Rate Drag

The Central Line Definitions associated with these features, as specified by the Aft End X/Y Pos-
ition, and Forward End X/Y Position, are always transformed, unless any of the Aft or Forward
End X/Y values are selected as a parameter , in which case none of the properties will be
modified by the Part Transform.

The formulation of these features assumes that the Central Line is horizontal, so the position and
orientation of the Central Line are only modified in the horizontal XY plane. The Depth to Bilge
and Offset of Bilge from Central Line properties are not modified by the Part Transform.

5.5.19.3.12. Current and Wind Force Coefficients

The Directions defined in the Coefficient Data table are rotated by the Rotation about Reference
Point Z angle defined in the Part Transform, and are then wrapped back into the range ± 180°
as necessary. If the transformed data does not include a set of coefficients in the ± 180° direction,
a new set of coefficients are added at ± 180° by linearly interpolating between the coefficient
values at the nearest adjacent directions.

If the Part Transform is subsequently modified, suppressed, or deleted, the original Current or
Wind Force Coefficients are restored until a Part Transform is re-applied.

5.5.19.3.13. Connection Points

Connection Point X/Y/Z positions are always transformed, unless any of the X/Y/Z values are se-

lected as a parameter , in which case none of the properties will be modified by the Part
Transform.

Where the Definition of Position is set to Vertex Selection, the X/Y/Z Offset values are also
transformed.

Where the Definition of Position is set to X and Y Coordinates, Z on Composite Cable Seabed,
the relationship of the position of the Connection Point relative to the structure is maintained
through the transform, but the Connection Point Z position is always set to the Composite Cable
Seabed depth at the transformed X/Y position.

5.5.19.3.14. Connection Point Groups

The connection points generated or imported within a Connection Point Group are always

transformed, unless any of the Origin X/Y/Z values are selected as a parameter , in which case
none of the properties will be modified by the Part Transform.

The group Origin X/Y/Z values displayed in the Details panel reflect the transformed position.
The Group Definition and Group Rotation values remain in the Connection Point Group reference
axis system.

Where the Position Points on Composite Cable Seabed option is set to Yes, the relationship
of the positions of the connection points relative to the structure is maintained through the
transform, but the vertical positions are always set to the Composite Cable Seabed depth at
the transformed lateral positions.
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5.5.19.3.15. Connections, Hydrodynamic Diffraction, and Hydrodynamic Response
Features

All other features defined in Aqwa Workbench are not modified by the application of a Part
Transform. The Aqwa Workbench editor will issue a warning message in these cases. Specifically,
the unaffected features include:

• Under Connections:

– Fender Axes and Joint Axes

– Connection Stiffness and any associated user-defined Equilibrium Position

• Under Hydrodynamic Diffraction:

– The Bounding Box and Calculation Coordinate defined for any Splitting Forces result

• Under Hydrodynamic Response:

– Starting Position, Point Force, Structure Force, and Deactivated Freedom objects

– Stability Analysis Movement Limitations and Maximum Error in Equilibrium Position
settings

– Time Response Analysis Co-simulation Coordinate System Offset settings

5.6. Attachment Point Groups

Fixed Points and Connection Points are introduced in Add Fixed Points (p. 46) and Structure Connection
Points (p. 84), respectively. Multiple Fixed Points or Connection Points in a user-defined arrangement
can be created, using a Fixed Point Group or Connection Point Group. These can be generated in a
pattern or imported from a .CSV file.

To add a Fixed Point Group:

1. Select the Fixed Pointsobject in the Outline tree view.

2. Right-click the Fixed Points object and select Add > Fixed Point Group, or click the Fixed
Point Group icon in the Fixed Points toolbar.

To add a Connection Point Group:

1. Select a Part in the Outline tree view.

2. Right-click the Part and select Add > Connection Point Group, or click the Connection Point
Group icon in the Parts toolbar.

In this section, the term ‘attachment point group’ refers to both Fixed Point Groups and Connection
Point Groups. Most of the user options are the same for each type of object.
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Set the Name of the attachment point group, then set the Visibility to choose whether the associated
attachment points are shown in the Graphical Window.

For a Connection Point Group, the Type field will display ‘Attached to Structure’, and the Structure
field will show the name of the parent Part. For a Fixed Point Group, the Type field will display ‘Fixed’.

5.6.1. Origin Definition

Each attachment point group requires an Origin Definition. The meaning of the group origin depends
on the Group Type, which will be described in the following section. The Origin X, Origin Y and
Origin Z fields show the location of the group origin in the Global Axes. Select the Origin Type from
the following options:

• Global Origin: matching the Global Axes origin.

• Manual Definition: defined by the user, entering values directly into the Origin X/Y/Z fields.

• Vertex Selection: based on the position of a Vertex, which is picked from the geometry in the
Graphical Window.

• Fixed/Connection Point: based on the position of a Fixed/Connection Point, which is selected
from a drop-down menu of existing attachment points.

Where a Composite Cable Seabed is defined, you can force the attachment points to lie on this seabed
by setting Position Points on Composite Cable Seabed to Yes. The Origin Z position will be updated
to display the seabed Z location at the defined Origin X/Y position. This may be useful when you
want to position an arrangement of Fixed Points on a sloped seabed, for example.
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5.6.2. Group Definition

Select the Group Type to specify the arrangement of attachment points that you are defining:

• Linear Pattern: attachment points are created in a line, starting from the Origin X/Y/Z position.
Use Number of Points to set the total number of attachment points in the group, and enter a
Spacing to set the distance between each attachment point.

• Circular Pattern: attachment points are created in a circle, with the Origin X/Y/Z position at its
center. Enter an Angular Spacing to set the angular distance between each attachment point
around the circumference of the circle. Set the Radius to define the distance from each attachment
point to the group origin. The points start from the origin X axis on the circumference of the circle
prior to Group Rotation (p. 96).

• Rectangular Pattern: attachment points are created in a two-dimensional grid, starting from the
Origin X/Y/Z position. Use Number of Points in X and Number of Points in Y to set the number
of attachment points in each direction, and enter Spacing in X and Spacing in Y to set the distances
between each attachment point.

• Import from CSV File: click the Import CSV File field to select a comma-separated values (.CSV)
file from a location on the disk. The selected file must meet the following requirements:

– Has the .CSV extension.

– Contains values separated by commas, tabs, or single spaces (not multiple spaces).

– When you are importing into a Fixed Point Group, the .CSV file should contain 4 columns, which
are the Name, Position X, Position Y and Position Z of each point in the group.

– When you are importing into a Connection Point Group, the .CSV file should contain 5 columns,
which are the Name, Position X, Position Y, Position Z and Include in Results settings for each
point in the group.

The unit system of the data in the .CSV file is assumed to match the display unit system of the
project. However, the imported data can be modified by setting the Length Unit for Imported
Data to the required unit system.

The imported Position X/Y/Z values are considered as offsets from the Origin X/Y/Z position.

Note:

The Group Definition table can also be exported as a .CSV file. To reimport the file
as a new group, ensure that the file matches the specified column format: Name,
Position X, Position Y, Position Z, and Include in Results.

Once the Origin Definition and Group Definition have been fully defined, the Attachment Point
Group Data table will show the names and positions of each generated or imported attachment
point.
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When you are generating attachment points in a Linear, Circular or Rectangular Pattern, each point
will be given a default Point Name. You can edit this name directly in the Attachment Point Group
Data table. For example, the third attachment point in this group would be referred to as ‘Connection
Point Group 1, Point 3’ throughout the Aqwa Workbench interface. For imported attachment points,
the Point Name is read from the .CSV file.

5.6.3. Group Rotation

You can apply a rotational transform to the attachment points in the group by specifying values in
the Rotation about Origin X/Y/Z fields.

5.6.4. Hydrodynamic Response Nodal Motions Output

When creating a Connection Point Group, choose whether to make the associated Connection Points
available for selected results output - see 5.5.16. Structure Connection Points for more information.

Select Include in Results from the following options:

• No: none of the Connection Points in this group will be available for results output.

• Define in Table: in the Attachment Point Group Data table, the Include in Results column will be
editable, allowing you to select Yes or No for each Connection Point.

• Yes: all of the Connection Points in this group will be available for results output.

In total, you may have up to 99 Connection Points for which the Include in Results option is set to
Yes.

5.7. Dynamic Point Structures

A Dynamic Point is a moving point that is not associated with a Part.

Unlike Fixed Points (p. 46) and Connection Points (p. 84), Dynamic Points introduce additional equations
of motion to the hydrodynamic solution and therefore must have their own mass and rotational inertia
defined. They can also include hydrodynamic properties such as linear stiffness, added mass, damping
and Morison drag.

Dynamic Points can be used to represent something physical such as the shackle on a bridle mooring,
or a derrick hoist block; or they can be used as a modeling tool such as a reference structure in the
time-domain user-defined force function. The mass and hydrodynamic properties assigned to a Dynamic
Point can also represent something physical such as the mass and drag of a linear cable (which is oth-
erwise without mass or drag) or they can be abstract.

Dynamic Points do not comprise any surfaces so they do not have frequency-dependent hydrodynamic
properties. They are included in the Hydrodynamic Diffraction analysis because they must be written
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into the hydrodynamic database generated by the Aqwa solver. However, you cannot review any results
for Dynamic Points under the Hydrodynamic Diffraction Solution as these results would not have any
physical significance.

The initial position of a Dynamic Point is defined in the same way as a Fixed Point or Connection Point.
Then, when setting the Connections, the Dynamic Point can be selected in place of a Connection Point.
For example, a Cable with structure-to-structure connectivity could either be defined between two
Dynamic Points, or a Connection Point and a Dynamic Point. A Dynamic Point can be used by more
than one connection (Cable, Fender, and so on). For steps on adding and defining Dynamic Points, see
Define Dynamic Points (p. 97).

In the setup of a Hydrodynamic Response analysis, you can apply Deactivated Freedoms, Starting Con-
ditions, Point Forces and Structure Forces to a Dynamic Point, in the same way that you would for a
Part.

Similarly, in the results of a Hydrodynamic Response analysis, the Dynamic Point can be considered as
a structure. Meaning any result that can be generated for a Part such as a graph plotting Structure Po-
sition vs Time can also be produced for a Dynamic Point.

5.7.1. Define Dynamic Points

To add a Dynamic Point:

1. Select Dynamic Point Structures in the Outline tree.

2. Right-click and select Add  Dynamic Point .

OR

Click the Dynamic Point icon in the Dynamic Point Structures toolbar.

3. Select the Dynamic Point object in the Outline tree and then, in the Details panel, define the
dynamic point position, equivalent mass, and hydrodynamic properties as described in the following
sub-headings.

5.7.1.1. Define Dynamic Point Position

The initial position of the Dynamic Point can be defined in one of three ways:

• Set Definition of Position to X, Y, and Z Coordinates, and then set the position coordinates (X,
Y, Z) in the Details panel.

The coordinates can be parameterized.

• Set Definition of Position to X and Y Coordinates, Z on Composite Cable Seabed. Then set the
Position Coordinates (X, Y) and a positive Z Offset from the Composite Cable Seabed Water
Depth at the given X, Y position.

• Set Definition of Position to Vertex Selection. Click Select a Single Vertex in the Vertex field,
select a vertex on a structure, and then click Apply.

You can then set an X Offset, Y Offset, or Z Offset from the vertex if needed.
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5.7.1.2. Equivalent Mass Properties

Each Dynamic Point must have a Mass defined. The Mass value should be realistic, taking into
consideration the scale of any other structures in the model; otherwise, the numerical stability of
Hydrodynamic Response calculations may be affected. For example, if a ship with a mass of several
thousand tons is connected to a Dynamic Point using a Cable (p. 101), the cable experiences a great
amount of tension, and the Dynamic Point has a small nominal Mass value of 1.0; the accelerations
experienced by the Dynamic Point may be extremely large and could cause the time domain Aqwa
solver to crash. It is therefore better to define a relatively large Mass value to start with and then
reduce it after the Hydrodynamic Response calculations run reliably.

By default, the Displaced Mass will automatically inherit the Mass value so there is no overall
gravity force on the Dynamic Point. You can change the Displaced Mass to any value that is zero
or positive. Reset the Displaced Mass to match the Mass value if you want to recover the default
inheriting behaviour.

The Moment of Inertia Definition allows you to choose how the Dynamic Point Moment of Inertia
is defined. The following options are available:

• Large Value (Minimise Rotation): by default, the Dynamic Point uses a very large value for
the rotational inertia about each global axis so that the rotational motion is minimized.

• Simple (Isotropic): a single value is defined, which is equally applied for the rotational inertia
about each global axis.

• Full (6 x 6 Matrix): the individual (including off-diagonal) terms that describe the full moment
of inertia matrix, which are Ixx, Ixy, Ixz, Iyy, Iyz and Izz, are individually defined.

5.7.1.3. Hydrodynamic Properties

You can choose to define various hydrodynamic properties for each Dynamic Point. These include
Linear Stiffness, Added Mass, Linear Damping and second-order Morison Drag terms. For each type
of property, you can select from:

• None: by default, no properties are defined.

• Simple (Isotropic): a single translation value and a single rotation value are defined, which are
equally applied for every translational and rotational degree of freedom.

• Full (6 x 6 Matrix): a matrix object is added as a child of the Dynamic Point, allowing you to
define the full 6 x 6 matrix for the given property. This can be defined by manually entering
values or importing a .CSV.

5.7.2. Modelling Considerations

Listed below are some points which are helpful to consider when including Dynamic Points in your
hydrodynamic model:

• As described in Equivalent Mass Properties (p. 98), the Mass should be defined so that the
behaviour of the Dynamic Point is realistic, particularly in the time domain. Unless the overall
scale of the hydrodynamic model is small, the Mass of the Dynamic Point should not be small.
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One exception to this would be where the Dynamic Point is connected by a Joint to a Part;
however, the range of masses over all structures in the model should be less than 4 orders of
magnitude (meaning a maximum 10,000x difference between the smallest and largest masses).

• While the physical mass should be represented by the Mass value, which introduces inertia
and gravity force to the Dynamic Point, you can also use Added Mass to create inertia (only)
in specific freedoms.

• The Aqwa Workbench editor checks that some constraint is applied to the Dynamic Point. For
example, you will see a warning when you solve the Hydrodynamic Diffraction analysis if the
Dynamic Point has a Mass which is larger than the Displaced Mass, and there is no connection
to prevent it from falling freely due to gravity.

• Although Dynamic Points do not have any effect on the results of a Hydrodynamic Diffraction
analysis, a change in the properties of a Dynamic Point will cause the Hydrodynamic Diffraction
Solution to go out of date. This is because the hydrodynamic database created by the Aqwa
solver needs to include the latest Dynamic Point properties before any Hydrodynamic Response
calculations are performed. However, the Hydrodynamic Diffraction system should be relatively
quick to update, as the radiation-diffraction calculation will not be repeated.

5.8. Line Body Data

When the geometry imported from DesignModeler/Discovery Modeling contains at least one Line Body,
a Line Body Data object is automatically added under the Geometry object in the Outline tree. Beneath
this object you will find the Beam Sections that have been automatically created to store cross section
geometric properties from the imported geometry.

5.8.1. Beam Section

Beam Sections are automatically created to store the geometric properties of imported Line Body
cross sections, and also allow you to define the mass and hydrodynamic properties of those Line
Bodies.

Each Line Body should be assigned a cross section and an orientation in DesignModeler/Discovery
Modeling. In the Aqwa editor, when importing the geometry, each valid cross section is automatically
paired with a Beam Section object. Beam Sections are created under the Line Body Data object in
the Outline tree.

The Solver Line Type indicates what kind of element will be used by Aqwa to represent any Line
Bodies which inherit their properties from this Beam Section. Cylindrical sections are represented by
tubular (TUBE) elements, and non-cylindrical sections are represented by slender tube (STUB) elements.

The Beam Section Geometric Properties contain all of the information that is transferred from
DesignModeler/Discovery Modeling for a cross section. This includes the Cross Section Name and
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Cross Section Type, the dimensions of the cross section, the Cross Section Area, and the Second
Moment of Area (about both local Y and Z axes, for non-cylindrical sections).

Note:

It is not possible to change the geometric properties of a Beam Section in the Aqwa editor.
To do this, you must edit the cross section in DesignModeler/Discovery Modeling and re-
import the geometry.

Under Mass Properties you can define the Material Density of the Beam Section. The Inertia/Unit
Length of the Beam Section (about the local Y and Z axes, for non-cylindrical sections) is automatically
calculated as the product of the Material Density and the Second Moment of Area.

The Hydrodynamic Properties display the properties of the section that are relevant to the Line
Body viscous drag and added mass calculations, and allow you to define corresponding Transverse
Drag Coefficients, Axial Drag Coefficient, and Added Mass Coefficients. The Displaced Area is
used in the added mass calculation. For non-cylindrical sections the Dimension for Local Y Drag
and Dimension for Local Z Drag are used in the viscous drag calculation.

Duplicating Beam Sections

Where multiple Line Bodies have the same cross section but different mass or hydrodynamic properties,
a Beam Section can be Duplicated. The duplicate Beam Section will retain the same cross section
geometry, but can have different mass or hydrodynamic properties defined. In the Line Body details,
the Beam Section field can then be used to select which Beam Section the Line Body inherits its
properties from.

5.9. Define Connections

The Connections object allows you to create connections between structures or between structures
and the environment. The available connections are:

5.9.1. Cables

5.9.2.Tethers/Risers

5.9.3. Connection Data

5.9.4. Connection Stiffness

5.9.5. Fenders

5.9.6. Joints

When the Connections object is selected in the Outline tree, and there are one or more Cables, Teth-
ers/Risers, Fenders, or Joints defined, the Hydrodynamic Response Connections Summary table will
be displayed:
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The table summarizes the activity, type, connectivity, and attachment points for each connection included
in a Hydrodynamic Response analysis (Connection Stiffness objects are not listed).

The Hydrodynamic Response Connections Summary table also displays the Aqwa Index of each con-
nection as it is assigned by the Aqwa solver (the index number is assigned using the groupings:
Cables/Fenders, Joints, and Tethers/Risers). This is useful if you are using the Hydrodynamic Pressure
Mapping Add-On (p. 273) to transfer Cable, Joint, or Tether loads from a time domain Hydrodynamic
Response analysis to a Static Structural analysis because the connections in the structural analysis are
identified by their Aqwa Index. This table provides the relation between named connections in the hy-
drodynamic model and their Aqwa Index in the structural model.

For a linear cable which includes one or more pulleys along its length, each section of the cable is as-
signed its own index. In the example above, Cable 1 runs from Anchor 1, through Pulleys 1 and 2, to
Anchor 2, so it appears three times in the Hydrodynamic Response Connections Summary table.

Note:

The Aqwa solver internally considers Fenders as another type of cable. Aqwa Workbench
writes Fenders after Cables in the Aqwa input file; therefore, the Aqwa Index for a Fender
starts at max(Aqwa Index for Cables) + 1.

5.9.1. Cables

Aqwa supports four types of cables, each with their own input requirements:

5.9.1.1. Linear Elastic

5.9.1.2. Nonlinear Polynomial

5.9.1.3. Nonlinear Steel Wire

5.9.1.4. Nonlinear Catenary

To add a Cable:

1. Select the Connections object in the tree view.

2. Right-click the Connections object and select Insert Connection > Cable, or click the Cable icon
in the Connections toolbar.

3. Select the Cable object in the tree view and set properties.

The Type of the cable (Linear Cable, Polynomial Cable, Steel Wire Cable, or Catenary Cable) can
be set in the details panel.
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Cables may either be joined between two structures, between a fixed point and a structure, or between
two fixed points via a pulley (only available for Linear Cables); this option can be changed via the
Connectivity field in the Details panel. A cable cannot have both ends connected to the same
structure. For the first two cases an End Connection Point must exist at the position of the end of
the cable; this can be selected from a dropdown list of existing Connection Points defined on the
structures. For the third case and End Fixed Point must be selected from a dropdown of existing
Fixed Points. When the starting point is on a structure, you can define the start of the cable using
Start Connection Point, which again is a dropdown list of existing Connection Points defined on the
structures. When the starting point is a fixed point, a Start Fixed Point dropdown list of defined fixed
points is shown.

Linear Elastic and Polynomial cables can be winched by adding a Cable Winch  (p. 183). All cable
types can also have break conditions based on tension or time, defined by adding a Cable Failure
(p. 187) object.

Set additional options in the Details panel for each cable type as described in the sections below.
The extension of the cable and force applied depend on the Connectivity defined (the following in-
formation is not applicable to catenary cables):

For a cable attached between a structure and a fixed point

The extension of the cable, at any stage of the analysis, is calculated by subtracting the unstretched
length from the distance between the position of the fixed point and the current position of the
connection point on the structure.

The direction of this force is given by the vector going from the fixed point to the structure.

For a cable attached between two structures

The extension, at any stage of the analysis, is calculated by subtracting the unstretched length from
the distance between the connection points on the two structures at the current position of the re-
spective structures.

The direction of the force on a structure is given by the vector going between the two connection
points. The forces on each structure will therefore always be equal and opposite and hence the selec-
tion of start and end connection points can be interchanged.

The unstretched length is used to indicate the length at which the mooring line is slack; that is, if the
distance between the two attachment points at either end of the mooring line is less than this value,
then the tension in the mooring line will be zero. Although unusual, it is quite valid to input this
value as zero where the 'cable' is never slack. However, in the special case where both ends of the
cable are coincident, the direction of the force exerted by the cable is undefined and is automatically
set to zero.

For a cable attached between two fixed points

At any stage of the analysis, the extension is calculated by subtracting the unstretched length from
the total distance between each fixed point to the pulley on the connecting structure, at the current
position of that structure. When two pulleys are specified, the distance between the pulleys is also
included in the total distance.
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At each fixed point, the tension in the cable acts in the direction of the vector between the fixed
point and the adjacent pulley. The direction of the force on the structure is determined from the
resultant force on the pulley due to the cable tensions on each side of the pulley.

Note:

If a cable is not defined properly before running the analysis, the cable will be drawn as
a straight red line between the start and end, and an error will be reported in the Message
window.

5.9.1.1. Linear Elastic

For linear elastic cables, a Stiffness and Unstretched Length need to be defined, and up to two
pulleys can be defined along the line.

This is a very simple type of cable, simply a tension-only spring, where the tension is proportional
to its extension, and the constant of proportionality is termed the stiffness. As the extension may
vary during the analysis, the structure(s) to which the cable is attached will experience a force of
varying magnitude and direction. The magnitude of this force, which is equal to the cable tension
is given by Force = Stiffness x Cable Extension

Note that when the cable is slack, the cable extension is negative and the cable tension is set to
zero.

Pulleys

A Pulley has the effect of intersecting the cable and will effectively extend the cable to pass via the
pulley position. Adding a second pulley will extend the cable further from the first pulley to the
end of the cable, hence the cable will travel from the cable start point to the first pulley then, if it
exists, to the second pulley, and then to the cable end point. Pulleys can only be attached to
structures, and at least one pulley is required for a cable with a Connectivity of Fixed Point &
Fixed Point.

Along with the pulley position (defined by Connection Point which can be selected from the
dropdown list of existing connection points), you must enter a Friction Coefficient for the pulley.

The friction of the pulley is represented by , where  is the larger tension and the smaller.

 is defined for the situation where the line turns through 180° around the pulley.

For sliding friction cases, a friction factor μ is calculated such that . The friction is then varied

depending on how far around the pulley the line passes.

 must be in the range , with 1 being no friction.

5.9.1.2. Nonlinear Polynomial

For Nonlinear Polynomial cables, enter the polynomial coefficients (Coefficient A, Coefficient B,
Coefficient C, Coefficient D, Coefficient E) and Unstretched Length of the cable. The coefficients
of the polynomial define the force in the cable as a function of extension, therefore:
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where:

 = polynomial coefficients.

 = extension of the mooring line.

5.9.1.3. Nonlinear Steel Wire

For Nonlinear Steel Wire cables, enter the Asymptotic Stiffness and Asymptotic Offset in addition
to the Unstretched Length of the cable. These constants are physical properties used in defining
the tension/extension curve of a steel wire mooring line.

Tension in a steel wire mooring line is given by:

Where:

 = extension of mooring line

 = asymptotic stiffness (constant)

 = asymptotic offset (constant)

The names of the constants k and d arise from the fact that, at large values of extension,
tends to unity and the equation tends to the asymptotic form:

5.9.1.4. Nonlinear Catenary

Nonlinear Catenary Cables consist of up to 10 Catenary Sections and optionally 9 Catenary Joints
between the sections. Catenary Sections and Joints can be defined under the Connection Data
object and accessed as required to build up a number of Nonlinear Catenary Cables. For each cable,
the Section Type field allows you to select the Catenary Section via a drop-down list; once chosen,
the unstretched Length of that section can be entered. If more than one section is used then addi-
tional selections for the joint type are displayed to allow the selection of the Catenary Joint. The
whole cable make-up is summarized in the Catenary Cable Definition Data table.

Each Nonlinear Catenary Cable can, optionally, be analyzed using Cable Dynamics to obtain the
dynamic forces in the cable as well as their effect on the motion of structures in the analysis (Set
Use Dynamics to Defer to Analysis Settings "Use Cable Dynamics" Option, and ensure that the Use
Cable Dynamics option in your Hydrodynamic Response analysis is set to Yes). You can then enter
the Number of Elements to use in the analysis of the cable.

If Use Dynamics is set to No for a cable whose Connectivity is Fixed Point to Structure, and no
Composite Cable Global Seabed Slope has been defined in Geometry, the Seabed Slope parameter
is made available. This value is the seabed slope (in degrees) specific to this mooring line where a
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positive slope is for the seabed to slope up from the anchor towards the structure Connection
Point. If a Global Seabed Slope has been defined, the cable-specific Seabed Slope field will show
"Determined from Global Seabed Slope".

Note:

Seabed slope is ignored if Cable Dynamics is being used for the solution.

Once the cable is fully defined, the Initial Cable Tension at Start and Initial Cable Tension at
End are reported in the Details panel.

To avoid the iterative calculation of the mooring forces, the program establishes a database covering
all of the expected configurations of the cable.

Additional controls enable fine control over the cable. The availability depends upon the cable
Connectivity.

For cables attached between a fixed point and a structure (Connectivity set to Fixed Point to
Structure), the range of the possible end points of the cable is determined by Negative dZ Range
of Expected Connection Point Vertical Motion (measured from the lowest anticipated database
point to the connection point in the definition position) and Positive dZ Range of Expected
Connection Point Vertical Motion (measured from the connection point in the definition position
to the highest anticipated database point) along with the slack and maximum tension positions
(including the effects of the global or cable-specific seabed slope). This area is then divided up to
form a database of cable end positions and corresponding tensions which is used in the analysis.
It is recommended that the full size of this grid is used, of 600 points, which is formed by the
multiplication of Number of Vertical Partitions and Number of X Coordinates.

For cables attached between two structures (Connectivity set to Structure to Structure), where
the Seabed Touchdown Expected option is set to No, the range of the possible end points of the
cable is determined by the relative positions of the two structures along with the slack and maximum
tension range. The cable is considered to be submerged in water of infinite depth. It is recommended
that the full size of the database is used, of 600 points, which is formed by the multiplication of
Number of Vertical Partitions and Number of X Coordinates.
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For cables attached between two structures where the Seabed Touchdown Expected option is
set to No, the database uses a radial coordinate system in which Number of X Coordinates becomes
the number of radial distances and the Number of Vertical Partitions is the number of angular
positions.

For cables attached between two structures (Connectivity set to Structure to Structure), where
the Seabed Touchdown Expected option is set to Yes, the range of the possible end points at
either end of the cable is determined by Negative dZ Range of Expected Connection Point Ver-
tical Motion (measured from the lowest anticipated database point to the connection point in the
definition position) and Positive dZ Range of Expected Connection Point Vertical Motion
(measured from the connection point in the definition position to the highest anticipated database
point). If Global Sloped Seabed is non-zero, you must also specify the Maximum Radius of Start
Connection Point Horizontal Motion (measured from the connection point in the definition pos-
ition to the furthest anticipated database point). It is recommended that the full size of the database
is used (600 points) which is formed by multiplication of Number of Vertical Partitions and
Number of X Coordinates.

Caution:

Generation of the database required for a Structure to Structure cable with Seabed
Touchdown Expected may increase the computational cost and memory requirement
of the analysis significantly. This option should be set to Yes only where there is any
chance a cable will touch down.

Note:

For a Structure to Structure cable which is resting on the seabed, the cable position il-
lustrated in the Graphics panel will only account for the seabed effect after a Solve has
been performed. For example, in a Stability Analysis, the cable may initially be shown
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hanging below the level of the seabed, but this is updated once the analysis has been
solved.

Tip:

Where the Global Seabed Slope is non-zero, it is recommended that the cable Start
Connection Point is positioned on the structure with the smaller expected range of
motion of the two connected structures. Minimizing the Maximum Radius of Start
Connection Point Horizontal Motion will improve the accuracy of the generated
database.

For more information on the different quasi-static databases generated for each cable configuration,
see The COMP/ECAT/SSCB Data Records - Composite Catenary Mooring Line in the Aqwa Reference
Manual.

5.9.2. Tethers/Risers

Aqwa allows for the modeling of installed tethers, such as those used on Tension-Leg Platforms (TLPs),
and drilling risers. As those features share some basic properties, they are combined into a single
Tether/Riser object.

To add a Tether/Riser:

1. Select the Connections object in the tree view.

2. Right-click the Connections object and select Insert Connection > Tether/Riser, or click the
Tether/Riser icon in the Connections toolbar.

3. Select the Tether/Riser object in the tree view and set properties.

Tethers/Risers may only be joined between a fixed point and a structure, therefore the Connectivity
field in the Details panel is not editable for this type of connection. The Start Fixed Point drop-down
list of defined fixed points allows you to select a fixed point for the tether/riser, while the End Con-
nection Point can be selected from a drop-down list of existing Connection Points defined on the
structures.

The Tether/Riser Local Axes (TLA) are defined with their origin at the position of the Start Fixed Point.
The TLA Z-axis points from this origin toward the End Connection Point. The TLA X-axis is parallel to
the Fixed Reference Axes (FRA) XY plane, and at right-angles to the TLA Z-axis. The TLA Y-axis follows
the right-hand rule. When the tether/riser is vertical in the FRA, the TLA will be parallel to the FRA.
For more information, see Mass and Stiffness Matrices in the Aqwa Theory Manual.

Tethers/Risers can consist of up to 24 Tether/Riser Sections, which can be defined under the Connection
Data object and accessed as required to build up a number of Tether/Riser connections. For each
tether/riser, the Section Type field allows you to select the Tether/Riser Section via a drop-down
list. Once chosen, the unstretched Length of that section can be entered. The whole tether/riser
make-up is summarized in the Tether/Riser Definition Data table.

In the Graphical Window, while the tether/riser object is selected in the Outline panel, the tether/riser
is drawn in its unstretched condition. Any length from the Start Fixed Point to the End Connection
Point which is not covered by the Tether/Riser Section Selection is shown as a yellow dashed line.
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When the tether/riser object is not selected in the Outline panel, the tether/riser is drawn in its
stretched condition.

Boundary conditions at each end of the tether/riser must be defined using the details under Teth-
er/Riser Boundary Conditions at Fixed Point and on Structure. For each attachment point you
must define an Axial Stiffness (in the direction of the Local Tether/Riser X-axis), and a Rotational
Constraint which may be either Define Stiffnesses or Encastre Condition. Setting Rotational Constraint
to Define Stiffnesses allows you to set rotational stiffnesses about the Local Tether/Riser Y- and Z-
axes, while Encastre Condition prevents any rotation about the Local Tether/Riser Y- and Z-axes.

For a tether/riser which consists of more than one section, it is also possible to define Intermediate
Constraints along its length. The Additional Constraint field contains a drop-down list of the positions
between tether/riser sections. Selecting one of these positions allows you to set the Constraint Type
which must be one of the following:

Rotational, Fixed

No rotations at this position relative to the Fixed Reference Axes (FRA)

Translational, Fixed

No translations at this position relative to the FRA

Rotational, on Structure

No rotations at this position relative to the Local Structure Axes (LSA) of the connected structure

Translational, on Structure

Restricted translations at this position relative to the LSA of the connected structure, where the
maximum permissible translation from the definition position is specified by the defined Gap

Finally, there are a number of Tether/Riser Specific Options that may be optionally defined. Although
some of these options are more relevant to the connection when it is considered as a tether or a
riser, there is no limitation on the combination of options that may be used.

The Number of Elements field allows you to specify the number of finite elements which are used
to model the tether/riser, up to a maximum of 250 elements.

The Tether Group Multiplier option specifies that a single modeled tether should be considered as
a group of tethers, which has the effect of multiplying the tether forces acting on the connected
structure by the specified integer factor.

The Anchor and Structure Cap Areas options can be used to set the areas of the tether/riser that
are not subject to external water pressure at the fixed point and connection point, respectively. These
values are used in the calculation of the tether/riser effective and wall tensions.

The Internal Fluid Pressure and Density options can be used to define the properties of the fluid
carried by the riser, which are also used in the calculation of the tether/riser effective and wall tensions.
If you define a non-zero pressure, you must also define a non-zero density (and vice-versa).

The Axial Stress Impact Factor and Impact Half Life options can be used to define the tether axial
stress peak and decay during an impact. The initial axial stress  at impact is determined from the
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product of the impact velocity and the stress impact factor, while the exponential decay of the axial
stress  with time  is determined from the impact half life  as:

If you define a non-zero stress impact factor, you must also define a non-zero impact half life (and
vice versa).

The Lower Stop Position defines the distance of the tether lower stop below the fixed point position.
Note that if the lower stop distance is input as zero, the tether can never be free-hanging.

5.9.3. Connection Data

Under the Connections object in the tree, a Connection Data object is automatically added. Under
this object, you can insert definitions for various types of Catenary Sections, Catenary Joints, and
Tether/Riser Sections that can be used to create Catenary Cables and Tethers/Risers.

5.9.3.1. Catenary Section

5.9.3.2. Catenary Joint

5.9.3.3.Tether/Riser Section

5.9.3.1. Catenary Section

To define the properties of a Catenary Section:

1. Select the Connection Data object in the tree view.

2. Right-click the Connection Data object in the tree and select Insert Connection Data >
Catenary Section, or click the Catenary Section icon in the Connection Data toolbar.

3. Select the Catenary Section object in the tree and enter the following information:

• The mass per unit length (Mass / Unit Length) of the section of the composite mooring line.

• The Equivalent Cross Sectional Area of the mooring line. It is often more convenient, espe-
cially with wire lines, to specify this parameter so the buoyancy of the line may be calculated
and subtracted from the structural weight to give the 'weight in water'. This parameter may
also be specified as zero if the mass per unit length is input as the mass of the line LESS the
mass of the displaced water per unit length (this does not apply to the cases when cable
dynamic analysis is required, for which a non-zero equivalent cross section area must be
defined).

• The stiffness of the line (Stiffness, EA), specified in terms of , where  is Young’s modulus
and  is the cross sectional area of the line. The default value is chosen to give a typical value
based on the mass/unit length. Clearly this may be in error if the mass per unit length specified
includes buoyancy effects.

• The Maximum Expected Tension, which is the highest value of tension that should be used
in the database created for this composite mooring line. It is important that this is a realistic
value. If a very high value is input the database will cover a very large range of tensions, and
the accuracy in the actual working range may be reduced. If a very small value is input the
database will only cover a small range of tensions, and constant tension may occur for larger
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strain values, that is, no extrapolation is carried out. If cable dynamics is utilized this limiting
value is not applied.

• The Axial Stiffness Coefficients (k1, k2, k3). A cable may have nonlinear axial stiffness. The
stiffness is calculated using the formula:

or

where:

 =  as a function of strain

 = the stiffness value input above

 = Nonlinear axial stiffness coefficients

 = linear strain 

 = strain at 

 = maximum tension specified above

For Cable Dynamics analyses the following optional additional data may be input.

• The Bending Stiffness (EI). The Bending Stiffness is specified in terms of EI, where E is Young’s
modulus and I is the 2nd moment of area of the line. The default value is zero.

• The Added Mass Coefficient (Ca). Added mass is calculated by ρ*Ca*A per unit length in
which ρ is the water density and A is the equivalent cross section area. Meaning, the added
mass is equal to the displaced mass of water multiplied by Ca. For cable dynamic analysis,
the equivalent cross section area A must NOT be omitted. The default is 1.0.

• The Transverse Drag Coefficient (Cd). Transverse drag force is calculated by 0.5*ρ*Cd*V²*De
per unit length where V is the relative transverse velocity. The default is 1.0

• The Equivalent Diameter (De) for drag. This allows the drag to be based on a different dia-
meter from the added mass.

• The Longitudinal Drag Coefficient (Cx). Inline drag force is calculated by 0.5*ρ*Cx*V²*De
per unit length where V is the relative inline velocity. The default is 0.025.

5.9.3.2. Catenary Joint

You can insert either a buoy or a clump weight between catenary cable sections (however, you do
not need to specify a joint). Intermediate buoys always have the same buoyancy and do not "know"
where the surface is. Therefore they may float above the water surface.

To define the properties of a Catenary Joint:

1. Select the Connection Data object in the tree view.
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2. Right-click the Connection Data object and select Insert Connection Data > Catenary Buoy
or Catenary Clump Weight, or click the Catenary Buoy or Catenary Clump Weight icon in
the Connection Data toolbar.

3. Select the Catenary Joint object in the tree and enter the following information:

• Section Joint Type should be set to Buoy or Clump Weight based on your menu selection
when adding the object.

• Specify the Structural Mass of the buoy or clump weight. This must be smaller than the mass
of displaced water for a buoy, or larger for a clump weight. This can be positive, zero or
negative.

• Specify the mass of water displaced (Displaced Mass of Water), that is, the buoyancy/gravity.
This can be positive, zero or negative.

• Specify the total (constant) Added Mass; that is, not the added mass coefficient. Applicable
to Cable Dynamics only.

• Specify the Drag Coefficient * Area (cable dynamics only); drag will be in the direction of
the relative velocity of the fluid, VR. The magnitude of the force is given by FD = 0.5 * ρ *
CDA * VR * |VR| where CDA = Drag coefficient * projected area.

5.9.3.3. Tether/Riser Section

To define the properties of a Tether/Riser Section:

1. Select the Connection Data object in the tree view.

2. Right-click the Connection Data object and select Insert Connection Data > Tether/Riser
Section, or click the Tether/Riser Section icon in the Connection Data toolbar.

3. Select the Tether/Riser object in the tree and enter the following information:

• The Density of the material of which this section is composed.

• The Young's Modulus of the material of which this section is composed.

• The Outer Diameter of this section of the Tether/Riser.

• The wall Thickness of this section of the Tether/Riser.

• The Added Mass Coefficient ( ). Added mass is calculated as  per unit length, where
 is the water density and  is the cross-sectional area. That is, the added mass is equal to

the displaced mass of water multipled by . The default is 1.0.

• The Transverse Drag Coefficient ( ). Transverse drag force is calculated as  per

unit length, where  is the relative transverse velocity and  is the outer diameter. The default
is 0.75.
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5.9.4. Connection Stiffness

The Response Amplitude Operators (RAOs) and Quadratic Transfer Functions (QTFs) calculated in a
Hydrodynamic Diffraction analysis assume that each structure is freely floating. The RAOs and QTFs
do not account for any Connections (Cables, Joints, Fenders, Tether/Risers) that may have been defined
between structures, or between a structure and the ground. However, under the Connections object
in the Outline tree, you can define one or more Connection Stiffness matrices. These linear stiffnesses
are included in the RAO/QTF calculations during the Hydrodynamic Diffraction analysis and can be
used to model the (linear) effect of, for example, a mooring system.

Connection Stiffness can be defined in one of two ways. You can either manually define the structure
connectivity and stiffness values, or import an MFK file which has previously been generated by the
Aqwa solver.

Note:

• A Connection Stiffness object applies only to a Hydrodynamic Diffraction analysis.

• The stiffness matrix is defined with respect to the motions of the connected structure
COGs.

• If you want to include the effects of Linearized Morison Drag in the analysis, you
cannot have two structures connected with a Connection Stiffness matrix.

5.9.4.1. Import MFK File

As part of the Hydrodynamic Response Stability Analysis, the Aqwa solver will create a text-based
MFK file which contains the global (linear) stiffness due to Cables, Fenders and Tether/Riser connec-
tions, relative to the equilibrium position of each structure. This includes the coupled stiffness terms
between structures that are connected by Cables, or in contact through Fenders.

To import an MFK file:

1. Select the Connections object in the tree view.

2. Right-click the Connections object and the click Insert Connection > Connection Stiffness
> Import MFK File…

OR

In the Connections toolbar, click Connection Stiffness > Import MFK File…

3. In the Open dialog box, select the MFK file to import the data.

Note:

The format of the MFK file is described by comments within the file itself. You can
create your own MFK file, or modify an existing file, for importing stiffness data into
the Aqwa Workbench editor. The editor requires only the CONFIGURATION and
GLOBAL-STIFF data records to be defined.
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After an MFK file has been imported, a Connection Stiffness (Imported) object will be added to the
Outline tree. Beneath this, one or more Matrix objects are also added, which are populated with
the stiffness values contained in the MFK file.

When the Connection Stiffness (Imported) object is selected, the Details panel shows the Imported
MFK File path and the Number of Structures in MFK File for your reference.

The unit system of the data in the MFK file is assumed to match the display unit system of the
project with the default rotation unit in radians. However, the imported data can be modified by
setting the Length Unit for Imported Data, Force Unit for Imported Data, and Rotation Unit
for Imported Data to the required unit system.

The structure numbering in the MFK file is assumed to match the order of Parts as they appear in
the Outline tree. However, you can use the Connection Stiffness Assignment options to re-assign
Parts to structure numbers as necessary.
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5.9.4.2. Manual Input

This object may be used to input a connection stiffness matrix between structures using tabular
input in the Matrix Definition Data window.

To add a Connection Stiffness Matrix:
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1. Select the Connections object in the tree view.

2. Right-click the Connections object and then click Insert Connection > Connection Stiff-
ness>Manual Input.

OR

In the Connections toolbar, click Connection Stiffness > Manual Input.

3. Select the Connection Stiffness object in the tree and then, in the Matrix Definition Data
window that appears below the graphics window, enter the matrix coefficients.

4. Set the Connectivity and structure information as described below.

The Connectivity can be set to Fixity & Structure for a structure connected to a point, or Structure
& Structure for two connected structures. Select the first and second (if present) structure in the
Connected Structure A and Connected Structure B fields.

The Position at Equilibrium field is available when Connectivity is set to Fixity & Structure. With
Position at Equilibrium set to Geometric Position, the Response Amplitude Operators (RAOs) of
the structure are calculated at the structure position as defined by the Geometry. If the Position
at Equilibrium field is changed to Manual Definition, the Position X/Y/Z and Rotation About
X/Y/Z fields can be used to define an alternative position for the additional stiffness term in the
structure RAO calculation. These options are for the purpose of calculating the structure RAOs only
– the structure is not moved for the analysis.

Matrix Definition Data can be entered manually, can be copied and pasted from an external source
(for example, an Excel spreadsheet), or can be imported from a comma-separated values (.CSV)
file using the Import CSV File option. For the Import CSV File option, the file must meet the fol-
lowing requirements:

• Has the .CSV extension.

• Contains values separated by commas, tabs, or single spaces (not multiple spaces).

• Contains exactly 6 columns and 6 rows.

The unit system of the data in the .CSV file is assumed to match the display unit system of the
project. However, the imported data can be modified by setting the Length Unit for Imported
Data, Force Unit for Imported Data, and Rotation Unit for Imported Data to the required unit
system.

A connection stiffness matrix between two structures has 12 degrees of freedom. It will normally
require four 6×6 submatrices to be defined, as shown below:

where each  is a 6×6 submatrix. Each of these matrices must be defined as described above.

The submatrices in the leading diagonal can be defined by using Fixity & Structure or by setting
the first and second structures to be the same. Only one of the off-diagonal submatrices must be
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defined, as it is assumed that the overall matrix is symmetric. Defining both off-diagonal matrices
is not permitted.

If you wish to represent multiple connections to the same structure using Connection Stiffness

Matrices, the leading diagonal submatrices for that structure (the  terms) must be summed.
You cannot have multiple definitions of the same submatrix.

5.9.5. Fenders

Fenders are a type of mooring, which allow you to model material contact between two structures.
They are the only way to model contact, so if there are no fenders, structures can pass through each
other. From a practical point of view, like other mooring elements fenders are defined as acting
between two structures or one structure and a fixed connection point.

Depending on the relative positions of the structure, on the type of Fender (floating, fixed unidirec-
tional, fixed omnidirectional), and on their positions on the structures, they create a varying force
acting on the structure and added to the other forces used for computing the structures' motions.
These forces are calculated using the properties defined for each fender.

A Contact Plane is defined for each fender; this is the plane which the fender is going to impact. This
plane is defined by a point and a vector.

An attachment point is defined for each fender. For fixed fenders, this is the point where the fender
is located on the structure. For floating fenders, the attachment point is translated to the mean water
surface.

Fixed unidirectional and floating fenders also have a direction of action, represented by a "normal
vector". Along with the attachment point given in the fender's definition, it defines a plane which is
going to be the second plane pressing on the fender. For floating fenders, the actual attachment
point is obtained by translating the original definition point down to the mean water surface, following
this plane. It therefore models the ship's side, which is not necessarily vertical. Omnidirectional fixed
fenders act in all directions.

The size of the fender must be specified. At each time step, the distance between the fender's attach-
ment and the contact plane is calculated and compared to the fender's size. If the distance is shorter
than the size, a force is calculated as a function of the difference following a polynomial law whose
coefficients are part of the fender's definition. This force is applied to the structure at the fender's
attachment point. The calculation of the distance depends on the type of fenders. Fixed unidirectional
and floating fenders have a direction along which the distance is calculated. For the omnidirectional
fender, the distance is simply the shortest distance from the contact plane to the attachment point.
Fenders can only have compressive forces.

To add a Fender:

1. Select the Connections object in the tree view.

2. Right-click the Connections object and select Insert Connection > Fender, or click the Fender
icon in the Connections toolbar.

3. Select the Fender object in the tree and enter the following information:

• Connectivity – Select the type of connectivity for the fender:
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Fender and Contact on Structures–

– Fender On Structure, Contact On Fixed Point

– Fender On Fixed Point, Contact On Structure

• Type – Fixed or Floating. Note that Floating fenders cannot have a horizontal connection plane.
If there is more than a 60 degree angle between the Floating fender and contact plane directions,
a warning is generated saying that the forces are in error. But this will not prevent the run from
completing.

• Action – For a Fixed fender, you can select Omni-Directional, or for either fender type choose
the axis (X Direction Only, Y Direction Only, or Z Direction Only) for a uni-directional fender.

• Fender Connection Point, Contact Connection Point – Allows you to select an existing Con-
nection Point on a structure to define the fender attachment point and contact plane origin.
These are present when the Fender/Contact is on a structure.

• Fender Fixed Point, Contact Fixed Point – Allows you to select from a dropdown list an existing
Fixed Point for the Fender/Contact when the connectivity is specified as such.

• Damping Coefficient – Material (or structural) damping coefficient β. Damping is modeled as
linear material damping, where the damping coefficient is β x the stiffness. Damping is only
applied in the direction perpendicular to the contact points.

• Friction Coefficient – This is the friction coefficient μ. The friction force is given by F = μR,
where R is the normal reaction.

• Size – The fender size.

• Polynomial Coefficient (A, B, C, D, E) – The force acting on the structure is Ax +

Bx2+Cx3+Dx4+Ex5, where x is the compression applied to the fender.

Fender friction works best in situations where the friction force is smaller than other forces in the
same direction. Friction will slow down relative motion between two structures, but is not suitable
for keeping them fixed together - there is no "stiction". When the relative velocity changes sign the
friction force must also change sign, but to avoid an instantaneous change in force (and therefore
an instantaneous change in acceleration) a smoothing function is applied. This means that when the
relative velocity is very small the friction force is also small, and the structures can move relative to
each other.

Table 5.1: Fender Color Codes

DescriptionFender Color

The fenders are stationary and not in contact.Orange

The fenders are in contact.Red

The fenders are deactivated.Purple

The fender compression force has exceeded the maximum
permissible value based on the defined fender stiffness
coefficients.

Black
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When inserting a fender, Fender Axes and Contact Axes objects are inserted as its children. These
axes objects define the orientation of the fender and the contact plane. The orientation can be set
using these fields in the Details panel for each axes object:

• Alignment Method – Select Global Axes to align the axes with the global axes. You can also set
the alignment of the axes using the Vertex Selection or Direction Entry methods.

• Origin Vertex, X Direction Vertex, Vertex Defining the XY Plane – For For an Alignment Method
of Vertex Selection, select the Origin Vertex of the fender or contact plane, a vertex defining the
X direction (X Direction Vertex), and a vertex that would, along with the other two vertices, define
the XY Plane (Vertex Defining the XY Plane). As these vertices must be part of a body in the
geometry, you may have to anticipate and include, for instance, a dummy massless line body in
the geometry oriented the same way as the fender to be defined. In DesignModeler you can, for
example, create such a line body as being perpendicular to the surface of the hull.

• Rotation about Global Z, Rotation about Local Y, Rotation about Local X – For an Alignment
Method of Direction Entry, define the alignment using these three rotation fields.

Note:

The Fender Axis definition should point towards the contact surface; meaning, through
the fender itself. The Contact Axis definition should point towards the fender attachment
surface; meaning, the opposite direction to the Fender Axis definition.

5.9.5.1. Examples of Use of Fenders

The following images show examples of using omni- and uni-directional fenders with various
alignment methods.

Omni-Directional Fender

Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.118

Aqwa Approach



Uni-Directional Fender Aligned to X Axis
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Uni-Directional Fender Aligned to Z Axis
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5.9.6. Joints

A hydrodynamic analysis allows structures to be connected by articulated joints. These do not permit
relative translation of the two structures but allow relative rotational movement in a number of ways
that can be defined by the user.

A maximum of 99 joints is allowed.

To add a Joint:

1. Select the Connections object in the tree view.

2. Right-click the Connections object and select Insert Connection > Joint, or click the Joint icon
in the Connections toolbar.

3. Select the Joint object in the tree and enter the following information:

• Type – To add a joint, select the type of joint you are adding:

Note:

In the following images, the joints are shown with their two ends split apart.
Each end is attached to one of the two joint structures (or a structure and a
fixed connection point). Each end of the joint has a set of axes attached to it
that corresponds to its position with respect to the structure that it is attached
to. The curved, colored arrows in the figures below indicate how the two ends
will be connected. When the two sets of axes are coincident, the starting position
of the structures in the simulation may be different from that in the imported
geometry.

– Ball and Socket. Free to rotate about all axes.
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Figure 5.5: Ball and Socket Joint

– Universal. Free to rotate about two axes transmitting a moment about the third axis at
right angles to the first two.

Figure 5.6: Universal Joint

– Hinged. Transmitting a moment about two axes and free to rotate about the third axis
at right angles the first two.
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Figure 5.7: Hinged Joint

– Rigid. Transmitting a moment about all three axes and not free to rotate at all. This type
of constraint enables you to find the reactions between two or more structures. This
type of joint rigidly connects the structures together so that the solution of the equations
of motion is the same as if one structure was defined.

Figure 5.8: Rigid Joint

In order to see the shape of the connections more easily, you can switch to wireframe mode.

• Connectivity – Select the type of connectivity for the joint:

– Fixed Point and Structure

– Structure and Structure
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• Fixed Point – For Connectivity of Fixed Point and Structure, select the fixed point from a
dropdown list of existing fixed points.

• Connection Point on Structure (A/B) – Allows you to select the connection point on the contact
structure(s) from a dropdown of existing connection points.

• Stiffness About X,Y,Z – These three fields define the rotational stiffness about the X, Y, and Z
axes.

• Damping About X,Y,Z – These three fields define the rotational damping about the X, Y, and
Z axes.

• Translation Friction Coefficient – Friction coefficient for transverse force ( ).

• Rotational Coefficient – Friction coefficient for overturning moment ( ).

• Axial Friction Coefficient – Friction coefficient for axial force ( ).

• Constant Friction Moment – Constant friction moment ( ).

The frictional moment is given by:

where:

 if the relative rotational velocity is less than 0.001 rad/s, 1 otherwise

 are coefficients. These are not conventional dimensionless friction coeffi-
cients, as used in the equation . These coefficients are factors to be applied to
the appropriate forces to give frictional moments, and they must include effects of the
bearing diameter etc.  through  must not be negative.  and  have dimensions

of length, and the maximum value allowed is  where  is the acceleration due

to gravity and  is the acceleration due to gravity in the [kg, meter, second] unit

system.  is non-dimensional and has a maximum value of 0.025.

When inserting a joint, two axis objects are inserted as its children (Joint Target Axes and Joint
Contact Axes). These axes objects define the orientation of the two objects that are connected by
the joint. The orientation can be set using these fields in the Details panel for each axes object:

• Alignment Method – Select Global Axes to align the axes with the global axes. You can also set
the alignment of the axes using the Vertex Selection or Direction Entry methods.

• Origin Vertex, X Direction Vertex, Vertex Defining the XY Plane – For an Alignment Method of
Vertex Selection, select the Origin Vertex of the axis, a vertex defining the X direction (X Direction
Vertex), and a vertex that would, along with the other two vertices, define the XY Plane (Vertex
Defining the XY Plane).

Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.124

Aqwa Approach



• Rotation about Global Z, Rotation about Local Y ,Rotation about Local X – For an Alignment
Method of Direction Entry, define the alignment using these three rotation fields.

Note:

If your joint is connecting the structure to a fixed connection point, it will be indicated by
a black sphere. This black sphere is not to be confused with the sphere of a ball and
socket joint.

5.9.6.1. Initial Positioning of Jointed Structures

In hydrodynamic analyses, inserting joints between two structures affects the initial position of
these structures when the analysis is run.

The program automatically determines the initial positions based on the defined joints so that you
do not have to edit the model’s initial geometry. If two connection points are not coincident, the
program moves one of the structures to align the connection points before running the analysis.
The geometry movement will not be shown in the viewer.

You can control which structure will remain in a defined position and which structure is free to
move by selecting Connection Point on Structure A or Connection Point on Structure B in the
details dialog for the joint. Fixed connections are shown in black.

The rules for defining fixed and movable structures are as follows:

1. If neither of the two is connected to a fixed connection point, the structure with the Connection
Point on Structure A option will remain at its original position and the structure with the
Connection Point on Structure B option will be moved.

2. The Connection Point on Structure A or Connection Point on Structure B designations will
be overridden in some situations. If one of two structures is connected to a fixed connection
point or is part of a group of articulated structures that are already connected to a fixed con-
nection point, then that structure will remain in a defined position and the other structure will
be moved. If this second structure is also part of a group of articulated structures that are not
connected to any fixed connection point, the full group to which this structure is already con-
nected will also be moved. Note that this action is independent of the Connection Point on
Structure A or Connection Point on Structure B designations.

3. If one or both of the structures are part of groups of articulated structures and none of these
structures is connected to a fixed connection point, then rule #1 applies and the structure with
the Connection Point on Structure B designation will be moved, along with its group of
structures.

4. If both articulated groups are already connected to fixed connection points, the new joint is
then going to close the loop. See rules for Closed Loops (p. 126) below.

5.9.6.2. Moving Structures

Structures are moved in two steps: They are first translated, which causes the joint points to be
coincident, and then the structures are rotated so that the two sets of axes attached to the joint
object become superimposed. This gives you the freedom to set an initial orientation for the
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structures at the start of the Time History Analysis. You will not see the structures move in the
viewer.

The resulting set of axes defines the local joint axes at the start of the Time History Analysis. In this
set of axes, some rotational motion of the structures will be allowed during the Time History Ana-
lysis, depending on the type of joint selected:

• Ball and Socket Joint: all rotations are allowed.

• Universal Joint: rotations are allowed around the X and Y axes of the local axes system.

• Hinged Joint: rotations are only allowed around the X axis of the local axes system.

• Rigid Joint: no rotation is allowed.

5.9.6.3. Closed Loops

In hydrodynamic analyses, the following conditions and recommendations apply to closed loops
in articulated groups of structures:

• The joint positions in the closed loop must be geometrically compatible. It is not possible to
connect two structures using two joints if the distance between these joints is different on both
structures.

• In some cases, use a single joint of a different type that performs the same function as two simpler
joints. For example, two ball and socket joints can be replaced by a single hinged joint or two
hinged joints can be replaced by a rigid joint.

• A closed loop should not introduce any redundancy in the way that the degrees of freedom will
be locked.
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Figure 5.9: A Closed Loop with No Redundant Constraints

Figure 5.9:A Closed Loop with No Redundant Constraints (p. 127) shows a closed loop joining
three wireframe structures. Three articulated structures are connected to form a triangle. One of
the joints is a vertical hinged type. The second one is a universal type where neither the joint's
local x- nor y-axis is parallel to the line passing through the connection points of the second and
third joints. The third one is a ball and socket joint because making it the same as the other joints
results in redundancy.
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Figure 5.10: A Closed Loop with Redundant Constraints

Figure 5.10: A Closed Loop with Redundant Constraints (p. 128) shows a closed loop joining three
wireframe structures. The ball and socket and universal joints from Figure 5.9:A Closed Loop with
No Redundant Constraints (p. 127) have been replaced by the rigid joints which have added five
redundant constraints to the problem. This results in the statically indetermined solution of the
reaction forces/moments on the joints.

When you close a loop, a warning message is produced to inform you that a loop is being closed
which may cause a statically indeterminate solution while solving.

5.9.6.4. Removing a Joint

Joints can be removed from an analysis temporarily or permanently by right-clicking on the Joint
item in the tree and selecting Suppress or Delete. The result is that the group of articulated
structures that contains the joint is broken into two parts. Closed loops that are suppressed or deleted
are opened.

If the starting positions of some structures were modified when the joint was created, they will be
moved again using the following rules:

• If the two structures are not part of any group, they will be returned to the positions they held
when the geometry was created.

• If more than two structures are part of the group to be broken apart, the program positions both
subgroup structures where they would have been if the two subgroups had been originally created
with the remaining joints. The suppressed and deleted joints are not considered as part of the
new arrangement. The existing joints are applied in chronological order.
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5.10. Establish Analysis Settings

The Analysis Settings object allows you to specify how the analysis runs and how the results are shown.
Different fields appear in the Details view for the object depending on the parent object (Hydrodynamic
Diffraction or Hydrodynamic Response).

Analysis options vary depending on the analysis system and the computation type. The following topics
are available:

5.10.1. Specifying External Pre- or Post-Solve Operations

5.10.2. Hydrodynamic Diffraction Settings

5.10.3. Hydrodynamic Response Settings

5.10.1. Specifying External Pre- or Post-Solve Operations

The External Operation before Solving and External Operation after Solving fields can be used
to instigate a user-defined operation immediately before or after the hydrodynamic solver runs. The
default for each of these fields is None, so that no external operation is performed.

Setting External Operation before Solving to Run a Python Script adds a Pre-Solve Python Script
object under the Analysis Settings. You can use this object to import an existing Python script by
selecting a file in the Pre-Solve Python Script field. You can define or edit your Python script directly
in the script editor that is provided.

Note:

Modifying the Pre-Solve Python Script will cause an up-to-date Solution to go out of date.
If the Pre-Solve Python Script fails to execute, the Solve operation will be terminated before
it progresses to the hydrodynamic calculation.

You can also set the External Operation after Solving field to Run a Python Script, which will add
a Post-Solve Python Script object under the Analysis Settings. You can import an existing Python
script by selecting a file in the Post-Solve Python Script field. Modifying the Post-Solve Python Script
will not cause the Solution to go out of date, and the Solution will still be marked as up-to-date at
the end of a Solve even if the Post-Solve Python Script fails to execute. However, a dialog box will
appear to warn you of such a failure.

When you import a Python script into your hydrodynamic system, the only retained reference to the
original file is the path shown in the Pre- or Post-Solve Python Script field. If you make any sub-
sequent changes in the Aqwa editor's Python script editor, they will not be saved in the original file.
If you modify the original file outside of the Aqwa editor, you will need to re-import it for those
changes to be captured.

Alternatively, the External Operation before or after Solving fields can be set to Run a Custom
Command. These allow you to specify paths to external programs, in the External Pre-Solve Command
and External Post-Solve Command fields, that should be run immediately before or after the hydro-
dynamic solver. The paths can be absolute or relative. If the location of the executable is in your
%PATH% environment variable, you should not need to specify the full path. You can also enter any
Windows command that can be executed from the command line.
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When a pre- or post-solve command is specified, the following environment variables are created in
the process' environment:

• AQWA_INPUT_FILE: points to the .DAT file used by the analysis.

• AQWA_INPUT_FILE_NOEXT: same, but without the extension (to access the result files, with ex-
tensions .PLT, .RES etc.).

• AQWA_WORK_DIR: the directory where the analysis is run.

• AQWA_USER_DIR: the project's user_files subdirectory.

• AQWA_INSTALL_DIR: the root of the Ansys installation folder.

• AQWA_PYTHON_EXE: the path to the CPython executable shipped with the Ansys installation.

For the post-solve command only, the following variable is also set:

• AQWA_RUN_COMPLETED: set to either TRUE or FALSE depending on the outcome of the solve.

5.10.2. Hydrodynamic Diffraction Settings

Hydrodynamic Diffraction analyses can take advantage of Parallel Processing with the proper licenses.
For more information, see Setting Aqwa Parallel Processing Options (p. 265).

The Generate Wave Grid Pressures option specifies whether Aqwa should generate a Cartesian grid
of wave pressures around the analyzed structures. This option must be set to Yes if you wish to include
results in which the surrounding wave surface is reported (specifically, Pressures and Motions (p. 227)
results with Contour Type of Wave Surface Elevation or Air Gap).

When Generate Wave Grid Pressures is set to Yes the following Wave Grid options are available:

• Wave Grid Resolution allows you to double the resolution of the wave surface from 81 x 51 wave
grid nodes (Standard) to 161 x 101 nodes (Fine). This is useful to capture the wave shapes of high-
frequency wave components, particularly where encounter frequencies are increased due to a
vessel’s forward speed.

• Wave Grid Size Factor controls how much larger the sea area is than the structure (or structure
group, if there are interacting structures present). The default value of 2 will cause the sea area to
be twice as long as the structure in the X or Y directions, a ratio of X = 1.6 Y is maintained.

The following options are available to the Hydrodynamic Diffraction analysis system:

5.10.2.1. Common Analysis Options

5.10.2.2. QTF Options

5.10.2.3. Output File Options
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5.10.2.1. Common Analysis Options

These analysis settings control how the analysis is performed. In normal circumstances they will
not need adjusting. However, if you get modeling warnings then you may wish to turn on the Ignore
Modeling Rule Violations option.

Note:

Mean wave drift coefficients are always included in the Hydrodynamic Diffraction calcu-
lation. If you do not want to include drift forces in a subsequent Hydrodynamic Response
analysis, you can achieve this by setting the Omit Calculation of Drift Forces to Yes in
any Irregular Wave (p. 156) objects that have been added to the Hydrodynamic Response
analysis. This option is only available for Irregular Wave Response with Slow Drift calcu-
lations.

Ignore Modeling Rule Violations

If Yes, modeling rule violations will not stop the analysis. Most modeling errors generate
warnings when this option is set to Yes. Do not use this option unless violations are minor and
difficult to correct. For more information on modeling rules, see Mesh Quality Check in the
Aqwa Theory Manual.

Calculate Extreme Low/High Frequencies

If Yes, in addition to the frequencies defined in Wave Frequencies, the solver also calculates
solutions at a 'very low' frequency and a 'very high' frequency. These are added to improve the
calculation of the full QTF matrix in the Hydrodynamic Diffraction analysis, and to improve the
convolution of radiation forces in any subsequent Hydrodynamic Response analyses.

This option must be turned on when the model includes active Moonpools. This enables the
correct options in the solver file. Failure to do so will result in an error message, and the solve
will be stopped.

Include Multi-Directional Wave Interaction

If No, do not account for interactions between different wave directions in the calculation of
QTF coefficients. Setting this option to No prevents the Apply Mean Drift Force with Multi-
Directional Wave Interaction option from being used in any subsequent Hydrodynamic Re-
sponse analysis.

Near Field Solution

If Program Controlled, the far field solution is used in the calculation of mean drift forces where
possible. However, the far field solution only calculates the mean drift force in three horizontal
degrees of freedom (surge, sway, and yaw) and is unable to consider the hydrodynamic inter-
action between structures. For analyses in which the full QTF matrix is to be calculated or which
contain multiple interacting structures, the near field solution must therefore be used.

If Yes, specifies that the near field solution should be used.

131
Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Establish Analysis Settings



Linearized Morison Drag

If Yes, computes linearized Morison drag for tube, disc, and slender tube elements. In order for
the drag to be computed, after enabling Linearized Morison Drag an Irregular Wave (p. 156)
must be added to the Hydrodynamic Diffraction analysis. Only one spectrum can be defined
(no Irregular Wave Group). The Irregular Wave must have only a single direction defined (no
Cross Swell).

This option will not be available if multiple structures are connected with a Connection Stiff-
ness (p. 112) matrix. If set to Yes and a Connection Stiffness object is then defined between two
structures it will show as a yellow field. In addition, the Analysis Options item will be marked
with the question mark until either: the Connection Stiffness matrix is suppressed or is changed
to connect between a point and a structure; or, the option is set to No.

5.10.2.2. QTF Options

The analysis settings control the use of the QTF matrix. For more information, see the Aqwa Reference
Manual.

Calculate Full QTF Matrix

If Yes, the program calculates the full QTF matrix.

5.10.2.3. Output File Options

These analysis settings control what is written to the Aqwa output text file or to specific additional
files. For more information, see the Aqwa Reference Manual.

Source Strengths

If Yes, writes the singularity strengths for both the modified and unmodified values to the
*.LIS file, the modified strengths being a linear combination of the unmodified values. The
actual relationship is a function of the number of body symmetries that are used.

Potentials

If Yes, writes the modified and unmodified values of the potential at the diffraction element
centers and at the field points to the *.LIS file. This information may be used to define the
fluid flow field about the body.

Centroid Pressures

If Yes, writes the hydrostatic differential and hydrodynamic fluid pressures at each plate in the
model to the *.LIS file.

Element Properties

If Yes, writes complete details of each element used in the body modeling to the *.LIS file.
All important details of the body elements are output together with the resultant properties of
the bodies.
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ASCII Hydrodynamic Database

If Yes, prints the hydrodynamic database (the .HYD file) in a compact ASCII format to a new
file with a .AH1 extension. This option must be set to Yes in order to use the Output Example
of Hydrodynamic Database option.

Example of Hydrodynamic Database

If Yes, prints a sample of the .AH1 file, with annotation to explain the format.

Generate AHD Pressure Output

If Yes, the program runs an additional post-processing step to write real and imaginary pressure
components, over all wave frequencies and directions in the Hydrodynamic Diffraction analysis,
to a new file with an .AHD extension. For analyses that include Morison elements, the disturbed
wave kinematics at Line Body mesh nodes are also included.

5.10.3. Hydrodynamic Response Settings

Analysis settings for the Hydrodynamic Response analysis system depend on the Computation Type
field. This field can be set to Stability Analysis for the calculation of static equilibrium starting con-
ditions for a subsequent Hydrodynamic Response analysis, Time Response Analysis for a calculation
in the time domain, or Frequency Statistical Analysis for a calculation in the frequency domain.

By default, a Hydrodynamic Response system connected to a Hydrodynamic Diffraction system has
the Computation Type of Stability Analysis. A Hydrodynamic Response system connected to another
Hydrodynamic Response system has a default Computation Type of Time Response Analysis. See
Hydrodynamic Response System (p. 35) for a table of valid system connections.

5.10.3.1. Stability Analysis

5.10.3.2.Time Response Analysis

5.10.3.3. Frequency Statistical Analysis

Parallel Processing

Time response analyses can take advantage of parallel processing for any of the following cases:

• Multiple dynamic cables are defined

• Multiple tether/risers are defined

• One or more quasi-static composite cable(s) that touch down on a sloped seabed are
defined

• Analysis Type in Time Response Specific Options is set to Irregular Wave Response

• Calculation of time domain pressure

Other Computation Types of Hydrodynamic Response analysis without quasi-static composite
cables that touch down do not make use of parallel processing. For these cases, if Parallel Pro-
cessing is set to Manual Definition and anything other than 1 is set for Number of Requested
Cores, an information message is displayed and only one core is used.
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For more information, see Aqwa Parallel Processing Calculation in the Aqwa Theory Manual.

Use Cable Dynamics

If Yes, enables cable dynamics to be used (can be set per cable). If Cable Dynamics is disabled,
then regardless of the selection in the individual cable, it is not used during the analysis.

5.10.3.1. Stability Analysis

The following analysis settings are specific to a Stability Response analysis.

Output Global Stiffness Matrix

If Yes, output the global stiffness matrix.

Require Convergence for Subsequent Analysis

If Yes, prevent any analysis dependent upon results from the current Stability Response analysis
from running if convergence is not achieved.

Maximum Number of Iterations

Defines the maximum number of iterations to perform in the stability analysis. If convergence
has not occurred after the maximum number of iterations has been reached, the simulation
stops.

Movement Limitations per Iteration Step

Defines the maximum amount a structure can move in the X, Y, Z, RX, RY, and RZ directions in
a single time step. When set to Program Controlled, the values for each maximum are 2 m, 2
m, 0.5 m, 0.573°, 0.573°, 1.432° respectively. When set to Manual Definition, the following addi-
tional options appear:

Movement Limitations Applied to

Defines the structure to apply manual movement limitations to. When defined, additional
Max Movement/Step fields appear for the X, Y, Z, RX, RY, RZ directions. You can define up
to 5 sets of movement limitations.

Maximum Error in Equilibrium Position

Defines the convergence criteria. When the movement per iteration drops below the values set
in this field (in all six freedoms), the solution is considered converged and the simulation stops.
When set to Program Controlled, the values for X, Y, Z, RX, RY, and RZ are 0.02 m, 0.02 m, 0.02
m, 0.057°, 0.057°, 0.143° respectively.

5.10.3.1.1. Common Analysis Options

Use Linear Stiffness Matrix to Calculate Hydrostatics

If Yes, uses the linear stiffness matrix and Froude-Krylov forces from the Hydrodynamic Dif-
fraction calculation instead of re-calculating using the individual elements. This normally will
reduce the time to run the program substantially.
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5.10.3.1.2. Output File Options

These analysis settings control what is written to the Aqwa output text file. For more information,
see the Aqwa Reference Manual.

Axes System for Joint Reactions

Defines the axis system for the output of joint reaction forces.

Fixed Reference Axes

Joint reactions are output using axes parallel to the global axes.

Local Structure Axes

Joint reactions are output using axes parallel to the local structure axes.

Local Articulation Axes

Joint reactions are output using the individual local joint axes.

Data List

If Yes, include all extended data output in the .LIS file.

Element Properties

If Yes, output complete details of each element used in the body modeling to the *.LIS
file. All important details of the body elements are output together with the resultant prop-
erties of the bodies.

Dynamic Cable/Tether Drag

If Yes, the drag force acting on each dynamic cable or tether connection at each iterative
step will be output in the *.LIS file.

5.10.3.2. Time Response Analysis

The following analysis settings are specific to a Time Response analysis.

Analysis Type

Select one of the analysis types listed. Depending upon the type selected, either a Regular or
Irregular Wave object must be defined for the analysis. Available settings are:

• Irregular Wave Response With Slow Drift (Irregular Wave)

• Irregular Wave Response (Irregular Wave)

• Regular Wave Response (Regular Wave)

• Slow Drift Only (Irregular Wave)
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Start Time, Duration

Set the Start Time and Duration for the Time Response simulation. The Finish Time is updated
automatically. If there is an upstream Hydrodynamic Response system the Start Time must be
within the range of the Start Time and the Finish Time of the upstream system.

Output Step

The length of time between outputs to the plotting and text files. The Output Step will default
to 0.1s, and will always be equal to the nearest whole number of time step intervals. Enter 0
to reset the Output Step to the Time Step value.

Note:

In order to limit the size of the hydrodynamic output files, the maximum number
of output time steps accepted by Aqwa Workbench is 1,000,000. If this is ex-
ceeded, the program will set Output Step to the minimum permissible for the
defined Time Step.

Time Step

Set the length of time simulated at each time step. The Number of Steps is calculated from
the Time Step and Duration, and is updated automatically.

Starting Position

If a Time Response Analysis is preceded by a Stability Analysis (p. 134), the equilibrium position
from the Stability Analysis (p. 134) is used and the (read-only) Starting Position is set to Determ-
ined by Upstream System. This also applies if there is an upstream Time Response Analysis,
where the Starting Position is determined by the position at the corresponding time in the
upstream system.

If a Time Response Analysis is linked directly to a Hydrodynamic Diffraction/Radiation (p. 130)
Analysis and Starting Position is set to Program Controlled, the equilibrium position will be
automatically determined before the Time Response Analysis is started and used as the starting
position. If Starting Position is set to Based on Geometry, the current geometry determines
the starting position. Note that when the model includes one or more Joints, the Based on
Geometry option is replaced by Based on Articulated Positions.

X- and Y-Position for Wave Surface Elevation Output

Define a Fixed Position at which the Wave Surface Elevation will be available as a result.

5.10.3.2.1. Time Response Pressure Output

When the Time Response Analysis Type is set to Irregular Wave Response or Regular Wave Re-
sponse, the Time Response Pressure Output options can be used to set up the generation of
instantaneous pressure results for one or more structures in the analysis. The options are:

Output for Structure

Select a structure for which instantaneous time domain pressures will be output; or, in an
analysis with multiple structures, you may choose All Structures.
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Output Start Time

Set the time at which pressures will start to be recorded. The Output Start Time cannot be
less than the analysis Start Time, and is automatically adjusted to the nearest whole number
of Output Step intervals.

Output Time Step

Set the length of time between pressure records. The Output Start Time is automatically
adjusted to the nearest whole number of Output Step intervals.

Output Finish Time

Set the time at which pressures will stop being recorded. The Output Finish Time cannot
be greater than the analysis Finish Time, and is automatically adjusted to the nearest whole
number of Output Step intervals.

Note:

For a workflow which includes time domain Hydrodynamic Response pressure mapping
to a Static Structural finite element analysis using the Aqwa Hydrodynamic Pressure
Mapping (p. 273) Add-on, the structures and time steps available for pressure mapping
in the Static Structural system are defined by the Time Response Pressure Output
options. Time domain pressure mapping will not be possible while the Output for
Structure option is set to None.

5.10.3.2.2. Common Analysis Options

These analysis settings control how the Time Response Analysis is performed. In normal circum-
stances they will not need adjusting. For more information, see the Aqwa Reference Manual.

Time Response analyses with the Use Cable Dynamics option set to Yes can take advantage of
parallel processing with the proper licenses. For more information, see Setting Aqwa Parallel
Processing Options (p. 265).

Convolution

If Yes, specifies that convolution method is used in radiation force calculation. This is a more
rigorous approach to the radiation force calculation in time domain and will enhance the
capability of handling nonlinear response of structures. Convolution requires that a Hydro-
dynamic Diffraction/Radiation analysis has been performed for at least 5 wave frequencies.

Call Routine "user_force"

If Yes, calls a routine called "user_force" at each stage of the calculation. This routine can be
used to add externally calculated forces to the simulation. See External Force Calculation in
the Aqwa Reference Manual for more information.

Connect to Server for External "user_force" Calculation

If Yes, uses a process running on an external server for the user-force calculation. See External
Server for User-Defined Force Calculation in the Aqwa Reference Manual for more information.
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Calculate Motions Using RAOs Only

If Yes, calculates motions using RAOs only. Note that this option suppresses all motion except
that defined by the RAOs. In particular current, wind, drift forces, moorings etc. have no effect
on the motions of the structure.

Account for Current Phase Shift

If No, switches off the wave phase shift due to a current speed.

Apply Mean Drift Force with Multi-Directional Wave Interaction

If Yes, utilize the drift coefficients which include interactions between different wave directions
that have been calculated in the preceding Hydrodynamic Diffraction analysis. This option is
invalid if the Include Multi-Directional Wave Interaction option in the preceding Hydro-
dynamic Diffraction analysis is set to No.

Calculate Wave Drift Damping

If No, stops the automatic calculation of wave drift damping for a floating structure. Note
that the wave drift damping calculated by the program is only for the floating structure,
damping from risers, etc. is not included.

Include Yaw Wave Drift Damping

If No, suppresses the calculation of wave drift damping for yaw motion. To prevent the calcu-
lation of all wave drift damping use the No Automatic Wave Drift Damping Calculation option.

Use Slow Velocity for Hull Drag Calculation

If Yes, uses the slow velocity (drift frequency velocity) for the hull drag calculation, instead
of the total velocity (drift frequency velocity + wave frequency velocity) which is the default.

Use Linear Starting Conditions

If Yes, starts a simulation with the motions and velocities derived from the Hydrodynamic
Diffraction system results. This can be used to limit the transient at the start of a simulation.

Use Linear Stiffness Matrix to Calculate Hydrostatics

If Yes, uses the linear stiffness matrix and Froude-Krylov forces from the Hydrodynamic Dif-
fraction calculation instead of re-calculating using the individual elements. This normally will
reduce the time to run the program substantially.

Include Maneuvering Force

If Yes, adds the maneuvering loads due to the low frequency ship maneuvering motions, as
described in Low Frequency Maneuvering Loads in the Aqwa Theory Manual, to the total
structure forces/moments.

Use Wheeler Stretching

The functionality of this option depends on the context in which it is used.
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• If the Analysis Type is set to Regular Wave Response: Use Wheeler Stretching = Yes turns
on Wheeler stretching when calculating the Froude-Krylov force over the instantaneous
wave surface.

• If the Analysis Type is set to Irregular Wave Response, Wheeler Stretching is always used.
The Use Wheeler Stretching field can be used to specify:

– With Linear Wave Theory - calculation will only use linear wave theory.

– With Second Order Correction - calculation will add a second order correction on wave
elevation, pressure, and fluid particle velocity/acceleration in addition to the linear wave
theory.

5.10.3.2.3. QTF Options

These analysis settings control the use of the QTF matrix for Time Response Analyses. For more
information, see the Aqwa Reference Manual.

Use Full QTF Matrix

If Yes, specifies that the full matrix of difference frequency QTFs is to be used when calculating
slowly varying drift forces.

Use Sum Frequency QTFs

If Yes, specifies that the full matrix of sum frequency QTFs is to be used when calculating
slowly varying drift forces, in addition to using the full matrix of difference frequency QTFs.
You must also have Use Full QTF Matrix set to Yes to use this feature.

5.10.3.2.4. Output File Options

These analysis settings control what is written to the Aqwa output text file. For more information,
see the Aqwa Reference Manual.

Axis System for Joint Reactions

Defines the axis system for the output of joint reaction forces.

Fixed Reference Axes

Joint reactions are output using axes parallel to the global axes.

Local Structure Axes

Joint reactions are output using axes parallel to the local structure axes.

Local Articulation Axes

Joint reactions are output using the individual local joint axes.

Data List

If Yes, include all extended data output in the *.LIS file.
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Element Properties

If Yes, writes complete details of each element used in the body modeling to the *.LIS file.
All important details of the body elements are output together with the resultant properties
of the bodies.

Dynamic Cable/Tether Drag

If Yes, the drag force acting on each dynamic cable or tether connection at each time step
will be output in the *.LIS file.

5.10.3.2.5. Output Aqwa FMU Package

When the Hydrodynamic Response Settings (p. 133) is set to Irregular Wave Response or Regular
Wave Response, the Co-simulation FMU Package options become available to set up the gen-
eration of the Aqwa Functional Mock-Up Unit (FMU) package. This Aqwa FMU package contains
the information of the current Aqwa model, and it is used for the co-simulation analysis. The inputs
for this Aqwa FMU package need to be the displacement, velocity, and acceleration at the center
of gravity of each Aqwa structure. The outputs of this Aqwa FMU package are the total forces
and moments of hydrostatic, hydrodynamic, and mooring loads at each Aqwa structure's center
of gravity. More information about Aqwa co-simulation is elaborated in The Aqwa Co-simulation
Add-on (p. 332) section. The following are the available options for the generation of the Aqwa
FMU package:

Output FMU Package

Select whether to output an Aqwa FMU package for the current analysis. Select Yes if the
co-simulation analysis is required. The solver input files of the current analysis and FMI sup-
porting file are contained within the Aqwa FMU package.

FMU Export Version

Select the FMU version for the output Aqwa FMU package file. The selection must be based
on the FMU versions supported by the co-simulation platform (p. 344).

Co-simulation Partner's Unit

Select the unit system used by the co-simulation partner, which is planned to be connected
to the Aqwa FMU package. The available selections follow the Mechanical application interface
unit options and their converting relationships with the Mechanical solver units. During the
co-simulation, the unit transformation will be conducted according to the selected units.

Co-simulation Coordinate System Offsets

Select whether there are differences between the coordinate system of the current Aqwa
model and the co-simulation partner. If Yes is selected, the offsets between the two coordinate
systems can be defined by X Offset, Y Offset, Z Offset, Rotational Offset X, Rotational Offset Y,
and Rotational Offset Z options. The application of the offsets on the Aqwa coordinate values
should be equal to the coordinate values of the co-simulation partner.

5.10.3.3. Frequency Statistical Analysis

The following analysis settings are specific to a Frequency Statistical analysis.
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Analysis Type

Select one of the analysis types listed. Available settings are:

• Wave and Drift Frequencies

• Wave Frequencies Only

• Drift Frequencies Only

Direction of Output for RAOs

Allows you to change the direction in which some of the Graphical Results (p. 217) (Motion
RAOs, Cable Tension and Fender Force RAOs, and Transfer Functions) are given. When there is
more than one direction available, the entries in the menu are the unsuppressed waves contained
in the analysis. When Direction of Output for RAOs is set to Program Controlled, the output
is given in the direction of the spectrum that has the largest significant wave height.

Spectrum Sub-Direction of Output for RAOs

Only editable if Direction of Output for RAOs has a Cross Swell defined, or is configured with
a Number of Sub-Spectra greater than 1 (Wave Spreading is not None (Long Crested Waves)).

Axis System for Significant Motions and Nodal Response

Sets the (global or local) axis system in which significant motions and nodal response spectra
are reported.

Starting Position

If a Frequency Statistical Analysis is preceded by a Stability Analysis (p. 134), the equilibrium
position from the Stability Analysis (p. 134) is used and the (read-only) Starting Position is set
to Determined by Upstream System.

If a Frequency Statistical Analysis is linked directly to a Hydrodynamic Diffraction/Radiation (p. 130)
Analysis and Starting Position is set to Program Controlled, the equilibrium position is auto-
matically determined before the Frequency Statistical Analysis starts and is used as the starting
position. If Starting Position is set to Based on Geometry, the current geometry determines
the starting position. Note that when the model contains one or more Joints, the Based on
Geometry option is replaced by Based on Articulated Positions.

Caution:

The Based on Geometry option should be used with care, as a Frequency Statistical
Analysis of any system containing connections or articulations is unlikely to be correct
if the tensions and reactions at those connections or articulations are not calculated
first. Linking a Frequency Statistical Analysis to a Stability Analysis, or setting Starting
Position to Program Controlled, ensures that the forces acting on connections and
articulations are determined before the Frequency Statistical Analysis is performed.
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5.10.3.3.1. Common Analysis Options

These analysis settings control how the Frequency Statistical analysis is performed. In normal
circumstances they will not need adjusting. For more information, see the Aqwa Reference
Manual.

Calculate RAOs with Mooring Lines

If Yes, allows access to the CRAO option in the input file.

Apply Drift Force with Multi-Directional Wave Interaction

If Yes, utilize the drift coefficients which include interactions between different wave directions
that have been calculated in the preceding Hydrodynamic Diffraction analysis. This option is
invalid if the Include Multi-Directional Wave Interaction option in the preceding Hydro-
dynamic Diffraction analysis is set to No.

Linearized Morison Drag

If Yes, computes linearized Morison drag for tube, disc, and slender tube elements, and for
wind and current drag forces.

5.10.3.3.2. QTF Options

The analysis settings control the use of the QTF matrix for Frequency Statistical analyses. For
more information, see the Aqwa Reference Manual.

Use Full QTF Matrix

If Yes, specifies that the full matrix of difference frequency QTFs is to be used when calculating
slowly varying drift forces.

5.10.3.3.3. Output File Options

These analysis settings control what is written to the Aqwa output text file. For more information,
see the Aqwa Reference Manual.

Axes System for Joint Reactions

Defines the axis system for the output of joint reaction forces.

• Fixed Reference Axes - Joint reactions are output using axes parallel to the global axes.

• Local Structure Axes - Joint reactions are output using axes parallel to the local structure
axes.

• Local Articulation Axes - Joint reactions are output using the individual joint axes.

Data List

If Yes, output all extended data output in the *.LIS file.
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Output Element Properties

If Yes, writes complete details of each element used in the body modeling to the *.LIS file.
All important details of the body elements are output together with the resultant properties
of the bodies.

5.11. Applying Ocean Environment and Forces

The following ocean environment and forces objects can be added to your analysis (or may be included
with your analysis by default). Some are restricted to the Hydrodynamic Diffraction analysis and some
are restricted to the Hydrodynamic Response analysis.

5.11.1. Structure Selection

5.11.2.Wave Directions

5.11.3.Wave Frequencies

5.11.4. Starting Conditions

5.11.5. Structure Force

5.11.6. Regular Wave

5.11.7. Irregular Wave

5.11.8. Irregular Wave Group

5.11.9. Current

5.11.10.Wind

5.11.11. Cable Winch

5.11.12. Connection Failure

5.11.13. Point Force

5.11.14. Deactivated Freedoms

5.11.1. Structure Selection

The Structure Selection tree object enables the definition of interacting structures, in addition to any
structures that you want to exclude for this particular analysis. It also enables the structure order to
be changed.

Structures can be selected graphically (use the Ctrl key to select more than one) for inclusion in a
group or to be excluded from the analysis. To include structures in a group, click an Interacting
Structure Groups field. To exclude structures from the analysis, click the Structures to Exclude field.
Select the structures in the model, then click the Apply button. The selected structures will be listed
in the field. If a structure is excluded, then it will automatically be removed from any groups and the
structure order. A structure may only be included in one interacting structure group.

By default, when Aqwa is first started all parts are considered to be hydrodynamically interacting and
are included in the analysis. Note, however, that if a part is made up entirely of non-diffracting elements
(for example, completely above the water surface or consisting of Morison elements only), then the
part is not considered as interacting and is excluded from the list of Interacting Structure Groups. If
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a part is subsequently suppressed, it cannot be used in the analysis, and is automatically excluded
in the Structure Selection.

Note:

Unsuppressing a structure from the right-click menu on the tree or the Details panel of
the structure doesn't affect the structure's status in the Structure Selection. If you suppress
a structure and then unsuppress it, you must go to the Structure Selection object and re-
move it from the Structures to Exclude set in order for it to be included in the analysis. If
hydrodynamic interaction is required then this must also be established manually in the
Structure Selection.

Once you have defined your groups of interacting structures, you can optionally lock the motions of
the structures by applying a Motion Lock to the relevant group. The RAOs calculated for the structures
in the locked interacting group are then consistent with the RAOs of an equivalent single structure.
This is particularly useful for the estimation of splitting forces and moments on a structure in a time
domain Hydrodynamic Response calculation. This is achieved in the time domain analysis by including
a joint between each of the bodies in the interacting group to output such forces/moments.

If a structure has been removed from the analysis and you want to add it back in, you must reselect
the set of Structures to Exclude. If you want all structures to be included in the analysis, you may
click the field next to Structures to Exclude then click Apply with no structures selected.

The Aqwa solver requires that a group of interacting structures be consecutively ordered for the
analysis. Modifying the interacting groups will automatically update the order of structures in the
Aqwa analysis, and this will be reflected in the Structure Ordering section of the Details panel.

The Structure Ordering will include any Dynamic Points that have been defined in the hydrodynamic
model, reflecting the fact that these are considered structures by the Aqwa solver.

Note:

The total number of structures, including Dynamic Points, must be less than or equal to
99. It is possible for all of these structures to interact hydrodynamically (excluding any
dynamic points, which are always non-diffracting).

5.11.2. Wave Directions

The Wave Directions tree object enables the definition of a range or single wave direction to use in
the Hydrodynamic Diffraction (p. 130) analysis and, optionally, a forward speed at which the structures
move in the positive X-direction.

If Type is set to Single Direction, Forward Speed, you can enter a structure Forward Speed and a
Wave Direction. In this case, only a single wave direction can be analyzed.

If Type is set to Range of Directions, No Forward Speed, waves are automatically created in -180 and
+180 directions, and either the Interval or the number of intermediate directions (No of Intermediate
Directions) can be specified. If a direction range is of particular interest, additional ranges or specific
directions can be added.
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If Type is set to Range of Directions, Forward Speed, you can enter a structure Forward Speed and
perform the analysis over a range of wave directions. Waves are automatically created in -180 and
+180 directions, and either the Interval or the number of intermediate directions (No of Intermediate
Directions) can be specified. If a direction range is of particular interest, additional ranges or specific
directions can be added.

To add Optional Wave Directions to analyses performed over a range of wave directions, select Single
or Range from the Additional Range dropdown. For the Single direction, specify the Start Angle.
For a Range of directions specify the Start Angle, End Angle, and either the Interval or No of Inter-
mediate Directions.

Duplicated directions will automatically be removed; although the number of directions does not
contribute greatly to the analysis time, there is a limit imposed of a total of 41 directions for any one
structure.

Note:

It is not possible to employ symmetry in Aqwa.

5.11.3. Wave Frequencies

The Wave Frequencies tree object enables the definition of a range or single wave frequency to use
in the analysis.

By default the frequency Range is Program Controlled; this equally spaces the specified Total Number
of Frequencies between a minimum value based on the water depth (p. 42) (or the default minimum
of 0.1 rad/s, whichever is larger) and a maximum based on the mesh size (p. 46). The spacing interval
can either be based on constant frequency or constant period increments (Intervals Based Upon,
which also applies to any additional frequency range definitions).

You can manually define a single frequency or a range of frequencies by selecting Manual Definition
for the Range. For a single frequency, set Definition Type to Single. Then set Lowest Frequency
Definition to Manual Definition if you wish to edit the Lowest Frequency or Longest Period.

To specify a range of frequencies, set Definition Type to Range. Change Lowest Frequency Definition
and/or Highest Frequency Definition to Manual Definition to edit the Lowest Frequency and
Highest Frequency, or the Longest Period and Shortest Period, as required.

The Lowest Frequency will default to 0.1 rad/s and the Highest Frequency will default to that de-

termined by the mesh. The lowest wave frequency permitted is calculated by 

rad/s, where d is the water depth and g is the acceleration due to gravity.

The intermediate positions in a range are defined by entering a Number of Intermediate Values.
The Interval Frequency or Interval Period will be updated automatically (according to whether In-
tervals Based Upon is set to Frequency or Period).

To specify additional frequencies, set Additional Range to Single or Range and enter the Period/Fre-
quency and Number of Intermediate Values information. Any duplicate frequencies are automatically
removed. The number of frequencies chosen extends the solution time linearly.
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The Wave Frequencies table displays the frequencies and associated wavelengths of the waves that
are included in the Hydrodynamic Diffraction analysis.

Note:

To perform a subsequent Hydrodynamic Response analysis using Convolution (p. 137), a
Hydrodynamic Diffraction/Radiation analysis must be performed with at least 5 wave fre-
quencies.

The frequency range must be wide enough to ensure an accurate calculation of the radiation
force in the Hydrodynamic Response. For more information, see The FREQ/PERD/HRTZ
Data Record - Frequencies/Periods at which the Hydrodynamic Parameters are Computed
in the Aqwa Reference Manual.

5.11.3.1. Encounter Frequencies for a Single Wave Direction

If the Hydrodynamic Diffraction (p. 130) analysis is to be performed over a single Wave Direction
with a Forward Speed defined, a table of the encounter frequencies in the analysis will be displayed
in the Table tab of the Encounter Frequencies panel. The number of encounter frequencies will always
be equal to the number of defined incident wave frequencies.

Clicking on the Graph tab of the Encounter Frequencies panel presents a graphical display of en-
counter frequencies against the corresponding incident wave frequencies. Negative encounter fre-
quencies (which typically occur at higher incident wave frequencies/larger forward speeds) are
permissible.
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5.11.3.2. Encounter Frequencies for Multiple Wave Directions

If the Hydrodynamic Diffraction (p. 130) analysis is to be performed over multiple Wave Directions
with a Forward Speed defined, additional Encounter Frequencies Options are available. Set Encounter
Frequencies (Target) as a guide value for the number of encounter frequencies. Following the
rules described in The FWDS Data Record - Define Forward Speed, Aqwa will use this target to de-
termine the number of Encounter Frequencies (Actual) that will be included in the Hydrodynamic
Diffraction (p. 130) analysis. This will always be more than the number of defined incident wave
frequencies.

The Display Encounter Frequencies option allows you to switch the information that is shown in
the Encounter Frequencies panel. When Display Encounter Frequencies is set to For All Wave
Frequencies and Directions, the Table tab will show the encounter frequencies corresponding to
all combinations of incident wave frequencies and directions.

The Graph tab will show the same information as a 3-D surface plot:
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When Display Encounter Frequencies is set to In Hydrodynamic Analysis Only, the Table tab will
show the subset of encounter frequencies that Aqwa will choose to include in the hydrodynamic
database. The Graph tab will show these encounter frequencies in ascending sequence order.

Note:

Where the number of Encounter Frequencies (Actual) is less than the product of the
number of incident wave frequencies and the number of defined wave directions, dif-
fraction forces and potentials in the Hydrodynamic Diffraction (p. 130) analysis will be
interpolated between the available data in the hydrodynamic database.

Aqwa will try to calculate over the whole range of encounter frequencies (both positive
and negative) corresponding to the defined incident wave frequencies, wave directions,
and forward speed. However, the minimum absolute encounter frequency is limited to
0.001 rad/s.

5.11.4. Starting Conditions

Depending on the analysis, it is possible to set a starting position and/or a starting velocity for a
structure using the Details panel in a Starting Conditions object.

A Starting Conditions object can be included in the Outline of an analysis system when the Compu-
tation Type in the Analysis Settings is set to either Stability Analysis or Time Response Analysis.
In each instance, varying restrictions apply, resulting in hidden fields in the Details panel. These re-
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strictions are described in Setting the Position Starting Conditions (p. 150) and Setting the Velocity
Starting Condition (p. 152).

Note:

A Starting Conditions object can not be included in the Outline if the Computation
Type is set to Frequency Statistical Analysis

Starting conditions are attached to a particular structure, so you must select the Structure to which
the starting conditions should be associated to.

Position and Velocity can be set to either Program Controlled or Manual Definition. When Program
Controlled is selected, the conditions will be based on the conditions associated with the geometry
at the time the analysis is being solved using the RDEP option in the solver file. When Manual Defin-
ition is selected (as shown in the image below), you can define the appropriate values for the analysis'
starting positions and/or starting velocity. For more information, refer to: Administration and Calculation
Options for the Aqwa Suite in the Aqwa Reference Manual
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5.11.4.1. Setting the Position Starting Conditions

For a given set of environmental conditions in a Stability Analysis, it is sometimes possible for there
to be more than one solution in which the forces acting on the system are equilibrated.

Consider a symmetric vessel, anchored at the bow, in a beam sea: the wave forces on the vessel
become more balanced whether the vessel swings towards the direction of the wave, or away from
the direction of the wave, as shown in Figure 5.11: Possible Equilibrium Positions (p. 150).

Figure 5.11: Possible Equilibrium Positions

There is usually a preferred state that should be used as the starting condition for a subsequent
Frequency Statistical Analysis or Time Response Analysis. In the case above, it is expected that the
bow of the vessel points toward the incoming waves. Due to the iterative method used by Aqwa
to determine equilibrium position, it is not always possible to predict which equilibrium position
the solution will converge towards.

To encourage convergence towards the expected equilibrium position, you can add a Starting
Conditions object to define the starting position of a structure (or group of articulated structures)
for the first iterative step of a Stability Analysis.

In the Details panel of the Starting Conditions object, there are position conditions which allow
you to set translational or rotational offsets about a selected reference point on a structure. The
offsets may be relative to the initial geometric position of the structure (as defined in the original
CAD geometry), or relative to an existing Fixed Point; alternatively, the absolute position of the
reference point may be set directly.

It is only possible to set a starting position when the Computation Type is set to Stability Analysis,
or when the Computation Type is set to Time Response Analysis and the Starting Position option
is set to Based on Geometry or Based on Articulated Positions

Once a Structure has been selected, to which the starting position refers to, the Reference Point
must be set as a Connection Point attached to the selected structure.

Selecting a Reference Point automatically populates the Position X, Position Y, and Position Z
fields with the absolute position of the selected Connection Point.

Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.150

Aqwa Approach



The Definition field of Translational Position can be set to Absolute Position, Relative to Geo-
metric Position, or Relative to Fixed Point.

Modifying the absolute Position X, Y, and Z applies a translation to the position of the selected
Reference Point in the Fixed Reference Axes (FRA).

Changing the Definition field to Relative to Geometric Position displays the Relative Position
X, Relative Position Y, and Relative Position Z fields. Varying the Relative Position X, Y, and Z
in this mode applies a translation to the position of the selected reference point in an axis system
whose origin lies at the original position of the reference point, and whose axes lie parallel to the
Fixed Reference Axes (FRA).

Changing the Definition field to Relative to Fixed Point displays the Fixed Point field, which allows
you to select an existing Fixed Point from the Geometry. In this mode, the Relative Position X,
Y, and Z are defined in an axis system whose origin lies at the position of the selected Fixed Point,
and whose axes lie parallel to the Fixed Reference Axes (FRA).

The Absolute Position or Relative Position X, Y, and Z are initialized with values described in the
following table:

Initial ValuesDefinition

Current position of Reference Point in FRAAbsolute Position

Difference between current position of Reference Point in FRA and
original geometric position of Reference Point in FRA

Relative to Geometric
Position

Difference between current position of Reference Point in FRA and
position of Fixed Point in FRA

Relative to Fixed Point
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The Rotation About Reference Point fields Rotation RX, Rotation RY, and Rotation RZ allow you
to rotate the selected structure about an axis system centered on the selected reference point, and
whose axes lie parallel to the Fixed Reference Axes (FRA).

The positions of structures within an articulated group, relative to one another, are not changed
by the application of a Starting Position. Translations and rotations due to a Starting Position
are applied as if the articulations within that group are rigid.

A Starting Position may only be applied to a structure whose position is not already defined in
some way. The Structure field is invalid if the structure is:

• Already selected in another Starting Position object.

• Connected by a Joint, or sequence of Joints, to a Fixed Point.

• Connected by a Joint, or sequence of Joints, to a structure which is already selected in another
Starting Position object.

In the latter two cases, if the initial position of the structure needs to be modified, you should instead
re-define the Alignment Method of the Joint Axes (see Joints (p. 121)).

5.11.4.2. Setting the Velocity Starting Condition

The velocity field is defined for a selected Structure at its COG location. Therefore, there is no need
to specify a reference point.
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The 6 degrees of freedom for the starting velocity can be set only when a Structure has been se-
lected, and the Computation Type in the Analysis Settings is set to Time Response Analysis and
the upstream analysis is not of the same type.

Note:

It is not possible to set the starting velocity when Computation Type is set to
Stability Analysis.

These starting conditions correspond to the velocity field at the Centre of Gravity.

5.11.5. Structure Force

A time history of structure forces and moments applied at the center of gravity can be defined directly
in a table or by importing the data from an existing .XFT file.

To add a time history of structure forces:

1. Select the Hydrodynamic Response object in the tree view.

2. Right-click the Hydrodynamic Response object and select Insert > Structure Force > Manual
Input if data is to be defined directly in a table; select Insert > Structure Force > Import XFT
File if data is to be read from a file, and browse to the file location.

Alternatively, click the Structure Force icon in the Analysis toolbar and from the drop-down
menu select Manual Input if the data is to be defined directly in a table; select Import XFT File
if the data is to be read from a file, and browse to the file location.

Note:

After the data is imported, no record of the file used to import the data is retained.
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In the Details panel, the column definition can be associated to the appropriate structures in the
model. A row has to be filled in for all structures; additional rows can be added to the end of the
table and they will be automatically re-sorted in ascending time order once entry is complete. Position
data can also be copied and pasted from an appropriate external source.

Defining the .XFT file

The time defined in the data does not need to match the time step defined in the analysis; the program
will interpolate the forces when necessary, using a cubic spline interpolation technique. For this
purpose there must be at least 4 entries in the Structure Force Definition Data table, and when
modeling periods of constant force, adequate data points must be provided to satisfy the interpolation
method. The times included in the Structure Force Definition Data must entirely cover the simulation
duration: the first time must not be greater than the Analysis Settings Start Time, and the last time
must be greater than or equal to the Finish Time. There is no upper limit on the length of the .XFT
file.

The unit system of the data in the .XFT file is assumed to match the display unit system of the project.
However, the imported data unit system can be modified by setting Force Unit for Imported Data
and Length Unit for Imported Data to the required unit system.

It is important to note that the forces defined in the .XFT file are in six degrees of freedom for each
structure and are in the global axis system.

Comment lines are permitted at any point in the file and must begin with *.

The first line (comments excepted) in the file ought to contain the structures information; this indicates
the structure numbers that the columns correspond to. For example, when there are 3 structures,
this line could be structures=1 3 9. The structure numbers can be determined from the Aqwa
Editor by reviewing the Structure Selection in the upstream Hydrodynamic Diffraction analysis.

Before the data defining the time and forces, there must be a line containing only the text,
data_start.

After the data start, the first column contains time, and subsequent columns (in sets of 6) indicate
the forces for specified structures. The forces are ordered as follows, using global directions: X, Y, Z,
RX, RY, RZ. The numbers in the .XFT file are in a free format and can be separated by spaces.

An example of the data in a file would be:

structures=1 
data_start
0.0000 4.4800E+05 5.0400E+06 3.1360E+06 5.0400E+07 8.9600E+06 1.5120E+08
0.5000 4.3978E+05 4.9689E+06 3.0784E+06 4.9689E+07 8.7956E+06 1.4907E+08
1.0000 4.1592E+05 4.8207E+06 2.9114E+06 4.8207E+07 8.3183E+06 1.4462E+08
...

Structure Force Definition Data can otherwise be entered manually, can be copied and pasted from
an external source (for example, an Excel spreadsheet), or can be imported from a comma-separated
value (.CSV) file using the Import CSV File option. For the Import CSV File option, the file must
meet the following requirements:

• Has the .CSV extension

• Contains value separated by commas, tabs, or single spaces (not multiple spaces)
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• Contains exactly (1 + 6* number of Force Sets) columns (you must define the Structure for Force
Set fields before importing)

The unit system of the data in the .CSV file is assumed to match the display unit system of the project.
However, the imported data can be modified by setting the Length Unit for Imported Data and
Force Unit for Imported Data to the required unit system.

5.11.6. Regular Wave

The Regular Wave object is used for Time Response analyses. Regular Waves can only be applied
when the Analysis Type under the Time Response Analysis Setting object is set to Regular Wave
Response (rather than the default value of Irregular Wave Response).

To add a Regular Wave:

1. Select the Hydrodynamic Response object in the tree view.

2. Right-click the Hydrodynamic Response object and select Insert > Regular Wave, or click the
Regular Wave icon in the Analysis toolbar.

Set Wave Type to Airy Wave Theory, Stokes 2nd Order Wave Theory, or Stokes 5th Order Wave Theory
for the calculation of the Froude-Krylov forces. Airy Wave Theory is not recommended for modeling
big waves; Stokes 5th Order Wave Theory is typically suited to shallow water situations. Enter the
Direction and Amplitude of the wave. The direction is shown in the graphics with an arrow (light
blue).

The other parameters to define the Regular Wave depend on the Wave Type. For Airy or Stokes 2nd
Order waves, enter a Period or Frequency for the wave. The period/frequency in general should be
within the range of that in the Hydrodynamic Diffraction analysis.

Note:

Both Frequency and Period are enabled as parameters, but it is only possible to paramet-
erize one of these at a time. For example, if you set Period as a parameter, the Frequency
field will not longer be visible; to set Frequency as a parameter, Period must be removed
as a parameter first.

For Stokes 5th Order waves, the wave definition is controlled by 6 parameters: Period, Wavelength,
Still Water Depth, Mean Water Depth, Uniform Current, and Volume Flux. These are interdependent,
meaning that you can define any 3 parameters at once; the Define By option allows you to choose
which parameters to set. For example, when Define By is selected as Wavelength, Still Depth,
Current, you must enter values for Wavelength, Still Water Depth and Uniform Current. The
Period, Mean Water Depth and Volume Flux values are calculated from your entered data, and
displayed (read-only) for your reference. For more information, see Fifth Order Stokes Wave.

The wave ramp is introduced to reduce the transient motion of the structure at the beginning of a
time domain analysis. The wave ramp will take effect from t=0.0 to t = tw, during which time a wave

ramp factor f (0.0 < f < 1.0) will be calculated and then used to multiply the incident wave amplitude.
The wave ramp factor f is
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It can be seen that at t=0, the factor is 0.0 and at t=tw, the factor is 1.0. If Ramping Method is set to

Program Controlled, tw will default to the wave period. Alternatively, change Ramping Method to

Manual Definition to allow the Ramping Time to be set to the desired time tw, or set Ramping

Method to No Ramping to turn the wave ramp off.

5.11.7. Irregular Wave

An Irregular Wave can be added to the Hydrodynamic Response system, either individually or as part
of an Irregular Wave Group (p. 171). In addition, it can be added to the Hydrodynamic Diffraction
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system when Linearized Morison Drag (p. 132) is specified for the analysis (however, only a single Ir-
regular Wave can be used in the Hydrodynamic Diffraction system, and no Cross Swell can be specified).

Note:

Although you can add multiple Irregular Wave Groups and individual Irregular Waves to
your analysis, you may have only one active wave or wave group; the others must be
suppressed.

To add an Irregular Wave:

1. Select the Hydrodynamic Response object in the tree view.

2. Right-click the Hydrodynamic Response object and select Insert > Irregular Wave > Wave
Type , or click the Irregular Wave icon in the Analysis toolbar and select the wave type from
the drop-down menu.

For each type of Irregular Wave the Wave Spectrum Definition Data table displays the Directions,
Sub-Weights, Frequencies, and Spectral Ordinates that fully define the wave spectrum/sub-spectra.
The wave definition in the Wave Spectrum Details section of the Details panel is displayed on the
Main Spectrum tab. If you have also defined a secondary spectrum using the Cross Swell Details, the
Frequencies and Spectral Ordinates for this are shown separately on the Cross Swell Spectrum tab.
Clicking on the Graph tab of the Wave Spectrum Definition Data panel presents a graphical display
of the Spectral Ordinates against their corresponding Frequencies (and, for multi-directional wave
spectra, Directions). The Main Spectrum and Graph tabs are empty until the Irregular Wave has been
fully defined. The Cross Swell Spectrum tab is disabled if no cross swell is defined. Control of the
Spectrum and Graph displays is described in greater detail below.

The following parameters are available in the Details panel for all Irregular Wave types.

If the Analysis Type in the associated Analysis Settings is set to Irregular Wave Response, a Ramping
Time may be specified. The wave ramp is described in Regular Wave (p. 155) and introduces the same
behavior for Irregular Waves. If Ramping Method is set to Program Controlled, tw defaults to the

longest period of any wave component in the defined spectrum. Alternatively, change Ramping
Method to Manual Definition to allow the Ramping Time to be set to the desired time tw, or set

Ramping Method to No Ramping to turn the wave ramp off.

Direction of Spectrum sets the direction of waves within a wave spectrum. This option is not available
for an Irregular Wave in a Hydrodynamic Diffraction system, or for a User Defined Spectrum (p. 164)
where the Wave Spreading option is set to Manual Definition (Carpet Spectrum).

Wave Spreading allows you to set a multi-directional wave spectrum. The default setting of None
(Long-Crested Waves) produces a unidirectional wave spectrum (all the wave energy acts in a single
direction). Setting Wave Spreading to Nth-Powered Cosine (Short-Crested Waves) produces a sym-
metric spread of wave energy over a number of directions. Selecting this option displays the additional
parameters Power of Spreading Function, Total Spreading Angle, and Number of Sub-Spectra:

• Power of Spreading Function sets the power N to which the cosine of  is raised, where  is the
angle between the main Direction of Spectrum and a sub-spectrum direction. To find the spectral
ordinates in a sub-spectrum direction, the spectral ordinates in the main spectrum direction are
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multiplied by a factor . Acceptable values for the Power of Spreading Function
are integer numbers between 2 and 250.

• Total Spreading Angle defines the spread range of wave energy in the short-crested waves. This
angle may take any value in the range 1° to 180° when the Power of Spreading Function is set
to 2, but will default to (and cannot be changed from) 180° for any other Power of Spreading
Function value.

• Number of Sub-Spectra sets the number of directions over which the wave energy is spread. For
Nth-Powered Cosine wave spreading this value must be an odd number in the range of 7 to 27.

Note:

The Directions and Sub-Weights for an Nth-Powered Cosine wave spread are always de-
termined by the program, and correspond to directions and weighting factors that have

been pre-calculated for a Gaussian integration of the  function over the given
Total Spreading Angle and Number of Sub-Spectra. Note also that the factor  from
Equation 2.55 in the Aqwa Theory Manual is included in the Sub-Weight values.

A third option for Wave Spreading is Manual Definition (Carpet Spectrum). This option is only available
when the Wave Type is set to User Defined Spectrum. The definition of, and additional options related
to, a Carpet Spectrum are described in User Defined Spectrum (p. 164).

Note:

The Wave Spreading parameter is not available when a User Time History spectrum is
generated from a Wave Height Time History (.WHT) file, as there is no accurate way to
combine the Low Frequency Perturbation (LFP) Function (described in User Time His-
tory (p. 169)) with an Nth-Powered Cosine spreading function.

Spectrum Presentation Method allows you to change the display mode for the Graph tab of the
Wave Spectrum Definition Data panel. For an Irregular Wave with Wave Spreading set to Long-
Crested Waves, the graph plots the Spectral Ordinates against the Frequencies calculated or defined
for that Irregular Wave (1D Graph option). If you also define a Cross Swell Spectrum in a unidirec-
tional wave, the two spectra are plotted on the same axes.
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When Wave Spreading is set to Nth-Power Cosine (Short-Crested Waves) or Manual Definition (Carpet
Spectrum), the default Spectrum Presentation Method changes to 2D Spectrogram (Linear) and the
Graph tab displays a colored contour plot of Spectral Ordinates against Directions (x-axis) and
Frequencies (y-axis). Because a Cross Swell Spectrum is unidirectional (no spreading is applied to
the wave energy), it will not be included in a 2D Spectrogram plot.

Alternatively you may display this contour plot on polar axes by selecting 2D Spectrogram (Polar),
where Spectral Ordinates are plotted against Frequencies (radius).
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While Wave Spreading is set to Nth-Power Cosine (Short-Crested Waves) or Manual Definition (Carpet
Spectrum), changing Spectrum Presentation Method to 1D Graph displays all of the sub-spectra
(and the Cross Swell Spectrum, if one is included).

For an Imported Time History wave the Spectrum Presentation Method has the additional option
Wave Height Time History, which plots the wave elevations against the times from the imported
.WHT file. The zoom box in the lower right corner may be used to view a more limited range of the
wave elevation trace.

Seed Definition defines the random seed for a wave spectrum. The options available are Program
Controlled or Manual Definition. If you select Manual Definition, you can set the seed value.

Number of Spectral Lines Definition defines the number of individual components used to simulate
an Irregular Wave. The options available are Program Controlled or Manual Definition. If you select
Manual Definition, you can set the Minimum Number of Spectral Lines, up to the maximum of 200.
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The actual number of spectral lines used will typically be greater than the Minimum Number of
Spectral Lines where you have added a Cross Swell Spectrum to an Irregular Wave.

Note:

The new user is strongly advised to use the Program Controlled option for Number of
Spectral Lines Definition . The program will automatically generate the appropriate
number of spectral lines for the particular method of analysis, and it is only in unusual
circumstances that user input is required.

In the case of a spectrum imported from a Wave Height Time History (.WHT) file, the
analysis will always use 200 spectral lines and the user will not be allowed to modify this
value.

Omit Calculation of Drift Forces disables the second order drift force calculations for the current
spectrum. Select Yes to disable the calculations and No to have them applied. This option is only
available for Irregular Wave Response with Slow Drift calculations.

The user should, in general, specify a spectral sea state whose range of frequencies is less than the
range for which the hydrodynamic parameters for the structure are defined (those specified in the
Wave Frequencies  (p. 145) object). At spectrum frequencies which are outside the range at which
the hydrodynamic parameters are defined, the program will automatically extrapolate the values re-
quired.

The effects of cross swell are implemented in most of Aqwa. Select the Cross Swell Spectrum type
in the Cross Swell Details section of the Details panel. The Cross Swell Spectrum can be different
from the current Wave Type. However the parameters used to define the Cross Swell Spectrum are
the same as those for the corresponding spectrum Wave Type, except that the start and finish fre-
quencies are calculated by the program.

For all wave types except User Time History and User Defined Spectrum, set Wave Range Defined
by to either Period or Frequency. Next, set Start and Finish Frequency/Period Definition. The
available options are:

• Program Controlled (default)

• Manual Start Frequency/Period Auto Finish Frequency/Period

• Manual Finish Frequency/Period Auto Start Frequency/Period

• Manual Definition

Start Frequency/Period is the lowest frequency or longest period at which the spectrum is defined
and Finish Frequency/Period is the highest frequency or shortest period at which the spectrum is
defined. Enter values in the fields that are user defined, based on the Start and Finish Frequency/Peri-
od Definition setting.

For formulated and User Time History spectra, the Export CSV File option allows you to output (in
a comma-separated value (.CSV) file format) the directions, sub-weights, frequencies, and spectral
ordinates that define the Irregular Wave.

Other parameters are available in the Details panel based on the wave type defined. The following
wave types are available:
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5.11.7.1. JONSWAP (Hs or Alpha)

5.11.7.2. Pierson-Moskowitz

5.11.7.3. Ochi-Hubble

5.11.7.4. Bretschneider

5.11.7.5.TMA Spectrum

5.11.7.6. Gaussian

5.11.7.7. User Defined Spectrum

5.11.7.8. User Time History

5.11.7.1. JONSWAP (Hs or Alpha)

The JONSWAP wave spectrum can be used to describe a wave system where there is an imbalance
of energy flow (that is, sea not fully developed). This is nearly always the case when there is a high
wind speed. It may be considered as having a higher peak spectral value than the Pierson-
Moskowitz spectrum but is narrower away from the peak in order to maintain the energy balance.

If you choose JONSWAP (Hs) as the Wave Type, Significant Wave Height will be used in the cal-
culations rather than the parameter Alpha, (which is used when the Wave Type is set to JONSWAP
(Alpha)).

Parameterization of the classic form of the JONSWAP spectrum (with parameters of fetch and wind
speed) was undertaken by Houmb and Overvik (BOSS Trondheim 1976, Vol 1). These empirical
parameters (which you must enter) are termed Gamma ( ), Alpha ( ) and Peak Frequency ( )
(the frequency at which the spectral energy is a maximum). The peak frequency together with
empirical parameters termed Gamma and Alpha are used in this formulation. The spectral ordinate
( ) at a frequency ( ) is given by

where:

 = the peak frequency in rad/s

 = the peak enhancement factor

 = a constant that relates to the wind speed and peak frequency of the wave spectrum,
which has the following relationship to the significant wave height :
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5.11.7.2. Pierson-Moskowitz

The Pierson-Moskowitz spectrum is formulated in terms of the two parameters of Significant Wave
Height ( ) and average (Zero Crossing Period) wave period ( ). This is considered of more direct
use than the classic form, in terms of the single parameter wind speed, or the form involving the
peak frequency, where the spectral energy is a maximum. The spectral ordinate ( ), at a frequency
( , in rad/sec), is given by

The average (that is, mean zero-crossing) wave period (Zero Crossing Period) and Significant
Wave Height are the parameters used to describe the Pierson-Moskowitz wave spectrum, the
special case for a fully developed sea.

5.11.7.3. Ochi-Hubble

The Ochi-Hubble spectrum is a bimodal spectrum designed to represent both the low- and high-
frequency components associated with storm conditions. Each mode is defined by a Significant
Wave Height, a Shape Parameter, and a Modal Frequency or Modal Period. More information
on the formulation may be found here.

5.11.7.4. Bretschneider

The Bretschneider spectrum is a special form of the Ochi-Hubble spectrum, with only a single
spectral mode and unit shape parameter. The spectrum is therefore defined only by a Significant
Wave Height and a Modal Frequency or Modal Period. More information on the formulation may
be found here.

5.11.7.5. TMA Spectrum

The TMA (Texel-MARSEN-ARSLOE) spectrum is a form of the JONSWAP (Alpha) spectrum, modified
to account for finite water depth. The spectrum is defined by the parameters Gamma, Alpha, and
Peak Frequency or Peak Period, and uses the Water Depth defined in the Geometry details. More
information on the formulation may be found here.

5.11.7.6. Gaussian

The standard Gaussian spectrum is given by

where:

 = significant wave height

 = peak frequency in rad/s

 = standard deviation
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The Peak Frequency, Significant Wave Height, and Sigma ( ) are the parameters used to describe
the Gaussian wave spectrum. The value of σ must be at least .

5.11.7.7. User Defined Spectrum

This option may be used to input any user-defined one- or two-dimensional spectrum. It is normally
employed for the input of non-deterministic spectra such as tank spectra, recorded full-scale spectra,
or simply where the formulated spectrum is not yet available.

5.11.7.7.1. With Wave Spreading: None (Long-Crested Waves)

In the Wave Spectrum Definition Data table, enter the frequency (or period, depending on the
Wave Range Defined by setting) and its corresponding spectral ordinate. The maximum number
of frequencies/periods is 200.

The rows of the Wave Spectrum Definition Data table are automatically sorted in ascending order
of Frequency. Zero or duplicate Frequency entries are not valid.
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If you create an Irregular Wave using one of the formulated spectra available in Aqwa (JONSWAP,
Pierson-Moskowitz, or Gaussian) or generate a formulated spectrum from a User Time History,
and then change the Wave Type to User Defined Spectrum, the spectral ordinates of the formu-
lated spectrum become editable for you to modify as necessary.

Note:

Using a User Time History spectrum as the template for a User Defined Spectrum wave
does not retain the Low Frequency Perturbation (LFP) Function of the User Time History
wave (described in User Time History (p. 169)). Only the JONSWAP fit of the imported
wave elevation spectral density is included.

Wave Spectrum Definition Data can otherwise be entered manually, can be copied and pasted
from an external source (for example, an Excel spreadsheet), or can be imported from a comma-
separated values (.CSV) file using the Import CSV File option. For the Import CSV File option,
the file must meet the following requirements:

• Has the .CSV extension.

• Contains values separated by commas, tabs, or single spaces (not multiple spaces).
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• Contains exactly 2 columns, and no more than 200 rows.

• The Direction and Sub-Weight rows are not included.

The unit system of the data in the .CSV file is assumed to match the display unit system of the
project. However, the imported data can be modified by setting the Length Unit for Imported
Data, Rotation Unit for Imported Data, and Frequency Unit for Imported Data to the required
unit system.

5.11.7.7.2. With Wave Spreading: Nth-Powered Cosine (Short-Crested Waves)

When defining a User Defined Spectrum with Nth-Powered Cosine (Short-Crested Waves) wave
spreading, only the Frequency and main direction Spectral Ordinate columns are editable.
Modifying one of the main direction spectral ordinates causes the other spectral ordinates at that
frequency to be updated automatically.

The same rules for importing a .CSV file apply: the first column of the imported file is inserted
into the Frequency column, and the second is used for the main direction Spectral Ordinates.
The spectral ordinates for all other directions are calculated automatically. The Direction and
Sub-Weight should not be included in the .CSV file.
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5.11.7.7.3. With Wave Spreading: Manual Definition (Carpet Spectrum)

With Wave Type set to User Defined Spectrum and Wave Spreading set to Manual Definition
(Carpet Spectrum), any combination of Directions, Sub-Weights, and User-Defined Wave Spectra
may be specified.

With Manual Definition (Carpet Spectrum) wave spreading, the Number of Sub-Spectra parameter
permits any value in the range of 2 to 41.

Sub-Spectrum Weighting determines the weighting factors for each carpet direction. The
available options are:

• Manual Definition, which allows the Sub-Weights to be entered manually (default).

• Program Controlled (Unit Weighting), which assigns a unit weighting factor to each direction.

• Program Controlled (Trapezoidal Weighting), which determines weighting factors  for each
direction  based on a simple trapezoidal integral, where:

in which  is the Number of Sub-Spectra and .
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For a User Defined Spectrum with Manual Definition (Carpet Spectrum) wave spreading, the Wave
Spectrum Definition Data table maybe populated using the method described in With Wave
Spreading: None (Long-Crested Waves) (p. 164): create a User Defined Spectrum with Wave
Spreading set to None (Long Crested Waves), turn this into a multidirectional spectrum by
changing Wave Spreading to Nth-Powered Cosine (Short Crested Waves), and then make all
fields of the Wave Spectrum Definition Data table editable by changing Wave Spreading to
Manual Definition (Carpet Spectrum).

Wave Spectrum Definition Data can otherwise be entered manually, can be copied and pasted
from an external source (for example, an Excel spreadsheet), or can be imported from a comma-
separated value (.CSV) file using the Import CSV File option. For the Import CSV File option,
the file must meet the following requirements:

• Has the .CSV extension.

• Contains values separated by commas, tabs, or single spaces (not multiple spaces).

• Contains exactly N+1 columns, where N is the Number of Sub-Spectra, and no more than 200
rows.

• The Direction and Sub-Weight rows are included.

The unit system of the data in the .CSV file is assumed to match the display unit system of the
project. However, the imported data can be modified by setting the Length Unit for Imported
Data, Rotation Unit for Imported Data, and Frequency Unit for Imported Data to the required
unit system.

The Direction and Sub-Weight rows must be included in the .CSV file, even if the sub-weights
are Program Controlled (where any values in the Sub-Weight row of the .CSV file are ignored).
There must also be (arbitrary) entries for the 'Direction' and 'Sub-Weight' header cells.

An example of such a .CSV file, as used to create the table shown above, follows:

dir,-85.42,-66.738,-36.526,0,36.526,66.738,85.42
wt,0,0,0,0,0,0,0
0.050006,0,0,0,0,0,0,0
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0.060415,0.0006,0.0156,0.0647,0.1002,0.0647,0.0156,0.0006
ETC.

5.11.7.8. User Time History

A time history series of wave elevations may be imported into your Hydrodynamic Response ana-
lysis, in order to reproduce model test wave conditions as accurately as possible. Select Insert >
Irregular Wave > Import WHT File..., or select Irregular Wave > Import WHT File... from the
Analysis toolbar, and browse to the file location.

The Imported WHT File field shows the file location on the disk. If the imported file contains the
optional NAME field, the value is displayed in the Imported WHT Name field.

When a time domain analysis is carried out, the wave elevation time-history will be reproduced
exactly, within the frequency range of the fitted spectrum and subject to the limitations of roundoff
error. This is achieved by multiplying each of the spectral wave components by a different Low
Frequency Perturbation (LFP) Function; that is:

Wave elevation = 

where:

 = number of spectral lines (set to 200)

 = wave component number

 = time

 = frequency (as normally output by the Aqwa solver)

 = phase (as normally output by the Aqwa solver)

 = amplitude

 = wave number

 = LFP function

Note that no spurious low frequency waves are generated by the above method. For any wave
component, the minimum frequency present in the wave elevation is , where  is the

highest frequency present in the LFP function. Note also that there is no frequency overlap for each
wave component. Each LFP function can be considered as a frequency spreading function over a
limited set of contiguous frequency bands. In this case each wave component has a different energy
(as opposed to the standard Aqwa wave components which have equal energy).

Import of the time series will also generate a user-defined spectrum, using a Fast Fourier Transform,
whose frequency range is based on a JONSWAP fit of the wave elevation spectral density. If Com-
putation Type is Stability Analysis or Frequency Statistical Analysis in a Hydrodynamic Response
system, this spectrum will be used in the same way as a normal user-defined spectrum. As the
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phases of the spectral wave components are allocated randomly, the input wave elevation time
history will not be reproduced.

Note:

Current is ignored when calculating the phase wave forces on the structure and the
wave kinematics for Morison elements.

The *.WHT file is an ASCII file with the wave elevation data in free format with 2 values per line.
The first value is the time and the second value is the wave elevation.

The following 2 statements are required in the file:

DEPTH=value
G=value

The DEPTH value should match the Water Depth specified in the Geometry Details or else a warning
will be generated. The G value is compared to the Gravity specified in the Geometry Details (p. 42)
to determine the units used. If no G value is defined, you have the option to set the unit system
for the imported data manually, using the Length Unit for Imported Data and Angle Unit for
Imported Data controls under Wave Spectrum Details.

The following optional data can also be input. If any are omitted, the relevant value defaults to
zero.

DIRECTION=value(degrees)
X_REF=value
Y_REF=value
NAME=Spectrum Name 
CURRENT_SPEED=value
CURRENT_DIRECTION=value(degrees)

Note:

• The X_REF and Y_REF values are used in the calculation of the phase of the wave and
are the position where the wave elevation was measured. For example (in SI units), if
the DIRECTION of the wave is zero degrees (that is, along the positive X-axis in the
global coordinate system) then values of X_REF/Y_REF of 100.0/0.0 will indicate that
the wave elevation was measured 100 metres downstream of the 0,0 wave reference
point. Omission of these data will default the reference point to 0,0. Meaning, the
wave elevation will be calculated using the origin of the global coordinate system as
the point at which the wave elevation will be reproduced. X_REF, Y_REF and DIRECTION
values appear in the Details panel for the Wave object.

• The Spectrum Name will be used for graphs and tables where appropriate throughout
the program, and is appended to the Wave object name in the tree.

• CURRENT SPEED and CURRENT DIRECTION are needed for calculation of the wavelengths
of the wave components used to reproduce the wave elevation. If present they must
match the corresponding values in the unsuppressed Current object in the tree (if
there is no Current object, a warning will be generated.) If omitted, it is assumed that
there is no current and a warning will be issued.
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• The duration of the time history in the file should be at least 7200s. This duration is
necessary in order to give sufficient resolution of low frequency resonant responses.
If the file contains less data than this, the data will be extended automatically up to
7200s, using a process of mirroring and copying.

• The maximum number of timesteps in the .WHT file is 150000.

• Comments (starting with * in Column 1) may be added anywhere in the file.

An example of a *.WHT file is shown below.

 ------------------------------------    
* This is an example of a *.wht file
* 
DEPTH=30.0
G=9.81
DIRECTION=0.0
X_REF=100.0
Y_REF=0.0
NAME=EXAMPLE
CURRENT_SPEED=0.6
CURRENT_DIRECTION=90
* TIME WAVE HT 
*     s      m 
0.0000 -1.088 
0.2366 -1.188 
0.4732 -1.268 
0.7098 -1.351 
0.9464 -1.427 
1.1830 -1.471 
1.4196 -1.494 
1.6562 -1.476 
1.8928 -1.406 
2.1294 -1.293 
2.3660 -1.149 
2.6026 -0.966 
ETC. 
------------------------------------ 

5.11.8. Irregular Wave Group

The Irregular Wave Group allows you to include multiple Irregular Waves in your analysis.

To add an Irregular Wave Group:

1. Select the Hydrodynamic Response object in the tree view.

2. Right-click the Hydrodynamic Response object and select Insert > Irregular Wave Group, or
click the Irregular Wave Group icon in the Analysis toolbar.

3. Click the Irregular Wave Group object in the tree view.

4. Right-click the Irregular Wave Group object and select Insert > Irregular Wave > Wave Type
, or click the Irregular Wave icon in the Analysis toolbar, and select the wave type from the drop-
down menu.

5. Define the options of each individual wave spectra in the group.
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To view a summary of the waves under an Irregular Wave Group, select the wave group object in the
tree.

If the Analysis Type in the associated Analysis Settings is set to Irregular Wave Response, a Ramping
Time may be specified. The wave ramp is described in Regular Wave (p. 155) and introduces the same
behavior for Irregular Wave Groups. If Ramping Method is set to Program Controlled, tw defaults to

the longest period of any wave component in all the wave spectra defined in the Irregular Wave
Group. Alternatively, change Ramping Method to Manual Definition to allow the Ramping Time to
be set to the desired time tw, or set Ramping Method to No Ramping to turn the wave ramp off.

Note:

• Although you can add multiple Irregular Wave Groups and individual irregular waves,
you must have only one active in order for the analysis to solve; the others must be
suppressed.

• There are limits on the total number of Irregular Waves you can insert in a group. The
total number of spectra is 41; an irregular-wave of formulated type (Pierson-Moskowitz,
JONSWAP) counts for 1 (or 2 if you add Cross-Swell), imported wave time history counts
for 1 (but you can only have a maximum of 5 imported history), and user defined counts
for 1 as well.

5.11.9. Current

A Current can be added to the Hydrodynamic Response system to supplement the wave forces being
applied to the structure. Current loading will be applied to tubular beams and slender tube elements
using the velocities at the depth of the element. If cable dynamics is used for the definition of a
composite catenary cable, current loading will also be applied along the length of the cable using
the variable current velocity with depth.
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Current loading is also applied at the center of gravity of a vessel (as long as Current Force Coefficients
have been provided) and will utilize the current velocity at a specified Current Calculation Position,
as defined in the Part details. Alternatively, where Morison Hull Drag Coefficients have been defined,
current loads in a Hydrodynamic Response analysis are calculated using the current velocity at the
depth of the structure center of gravity.

Note:

Although you can add multiple Current objects to your analysis, you may only have one
active Current; the others must be suppressed.

To add a Current:

1. Select the Hydrodynamic Response object in the tree view.

2. Right-click the Hydrodynamic Response object and select Insert > Current > Current Type
, or click the Current icon in the Analysis toolbar and select the current type from the drop-down
menu.

3. Click the Current object in the tree and enter the current data.

Note:

If an Irregular Wave is defined by importing a User Time History of wave elevations from
a WHT file, it may be necessary to define the current profile with negative velocities: the
WHT file must contain a positive constant current in order for the waves to be calculated
correctly. The total current velocity will be the sum of the value in the WHT file and the
values defined here.

For all types of Current it is necessary to define a Water Depth to which the current profile extends.
By default, the Water Depth Definition is set to Use Water Depth in Environment Constants, and
the Water Depth field will reflect the value defined under Details of Geometry; or, where a Composite
Cable Seabed is defined, the Water Depth Definition may be set to Use Composite Cable Seabed
Water Depth at Reference Point. Alternatively, the Water Depth Definition can be set to Manual
Definition and the total Water Depth for the current profile can be entered directly.

Use the Type option to select the type of current that you would like to define. The following current
types are available:

• Constant Velocity (p. 174)

• Varies with Depth, Dimensional (p. 174)

• Varies with Depth, Non-Dimensional (p. 175)

• Formulated (p. 176)
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5.11.9.1. Constant Velocity

A Constant Velocity current does not vary with depth, and requires only its Speed and Direction
to be defined. Both of these properties can be parameterized as part of a design point study.

5.11.9.2. Varies with Depth, Dimensional

In a more realistic description of the simulated environment the current definition should account
for the variation of speed and direction with depth. When the current Type is set to Varies with
Depth, Dimensional, this data can be entered directly into the Current Definition Data table.

Current depth is measured from the sea surface. The rows of the Current Definition Data table are
automatically sorted in order of Depth from the sea surface to the sea bed.

Duplicate Depth entries, negative entries, or entries greater than the Water Depth are not valid.
A maximum of 25 rows may be added. If a complete definition of current with depth is not defined
between the water surface and the defined Water Depth, constant values will be assumed based
upon the lowest and highest defined data.

Current Definition Data can be entered manually, can be copied and pasted from an external source
(for example, an Excel spreadsheet), or can be imported from a comma-separated values (.CSV)
file using the Import CSV File option. For the Import CSV File option, the file must meet the fol-
lowing requirements:
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• Has the .CSV extension.

• Contains values separated by commas, tabs, or single spaces (not multiple spaces).

• Contains exactly 3 columns, and no more than 25 rows.

The unit system of the data in the .CSV file is assumed to match the display unit system of the
project. However, the imported data can be modified by setting the Length Unit for Imported
Data and Rotation Unit for Imported Data to the required unit system.

5.11.9.3. Varies with Depth, Non-Dimensional

When the current Type is set to Varies with Depth, Non-Dimensional, data can be entered as factors
and offsets into the Current Definition Data table. Depth Factors are multiplied by the Water
Depth; Speed Factors are multiplied by the defined current Speed; and Direction Offsets (which
may be negative) are added to the defined current Direction. Current Speed and Direction can
both be parameterized as part of a design point study.

Duplicate Depth Factor entries, negative entries, or entries greater than 1.0 are not valid. A max-
imum of 25 rows may be added. If a complete definition of current with depth is not defined
between the water surface and the defined Water Depth, constant values will be assumed based
upon the lowest and highest defined data.

Current Definition Data can be entered manually, can be copied and pasted from an external source
(for example, an Excel spreadsheet), or can be imported from a .CSV file using the Import CSV
File option. For the Import CSV File option, the file must meet the following requirements:

• Has the .CSV extension.

• Contains values separated by commas, tabs, or single spaces (not multiple spaces).

• Contains exactly 3 columns, and no more than 25 rows.

The unit system of the data in the .CSV file is assumed to match the display unit system of the
project. However, the imported data can be modified by setting the Rotation Unit for Imported
Data to the required unit system.
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5.11.9.4. Formulated

In cases where it is impractical to measure current velocities at depth, you can use a Formulated
current.

To represent a current generated by the tide, you can define a Tidal Speed at the water surface,
a Tidal Direction at the water surface, and a Tidal Variation Inverse Exponent. The variation of
current velocity  with increasing depth  due to a tide is determined as

Where  is the tidal speed at the water surface and  is the total water depth. By default the
Tidal Variation Inverse Exponent will be set to 7, which yields a one-seventh power law profile
(the classic approximation for a fully-developed turbulent flow over a smooth solid boundary).

To represent a current generated by the wind, you can define a Mean Wind Speed and Mean
Wind Direction (as measured over 1 hour at a height of 10 meters), a Reference Depth, and a
Wind Speed Factor. The variation of current velocity  with increasing depth  due to a wind is
determined as
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Where  is the reference depth, and  is the wind-generated current speed at the water surface
defined by

In which  is the wind speed factor and  is the mean wind speed measured over 1 hour at a
height of 10 meters. The Reference Depth has a default value of 50 meters, and the Wind Speed
Factor should typically lie within the range of 0.015 - 0.03.

Tide and wind-generated currents can be combined by defining parameters for both. The total
current velocity  with increasing depth  due to tide and wind is then

All properties of a Formulated current may be parameterized as part of a design point study;
however, at least one of Tidal Speed and Mean Wind Speed must always be non-zero.

The Current Definition Data table will display the current profile which is generated from the input
data. Use the Export CSV File option if you would like to save this data in the .CSV file format.

5.11.9.5. Graphical Representation

For each current depth, an arrow is drawn to represent the current direction and speed; these will
be purple if valid, or yellow if invalid. For a Constant Velocity current, a single arrow is shown at
the water surface. The arrows are scaled with speed, while the overall current profile is illustrated
by the purple shaded region.
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5.11.10. Wind

To supplement the wave forces being applied to the structure, wind forces can be modeled. Wind
can be modeled using a number of spectrum options (including user defined), user time dependent
data, or constant velocity. The wind is shown in the graphic by an arrow at the reference height (or
at ht = 0, if not applicable), scaled with speed.

To add a Wind:

1. Select the Hydrodynamic Response object in the tree view.

2. Right-click the Hydrodynamic Response object and select Insert > Wind > Wind Type , or click
the Wind icon in the Analysis toolbar and select the wind type from the drop-down menu.

Available wind types are:

• Constant Velocity

• Ochi and Shin Spectrum

• API Standard Spectrum

• NPD Standard Spectrum
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• ISO Standard Spectrum

• User Defined Spectrum

You can also define Time Dependent Velocity wind data. For more information, see Time Dependent
Velocity (p. 181).

The wind type of Constant Velocity is permitted for any wave type. Enter the Speed and Direction
of the constant wind in the Wind Spectral Definition section of the Details panel.

The wind types (Ochi & Shin, API, NPD, ISO, and User Defined) are only permitted for analysis types
that permit irregular waves. The following options are shown in the Details panel for all of the spectra,
except User Defined (multiple sets of these options are defined for Time Dependent Velocity (p. 181)).
Enter the Reference Height at which the wind speed is measured, the Speed of the wind at the
reference height, and the Direction of the wind spectrum.

Seed Definition defines the random seed for a wind spectrum. The options available are Program
Controlled or Manual Definition. If you select Manual Definition you can set the seed value.

For a User Defined spectrum, in addition to the Reference Height, Speed, and Direction, you need
to enter the following in the Details panel:

• Frequency Coefficient - 

• Speed Coefficient - surface drag coefficient or roughness - 

• Normalized Turbulence Intensity - 

In the Wind Definition Data panel, enter a Dimensionless Frequency  and its associated Spectral

Ordinate  in each row of the table. For user-defined spectra, the dimensionless frequency is
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defined as , where  is the frequency in hertz. The wind speed spectral density is defined

as . Up to 200 rows may be entered.

The rows of the Wind Definition Data table are automatically sorted in ascending order of Dimension-
less Frequency. Duplicate Dimensionless Frequency entries are not valid.

Wind Definition Data can be entered manually, can be copied and pasted from an external source
(for example, an Excel spreadsheet), or can be imported from a comma-separated values (.CSV) file
using the Import CSV File option. For the Import CSV File option, the file must meet the following
requirements:

• Has the .CSV extension.

• Contains values separated by commas, tabs, or single spaces (not multiple spaces).

• Contains exactly 2 columns, and no more than 200 rows.

The unit system of the data in the .CSV file is assumed to match the display unit system of the project.
However, the imported data can be modified by setting the Length Unit for Imported Data and
Rotation Unit for Imported Data to the required unit system.

For more in-depth description of the available wind spectra, refer to the following sections in the
Aqwa Theory Manual.
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• Ochi and Shin Wind Spectrum

• API Wind Spectrum

• NPD Wind Spectrum

• ISO Wind Spectrum

• User Defined Wind Spectrum

5.11.10.1. Time Dependent Velocity

A time history of wind velocity can be defined directly in a table or by importing the information
from an existing .WVT file.

To add a Time Dependent Wind Velocity:

1. Select the Hydrodynamic Response object in the tree view.

2. Right-click the Hydrodynamic Response object. To define the data directly in a table, select
Insert > Wind > Time Dependent Velocity > Manual Input. To read data from a file, select
Insert > Wind > Time Dependent Velocity > Import WVT File

Alternatively, click the Wind icon in the Analysis toolbar. To define the data directly, select
Manual Input from the drop-down menu. To read the data from a file select Import WVT File.

Note:

After the data is imported, no record of the file used to import the data is retained.

For Manual Input, enter in each row of the table in the Data panel the Time, and the Velocity and
Direction of the wind at that time. The number of rows is not limited.
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The rows of the Wind Definition Data table are automatically sorted in ascending order of Time.
Duplicate Time entries are not valid, and the Time in the last row of the table must equal or exceed
the Finish Time defined in the Analysis Settings object.

Wind Definition Data can be entered manually, can be copied and pasted from an external source
(for example, an Excel spreadsheet), or can be imported from a comma-separated values (.CSV)
file using the Import CSV File option. For the Import CSV File option, the file must meet the fol-
lowing requirements:

• Has the .CSV extension.

• Contains values separated by commas, tabs, or single spaces (not multiple spaces).

• Contains exactly 3 columns.

The time defined in the table rows does not need to match the time steps defined in the analysis;
the program will interpolate the wind speed and direction when necessary, using a cubic spline
interpolation technique. When modeling periods of constant wind velocity, adequate data points
must be provided to satisfy the interpolation method.

Defining the .WVT File

Comment lines beginning with * can be placed at any point in the file.
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Before the data defining the time and wind velocities/directions, there must be a line containing
only the text, "data_start".

After the data start, for each line the first column contains time (in s), the second column is wind
speed, and the third column is wind direction (blowing towards). The numbers in the .WVT file are
in a free format and can be separated by spaces.

The unit system of the data in the .WVT file is assumed to match the display unit system of the
project. However, the imported data can be modified by setting Length Unit of Imported Data
and Angle Unit for Imported Data to the required units.

There is no limit on the length of the .WVT file.

The following is an example of data from a .WVT file:

data_start 
0.0000 8.0000 90.0000
0.5000 7.8532 88.7310
1.0000 7.4271 86.0840
...

Time Dependent Velocity in a Stability Analysis

A time dependent wind velocity can be added to a Time Response Analysis or a Stability Analysis.
The option to include a Time Dependent Velocity in a Stability Analysis is provided so that a time
dependent Wind object can be propagated into downstream Time Response Analysis systems (see
Propagate (p. 258)).

In a Stability Analysis you must a provide a Steady-State Definition, which is used as a constant
value for that analysis. This can be either:

• Initial Value, taken from the first row of the Wind Definition Data table

• Manual Definition, which may be entered directly into the Speed and Direction fields

5.11.11. Cable Winch

Two types of winch can be applied to a cable,

• a winch that can wind in or pay out as required to maintain a constant tension in the cable

• a winch that can wind in or pay out at a given rate to lengthen or shorten the line

Note:

In a Hydrodynamic Response System where the Computation Type is set to Stability
Analysis (p. 134) or Frequency Statistical Analysis (p. 140), only the first of these options is
available.

To add a Cable Winch:

1. Select the Hydrodynamic Response object in the tree view.
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2. Right-click the Hydrodynamic Response object and select Insert > Cable Winch, or click the
Cable Winch icon in the Analysis toolbar.

3. Select the Cable Winch object in the tree and configure it.

5.11.11.1. Winch that Maintains Constant Tension

Cable winches that maintain constant tension can only be used with Linear Elastic or Nonlinear
Polynomial cables.

In the case of a constant tension winch, friction coefficients during the winding in ( ) or paying
out ( ) process are required; hence the tension in the winch mooring line when winding-in is

given by  where  is the winch tension specified. When paying-out, the winch

tension is given by . For example, if the tension specified is 1000 tonnes and  and
 are 0.3 and 0.1 respectively, then the tensions will be 700 and 1100 tonnes respectively.

The initial tension is undefined. The default initial tension is the winding-in tension; that is, 700
tonnes in the example above. The winding-in friction coefficient should be specified as negative if
the paying-out value of tension is required as the initial tension.

The tension will be varied according to whether the range (distance between the anchor and vessel
attachment point) is increasing or decreasing. If the range is less than the initial length specified
the line becomes slack and the tension is zero.

To set up the constant tension Cable Winch object, click on the object. In the Details panel:

• Select Maintains Constant Tension from the Cable Type dropdown list

• Select the cable to associate with the winch from the Cable Selection dropdown

• Enter the value of the Winding In Friction

• Enter the value of the Paying Out Friction

• Enter the desired Winch Tension value

5.11.11.2. Winch that Changes Cable Length

Cable Winches that change the cable length can only be used with Linear Elastic (without Pulleys).
In the case when the winch changes the cable length, it can be made to start at the given speed
after the start time, and pauses if the maximum tension is exceeded. The winch will stop paying
out or winding in when the final length is reached. An additional length, , can be entered to affect

the initial stiffness of the cable and the maximum stiffness ( ).

The initial stiffness of the line,  is used, which is equal to  for the line (  = Young’s modulus,

 = cross sectional area). The stiffness of the line during the winch action will change as the length
changes; that is, the stiffness during the simulation, assuming that the length varies from  to the

final length, , will be  to ; where .
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The speed entered is positive for paying out and negative for winding in. In mathematical terms

the speed is , where  is the unstretched length of line and  is time. For lines which have signi-
ficant strain ( ) (this precludes steel which yields at about 0.001), you may wish to consider the
speed of the drum in terms of stretched length.

When winding in, the line wound onto the drum will have the same tension as the free line itself
at any particular time. This means that in order to wind a length of unstretched line the effective

speed must be increased by a factor of . This is done automatically. If you want to simulate
a stretched line speed for winding in, then the speed specified should be input with a speed reduc-

tion factor of , where  is the average strain.

When paying out, the adjustment of speed is not straightforward. The elastic energy of the line on
the drum will depend on exactly how the line was wound on the drum originally. This 'energy'
stored on the drum is unknown and is assumed to be zero. That is, the line on the drum when
paying out is assumed to be unstretched. The effective winch speed, (effectively with only 1 side

of the line stretched) is . If you want to simulate a stretched line speed for paying out, then

the speed specified should be input with a reduction factor of , where  is the average strain.

To set up the changing cable length Cable Winch object, click on the object. In the Details panel:

• Select Changes Cable Length from the Cable Type dropdown list

• Select the cable to associate with the winch from the Cable Selection dropdown

• Enter the value of the Start Time

• Enter the cable's Final Length at which winching will stop

• Enter the value of the Speed of the winch

• Enter the Max Tension at which winching will pause

• Enter the Additional Length which affects the initial stiffness of the cable

Note:

• The exact length of the line at any time will depend on the previous motions which
have been encountered by the structure connected to this line. This in turn means
that the length of the line has 'memory'. The implication of this is that in situations
where initial or specific positions are used in Aqwa, the line length cannot be determ-
ined and will be assumed to be the initial length. An example of this is the hot start.
A warning message to this effect will be issued in these cases.

• The resolution of switching on and off the drum winch can only be the same as the
time step. This means that the winch drum can only be switched at the beginning or
the end of a time step and NOT in the middle. In order to conserve energy/momentum
in the equations of motion, the length of the line can only be changed in steps of
(time step)*speed of the winch. The tension resolution will therefore be stiffness*time
step*speed. Large stiffnesses or drum speed should therefore be specified with appro-
priately small timesteps.
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• If the unstretched length of the cable is less than 0.1m, it will be defaulted to 0.1m.

5.11.12. Connection Failure

Connections such as Cables (p. 101) and Fenders (p. 116) can be selected to fail for purposes that suit
your simulation objectives.

To add a Connection Failure:

1. Right-click the Hydrodynamic Response object in the tree view.

2. Select Insert>Connection Failure.

In the Failing Connection drop-down menu in the Details panel, select either Cables or Fenders for
your analysis.

Note:

Only the Failure Time option is visible when Fenders is selected. The Failure Mode,
Failure Tension at Cable Start, and Failure Tension at Cable End options are all hidden,
as they only apply to Cables.
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5.11.12.1. Cable Failure

A cable can be defined to fail when a given tension is reached and/or after a specified period of
time. Note that the tension in a cable will be the same at the start or the end of the cable unless
Nonlinear Catenary cables are used.

To add a Cable Failure:

1. Select the Hydrodynamic Response object in the tree view.

2. Right-click the Hydrodynamic Response object and select Insert > Connection Failure.

3. Select the Cable within the Failing Connection drop-down menu and configure the settings
in the Details Panel.

The behavior of the Cable Failure depends on the Computation Type of the parent Hydrodynamic
Response system. If you are performing a Stability Analysis (p. 134) or a Frequency Statistical Analys-
is (p. 140), the selected cable is considered as broken throughout the calculation.

If you are performing a Time Response Analysis (p. 135), select one of the following for Failure
Mode, and enter the parameters for that failure mode:

• At given time – enter the analysis Failure Time at which the cable fails.

• After given time if tension at Cable Start is exceeded – enter the analysis Failure Time after
which the cable fails if the cable start tension exceeds Failure Tension at Cable Start.

• After given time if tension at Cable End is exceeded – enter the analysis Failure Time after which
the cable fails if the cable end tension exceeds Failure Tension at Cable End.

• After given time if tension at Cable Start or End is exceeded – enter the analysis Failure Time
after which the cable fails if the cable start tension exceeds Failure Tension at Cable Start or
the cable end tension exceeds Failure Tension at Cable End.

• If tension at Cable Start is exceeded – enter the Failure Tension at Cable Start at which the
cable fails.

• If tension at Cable End is exceeded – enter the Failure Tension at Cable End at which the cable
fails.

• If tension at Cable Start or End is exceeded – enter the Failure Tension at Cable Start and the
Failure Tension at Cable End at which the cable fails.

5.11.12.2. Fender Failure

A single fender or a group of fenders can be set to fail after a specified period of time. In Aqwa,
fenders are used to model contact. Fender Failure can model the kinetic contact between two
bodies. This is particularly useful when performing a launch analysis.

To add a Fender Failure:

1. Right-click Hydrodynamic Response and select Insert>Connection Failure.

2. Select the Fender within the Failing Connection drop-down menu.
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3. Set a time (in seconds) in Failure Time for the fender to fail.

To set failure times for additional Fenders, right-click Connection Failure 1 in the Outline
tree, select Duplicate, and set the time.

Table 5.2: Fender Color Codes

DescriptionFender Color

The fenders are stationary and not in contact.Orange

The fenders are in contact.Red

The fenders are deactivated.Purple

The fender compression force has exceeded the maximum
permissible value based on the defined fender stiffness
coefficients.

Black

Applying Connection Failure in a Launch Analysis

An example of the application of Connection Failure is a launch analysis. In this application, models
of a barge and load block are used. The load is usually placed directly on the barge.

This workflow simulates the contact between the two models, which is depicted by the fenders, as
well as the moment the fenders are deactivated. Cables are also included in this demonstration.
This results in the load sliding off and dropping into the water body.

To view a video tutorial for this application, see Connection Failure in Aqwa Workbench.

Note:

It is recommended to run the simulation without any Connection Failure objects first,
and then play the Animation to see when each fender should be turned off.
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To perform a launch analysis with fenders:

1. Create your Barge and Load models.

2. Right-click Barge in the Outline tree and select Add>Connection Point to add a Connection
Point to a corner of the Barge, which will define the Contact Plane for the Fenders.

3. Right-click Load in the Outline tree and select Add>Connection Point to add Connection Points
to the corners of the Load, which will define the position of the fenders

4. Under Connections in the Outline tree, click each Fender to set the Fender Connection Point,
Connection Point on Contact Plane, Size, and Coefficients (for fender stiffness) in the Details
panel.

5. Click Contact Axes and Fender Axes under Connections in the Details panel to orientate the
Contact Plane and the Fender, respectively.

6. For the time-domain calculation, right-click Hydrodynamic Response and select Insert>Con-
nection Failure.

7. Select the desired Fender within the Failing Connection drop-down menu, and set a time (in
seconds) in Failure Time for the Fender to fail.

To set failure times for additional Fenders, right-click Connection Failure 1 in the Outline tree,
select Duplicate, and set the time.

8. Click Solution>Solve to solve the calculation.

9. Click Animation and select Play in the Output panel to review the results.

5.11.13. Point Force

A force of constant magnitude may be applied to any point on a structure by the addition of a Point
Force object.

To add a Point Force:

1. Select the Hydrodynamic Response object in the tree view.

2. Right-click the Hydrodynamic Response object and select Insert > Point Force, or click the Point
Force icon in the Analysis toolbar.

Point Forces can be applied to Stability Analyses, Frequency Statistical Analyses, and Time Response
Analyses. A Point Force which has been added to a Stability Analysis can be Propagated to any
downstream Frequency Statistical or Time Response Analyses.

Under the Point Force Force Definition, select Application Position from the drop-down menu of
structure Connection Points. The Behavior of the Point Force can be set to either:

• Direction is Constant: the position at which the force is applied moves with the structure, but the
direction that the force acts in remains constant in the Fixed Reference Axes (FRA). This can be
used to model the force of the wind acting on a vessel's superstructure, for example.
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• Direction Moves with Structure: both the position and direction of the force move with the structure
(the direction that the force acts in remains constant in the Local Structure Axes (LSA)). This can
be used to model a vessel's thruster, for example.

Under Application Definition, use the Defined By option to specify whether the Point Force is
defined by:

• Components: use the Component X, Component Y, and Component Z fields to set the individual
force components in the Fixed Reference Axes (FRA).

• Magnitude and Direction: specify the absolute Magnitude of the Point Force, and select a Fixed
Point or Connection Point from the Direction Vertex drop-down menu to define the direction in
which the force will initially act.

5.11.14. Deactivated Freedoms

The motions of a structure can be restricted by the deactivation of one or more of its degrees of
freedom.

To add a Deactivated Freedoms:

1. Select the Hydrodynamic Response object in the tree view.

2. Right-click the Hydrodynamic Response object and select Insert > Deactivated Freedoms, or
click the Deactivated Freedoms icon in the Analysis toolbar.

Deactivated Freedoms objects can be added to Stability Analyses and Time Response Analyses. A
Deactivated Freedoms object which has been added to a Stability Analysis can be propagated to
any downstream Time Response Analyses.

Under Freedom Deactivation, select a Structure from the drop-down menu of structures included
in the analysis. Then select up to six Deactivated Freedoms. A graphical representation of the unres-
tricted freedoms will be displayed at the structure's center of gravity. In the example below, the motion
of the selected structure has been restricted to the horizontal (XY) plane.
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Note:

If all translational degrees of freedom are to be deactivated, it is preferrable to use a Joint
connection to restrict the motion of the structure.

5.12. Solution

Results can be added when the Solution object is selected in the tree; this can be either before or after
an analysis is performed.

To add a Results object:

1. Select the Solution object in the tree view.

2. Right-click the Solution object and select Insert Result > Result Type , or click the required
result type in the Solution toolbar. Some icons have dropdown menus to refine the selection.
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When you select a Hydrodynamic Graph result object under Solution, the graph will display in the Graph
tab of the upper right pane of the window, and the data for the graph will display in the pane below
the graph. Various fields will appear in the Details panel, depending on the type of graph and the axes
that are displayed.

If the input to an analysis is changed, then the results objects will indicate that they are out of date via
the yellow lightening bolt icon, and any existing results will become unavailable. Note that the solution
files stored in the project files directory will remain unless Clear Generated Data is selected. Changing
the Axes Selection for any graph will cause that result object to require an update, which can be done
from the right-click menu.

For certain types of Hydrodynamic Response analyses, the results can also be read from the external
co-simulation result files by selecting Import Co-simulation Results. However, the co-simulation result
files must be derived from solving the Aqwa-FMU package generated by the selected Hydrodynamic
Response analysis and the model or analysis settings must not be modified since the generation of the
Aqwa-FMU package. Once Import Co-simulation Results is selected, the program will ask for the location
of the Aqwa co-simulation input .DAT file in the co-simulation result file folder. All the corresponding
Aqwa co-simulation result files will be copied into the solver file directory of the selected Hydrodynamic
Response analysis. The time settings of the Hydrodynamic Response analysis will be altered to the co-
simulation time settings. After the Aqwa Workbench editor has been closed and re-opened as suggested
in the message below, the co-simulation results can be evaluated in Solution.

In relation to Moonpools, you can only produce and access the Hydrodynamic Diffraction results such
as the hydrostatic information, hydrodynamic graphs, and pressure display when a Geometry model
contains active Moonpool objects.

The following types of results are available:

5.12.1. Hydrostatic Results

5.12.2. Hydrodynamic Graphical Results
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5.12.3. Frequency Domain Tabular Results

5.12.4. Pressures and Motions Results

5.12.5. Internal Tank Pressures Results

5.12.6. Animation Results

5.12.7. Dynamic Natural Modes

5.12.8.Time Domain Statistical Results

5.12.9.Time Domain Pressures Results

5.12.1. Hydrostatic Results

The Hydrostatic results tree item enables you to view the centers of buoyancy, flotation and gravity
in the graphical view once a hydrostatic or hydrodynamic solve has been performed.

Detailed hydrostatic results are available by selecting the Properties tab at the bottom of the
graphical view.

In the Details panel, select the Structure whose results you want to display. You can add as many
Hydrostatic results objects as you like to display the results of different structures. For each result
object, you can suppress or enable the display of the Center of Gravity, Center of Buoyancy, and
Center of Flotation information from the Details panel. Any number of Hydrostatic results objects
can be added to the Solution.
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Note:

For best graphical display of hydrostatic results, it is recommended that you change the
View options to enable Wireframe and turn off Select Tree Related Items.

When the selected structure includes Moonpools, the hydrostatic Moonpools properties will also be
displayed. They are grouped per structures and all Moonpool properties are listed back-to-back:

• The centre point coordinate and the area of the free surface

• The general stiffness matrix for each pressure mode (see Equation 4.119)
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When generating the report, the hydrostatic stiffness matrix may be wrapped if the size of the matrix
exceeds the size of an A4 sheet.

5.12.2. Hydrodynamic Graphical Results

The following analysis types can output graphical results:

5.12.2.1. Diffraction

5.12.2.2.Time Response

5.12.2.3. Frequency Domain

5.12.2.4. Stability Response

Hydrodynamic graphs allow you to plot your results using either a line, surface, or contour surface
plot.

There are three different types of graphs that can be displayed: 2D lines can be used to plot a para-
meter against one axis (for example, Structure Position vs Time), while 3D surfaces and contour surface
plots can be used in a Hydrodynamic Diffraction analysis to plot a parameter against two axes (for
example, RAOs vs Frequency and Direction). The chart type and axes will be based on the selection
that you make from the right-click menu when you add the object to the Solution.

When you create a 2D line graph object,a child input object is also created to define the properties
of that line; you can select it and edit its properties in the Details pane. You can right-click and Add
Line on the parent graph object to add more lines (up to 20 per graph), or you can right-click and
Duplicate on the child input object to quickly add multiple lines with similar properties. For 3D surface
and contour surface plots, the result properties are defined directly in the Details pane for that graph.
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For graph results under a Hydrodynamic Response analysis, the child input object includes a Result
Source selection. Where there are multiple Hydrodynamic Response systems of the same Computation
Type appearing in the Outline tree, you may select as a Result Source any of the systems whose
Computation Type matches that of the current analysis. This allows results from similar analyses – for
example, structure position time histories under different environments – to be compared on the
same graph.

After inserting a new graph or changing input in an existing graph, the results need to be evaluated.
The update results option is available via the context (right-click) menu. When you select an up-to-
date graphical object in the tree, the graph will be displayed in a Graph tab in the main window
pane, and the data for the graph will be displayed in the Tabulated Results Data panel below the
graph. Where you have multiple child inputs for a 2D line graph, clicking on an input will cause the
graph to display only the line corresponding to that input.

A Maximum and Minimum value for each plotted parameter will be shown in the Details panel of
the graph object, and will also be highlighted in the data table (minimum is blue and maximum is
red). Multiple entries are highlighted in the table if they have the same value. The positions of the
Minimum and Maximum points are also given in the Details panel. For a Stability Analysis, Initial and
Final parameter values are shown instead – simulation parameters should not be considered to have
any physical meaning at non-converged iteration steps.

The Maximum, Minimum, Position of Maximum, Position of Minimum, Initial and Final fields can be
set as output design point parameters by clicking the check box next to each field. See Paramet-
ers (p. 269) for more information. Once you have parameterized an output field, you will not be able
to modify or delete the associated line input – you must de-parameterize the output first.

Note:

Output values can only be parameterized when their Result Source is defined as the current
analysis system.

The lower right corner of the graph window contains a control that allows you to zoom and pan on
the chart by selecting the corners of the control to zoom and the center to pan.

Note:

Aqwa always produces results in global coordinate systems. Traditionally, the ship is defined
with its longitudinal axis in the global X direction. However, if you are aware of the results
orientation, this does not have to be respected in DesignModeler.

Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.196

Aqwa Approach



Figure 5.12: Line Graph

Figure 5.13: Surface Graph
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Figure 5.14: Surface Contour Graph

Note:

Hydrodynamic Diffraction is the only analysis supporting geometries containing active
Moonpool objects. Time Response, Frequency Domain, and Stability Response will not
run under this model configuration.

5.12.2.1. Diffraction

The following graph types for the Hydrodynamic Diffractions Solution object are available from the
Hydrodynamic Graphs menu on the Insert Results toolbar.

5.12.2.1.1. Diffraction, Froude-Krylov, Diffraction + Froude-Krylov, Linearized Morison Drag, and Total Ex-
citing Force Including Morison Drag

5.12.2.1.2. Response Amplitude Operators (RAOs) and RAOs with Linearized Morison Drag

5.12.2.1.3. Radiation Damping & Added Mass

5.12.2.1.4. Steady Drift

5.12.2.1.5. Sum QTF and Difference QTF

5.12.2.1.6. Splitting Forces (RAO)

5.12.2.1.7. Bending Moment and Shear Force

5.12.2.1.1. Diffraction, Froude-Krylov, Diffraction + Froude-Krylov, Linearized Mor-
ison Drag, and Total Exciting Force Including Morison Drag

Result Description:

2D or 3D graphs to illustrate how these forces, moments, or the corresponding phase angle
change with direction, frequency or both direction and frequency. Total Exciting Force Including
Morison Drag is the sum of the already existing forces (FK+Diff ) and the additional Linearized
Morison Drag (p. 132).

Plot availability:

• Line graph presentation: Phase Angle plotted against either Direction or Frequency

• Line graph presentation: Force/Moment plotted against either Direction or Frequency
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• Surface graph presentation: Phase Angle plotted against Direction + Frequency

• Surface graph presentation: Force/Moment plotted against Direction + Frequency

The Frequency Scale can be modified to be Period Scale if required.

Line Graph Input:

• Use the Component input to select which force component to plot, either X, Y, Z for forces
or RX, RY, RZ for moments.

When the selected Part includes active Moonpools, the Component is enhanced with additional
degrees of freedom in the form of a list of Moonpool pressure modes associated with each
active Moonpool under the selected Part. See the note on pressure modes modification and
impact on results' validity under Pressure Modes (p. 71).

• When the plot is performed against Direction, then the required frequency can be chosen using
the Frequency input.

• When the plot is performed against Frequency, then the required direction can be chosen using
the Direction input.

Line Graph Output:

Maximum Value and Minimum Value of Angle or Force/Moment and the first Frequency or
Direction at which they occur (Abscissa Position of Minimum, Abscissa Position of Maximum).
These values can be parameterized by selecting the adjacent check box.

Surface Graph Input:

Use the Component input to select which force component to plot, either X, Y, Z for forces or
RX, RY, RZ for moments.

Surface Graph Output:

Maximum Value and Minimum Value of Angle or Force/Moment and the Frequency and Direction
at which they occur (Abscissa (X) Position of Minimum, Abscissa (X) Position of Maximum
and Ordinate (Y) Position of Minimum, Ordinate (Y) Position of Maximum). These values can
be parameterized by selecting the adjacent check box.

5.12.2.1.2. Response Amplitude Operators (RAOs) and RAOs with Linearized Morison
Drag

Result Description:

2D or 3D graphs to illustrate how the amplitude and phase of the structure response change
with wave direction, frequency or both direction and frequency. You can view RAOs and RAOs
taking into account the linearized Morison drag effects, if Linearized Morison Drag (p. 132) is
specified.

Plot availability:

• Line graph presentation: Phase Angle plotted against either Direction or Frequency
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• Line graph presentation: Distance/Rotation plotted against either Direction or Frequency

• Surface graph presentation: Phase Angle plotted against Direction + Frequency

• Surface graph presentation: Distance/Rotation plotted against Direction + Frequency

The Frequency Scale can be modified to be Period Scale if required.

Line Graph Input:

• Use the Component input to select which degree of freedom to plot, either X, Y, Z for translation
or RX, RY, RZ for rotation.

When the selected Part includes active Moonpools, the Component is enhanced with additional
degrees of freedom in the form of a list of Moonpool pressure modes associated to each active
Moonpool under the selected Part. See the note on pressure modes modification and impact
on results' validity under Pressure Modes (p. 71).

• When the plot is performed against Direction, then the required frequency can be chosen using
the Frequency input.

• When the plot is performed against Frequency, then the required direction can be chosen using
the Direction input.

• For a translation RAO, the Reference Point at which the RAO is reported can be the Center of
Gravity of the selected Structure, or can be any Connection Point on that structure.

• A translation RAO is typically reported for Motion Relative To the Origin of the Fixed Reference
Axes (FRA). However, when the Component is set to Global Z and the Reference Point is a
Connection Point, the RAO may instead be reported relative to the undiffracted Wave Surface.

Note:

For Hydrodynamic Diffraction RAO results, the Connection Point Include in Results
option is not required for that Connection Point to be used as a Reference Point.

Line Graph Output:

Maximum Value and Minimum Value of Angle or Distance/Rotation and the first Frequency or
Direction at which they occur (Abscissa Position of Minimum, Abscissa Position of Maximum).
These values can be parameterized by selecting the adjacent check box.

Surface Graph Input:

Use the Component input to select which degree of freedom to plot, either X, Y, Z for translation
or RX, RY, RZ for rotation. For translational degrees of freedom, use the Reference Point and
Motion Relative To inputs to set the position and frame of reference for the reported RAOs.

Surface Graph Output:

Maximum Value and Minimum Value of Angle or Distance/Rotation and the Frequency and
Direction at which they occur (Abscissa (X) Position of Minimum, Abscissa (X) Position of
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Maximum and Ordinate (Y) Position of Minimum, Ordinate (Y) Position of Maximum). These
values can be parameterized by selecting the adjacent check box.

5.12.2.1.3. Radiation Damping & Added Mass

Result Description:

2D graphs to illustrate how the Radiation Damping or Added Mass varies with frequency.

Plot Availability:

• Line Graph Presentation: Radiation Damping or Added Mass plotted against Frequency

The Frequency Scale can be modified to be Period Scale if required.

Line Graph Input:

Use the Subtype and Component inputs to select which value from the Radiation Damping or
Added Mass matrix to plot, X, Y, Z for linear components or RX, RY, RZ for rotational components.

When the selected Part includes active Moonpools, the Component and the Subtype are appen-
ded with additional degrees of freedom in the form of a list of pressure modes associated to
each active Moonpool under the selected Part. See the note on pressure modes modification and
impact on results' validity under Pressure Modes (p. 71).

This image shows how the lists of Subtype and Component have been appended with the
Moonpool pressure modes:

Figure 4.7: Coefficient Locations in Added Mass and Hydrodynamic Damping Matrices details
which coefficient is being queried or selected in the Added Mass coefficients matrix for a given
structure selection.

The same applies for the radiation damping coefficient matrix.

The combination between the 6 positional degrees of freedom (X,Y,Z, RX, RY, RZ) and the
Moonpool pressure modes will result in the following unit system. The SubType and Component
selection will give the following type of units:
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Moonpool Pressure
Mode

Rotational (RX, RY,
RZ)

Translation
(X,Y,Z)

Component 

SubType▼

Tran-TranRot-TranTran-TranTranslation (X,Y,Z)

Tran-RotRot-RotTran-RotRotational (RX, RY, RZ)

Tran-TranRot-TranTran-TranMoonpool Pressure
Mode

Line Graph Output:

Maximum Value and Minimum Value of Radiation Damping and the first Frequency at which
they occur (Abscissa Position of Minimum, Abscissa Position of Maximum). These values can
be parameterized by selecting the adjacent check box.

5.12.2.1.4. Steady Drift

Result Description:

2D or 3D graphs to illustrate the mean drift forces/moments applied on the structure and how
they change with direction, frequency, or both direction and frequency.

Plot availability:

• Line graph presentation: Force/Moment plotted against either Direction or Frequency

• Surface graph presentation: Force/Moment plotted against Direction + Frequency

The Frequency Scale can be modified to be Period Scale if required.

Line Graph Input:

• Use the Component input to select which force component to plot, either X, Y, or Z for forces
or RX, RY, or RZ for moments.

• When the plot is performed against Direction, then the required frequency can be chosen using
the Frequency input.

• When the plot is performed against frequency, then the required direction can be chosen using
the Direction input.

Line Graph Output:

Maximum Value and Minimum Value of Angle or Force/Moment and the first Frequency or
Direction at which they occur (Abscissa Position of Minimum, Abscissa Position of Maximum).
These values can be parameterized by selecting the adjacent check box.

Surface Graph Input:

Use the Component input to select which force component to plot, either X, Y, or Z for forces
or RX, RY, or RZ for moments.

Surface Graph Output:
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Maximum Value and Minimum Value of Angle or Force/Moment and the Frequency and Direction
at which they occur (Abscissa (X) Position of Minimum, Abscissa (X) Position of Maximum
and Ordinate (Y) Position of Minimum, Ordinate (Y) Position of Maximum). These values can
be parameterized by selecting the adjacent check box.

5.12.2.1.5. Sum QTF and Difference QTF

Result Description:

3D graphs to illustrate how these quadratic transfer function (QTF) matrix (which is a force or
moment) results change with frequency, for a given direction.

Plot availability:

• Surface graph presentation: Phase Angle plotted against Frequency + Frequency

• Surface graph presentation: Force/Moment plotted against Frequency + Frequency

The Frequency Scale can be modified to be Period Scale if required.

Surface Graph Input:

• Use the Component input to select which force component to plot, either X, Y, Z for forces
or RX, RY, RZ for moments.

• The required Direction can be chosen.

• When Force/Moment plots are performed, the SubType field is shown to enable the selection
of the full Amplitude component, or just the Real or Imaginary components.

Surface Graph Output:

Maximum Value and Minimum Value of Angle or Force/Moment and the Frequency and Direction
at which they occur (Abscissa (X) Position of Minimum, Abscissa (X) Position of Maximum
and Ordinate (Y) Position of Minimum, Ordinate (Y) Position of Maximum). These values can
be parameterized by selecting the adjacent check box.

5.12.2.1.6. Splitting Forces (RAO)

Result Description:

2D or 3D graphs to illustrate how the Splitting Forces (RAO) vary with frequency, direction, or
both frequency and direction.

Splitting Forces (RAO) calculations depend upon the masses being accurately defined in the
geometry section and are only available for structures that are not included in an Interacting
Structure Group.

Note:

Splitting Forces (RAO) results are not available for structures containing only a single
mass (from Point Mass or Line Body definitions).
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Plot availability:

• Line graph presentation: Force/Moment vs. Frequency or Direction

• Line graph presentation: Phase Angle vs. Frequency or Direction

• Surface graph presentation: Force/Moment vs. Frequency + Direction

• Surface graph presentation: Phase Angle vs. Frequency + Direction

The Frequency Scale can be modified to be Period Scale if required.

Line Graph Input:

• Use the Component input to select which force component to plot, either X, Y, or Z for forces
or RX, RY, or RZ for moments.

• When the plot is performed against Direction, then the required frequency can be chosen using
the Frequency input.

• When the plot is performed against Frequency, then the required direction can be chosen using
the Direction input.

• When Force/Moment plots are performed, the SubType field is shown to enable the selection
of the full Amplitude component, or just the Real or Imaginary components.

• When Force/Moment plots are performed, use Bounding Box Min Coordinate [X Y Z] to enter
the coordinates of one corner of a bounding box and Bounding Box Max Coordinate [X Y
Z] to enter the coordinates of the opposite corner of the box. Then enter a Calculation Co-
ordinate [X Y Z] to enter the coordinates of the point about which the moments are calculated.
Values entered should be separated by spaces.

Line Graph Output:

Maximum Value and Minimum Value of Angle or Force/Moment and the first Frequency or
Direction at which they occur (Abscissa Position of Minimum, Abscissa Position of Maximum).
These values can be parameterized by selecting the adjacent check box.

Surface Graph Input:

• Use the Component input to select which force component to plot, either X, Y, Z for Forces
or RX, RY, RZ for moments.

• When Force/Moment plots are performed, the SubType field is shown to enable the selection
of the full Amplitude component, or just the Real or Imaginary components.

• When Force/Moment plots are performed, use Bounding Box Min Coordinate [X Y Z] to enter
the coordinates of one corner of a bounding box and Bounding Box Max Coordinate [X Y
Z] to enter the coordinates of the opposite corner of the box. Then enter a Calculation Co-
ordinate [X Y Z] to enter the coordinates of the point about which the moments are calculated.
Values entered should be separated by spaces.

Surface Graph Output:

Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.204

Aqwa Approach



Maximum Value and Minimum Value of Angle or Force/Moment and the Frequency and Direction
at which they occur (Abscissa (X) Position of Minimum, Abscissa (X) Position of Maximum
and Ordinate (Y) Position of Minimum, Ordinate (Y) Position of Maximum). These values can
be parameterized by selecting the adjacent check box.

When defining the Bounding Box Min, Max Coordinates [X Y Z], and Calculation Coordinate
[X Y Z] for the Splitting Forces (RAO) calculation, while the result object is not yet evaluated,
graphical representations of the bounding box and calculation position are shown in the Geometry
tab.

5.12.2.1.7. Bending Moment and Shear Force

Static Bending Moments and Shear Forces can be calculated by the SF/BM (Static) result, and are
always plotted along the neutral axis of the vessel. Alternatively, response amplitude operator
(RAO) based results can be determined for each wave direction, frequency, and position along
the neutral axis. Depending upon the combination of requirements, these will be shown on both
2D and 3D graphs appropriately. When graphs are plotted against Position, the Frequency or
Direction can be explicitly selected or they can be enveloped so that the critical result can be
identified easily. When graphs are not plotted against Position, then the calculation Position can
be specified, and if appropriate, the Frequency or Direction can be explicitly defined (in this
situation they cannot be enveloped).
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Bending Moment and Shear Force calculations depend upon the masses being accurately defined
in the geometry section and will only be permitted if there is only a single structure in the ana-
lysis.

Note:

If you define only a single Point Mass on a structure, and then request Bending Moment
and Shear Force results, the mass is assumed to be distributed over the length of the
Part in the selected Neutral Axis direction.

If you define multiple Point Masses, or a Distributed Mass, the mass definitions are
split into a number of sections such that the masses are evenly distributed along the
length of the Part in the selected Neutral Axis direction (while maintaining the overall
CoG position of the Part). Masses from Line Bodies are distributed over the extents of
each Line Body, and are then superimposed on the mass distribution.

Result Description:

2D or 3D graphs to illustrate the shear forces/bending moments applied on the structure and
how they change with direction, frequency, position along the neutral axis, or combinations of
direction/frequency/position.

Plot availability:

• Line graph presentation (static): Force/Moment plotted against Position

• Line graph presentation (RAO): Force/Moment plotted against either Position, Direction, or
Frequency

• Line graph presentation (RAO): Phase Angle plotted against either Position, Direction, or Fre-
quency

• Surface graph presentation (RAO): Force/Moment plotted against Direction + Frequency, Direc-
tion + Position, or Frequency + Position

• Surface graph presentation (RAO): Phase Angle plotted against Direction + Frequency, Direction
+ Position, or Frequency + Position

The Frequency Scale can be modified to be Period Scale if required.

Line Graph Input:

• Use the Component input to select which force component to plot, either X, Y, or Z for forces
or RX, RY, or RZ for moments.

• When the plot is performed against Direction (RAO), then the required frequency can be chosen
using the Frequency input and the Position can be entered.

• When the plot is performed against Frequency (RAO), then the required direction can be chosen
using the Direction input, and the Position can be entered.
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• When the plot is performed against Position (RAO), then the required direction can be chosen
using the Direction input, and the required frequency can be chosen using the Frequency
input.

Line Graph Output:

Maximum Value and Minimum Value of Angle or Force/Moment and the first Frequency, Direc-
tion, or Position at which they occur (Abscissa Position of Minimum, Abscissa Position of
Maximum). These values can be parameterized by selecting the adjacent check box.

Surface Graph Input:

Use the Component input to select which force component to plot, either X, Y, or Z for forces
or RX, RY, or RZ for moments.

Surface Graph Output:

Maximum Value and Minimum Value of Angle or Force/Moment and the Frequency and Direction
or Frequency and Position or Position and Direction at which they occur (Abscissa (X) Position
of Minimum, Abscissa (X) Position of Maximum and Ordinate (Y) Position of Minimum, Or-
dinate (Y) Position of Maximum). These values can be parameterized by selecting the adjacent
check box.

5.12.2.2. Time Response

Under the Solution object of a Hydrodynamic Response system, a number of graphs will be available
to track the behavior of a number of parameters over time. The graphs are all line graphs, and the
following categories of graphs are available:

5.12.2.2.1.Wave Surface Elevation

5.12.2.2.2. Structure Position

5.12.2.2.3. Structure Velocity

5.12.2.2.4. Structure Acceleration

5.12.2.2.5. Structure Forces

5.12.2.2.6. Fender Forces

5.12.2.2.7. Fender Motions

5.12.2.2.8. Joint Forces

5.12.2.2.9. Cable Forces

5.12.2.2.10.Tether/Riser Motions

5.12.2.2.11.Tether/Riser Tensions

5.12.2.2.12.Tether/Riser Shear Force/Bending Moment

5.12.2.2.13.Tether/Riser Stresses

5.12.2.2.14.Time Step Error

Note:

For Time Response results, the table of data points is hidden by default. Use the Show
Tabulated Results Data option to show the data points in tabular form.
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5.12.2.2.1. Wave Surface Elevation

2D graph to illustrate the elevation of the wave surface over time at a selected position.

Plot Availability:

• Line graph presentation: Distance plotted against Time

Line Graph Input:

Use the Reference Point input to select the position at which the Wave Surface Elevation is re-
ported. This may either be at the fixed position specified in the Time Response Analysis Set-
tings (p. 135) or at the (moving) position of any Connection Point that has its Include in Results
option to set to yes before the analysis is solved.

Line Graph Output:

Maximum Value and Minimum Value of Wave Surface Elevation and the Time at which they
occur (Abscissa Position of Minimum, Abscissa Position of Maximum). These values can be
parameterized by clicking the adjacent check box.

5.12.2.2.2. Structure Position

Result Description:

2D graphs to illustrate the following response subtypes of the Structure Position during the
analysis:

• Actual Response

• Low Frequency – The low frequency subtype values are obtained by filtering the actual
response with a filter which has a cut-off frequency of one third of the frequency of the

(10% + 1)th spectral line; that is, with N spectral lines, n = 0.1N + 1, ωcutoff = ωn/3

• Wave Frequency – the wave frequency response is that which remains when the low fre-
quency response is subtracted from the actual response

• RAO Based – The RAO based motions are those that are calculated using only the RAOs,
ignoring the effects of connections (unless these are included as additional matrices in
the diffraction analysis), using the applied wave

These values are available in all translational and rotational component directions, and are calcu-
lated at the center of gravity or (translation components only) at a Connection Point on the se-
lected structure.

Plot availability:

• Line graph presentation: Distance/Rotation plotted against Time

Line Graph Input:

Use the Component input to select which Position component to plot: distance from a defined
reference point, X, Y, or Z for translation or RX, RY, or RZ for rotation.
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For a translation, the Reference Point at which the result is reported can be the Center of Gravity
of the selected Structure, or can be any Connection Point on that structure.

The Motion Relative To input can be used to set the frame of reference for the reported trans-
lation. This may be either the Origin of the Fixed Reference Axes (FRA), the Center of Gravity of
another structure, a Connection Point on another structure, or a Fixed Point. When the Component
is set to Global Z and the Reference Point is a Connection Point, the result may also be reported
relative to the Wave Surface. For the latter, the selected Connection Point must have its Include
in Results option set to Yes before the analysis is solved, and the result SubType must be set
to Actual Response.

Line Graph Output:

Maximum Value and Minimum Value of Structure Position and the Time at which they occur
(Abscissa Position of Minimum, Abscissa Position of Maximum). These values can be paramet-
erized by selecting the adjacent check box.

5.12.2.2.3. Structure Velocity

Result Description:

2D graphs to illustrate the following response subtypes of the Structure Velocity during the
analysis:

• Actual Response

• Low Frequency – The low frequency subtype values are obtained by filtering the actual
response with a filter which has a cut-off frequency of one third of the frequency of the

(10% + 1)th spectral line; that is, with N spectral lines, n = 0.1N + 1, ωcutoff = ωn/3

• Wave Frequency – the wave frequency response is that which remains when the low fre-
quency response is subtracted from the actual response

• RAO Based – The RAO based motions are those that are calculated using only the RAOs,
ignoring the effects of connections (unless these are included as additional matrices in
the diffraction analysis), using the applied wave

These values are available in all translational and rotational component directions, and are calcu-
lated at the center of gravity or (translation components only) at a Connection Point on the se-
lected structure.

Plot availability:

• Line graph presentation: Velocity plotted against Time

Line Graph Input:

Use the Component input to select which Velocity component to plot, either X, Y, or Z for
translational velocity or RX, RY, or RZ for rotational velocity.

For a translational velocity, the Reference Point at which the result is reported can be the Center
of Gravity of the selected Structure, or can be any Connection Point on that structure.
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The Motion Relative To input can be used to set the frame of reference for the reported trans-
lational velocity. This may be either the Origin of the Fixed Reference Axes (FRA), the Center of
Gravity of another structure, or a Connection Point on another structure. When the Component
is set to Global Z and the Reference Point is a Connection Point, the result may also be reported
relative to the Wave Surface. For the latter, the selected Connection Point must have its Include
in Results option set to Yes before the analysis is solved, and the result SubType must be set
to Actual Response.

Line Graph Output:

Maximum Value and Minimum Value of Structure Velocity and the Time at which they occur
(Abscissa Position of Minimum, Abscissa Position of Maximum). These values can be paramet-
erized by selecting the adjacent check box.

5.12.2.2.4. Structure Acceleration

Result Description:

2D graphs to illustrate the following response subtypes of the Structure Acceleration during the
analysis:

• Actual Response

• Low Frequency – The low frequency subtype values are obtained by filtering the actual
response with a filter which has a cut-off frequency of one third of the frequency of the

(10% + 1)th spectral line; that is, with N spectral lines, n = 0.1N + 1, ωcutoff = ωn/3

• Wave Frequency – the wave frequency response is that which remains when the low fre-
quency response is subtracted from the actual response

• RAO Based – The RAO based motions are those that are calculated using only the RAOs,
ignoring the effects of connections (unless these are included as additional matrices in
the diffraction analysis), using the applied wave

These values are available in all translational and rotational component directions, and are calcu-
lated at the center of gravity or (translation components only) at a Connection Point on the se-
lected structure.

Plot availability:

• Line graph presentation: Acceleration plotted against Time

Line Graph Input:

Use the Component input to select which Acceleration component to plot, either X, Y, or Z for
translational acceleration or RX, RY, or RZ for rotational acceleration.

For a translational acceleration, the Reference Point at which the result is reported can be the
Center of Gravity of the selected Structure, or can be any Connection Point on that structure.

The Motion Relative To input can be used to set the frame of reference for the reported trans-
lational acceleration. This may be either the Origin of the Fixed Reference Axes (FRA), the Center
of Gravity of another structure, or a Connection Point on another structure. When the Component
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is set to Global Z and the Reference Point is a Connection Point, the result may also be reported
relative to the Wave Surface. For the latter, the selected Connection Point must have its Include
in Results option set to Yes before the analysis is solved, and the result SubType must be set
to Actual Response.

Line Graph Output:

Maximum Value and Minimum Value of Structure Acceleration and the Time at which they
occur (Abscissa Position of Minimum, Abscissa Position of Maximum). These values can be
parameterized by selecting the adjacent check box.

5.12.2.2.5. Structure Forces

Result Description:

2D graphs to illustrate the following response subtypes of the Structure Forces during the analysis:

• Total Force/Moment

• Mooring Sum Only

• Gyroscopic Only

• Diffraction Only

• Linear Damping Only

• Morison Drag Only

• Drift Only

• Froude-Krylov Only

• Gravitation Only

• Current Drag Only

• Wave Inertia Only

• Hydrostatic Only

• Wind Only

• Slam Only

• Point Only

• Yaw Drag Only

• Slender Body Only

• Radiation Only

• Fluid Momentum Only
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• Fluid Gyroscopic Only

• Externally Applied Only

• Linear Wave Drift Damping Only

• Maneuvering Force Only

The sum of forces for each individual subtype will be shown in the graph. If all of the forces are
taken in combination, they will form the result available by the Total Force/Moment subtype. In
the case where the force is not included in the analysis the subtype will not be available for se-
lection.

Note:

When including drift effects, the Froude-Krylov Only excludes those calculated on dif-
fracting panels; instead, these are included under the Diffraction Forces.

These values are calculated at the center of gravity and are available in all translational and rota-
tional component directions.

Plot availability:

• Line graph presentation: Force/Moment plotted against Time

Line Graph Input:

Use the Component input to select which Structure Force/Moment component to plot, either
X, Y, or Z for force components or RX, RY, or RZ for rotational components.

Line Graph Output:

Maximum Value and Minimum Value of the Structure Force and the Time at which they occur
(Abscissa Position of Minimum, Abscissa Position of Maximum). These values can be paramet-
erized by selecting the adjacent check box.

5.12.2.2.6. Fender Forces

Result Description:

2D graphs to illustrate the fender forces during the analysis. You must select the Structure and
Connection to that structure (connected Fender) for which you want to display the results.

Plot availability:

• Line graph presentation: Force plotted against Time

Line Graph Input:

Use the Component input to select which Fender Force component to plot; either X, Y, or Z force
components, or one of the following: Total Force, Elastic Force, Damping Force, or Friction Force.

Line Graph Output:
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Maximum Value and Minimum Value of the Fender Force and the Time at which they occur
(Abscissa Position of Minimum, Abscissa Position of Maximum). These values can be paramet-
erized by selecting the adjacent check box.

5.12.2.2.7. Fender Motions

Result Description:

2D graphs to illustrate the fender motions during the analysis. You must select the Structure
and Connection to that structure (connected Fender) for which you want to display the results.

Plot Availability:

• Line graph presentation: Distance plotted against Time

Line Graph Input:

Use the Component input to select which Fender Motion to plot; either Compression, Horizontal
Movement, or Upward (Z) Movement.

Line Graph Output:

Maximum Value and Minimum Value of the Fender Motion and the Time at which they occur
(Abscissa Position of Minimum, Abscissa Position of Maximum). These values can be paramet-
erized by selecting the adjacent check box.

5.12.2.2.8. Joint Forces

Result Description:

2D graphs to illustrate the joint forces during the analysis. You must select the Structure and
Connection to that structure (connected Joint) for which you want to display the results.

Plot availability:

• Line graph presentation: Force/Moment plotted against Time

Line Graph Input:

Use the Component input to select which Joint Force component to plot; either X, Y, or Z force
components, or RX, RY, or RZ rotational components.

Line Graph Output:

Maximum Value and Minimum Value of the Joint Force and the Time at which they occur
(Abscissa Position of Minimum, Abscissa Position of Maximum). These values can be paramet-
erized by selecting the adjacent check box.

5.12.2.2.9. Cable Forces

The force components are available for each cable. For multi-segment catenary cables, section
tension is also available.

Result Description:
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2D graphs to illustrate cable tension during the analysis.

• Whole Cable Forces

• Cable Section Tension

Plot availability:

• Line graph presentation: Force or Tension plotted against Time

Line Graph Input:

• For Whole Cable Forces, use the Connection field to select which cable's characteristics to plot.
Use the Component input to select which Cable Force component to plot; either X, Y, or Z
force components, or Anchor Uplift, Tension, or Laid Length.

• For Cable Section Tension, use the Connection field to select which catenary cable's character-
istics to plot. Use the Cable Section field to select the Catenary Section for which you want
to plot section tension.

Line Graph Output:

Maximum Value and Minimum Value of Cable Force/Tension and the Time at which they occur
(Abscissa Position of Minimum, Abscissa Position of Maximum). These values can be paramet-
erized by selecting the adjacent check box.

5.12.2.2.10. Tether/Riser Motions

Result Description:

2D graphs to illustrate the variation in the following results of a tether/riser node during the
analysis:

• Displacement

• Velocity

• Acceleration

You must select the Structure and Connection to that structure (connected tether/riser) for
which you want to display the results.

Tether/Riser motion results are output in the Tether/Riser Local Axes (TLA), which are described
in Tethers/Risers (p. 107). As the TLA points from the Start Fixed Point to the End Connection Point
of the Tether/Riser, where the End Connection Point will be moving with its associated Structure,
the motions of the first and last nodes will always be zero.

Plot Availability:

• Line graph presentation: Result plotted against Time

Line Graph Input:
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Use the Tether/Riser Node input to select the node for which results will be displayed. Use the
Component input to select which tether/riser nodal result component to plot: either X or Y
translational components, or RX or RY rotational components.

Line Graph Output:

Maximum Value and Minimum Value of the tether/riser nodal result and the times at which
they occur (Abscissa Position of Minimum, Abscissa Position of Maximum). These values can
be parameterized by selecting the adjacent check box.

5.12.2.2.11. Tether/Riser Tensions

Result Description:

2D graphs to illustrate the following subtypes of the Tether/Riser Tensions during the analysis:

• Connection Point Tension

• Section Tension

• Nodal Tension

• Wall Tension

You must select the Structure and Connection to that structure (connected tether/riser) for
which you want to display the results.

Plot availability:

• Line graph presentation: Force plotted against Time

Line Graph Input:

The input required depends on the selected graph subtype.

For Connection Point Tension, no other input in required; the graph will display the Tether/Riser
tensions at the structure Connection Point.

For Section Tension, use the Tether Section input to select the section for which results will be
displayed.

For Nodal Tension, use the Tether/Riser Node input to select the node for which results will be
displayed. The definition elevation of the selected node is shown for reference.

For Wall Tension, use the Tether/Riser Element input to select an element along the tether, and
the Tether/Riser Element End input to select the end of that element for which results will be
displayed. The definition elevation of the selected element end is shown for reference.

Line Graph Output:

Maximum Value and Minimum Value of tether/riser tensions and the times at which they occur
(Abscissa Position of Minimum, Abscissa Position of Maximum). These values can be paramet-
erized by selecting the adjacent check box.
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5.12.2.2.12. Tether/Riser Shear Force/Bending Moment

Result Description:

2D graphs to illustrate the following subtypes of the Tether/Riser Shear Force/Bending Moment
during the analysis:

• Element Shear Force/Bending Moment

• Connection Point Shear Force/Bending Moment

You must select the Structure and Connection to that structure (connected tether/riser) for
which you want to display the results.

Plot availability:

• Line graph presentation: Force/Moment plotted against Time

Line Graph Input:

If the selected graph subtype is Element Shear Force/Bending Moment, use the Tether/Riser
Element input to select an element along the tether, and the Tether/Riser Element End input
to select the end of that element for which results will be displayed. The definition elevation of
the selected element end is shown for reference.

Regardless of the selected graph subtype, you should use the Component input to select which
Shear Force/Bending Moment component to plot: Local Tether/Riser X or Y for shear force com-
ponents, or Local Tether/Riser RX or RY for bending moment components.

Line Graph Output:

Maximum Value and Minimum Value of tether/riser shear forces/bending moments and the
times at which they occur (Abscissa Position of Minimum, Abscissa Position of Maximum).
These values can be parameterized by selecting the adjacent check box.

5.12.2.2.13. Tether/Riser Stresses

Result Description:

2D graphs to illustrate the following subtypes of the Tether/Riser Stresses during the analysis:

• Shear Stress

• Maximum Bending + Axial Stress

• Minimum Bending + Axial Stress

• Von Mises Stress

• Y Bending Stress

You must select the Structure and Connection to that structure (connected tether/riser) for
which you want to display the results.

Plot availability:
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• Line graph presentation: Stress plotted against Time

Line Graph Input:

Use the Tether/Riser Element input to select an element along the tether, and the Tether/Riser
Element End input to select the end of that element for which results will be displayed. The
definition elevation of the selected element end is shown for reference.

Line Graph Output:

Maximum Value and Minimum Value of tether/riser stresses and the times at which they occur
(Abscissa Position of Minimum, Abscissa Position of Maximum). These values can be paramet-
erized by selecting the adjacent check box.

5.12.2.2.14. Time Step Error

The movement error is graphed for each time step. The program outputs the movement error
at each time step in each degree of freedom which is related to the chosen time step. These errors
can always be reduced by shortening the time step.

Result Description:

2D graphs to illustrate the movement error per step during the analysis.

Plot availability:

• Line graph presentation: Movement Error plotted against Time

Line Graph Input:

None.

Line Graph Output:

Maximum Value and Minimum Value of Movement Error and the Time at which they occur
(Abscissa Position of Minimum, Abscissa Position of Maximum). These values can be paramet-
erized by selecting the adjacent check box.

5.12.2.3. Frequency Domain

A number of line graphs may be added under the Solution object of a Frequency Domain Analysis
system to illustrate the variation of different parameters with frequency. The following topics are
available:

5.12.2.3.1.Wave Spectra

5.12.2.3.2. Structure Response

5.12.2.3.3. Connection Response

5.12.2.3.1. Wave Spectra

Result Description:

2-D graphs to illustrate an input wave energy spectrum, over the range of frequencies assumed
or defined in an active Irregular Wave object, from the present analysis. Note that a Wave Spectrum
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may be plotted on the same axes as a Structure Position Response Spectrum by changing the
plot Type of an additional Line to Position Response Spectra.

Plot Availability:

• Line graph presentation: Spectral Density plotted against Frequency

The Frequency Scale can be modified to be Period Scale if required.

Line Graph Input:

• Use the Wave Spectrum Input to select an Irregular Wave spectrum to plot.

• If the selected Irregular Wave contains more than one sub-spectrum and/or Cross Swell Spec-
trum, the Spectrum Sub-Direction input should be used to select a specific sub-spectrum for
plotting.

Line Graph Output:

Maximum Value and Minimum Value of Spectral Density, and the Frequencies at which these
occur (Abscissa Position of Minimum, Abscissa Position of Maximum). These values can be
parameterized by selecting the adjacent check box.

5.12.2.3.2. Structure Response

Result Description:

2-D graphs to illustrate various structural force and motion responses over the range of frequencies
used in the present Frequency Statistical Analysis. The direction used for output of Motion RAOs
and Transfer Functions is that specified in Spectrum Sub-Direction of Output for RAOs under
Analysis Settings. Note that a Position Response Spectrum may be plotted on the same axes as
a Wave Spectrum by changing the plot Type of an additional Line to Wave Spectra, and a
Force/Moment Response Spectrum may be plotted on the same axes as a Joint Reaction Spectrum
by changing the plot Type of an additional Line to Joint Reaction Spectra.

Plot Availability:

• Line graph presentation: Response Amplitude Operator (RAO) plotted against Frequency

• Line graph presentation: Force/Moment Response Spectrum plotted against Frequency

• Line graph presentation: Position Response Spectrum plotted against Frequency

• Line graph presentation: Velocity Response Spectrum plotted against Frequency

• Line graph presentation: Acceleration Response Spectrum plotted against Frequency

• Line graph presentation: Transfer Function plotted against Frequency

The Frequency Scale can be modified to be Period Scale if required.

Line Graph Input:

• Use the Structure input to select a structure from the present analysis.
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• Use the Component input to select which component to plot: either X, Y, Z for forces/transla-
tions or RX, RY, RZ for moments/rotations.

• For translational Motion RAOs and translational Position/Velocity/Acceleration Response Spectra,
the Reference Point at which the result is reported can be the Center of Gravity of the selected
Structure, or can be any Connection Point on that structure. For the latter, the selected Con-
nection Point must have it Include in Results option set to Yes before the analysis is solved.

• Translational Motion RAOs and translational Position/Velocity/Acceleration Response Spectra
are typically reported for Motion Relative To the Origin of the Fixed Reference Axes (FRA).
However, when the Component is set to Global Z and the Reference Point is a Connection
Point, the translational RAO/Response Spectrum may instead be be reported relative to the
Wave Surface. Alternatively, if the Reference Point is a Connection Point and the Axis System
for Significant Motions and Nodal Response option under Analysis Settings is set to Local
Structure Axes, Motion Relative To can be set to the Origin of the Local Structure Axes (LSA).

Line Graph Output:

Maximum Value and Minimum Value of the selected Structure Response variable, and the Fre-
quencies at which these occur (Abscissa Position of Minimum, Abscissa Position of Maximum).
These values can be parameterized by selected the adjacent check box.

5.12.2.3.3. Connection Response

Result Description:

2-D graphs to illustrate forces and reactions in cables, fenders, and joints over the range of fre-
quencies used in the present Frequency Statistical Analysis. The direction used for output of Cable
Tension RAOs and Fender Force RAOs is that specified in Spectrum Sub-Direction of Output
for RAOs under Analysis Settings.

Plot Availability:

• Line graph presentation: Cable Tension Response Amplitude Operator (RAO) plotted against
Frequency

• Line graph presentation: Fender Force Response Amplitude Operator (RAO) plotted against
Frequency

• Line graph presentation: Joint Reaction Spectrum plotted against Frequency

The Frequency Scale can be modified to be Period Scale if required.

Line Graph Input:

• Use the Structure input to select a structure from the present analysis.

• Use the Connection input to select a valid connection for that structure.

• For Joint Reaction Spectra, use the Component input to select which component to plot: either
X, Y, Z for forces, or RX, RY, RZ for moments.

Line Graph Output:
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Maximum Value and Minimum Value of the selected Connection Response variable, and the
Frequencies at which these occur (Abscissa Position of Minimum, Abscissa Position of Maxim-
um). These values can be parameterized by selecting the adjacent check box.

5.12.2.4. Stability Response

Under the Solution object of a Stability Response analysis, a number of graphs will be available to
track the behavior of a number of parameters as they vary with each iteration step. The graphs are
all line graphs, and the following categories are available:

5.12.2.4.1. Structure Position

5.12.2.4.2. Structure Forces

5.12.2.4.3. Fender Forces

5.12.2.4.4. Fender Motions

5.12.2.4.5. Joint Forces

5.12.2.4.6. Cable Forces

5.12.2.4.7.Tether/Riser Tensions

5.12.2.4.8.Tether/Riser Shear Force/Bending Moment

5.12.2.4.9. Iteration Step Error

5.12.2.4.1. Structure Position

Result Description:

2D graphs to illustrate the Structure Position during the analysis.

These values are available in all translational and rotational component directions, and are calcu-
lated at the center of gravity or (translation components only) at a Connection Point on the se-
lected structure.

Plot availability:

• Line graph presentation: Distance/Rotation plotted against Iteration Step

Line Graph Input:

Use the Component input to select which Position component to plot, either X, Y, or Z for
translation or RX, RY, or RZ for rotation.

For a translation, the Reference Point at which the result is reported can be the Center of Gravity
of the selected Structure, or can be any Connection Point on that structure.

The Motion Relative To input can be used to set the frame of reference for the reported trans-
lation. This may be either the Origin of the Fixed Reference Axes (FRA), the Center of Gravity of
another structure, a Connection Point on another structure, or a Fixed Point.

Note:

For Hydrodynamic Equilibrium Results, the Connection Point Include in Results option
is not required for that Connection Point to be used as a Reference Point.
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Line Graph Output:

Initial Value and Final Value of Structure Position. These values can be parameterized by selecting
the adjacent check box.

5.12.2.4.2. Structure Forces

Result Description:

2D graphs to illustrate the following response subtypes of the Structure Forces during the analysis:

• All

• Mooring Sum Only

• Articulation Sum Only

• Morison Drag Only

• Drift Only

• Gravitational Only

• Current Drag Only

• Hydrostatic Only

• Wind Only

• Point Only

• Slender Body Only

• Externally Applied Only

The sum of forces for each individual subtype will be shown in the graph. If all of the forces are
taken in combination, they will form the result available by the All subtype. In the case where
the force is not included in the analysis (for example, Drift Forces, when drift is excluded) the
subtype will produce zero values.

Note:

When including drift effects, the Froude-Krylov Only excludes those calculated on dif-
fracting panels; instead, these are included under the Diffraction Forces.

These values are calculated at the center of gravity and are available in all translational and rota-
tional component directions.

Plot availability:

• Line graph presentation: Force/Moment plotted against Iteration Step

Line Graph Input:

221
Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Solution



Use the Component input to select which Structure Force/Moment component to plot, either
X, Y, or Z for force components or RX, RY, or RZ for rotational components.

Line Graph Output:

Initial Value and Final Value of the Structure Force. These values can be parameterized by se-
lecting the adjacent check box.

5.12.2.4.3. Fender Forces

Result Description:

2D graphs to illustrate the fender forces during the analysis. You must select the Structure and
Connection to that structure (connected Fender) for which you want to display the results.

Plot availability:

• Line graph presentation: Force plotted against Iteration Step

Line Graph Input:

Use the Component input to select which Fender Force component to plot; either X, Y, or Z force
components, or one of the following: Total Force, Elastic Force, Damping Force, or Friction Force.

Line Graph Output:

Initial Value and Final Value of the Fender Force. These values can be parameterized by selecting
the adjacent check box.

5.12.2.4.4. Fender Motions

Result Description:

2D graphs to illustrate the fender motions during the analysis. You must select the Structure
and Connection to that structure (connected Fender) for which you want to display the results.

Plot Availability:

• Line graph presentation: Distance plotted against Iteration Step

Line Graph Input:

Use the Component input to select which Fender Force component to plot; either Compression,
Horizontal Movement, or Upward (Z) Movement.

Line Graph Output:

Initial Value and Final Value of the Fender Motion. These values can be parameterized by se-
lecting the adjacent check box.

5.12.2.4.5. Joint Forces

Result Description:

Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.222

Aqwa Approach



2D graphs to illustrate the joint forces during the analysis. You must select the Structure and
Connection to that structure (connected Joint) for which you want to display the results.

Plot availability:

• Line graph presentation: Force/Moment plotted against Iteration Step

Line Graph Input:

Use the Component input to select which Joint Force component to plot; either X, Y, or Z force
components, or RX, RY, or RZ rotational components.

Line Graph Output:

Initial Value and Final Value of the Joint Force. These values can be parameterized by selecting
the adjacent check box.

5.12.2.4.6. Cable Forces

The force components are available for each cable. For catenary cables sections, section tension
is also available.

Result Description:

2D graphs to illustrate cable tension during the analysis.

• Whole Cable Forces

• Cable Section Tension

Plot availability:

• Line graph presentation: Force or Tension plotted against Iteration Step

Line Graph Input:

• For Whole Cable Forces, use the Connection field to select which cable's characteristics to plot.
Use the Component input to select which Cable Force component to plot; either X, Y, or Z
force components, or Anchor Uplift, Tension, or Laid Length.

• For Cable Section Tension, use the Connection field to select which catenary cable's character-
istics to plot. Use the Cable Section field to select the Catenary Section for which you want
to plot section tension.

Line Graph Output:

Initial Value and Final Value of Cable Force/Tension. These values can be parameterized by se-
lecting the adjacent check box.

5.12.2.4.7. Tether/Riser Tensions

Result Description:

2D graphs to illustrate the following subtypes of the Tether/Riser Tensions during the analysis:
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• Connection Point Tension

• Section Tension

You must select the Structure and Connection to that structure (connected tether/riser) for
which you want to display the results.

Plot availability:

• Line graph presentation: Force plotted against Iteration Step

Line Graph Input:

The input required depends on the selected graph subtype.

For Connection Point Tension, no other input in required; the graph will display the Tether/Riser
tensions at the structure Connection Point.

For Section Tension, use the Tether Section input to select the section for which results will be
displayed.

Line Graph Output:

Initial Value and Final Value of Tether/Riser tensions. These values can be parameterized by
selecting the adjacent check box.

5.12.2.4.8. Tether/Riser Shear Force/Bending Moment

Result Description:

2D graphs to illustrate the Tether/Riser Shear Force/Bending Moment at the structure Connection
Point during the analysis.

You must select the Structure and Connection to that structure (connected tether/riser) for
which you want to display the results.

Plot availability:

• Line graph presentation: Force/Moment plotted against Iteration Step

Line Graph Input:

Use the Component input to select which Connection Point Shear Force/Bending Moment
component to plot: Local Tether/Riser X or Y for shear force components, or Local Tether/Riser
RX or RY for bending moment components.

Line Graph Output:

Initial Value and Final Value of Tether/Riser shear forces/bending moments. These values can
be parameterized by selecting the adjacent check box.
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5.12.2.4.9. Iteration Step Error

The ratio of movement at each iterative step to the maximum allowable error is graphed for each
iteration step. These errors can always be reduced by decreasing the Movement Limitation or
increasing the Maximum Error in Equilibrium Position.

Result Description:

2D graphs to illustrate the relative error per step during the analysis.

Plot availability:

• Line graph presentation: Relative Error plotted against Iteration Step

Line Graph Input:

None.

Line Graph Output:

Initial Value and Final Value of Relative Error. These values can be parameterized by selecting
the adjacent check box.

5.12.3. Frequency Domain Tabular Results

Frequency Domain Statistics allows you to view text statistics in the graphical view for a Frequency
Statistical Analysis (p. 140).

Statistics are available by clicking the Properties tab at the bottom of the graphical view.

In the Details panel, select the Statistical Measure that you would like to display. By default, each
statistic shown will be a Significant Value (Amplitude); alternatively, each value can be scaled as a
Probable Maximum, a Median Maximum, an Expected Extreme, or a Percentile Extreme. The scaling
requires a Duration for Maximum Value Estimates to be defined, and when you choose to display
each statistic as a Percentile Extreme, the Percentile must also be specified. The Calculated Zero
Crossing Period is automatically determined from the Irregular Wave spectra defined for the analysis.
See Significant Value Calculation in the Aqwa Theory Manual for more information.

Note:

• Statistical values are calculated under the assumption that the corresponding response
spectra are Rayleigh-distributed, and that the zero crossing period of the response is
similar to the zero crossing period of the defined Irregular Wave spectrum.

• The zero crossing period calculated by Aqwa may not match the zero crossing period
defined within an Irregular Wave, because the wave spectrum may not exactly fit a
Rayleigh distribution.

Next, select a Result Type in one of the Result A-E fields. You can select from Motions, Joint Reactions,
Cable Forces, or Fender Forces.
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Each of the Result A-E sets includes a Result Source selection. Where there are multiple Frequency
Statistical Analysis systems in the Outline tree, you may select any as a Result Source for the current
Result Set. This allows results from similar Frequency Statistical Analyses – for example, structure
significant motions under different environments – to be compared in the same table of statistics.

When a result type is selected, the Result object will expand with further information in the Details
panel.

For a Motions result, select an active Structure from the current model and a Reference Point on
the structure where the results should be reported.

If the Reference Point is a Connection Point, you may use the Motion Relative To field to specify
whether the motions are relative to the Wave Surface. Otherwise, the motions will be reported in the
axis system defined by the Axis System for Motion Statistics and Nodal Response option in Ana-
lysis Settings. In addition to the conventional motion properties, the statistical values of the transla-
tional effective acceleration are also reported (see 27.4. The ALLM Data Record - All Motions). If the
data is not available in the Aqwa database (due to the resumption of a previous Aqwa Workbench
project or removing the ACEF option), N/A will be displayed both in the table in the graphical window
and the Property View of the current solution in the Aqwa Editor. In the former case, users need to
solve the solution again to access these values.

For Joint Reactions, Cable Forces, and Fender Forces, you should specify a Joint, Cable, or Fender
from the current model, respectively.
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Results also appear in the Properties view, and are included in the text summary of the report.

Note:

You can include any of the results in your design points by clicking the check box next to
the result in the Details panel. However, output values can only be parameterized when
their Result Source is defined as the current analysis system.

Caution:

When the selected Result Type is Motions, and the selected Reference Point is a Connec-
tion Point, the Include in Results option for that Connection Point must be set to Yes
before the analysis is performed. Connection Points for which the Include in Results option
is set to No are not available for use as a result Reference Point in a Frequency Domain
analysis.

5.12.4. Pressures and Motions Results

The Pressures and Motions results object enables the visualization and display of a number of results
generated from Aqwa once a hydrodynamic solve has been performed. Any number of Pressures and
Motions results may be added.

Note:

If the associated Analysis Settings (p. 130) option Generate Wave Grid Pressures is
set to No, the wave surface, and any results related to it, are not available in the
Pressures and Motions result.

You must define the structures (Parts (p. 54)) that are shown in the result. The Structure Selection
field provides a dropdown list that allows you to select any of the Interacting Structure Groups (p. 143),
or structures that do not belong to an interacting group, in the Hydrodynamic Diffraction analysis.
An individual structure must have at least one diffracting panel element to be a valid selection.
Pressures and Motions results are not relevant for structures consisting only of Morison elements.

The Frequency  (p. 145) and Direction  (p. 144) options allow you to select a Frequency and Direction
from those defined in the Hydrodynamic Diffraction Wave Frequencies and Wave Directions objects.
If you have only a single Frequency or Direction defined, the corresponding field becomes read-only,
and is automatically updated if the single Frequency or Direction is modified.

The Incident Wave Amplitude can be modified to provide results that are factored from the unit
amplitude wave that is the default; extreme modification may extend results beyond the capabilities
of a linear analysis, in which case inaccurate results can be produced.

The Result Type can be defined as:

• Phase Angle, where an equivalent phase position of the incident wave component can be se-
lected (or is shown in the graph as the time as a proportion of wave period if a sequence is
chosen)

• Amplitude
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• Maximum value of the selected result

• Minimum value of the selected result

When Phase Angle is selected, Wave Position (Phase) can be set to 0° (t/T = 0) or 90° (t/T = 0.25),
or you can enter a specified phase position (in rotation units), or select a sequence of results for an-
imation. If a sequence of results is selected, then the Number of Steps can be selected.

If you select a sequence of results for animation, after you evaluate the Pressures and Motions results
(right-click the object and select Evaluate All Results), controls appear that allow you to start, pause,
and stop the animation. If a particular result is required from the animated set, click the graph to
display it. Other controls on the graph allow you to change the time over which the animation occurs
and create an .avi animation file.

Under the Contour Selection section of the Details panel, the Contour Type field allows you to select
which results are plotted over the structure or water surface mesh. This field can be defined as:

• Structure Interpolated Pressure

• Structure Panel Pressure

• Wave Surface Elevation (requires Generate Wave Grid Pressures to be set to Yes)

• Structure Air Gap (requires Generate Wave Grid Pressures to be set to Yes)

• Structure Motion Amplitude

Structure Interpolated Pressure displays element pressures which are interpolated from the nodal
pressures calculated by Aqwa. This produces a smoothly-varying contour plot. Conversely, Structure
Panel Pressure shows the pressures at the element centroids, and can be directly compared with
results in Mechanical once a load transfer procedure has been completed (see The Hydrodynamic
Pressure Add-on (p. 273) for more information). When plotting Structure Interpolated Pressure or
Structure Panel Pressure, you can use the Pressure Measurement option to change the reported
results between Head of Water and Force/Area.
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Structure Air Gap plots the vertical distance between the sea surface and any point on the structure,
with negative values at a given position indicating that this position is immersed. The contour legend
can be adjusted to display a solid color above or below a given value, as shown in the following figure.
Air Gaps can only be displayed for a Result Type of Minimum, Maximum, or Phase Angle.
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Structure Motion Amplitude displays the displacement or any position on the structure, as interpolated
from the nodal displacements calculated by Aqwa. Motion Amplitudes can only be displayed for a
Result Type of Phase Angle.

When plotting Structure Interpolated Pressure, Structure Panel Pressure, Structure Air Gap, or Structure
Motion Amplitude, and the Result Type is set to Phase Angle, the position of the wave surface is
plotted by default. To hide the waves, the Water Elements Shown As option can be changed from
Opaque to Dimmed.

When plotting Structure Interpolated Pressure or Structure Panel Pressure, the non-diffracting panel
elements are shown with zero pressure values by default. To hide the non-diffracting panels, the Non-
Diffracting Elements Shown As option can be changed from Opaque to Dimmed.

Wave Surface Elevation plots the vertical position of the wave surface. In the figure below, plotting
the Amplitude of the Wave Surface Elevation highlights the shielding effect of the structures in the
lee of the oncoming wave; Mesh Element Outcomes Off is set to provide a clearer image.
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When plotting Wave Surface Elevation, the structure mesh is hidden by default. To show the structure,
the Structure Elements Shown As option can be changed from Dimmed to Opaque.

When plotting Structure Interpolated Pressure, Structure Panel Pressure, Wave Surface Elevation, or
Structure Air Gap, where the Result Type is set to Phase Angle and the Display RAO-Based Motions
option is set to Yes, the RAO-based motion of the structure at the defined phase angle (or sequence
of phase angles) is included in the graphical display. While this option is turned on, the wave mesh
extends throughout the structure; however, the results that are presented within dry areas are not
accurate. Setting the Display RAO-Based Motions option to No fixes the structure in its geometric
definition position, and hides any wave mesh that lies inside the structure, except for any Moonpool
free surface elements.

Note:

The Display RAO-Based Motions option is automatically set to No, and cannot be changed,
when the Pressures and Motions Structure Selection includes structures with Moonpools.

When plotting Structure Motion Amplitude, the RAO-based motion of the structure is always displayed
and the wave surface is always hidden.

Any combination of wave components can be included in the reported results (exceptions are described
in the following notes). To display a particular component, set its corresponding field in the Component
Selection section of the Details panel to Yes:

• Include Incident Wave

• Include Diffracted Wave
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• Include Radiation Wave

• Include Hydrostatic Varying

• Include Second Order Terms

Note:

The Hydrostatic Varying component is only applicable for Structure Interpolated Pressure
and Structure Panel Pressure results.

Second Order Terms are only applicable for Wave Surface Elevation and Structure Air Gap
results, and cannot be included if a Forward Speed has been defined in Wave Directions.
For Structure Air Gap results, Second Order Terms refers only to the wave surface; the
structure motion is always linear in this context.

When plotting Structure Air Gap or Structure Motion Amplitude results, the Incident, Dif-
fracted, and Radiation terms are always included.

The wave mesh size can be altered via the Analysis Settings (p. 129), Wave Grid Size Factor setting.

The Minimum Value and Maximum Value of the results are shown and can be parameterized.

Once the Pressures and Motions result has been evaluated, you can export data into a comma-separ-
ated values (.CSV) file using the Export to CSV File option. For results of Structure Interpolated
Pressure, Structure Panel Pressure, Wave Surface Elevation, and Structure Air Gap, when the Result
Type is set to Phase Angle and the Wave Position (Phase) is set to Sequence, you can also set Export
Phase Angle to define the wave position for which results will be exported.

The content of the exported file depends on the Contour Type, as described below:

Structure Interpolated Pressure

The .CSV file contains a row for each panel node on the selected structure(s), and has the following
columns:

• Part name

• Surface Body name

• Structure node position (X, Y, Z coordinates)

• Total nodal pressure

Structure Panel Pressure

The .CSV file contains a row for each panel element on the selected structure(s), and has the
following columns:

• Part name

• Surface Body name

• Element centroid position (X, Y, Z coordinates)
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• Unit normal vector (X, Y, Z components) for the element orientation

• Element area

• Total element pressure

Wave Surface Elevation

The .CSV file contains a row for each water surface node on the selected structure(s), and has
the following columns:

• Part name

• Water node position (X, Y, Z coordinates)

• Total wave surface elevation

Structure Air Gap

The .CSV file contains a row for each panel node on the selected structure(s), and has the following
columns:

• Part name

• Surface Body name

• Structure node position (X, Y, Z coordinates)

• Total air gap to wave surface

Structure Motion Amplitude

The .CSV file contains a row for each panel node on the selected structure(s), and has the following
columns:

• Part name

• Surface Body name

• Structure node position (X, Y, Z coordinates)

• Total nodal motion, real part (X, Y, Z components)

• Total nodal motion, imaginary part (X, Y, Z components)

5.12.5. Internal Tank Pressures Results

The Internal Tank Pressures results object enables the visualization and display of a number of results
generated from Aqwa once a hydrodynamic solve has been performed. Any number of Internal Tank
Pressures results may be added.

You must define the Internal Tanks (p. 64) that are included in the result. The Internal Tank Selection
field provides a dropdown list that allows you to select any of the Internal Tanks in the Geometry, or
you can select a Part for which all of the associated Internal Tanks will be displayed.
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The Frequency and Direction options allow you to select from those defined in the Hydrodynamic
Diffraction Wave Frequencies (p. 145) and Wave Directions (p. 144) objects. If you have only a single
Wave Frequency or Direction defined in the Hydrodynamic Diffraction analysis, the corresponding
field in the Internal Tank Pressures result becomes read-only, and is automatically updated if the
single Wave Frequency or Direction is modified.

The Incident Wave Amplitude can be modified to provide results that are factored from the unit
amplitude wave that is the default; extreme modification may extend results beyond the capabilities
of a linear analysis, in which case inaccurate results can be produced.

The Result Type can be defined as:

• Phase Angle, where an equivalent phase position of the incident wave component can be selected
(or is shown in the graph as the time as a proportion of wave period if a sequence is chosen)

• Maximum value of the selected result

• Minimum value of the selected result

When Phase Angle is selected, Wave Position (Phase) can be set to 0° (t/T = 0) or 90° (t/T = 0.25),
or you can enter a specified phase position (in rotation units), or select a sequence of results for an-
imation. If a sequence of results is selected, then the Number of Steps can be selected.

If you select a sequence of results for animation, after you evaluate the Internal Tank Pressures results
(right-click the object and select Evaluate All Results), controls appear that allow you to start, pause,
and stop the animation. If a particular result is required from the animated set, click the graph to
display it. Other controls on the graph allow you to change the time over which the animation occurs
and create an .avi animation file.

Under the Contour Selection section of the Details panel, the Contour Type field allows you to select
which results are plotted over the internal tank surface mesh. This field can be defined as:

• Internal Tank Interpolated Pressure

• Internal Tank Panel Pressure

Internal Tank Interpolated Pressure displays element pressures which are interpolated from the nodal
pressures calculated by Aqwa. This produces a smoothly-varying contour plot. Conversely, Internal
Tank Panel Pressure shows the pressures at the element centroids. You can use the Pressure Meas-
urement option to change the reported results between Head of Internal Fluid and Force/Area.

Note:

The Pressure Measurement option is restricted to Force/Area when results are displayed
for multiple Internal Tanks with different internal fluid densities.
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The parts of the structure that do not constitute the Internal Tank(s) selected for display are shown
with a high transparency, by default. To modify this, you can change the Structure Elements Shown
As option from Dimmed to Opaque.

Any combination of radiated or hydrostatic-varying internal fluid pressure components can be included
in the reported results. To display a particular component, set its corresponding field in the Component
Selection section of the Details panel to Yes:

• Include Radiation Wave

• Include Hydrostatic Varying

The Minimum Value and Maximum Value of the results are shown and can be parameterized.

Once the Internal Tank Pressures result has been evaluated, you can export data into a comma-sep-
arated values (.CSV) file using the Export to CSV File option. The content of the exported file depends
on the Contour Type, as described below:

Internal Tank Interpolated Pressure

The .CSV file contains a row for each panel node on the selected internal tank(s), and has the
following columns:

• Part name

• Surface Body name

• Structure node position (X, Y, Z coordinates)
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• Hydrostatic pressure, real and imaginary parts

• Radiation pressure, real and imaginary parts

Internal Tank Panel Pressure

The .CSV file contains a row for each panel element on the selected internal tank(s), and has the
following columns:

• Part name

• Surface Body name

• Element centroid position (X, Y, Z coordinates)

• Unit normal vector (X, Y, Z components) for the element orientation

• Element area

• Hydrostatic pressure, real and imaginary parts

• Radiation pressure, real and imaginary parts

5.12.6. Animation Results

Structural motions may be animated either in time for a Time Response Analysis or by iteration step
for a Stability Analysis. The Animation results object allows you to view an animation of the motion
of the parts in your project over the entire analysis period. This feature is particularly useful for ob-
serving the interaction between marine structures and the motion of waves. You can insert the Anim-
ation object into the tree before or after running the analysis. Only one of these results can be added
to an analysis.

The controls described in Animation Controls (p. 237) allow you to start and pause the animation,
change the portion of the animation that plays, and create an AVI movie file. For Equilibrium Motion
Results, each iteration is depicted as 1 second in the control panel.
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5.12.6.1. Animation Controls

Below is a table enlisting the available controls for animations in Aqwa Workbench and their function:

Table 5.3: Animation Controls

DescriptionControl

Play the animation from the current time

Pause the animation

Enter the time at which to start the animation for viewing or video
export

Current Time (a slider to the
right of the field can be used
instead)

Start the video export

Play or export every Nth animation frameFrame Increment

To export a video of all or part of an animation set Current Time. Then click the video export icon
to begin the recording. A dialog box will appear asking you to provide a file name and browse to
the location where you want to save the file. The Video Running Time text box displays the length
of the video currently being recorded. The video export button changes to a red dot to indicate
that recording is in progress. You can click the red dot icon to stop recording. You can pause or
resume recording by clicking the play and pause animation button on the left. The recording will
automatically end when the animation is complete.

Note:

When entering time into the animation toolbar fields, you must press the Enter key
before leaving the field in order to set the value.

The animation must be stopped in order to export a video. If you try to export a video
while the animation is playing on the screen, nothing will happen.

5.12.6.2. Animation Settings

There is a collection of settings available in the Details panel, which enables you to determine the
outcome of your animation:

Name

This enables you to modify the name of your animation. This helps to keep track of animation objects
in the Outline tree.
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Show Incident Wave Surface

This setting enables you to include or remove the entire water body, together with the motion of
waves, in your animation by selecting either Yes or No.

Wave Palette

This setting enables you to change the gradient color scheme of the waves surrounding the marine
structure, based on your preference. The available options include:

• Blue-Grey

• Blue-Green

• Green-Grey

• Dark Blue

Wave Surface Resolution

This setting enables you to change the resolution of the animation. The available options include:

• Fine

• Medium

• Coarse

Fine or Medium is suitable for high-speed computers. If your computer's speed is limited, you may
have to change your resolution from Fine or Medium to Coarse. This should help the animation
run smoother in situations where the motion appears to lag.

Note:

If you add a new animation to a different Time-Domain Hydrodynamic Response calcu-
lation, the Wave Palette defaults to Blue-Grey and the Wave Surface Resolution defaults
to Medium. However, you can create alternative default settings by following this path:
Edit > Options > Aqwa > Animation.

5.12.7. Dynamic Natural Modes

The natural frequencies of a system of one or more structures can be found using the Natural Modes
result object.

When a Natural Modes result is added to a Hydrodynamic Diffraction analysis, natural modes are
determined for individual freely-floating structures or groups of hydrodynamically-interacting structures
in their positions as defined in the geometry editor. The effects of Connections (Cables, Joints, Tethers,
Fenders and Connection Stiffness matrices) are not included, and any Motion Locks applied to hydro-
dynamic interaction groups are ignored.

When a Natural Modes result is added to a Hydrodynamic Response stability analysis, the natural
modes are determined for the entire system of structures, including their connections and the effects
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of any defined environment (Wind, Current, drift due to Irregular Waves, etc). Structures are moved
into their equilibrium positions, as calculated during the stability analysis, before the natural modes
calculation is performed.

Note:

If you are resuming a Workbench project created in previous releases, where the Hydro-
dynamic Diffraction Solution is in a solved state and where the Hydrodynamic Diffraction
analysis did not include Shear Forces/Bending Moments or Linearized Morison Drag, you
will need to Clear Generated Data before you can add a Natural Modes result to the Hydro-
dynamic Diffraction Solution.

Figure 5.15: Natural Modes Result Object

As Natural Modes depend on frequency-dependent Added Mass and Damping, a direct calculation
of the eigenvalues and the eigenmodes of a single matrix is not possible. Instead, the following
method is used:

Aqwa scans a range of input frequencies and solves the eigenvalue problem based on Added Mass
and Damping values for the current scanning frequency, which yields a list of pairs of eigenmodes
and their corresponding frequency. Aqwa discards the modes in which the frequency does not match
the scanning frequency and retains the matching modes as actual physical modes.
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Figure 5.16: Mode Match Indicator

In order to provide you with an immediate view on the quality of the search, the results listed under
the Monitor tab of the output window contain a graph of Mode Match Indicator vs. Scanning Fre-
quency. This indicator, calculated for each scanning frequency, is the difference between the scanning
frequency and the closest frequency found when solving the eigenvalue problem using Added Mass
and Damping values associated with the scanning frequency. A match is obtained where this indicator
reaches a local minimum below a certain tolerance. This tolerance is adaptive, complex, and depends
(among other things) on the local resolution of the scan.

The local resolution of the scan is also adaptive, and based on the value of the match indicator calcu-
lated at the previous scanning point. It is limited by the Maximum Relative Precision parameter in
the Details panel when Use Advanced Options is on.

The start and end frequency of the range may be controlled using the Use Advanced Options field.

Figure 5.17: Natural Modes Advanced Options

Underneath the Mode Match Indicator graph, the list of the retained Natural Modes is displayed.
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The values for the amplitudes are highlighted with a color depending on the value, allowing for
easier visual identification of the leading degree of freedom. Next to the mode, an Animate button
allows you to visualize the motions of the structures corresponding to the natural mode in the geo-
metry window. The Scroll Back to Graph button allows you to navigate back to the top of the page
easily. By clicking the dot moving along the curve displayed on the graph, you can easily navigate
to the mode with frequency closest to the clicked point's abscissa. You can zoom the graph by selecting
a portion of the graph with click and drag. You can zoom out by double-clicking the left mouse
button.

Figure 5.18: Mode List with Animation

5.12.8. Time Domain Statistical Results

Time Domain Statistics allow you to view statistics and probability distributions for a Time Response
Analysis (p. 135).

By default, statistics are calculated over the Full Time Series (all the steps) in the time response ana-
lysis. Changing the Statistics Calculated Over setting to Cropped Time Series allows you to specify
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Cropping from Start of Time Series and Cropping from End of Time Series times. The calculated
statistics will then be restricted to this time frame.

In the Details panel, select a Result Type in one of the Result A-E fields. You can select from any
quantity which has been calculated in the time response analysis, such as Wave Surface Elevation,
Structure Motions and Forces, Connection Forces, Tether/Riser Properties, or Time Step Error.

Each of the Result A-E sets includes a Result Source selection. Where there are multiple Time Response
Analysis systems in the Outline tree, you may select any as a Result Source for the current Result Set.
This allows results from similar Time Response Analyses – for example, cable tension statistics under
different environments – to be compared in the same table of probability distributions.

When a result type is selected, the Result object expands with further information in the Details
panel.

Note:

You can include any of the results in your design points by clicking the check box next to
the result in the Details panel. However, output values can only be parameterized when
their Result Source is defined as the current analysis system.

If you wish to calculate statistics for the translation motion of the structure, the Reference Point at
which the result is reported can be the Center of Gravity of the selected Structure, or any Connection
Point on that structure.

Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.242

Aqwa Approach



The Motion Relative To input can be used to set the frame of reference for the reported translation
motion. This may either be the Origin of the Fixed Reference Axes (FRA), the Center of Gravity of an-
other structure, a Connection Point on another structure, or a Fixed Point.

Note:

When the Type is set to Structure Position, the SubType is set to Actual Response, the
Component is set to Global Z, and the Reference Point is a Connection Point, the result
may also be reported relative to the Wave Surface.

The selected Connection Point must have its Include in Results option set to Yes before
the analysis is solved.

Probability Density Functions are available by clicking the Properties tab at the bottom of the
graphical view. The distributions are shown as histograms, where the number of bins for each histogram
is automatically determined as a function of the number of time steps. Mean and standard deviations
are plotted as dot-dashed and dashed lines, respectively.

You can also use the Statistics Shown As setting to optionally plot these histograms as Cumulative
Distribution Functions.
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5.12.9. Time Domain Pressures Results

The Time Domain Pressures results object enables the display of the instantaneous internal tank
and external hull surface pressures generated by Aqwa, during a time domain response analysis in
which the Hydrodynamic Response Analysis Settings option Analysis Type is set to Irregular Wave
Response or Regular Wave Response. Any number of Time Domain Pressures results may be added.

The Time Domain Pressures result shows the pressures at the element centroids, and can be directly
compared with results in Mechanical once a load transfer procedure has been completed (see The
Hydrodynamic Pressure Mapping Add-On (p. 273) for more information).

When there is more than one structure in the model and Output for Structure is set to All Structures
in the Analysis Settings, the Structure dropdown list allows you to select the structure(s) that should
be shown in the Time Domain Pressures result. The Structure field will be read-only if there is only
one structure for which time domain pressures are being calculated.

The Display Pressures At option can be defined as:

• Single Time Step - select a single Output Time at which pressures will be displayed.

• Multiple Time Steps (Animation) – select an Output Start Time and Output Finish Time to define
the start and finish times for an animation of time domain structure motions and panel pressures.
The Number of Steps field is automatically updated to indicate the number of frames that will be
displayed in the animation.

Note:

The Output Time, Output Start Time, and Output Finish Time fields are automatically
adjusted to be within the range of the Hydrodynamic Response Analysis Settings Output
Start Time and Output Finish Time, and are rounded to the nearest whole number of
Output Step intervals.

When the Display Pressure At option is set to Multiple Time Steps (Animation), and once you have
evaluated the Time Domain Pressures results (right-click the object and select Evaluate All Results),
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controls appear that allow you to start, pause, and stop the animation. You can click the wave elevation
timeline to display results at a particular instant. Other controls allow you to change the speed of the
animation, and to create a .avi animation file from the current frames.

Under the Contour Selection section of the Details panel, the read-only Contour Type field indicates
that Structure Panel Pressure will be displayed. You can use the Pressure Measurement option to
change the reported results between Head of Water and Force/Area. You may choose to set Mesh
Element Outlines Off from the graphical toolbar to provide a clearer image.

The combination of wave components included in the reported results is indicated in the Component
Selection section of the Details panel. Incident, Diffracted, Radiation, and Hydrostatic components
are always included in the Time Domain Pressures result.

The Maximum Value of the results are shown, and where Display Pressures At is set to Multiple
Time Steps (Animation), the Time of Maximum Value is also provided. Both of these fields can be
parameterized.

Once the Time Domain Pressures result has been evaluated, you can export pressure data into a
comma-separated values (.CSV) file using the Export Panel Pressures to CSV File option. From the
range of times defined in the Result Selection details, set Export at Time to define the time at which
panel pressures will be output; Export to Time will be read-only if Display Pressures At is set to
Single Time Step. The Export to Time field is automatically adjusted to the nearest whole number
of Output Step intervals. The .CSV file contains a row for each panel element on the selected
structure(s), and has the following columns:

• Part name
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• Surface Body name

• Element number

• Instantaneous position (X, Y, Z) of the element centroid

• Instantaneous unit normal vector (X, Y, Z) for the element orientation

• Element area

• Instantaneous total pressure (sum incident, diffracted, radiation and hydrostatic components)

5.13. Aqwa Model Data Import

The Hydrodynamics systems in Workbench support the import of data from Aqwa models defined using
the Aqwa solver input format contained in files with the .DAT extension. The syntax for this format is
described in the Aqwa Reference Manual.

An Aqwa .DAT file is divided into a number of sections, called data categories, which contain the in-
formation needed by the solver to perform an analysis. The Workbench Aqwa editor is capable of
reading some of that information in order to create the corresponding objects in the Workbench project's
Outline tree.

To import data from an Aqwa solver input file:

1. Create a new Workbench project and add a Hydrodynamic Diffraction system, and any linked Hydro-
dynamic Response systems as required, to the Project Schematic.
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2. Attach a geometry, or a dummy geometry, to the system and open the Aqwa editor.

Note:

To import the Aqwa solver input file, a dummy geometry is required if there is no geometry
in the project. This dummy geometry may be suppressed if not required in the subsequent
analysis.

3. In the Outline tree, select the branch under which you want to add the objects corresponding to
the information you want to import from the file. Right-click the branch and select Insert from Aqwa
Model Data File.

Browse to the file containing the information you want to import and select it. The program then
loads the input file, analyzes its contents, and selects the part of the contents which are relevant in
the context of the selected tree item. In this example the tree object is Connections, which can import
Cables, Joints, and Fenders. It then creates objects in the tree that correspond to the data in the
file.
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Note:

The Aqwa solver input file does not specify units. Be sure that the Hydrodynamic Solver
Unit System selected in the Details of your Project are appropriate for the model you are
importing.

4. In the example given of Insert from Aqwa Model Data File in the Connections object, the created
items are shown as incomplete. Looking at their details shows that some information is missing:

The information was missing from the input file used.

5. Once you have added the missing information to the Catenary Sections, the objects show as up-to-
date.
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The cables are still showing as incomplete. Looking at their details shows that the connection points
are undefined.
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The connection points are undefined because the import was initiated from the Connections object
in the Outline tree, which does not include the Geometry branch where the attachment points have
to be defined. Selecting a particular tree item for initiating the import operation allows you to select
which part of that information you want to include or to exclude from the process. The table below
summarizes the extent of the import depending on the tree item selected at the start of the process.

Objects Added to the TreeInformation Read from the
Input File

OutlineTree
Object Selected
when Starting
The Import
process

All items as listed in the column below, with the
following differences:

All Items in the column
below.

Project/Model

Cable/Fender/Joint/Force definitions, with  the
corresponding Connection Points on structures
and Fixed Points, as well as full catenary
definitions (type of catenary, buoys, clump
weights).

If there are multiple hydrodynamic systems in your
project, objects created (imported) under Project
or Model are duplicated for each analysis as the
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program has no way of deciding to which specific
analysis they should belong.

Parts, Bodies, Point Masses, Point Buoyancies, Wind
Force Coefficients, Current Force Coefficients.

Nodes, elements and
structures.

Geometry

Cable/Fender/Joint, without  the corresponding
Connection Points on structures and Fixed Points,
and without fender and joint axis directions.

Cable, Catenary, Fender, and
Joint definitions.

Connections

Catenary definitions (type of Catenary, Buoy, Clump
Weight).

Catenary definitions.Connection Data

Cable Failure. Cable Winch. Point Force of constant
magnitude and direction. Current, Wind, and Wave
objects. Deactivated Freedoms.

Winch; Cable Failure; Point
Force of constant magnitude
and direction; Current, Wind,

Analysis

and Wave definitions (either
regular or irregular);
Deactivated Freedoms.

Note:

• New parts created through importing Geometry information cannot be shared with any
other Ansys system by using a link between the Geometry cells on the schematic. Any
non-Aqwa downstream system added on the Workbench schematic will be unable to see
them. Also, their mesh is fixed and cannot be modified as it corresponds always to the
panels defined in the original input file.

• If the imported Current and Wind Force Coefficients matrices are defined as symmetrical
in the Aqwa data file, the corresponding table entries will be filled out in the Workbench
system objects.

• Importing the information at the Project level implies that the input files contains all the
corresponding data categories. This is possible if the imported Aqwa model data file covers
the analysis stages 1 to 5. Since the Aqwa solver allows the analysis stages to be split over
several files (for instance a first file containing the definitions for the analysis stages 1 to
3, and a second file covering stages 4 to 5), you may either merge these multiple files into
one single file in order to import all of the information at once, or import one file for the
analysis stages 1 to 3 and add another file for the analysis stages 4 to 5 by clicking Yes in
the dialog and selecting the second import file.
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Chapter 6: Aqwa Workbench Interface
Hydrodynamic analysis systems are available to place on the Workbench Project Schematic from the
Toolbox. After configuring the connections to/from the Hydrodynamic analysis systems and/or any inputs
to the systems, you will open the Aqwa Editor to perform the analysis and view the results of the Hy-
drodynamic analysis system. This chapter discusses how to place and configure your analysis system
on the Project Schematic and describes the User Interface of the Aqwa Editor. The topics covered are:

6.1.The Aqwa Editor User Interface

6.2. Editing Objects

6.3. Displayed Positions and Features

6.4. Setting Aqwa Application Options

6.1. The Aqwa Editor User Interface

Hydrodynamic analysis systems open a Workbench based editor that is a graphical interface for Aqwa
analyses. Using this editor you can create an element based model from geometry defined in Design
Modeler format, apply Aqwa specific input, and view results. The layout is similar to other Workbench
based applications (for example, the Mechanical application) and is composed of a number of objects
in a tree based layout.

Hydrodynamic analysis systems follow the conventions used in other Ansys Workbench products where
it is appropriate for the Aqwa Editor. The user interface has a number of key areas, but is tree driven.
Along with the tree and its details pane are toolbars and graphical / text display windows.

The toolbar uses a number of standard Workbench icons along with a number of specialist additions.

Table 6.1: Standard Workbench Toolbars

PurposeSymbols

View manipulation

Selection control

File shortcuts

Show/hide element boundaries

Add a Comment (p. 270) to the selected
tree object

Add a Figure (p. 272) or Image (p. 271) to
the selected tree object
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PurposeSymbols

Control the output of the Report
Preview (p. 269) results

Table 6.2: Aqwa Editor Toolbars

PurposeSymbols

Turn on/off highlighting of objects selected in the tree

Show/hide the sea surface and (left) diffracting or (right) composite cable
seabed

Solver shortcuts

The tree and the details are where the objects that are used to define the modelling requirements are
organized. Depending upon the selection in the tree, a detail pane, normally located below the tree
will show the details of the selected object.

The style of each editable detail depends on the data: in some places you type a value into a field, while
in others you select an entry from a drop-down menu, or choose a file location on disk. Where a floating-
point value can be typed into a field, you can alternatively write a simple expression, which should start
with an equals character =. For example, instead of 1.4142135623731, you could write =2^0.5.
Permitted operators are shown in the table below.

Value after
evaluation

Example
entry

Operation

7.8=4.6+3.2Add x and y

3.835=4-0.165Subtract y from x

11.88=5.4*2.2Multiply x and y

3.9375=6.3/1.6Divide x by y

2.716898…=2.3^1.2Raise x to the power of y

2300000=2.3e6Multiply x by 10 to the power of y

9.025013…=exp(2.2)Raise natural number e to the power of x

0.788457…=log(2.2)Natural logarithm of x

0.999999…=sin(1.57)Trigonometric functions sin, cos, tan

1.570796…=asin(1)Inverse trigonometric functions asin, acos,
atan

1.185465…=cosh(0.6)Hyperbolic functions sinh, cosh, tanh

Expressions can include multiple brackets ( and ). The value of pi is not included, but can be calculated
as ‘=2*acos(0)’. Note that the typed expression is not retained after it has been evaluated by the editor.

Symbols are shown next to each object in the tree to indicate its state.
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Each object in the tree has properties that are used to control the analysis and view the results. For
some objects, the right mouse button can be used to insert additional objects under that object, such
as masses or result views. Alternatively, the dynamic toolbar can be used to insert additional objects.

If you are an existing Aqwa user, then you may find the section Information for Existing Aqwa
Users (p. 349) a useful comparison of capabilities and definition methodology.

There are either one or two other windows shown, depending upon the state of the analysis or tree
item that is selected:

• The main window which generally shows the model (either geometry or mesh views) in the
Geometry tab, Hydrodynamic results in the Graph tab, a report of your analysis in the Report
Preview tab, and Hydrostatics results in the Properties tab where you can view text based results.

• The secondary window which is used for displaying messages, controlling the results, and entering
data. This will appear automatically, depending upon the tree item selected. Messages are also
displayed in the Messages view of the Project Schematic.
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6.2. Editing Objects

Right-clicking on an object in the tree view, or selecting an object and clicking Edit in the menu toolbar,
allows you to perform a number of editing operations on that object:

6.2.1. Copy and Paste

6.2.2. Duplicate

6.2.3. Propagate

6.2.4. Break Link

6.2.5. Delete

The editing operations that are available depend on the type of object selected.

Table 6.3: Availability of Editing Operations

Results
Objects

Environment
Features

ConnectionsGeometric
Features

√ [b]√√Copy and Paste [a]

√√√ [d]Duplicate [a] [c]

√Propagate [a] [c]

√ [e]Break Link

√√√√Delete

An object must be up-to-date (shown with a green check mark in the tree view) before the
Copy, Duplicate and Propagate operations can be used.

[a]

Only between analysis systems of the same Computation Type, or for graphical results
between a Stability Analysis and a Time Response Analysis.

[b]
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Duplicate and Propagate use a separate clipboard than Copy. If you copy one object and
then duplicate or propagate another, the data of the first object is still available to be
pasted.

[c]

Only on an object of which more than one per structure is permitted.[d]

On an object that has been created by a Propagate operation.[e]

6.2.1. Copy and Paste

Copy and paste can be used to copy an object from one structure or analysis into another structure
or analysis. They are used to create a copy under a different parent object in the tree.

Some object properties are not copied. For example, the object Name is unique and is generated
automatically when the object is pasted.

A paste operation can only be performed where the copied object could normally be added or inserted.
For example, a copied Connection Point can be pasted into a structure or into the Geometry, but a
copied Point Mass can only be pasted into a structure.

The following are some examples where copy and paste can be useful:

• A model contains two identical vessels. Wind and Current Force Coefficients are defined for the
first vessel. Rather than entering the same data again, these objects can be copied and pasted into
the second vessel.

• A Joint is to be created between two structures A and B. Once its position has been defined, the
Connection Point on structure A can be copied and pasted into structure B.

Note:

Copying an object creates an unlinked copy of that object on the clipboard. This means
that once it has been pasted, changes to the original object are not reflected in the original.

The data on the clipboard may still be pasted even after the original object has been de-
leted.

Changing the unit system after a Copy operation does not have any effect on the copied
data on the clipboard. For example, copying a Connection Point with X of 100 m and then
changing the length unit from meters to feet will result in a subsequently pasted Connection
Point with X of 100 feet.

6.2.2. Duplicate

Duplicating an object creates a copy of that object under the same parent object in the tree.

Some object properties are not duplicated: the Connection Points of a Cable, for example, are unique,
and will be undefined in the duplicate object.

The following are some examples where duplicate can be useful:
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• A row of four Connection Points are required along the edge of a pier structure. The Position Co-
ordinates of the Connection Points vary only in X. Once the first Connection Point has been created,
it is duplicated three times - only the X position will need to be redefined in the duplicates.

• A Nonlinear Catenary Cable consisting of three Catenary Sections is to be modeled. The material
properties of each Section are similar, differing only in Mass/Unit Length and Stiffness, EA. Once
the first Catenary Section has been defined, it is duplicated twice. The Mass/Unit Length and
Stiffness, EA are then re-defined in each duplicate as necessary.

• A moored turret is connected to four Fixed Points by identical Nonlinear Catenary Cables. Each
Cable is composed of three Catenary Sections, and each Section is connected by a Catenary Buoy.
Once the first Cable has been fully defined, it is duplicated three times - only the Start Fixed Point
and End Connection Point will need to be defined in the duplicates.

6.2.3. Propagate

Propagating an object creates a linked copy of that object in every downstream analysis system. This
operation is useful where an environment object in a Stability Analysis system should be re-used in
subsequent Frequency Statistical Analysis and Time Response Analysis systems. Figure 6.1: Project
Schematic of Linked Hydrodynamic Response Systems (p. 258) shows a schematic for such a case.

Figure 6.1: Project Schematic of Linked Hydrodynamic Response Systems

Linked objects created by a propagate operation cannot be edited. The Name of the linked object
is prefixed with a ^ symbol to indicate that it is linked to an upstream environment object. Fig-
ure 6.2: Project Outline with Linked Environment Objects (p. 259) shows an example of environment
objects that have been propagated into two downstream systems.
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Figure 6.2: Project Outline with Linked Environment Objects

Changes to a property in the original object are reflected in the linked copies, so that the environment
remains consistent throughout the different analyses. This also applies to Parameters (see Paramet-
ers (p. 269)); parameterizing a property in the original object effectively parameterizes the same
property in any linked copies.

6.2.4. Break Link

The Break Link operation turns a linked copy into an unlinked copy. It is only available on linked
copies of environment objects that were created using a propagate operation. Breaking the link to
the original allows the properties of the copy to be modified, and subsequent changes to the original
object will not be reflected in the copy.

Note:

Careful consideration should be given before the link between environment objects is
broken. Typically, results from a Stability Analysis should only be used as input conditions
for a subsequent Frequency Statistical Analysis or Time Response Analysis if the environ-
ments are consistent.

Once a link between objects has been broken it cannot be reinstated, and links can only
be created by a Propagate operation.

6.2.5. Delete

Deleting an object removes it from the tree. If that object is an environment object that has been
propagated, any linked objects in downstream systems are also deleted.
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Pasted and duplicated objects, as well as environment objects that have been created by a Propagate
operation but have subsequently had their link to the original object broken, are not deleted when
the original object is deleted.

6.3. Displayed Positions and Features

In the Graphical Window, the displayed positions of the structures, as well as the features included in
the display, depend on the current selection in the tree view outline.

The table below summarizes which positions and features are shown for each selected object, where:

• Geometric features are Fixed/Connection Points, Point Masses/Buoyancies, Discs, and Structure Axes.

• Connections are Cables, Joints, Fenders, Catenary Joints and Joint/Fender Axes.

• Environment Features are Currents, Winds, Regular/Irregular Waves, Structure Forces, and Cable
Winches.

Table 6.4: Structure Positions and Features Displayed According to Tree Selection

Displayed FeaturesStructure PositionsSelection

Connected positions
(accounting for

Project Model
Connections

• Included structures

• Geometric featuresarticulations between
structures)

• Connections

Geometric positions (as
defined in the original
CAD geometry)

Geometry • Included structures

• Geometric features

The generated mesh (if up-to-date)Mesh

HD Analysis
Type or
Solution

• Included structures

• Analysis-specific features (for example, Wave
Directions)

All structures (including those structures that may have been
excluded in Structure Selection)

HD Structure
Selection

HR (Stability)
Analysis Type
or Solution

• Included structures• Unsolved:
Connected
positions, • Geometric features

including
Starting Positions • Connections

• Environment features• Solved,
converged:
Equilibrium
positions
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Displayed FeaturesStructure PositionsSelection

• Solved,
unconverged:
Final iteration
positions

Connected positions,
including Starting
Positions

HR (Stability)
Setup Objects

• Included structures

• Geometric features

• Connections

• Object-specific features (for example, Wind Direction)

HR
(Frequency/Time)

• Included structures• Upstream
unsolved

• Geometric featuresStability Analysis:
Initial positions

Analysis Type
or Solution

• Connectionsfrom upstream
analysis

• Environment features

• Upstream solved
Stability Analysis:HR

(Frequency/Time)
Setup Objects

• Included structures

Final positions
from upstream
analysis

• Geometric features

• Connections

• Stand-alone,
unsolved:

• Object-specific features (for example, Wind Direction)

Connected
positions

• Stand-alone,
solved:
Equilibrium or
final iteration
positions

The following sequence of figures are provided to illustrate the structure positions and features displayed
during the Hydrodynamic Diffraction/Radiation and Hydrodynamic Response analysis of two connected
vessels. These include:

• Figure 6.3: Geometric Features Defined (p. 262): After geometric features have been defined.

• Figure 6.4: Connections Defined (p. 263): After connections and articulations have been defined.

• Figure 6.5: Setting Wave Directions (p. 263): Setting wave directions.

• Figure 6.6: Stability Analysis Starting Conditions (p. 264): Starting conditions before a Stability Analysis
calculation.
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• Figure 6.7: Stability Analysis Final Conditions (p. 264): Final conditions after a Stability Analysis calcula-
tion.

Note that for illustration purposes:

• A hinge articulation is defined between the vessels, with an initial rotation of 15° about the hinge
axis.

• A Current profile varying with depth, as well as an Irregular Wave, are added to the environment.

• A Starting Position has been applied to translate and rotate the moored vessel about the mooring
Connection Point, so that the starting conditions of the Stability Analysis are closer to the expected
final positions.

Figure 6.3: Geometric Features Defined
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Figure 6.4: Connections Defined

Figure 6.5: Setting Wave Directions
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Figure 6.6: Stability Analysis Starting Conditions

Figure 6.7: Stability Analysis Final Conditions

6.4. Setting Aqwa Application Options

Once you have created your Hydrodynamics analysis system and attached a geometry, you can open
the Aqwa Editor and set some options.

1. Select Edit > Options from the Aqwa Editor window.

2. Expand the Aqwa item in the tree.

3. Select the Analysis entry. This panel allows you to set the following Solver options:
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• Aqwa Executable Location - location of the executable file for the Aqwa solver. You should not
have to change this from the default setting.

• Severity to Force Showing of Messages - level of error messages that will cause reporting to
the Workbench Message pane.

• Maximum Program Controlled Number of Cores - default number of parallel processing cores
to use when the Analysis Settings Parallel Processing option is set to Program Controlled. For
more information on how this value is used, see Setting Aqwa Parallel Processing Options (p. 265).

4. Select the Report entry. This panel allows you to customize the following report generation options:

• Figure Options - whether figures sould be included in the report, and the default figure size.

• Graphics Options - the default image size and resolution.

• Table Options - which tables to include in the report, and the maximum number of rows and
columns in any table. If the table size is greater than the maximum N rows/columns defined here,
the table in the report will contain (approximately) equally-spaced entries up to N rows/columns.

• Customization - specify the location of a folder for your own report-generating scripts. The folder
contents should match that of installation_directory\aisol\aqwa\AQWAPages\re-
port\.

5. When you are finished, click OK. Click Cancel to discard your changes.

Note:

Option settings within a particular language are independent of option settings in another
language. If you change any options from their default settings, then start a new Workbench
session in a different language, the changes you made in the original language session are
not reflected in the new session. You are advised to make the same option changes in the
new language session.

6.4.1. Setting Aqwa Parallel Processing Options

Aqwa can take advantage of multi-core machines to improve computational speed during the solution
stages. For more information, see Aqwa Parallel Processing Calculation in the Aqwa Theory Manual.
There are several ways to determine and specify the number of cores to be used in a given analysis.

When the Aqwa Editor is opened for the first time after installation, it automatically detects the
number of processing cores that exist on the node on which it is run. The number is set as the default
value for the Maximum Program Controlled Number of Cores option, which can be found in the
Edit > Options > Aqwa > Analysis menu.

Note:

The Maximum Program Controlled Number of Cores is set to the maximum number of
physical cores on your machine. You cannot request more than this number of cores.
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If you manually set Maximum Number of Program Controlled Cores to 0, or a number greater than
the total number of cores in the node, the Aqwa Editor will reset the value of Maximum Number of
Program Controlled Cores to the default value.

Note:

The Number of Processors option, found under Edit > Options > Common Settings >
Parallel Processing, is not used by the Aqwa Editor at any stage.

If you click Reset in the Edit > Options window, the Maximum Number of Program
Controlled Cores will be set to 0 and the behavior described above will apply.

Within each analysis system, under Analysis Settings, there is a Parallel Processing drop-down
menu. This menu has three options: Serial, Manual Definition, and Program Controlled (default).

Setting Parallel Processing to Program Controlled causes the Aqwa Editor to automatically determine
how many cores to request during the solve process. The number of requested cores varies depending
on the Computation Type, and on whether the analysis includes dynamic cables and/or tethers, etc.
See Aqwa Parallel Processing Calculation in the Aqwa Theory Manual for a table of actual number of
cores used in different Aqwa analysis cases.

Setting Parallel Processing to Serial causes the Aqwa Editor to request a single core for that analysis,
regardless of Computation Type.

Setting Parallel Processing to Manual Definition shows an additional Requested Number of Cores
option. This field accepts any value greater than 0 and less than or equal to the number of physical
cores in the node. Setting a value outside of this range will result in an error and will prevent the
solve process from executing. Setting a value that is higher than the value that would be used if
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Parallel Processing were set to Program Controlled will result in an informational message in the
log.

Note:

Changing Parallel Processing or Requested Number of Cores does not invalidate an up-to-
date solution.

The Maximum Program Controlled Number of Cores option is a global setting for the
machine, it is not saved within a project file or reset between projects. The Parallel Pro-
cessing and Requested Number of Cores options are project specific and are saved in
the project file.

Although the number of available HPC licenses may change due to the activity of other
users within your organization, the Aqwa Editor itself does not perform the licensing check.
The Aqwa solver performs the check when you execute the solve process. The number of
cores used in the computation may be less than the number requested (automatically or
manually), depending on the number of available licenses.
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Chapter 7: Aqwa Common Features
There are a number of features common to all of the Aqwa analysis systems. The following are discussed
in this chapter:

7.1. Generating Reports

7.2. Parameters

7.3. Comments, Images, and Figures

7.1. Generating Reports

You can click on the Report Preview tab in the main window pane to generate a summary of all of
the objects in your Outline. Once started, the report generation process must run to completion. Avoid
clicking anywhere in the Workbench window while the report is generating because it will stop the
report and may cause an error.

The Details information for each object appears as tables in the report. Figures and images appear as
specified in the Outline. Charts that appear in the outline are also included.

When you are viewing the Report Preview tab, several related buttons will appear in your toolbar. Use
the Print button to print a copy of the report. The Publish button will save the report in one of three
formats:

• .mht, a web page archive format that can be opened by Internet Explorer 5.5 or later

• .html file with graphics in a sub directory

• .html file with graphics in the same directory

Click Publish then select the format in which you want to save from the Save as type drop down list.

Use the Send To button to send the report to an email recipient (.mht file format only), Word, or
PowerPoint. The document is opened in Word as any published HTML file would be. Only the images
contained in the report are imported in PowerPoint; no other information is imported.

See Report Preview for more information on generating reports.

7.2. Parameters

Certain quantities in your Hydrodynamic analysis can be exposed to the Workbench environment as
parameters. A parameter may be exposed by selecting the checkbox next to its Detail field, which shows
a 'P' when selected. For an input parameter, the value set in the field at the moment when the quantity
is parameterized becomes the value for that quantity in the first (Current) design point. The field is
then read-only, and any changes to the value must be made through the design point table. Parameters
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can be used in post-processing to conduct optimization analysis and "what-if" scenarios. See Working
with Parameters and Design Points for more information about working with parameters.

Figure 7.1: Example of Parameters in the Details View

When an item in the project tree is suppressed or deleted, any parameters and design point values as-
sociated with it are removed from the design point table.

If you have parameterized a property which then goes out of context due to changes made to another
property, the parameter and its design point values are permanently removed from the design point
table. For example, if you have parameterized the Significant Wave Height of an Irregular Wave with
Wave Type of JONSWAP (Hs), and then change the Wave Type to JONSWAP (Alpha), the Significant
Wave Height parameter is removed.

7.3. Comments, Images, and Figures

You can insert Comment objects, Image objects, and Figure objects under various parent objects in the
tree to add text or graphical information that pertains specifically to those parent objects. These objects
can all be deleted from their parent objects by right clicking on them and selecting Delete.

7.3.1. Comments

7.3.2. Images

7.3.3. Figures

7.3.1. Comments

You can insert a Comment object in the tree by clicking on the Comment button in the toolbar .
A window pane will open below the main graphics pane displaying a text box where you can enter
the comment. Any time you click on the Comment object in the tree, this comment edit pane will
open. You can enter text, do some basic formatting, change the background and foreground colors,
and add pictures to the comment. In the Details view, you can enter an author name in the Name
field. Comments will appear in a generated Report under the parent object in the tree.
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Figure 7.2: Comment Edit Pane

7.3.2. Images

You can insert an Image object in the tree or save the current Model view to a file by clicking on the

New Figure or Image button  in the toolbar.

Figure 7.3: New Figure or Image Menu

From the drop down menu, you can select:

• Image to insert an Image object in the tree containing a snapshot of the Model's current view
in the Geometry window.

• Image from File... to insert an image from a file as an Image object in the tree. Browse to an
existing .bmp, .jpg, or .png file to insert the image.

• Image to File... to save the Model's current view. Browse to the desired location, and chose
the file format: .png, .bmp, .jpg, .tif, or .eps.

In the Details view, you can enter an annotation for the image in the Text field. Image objects will
appear in a generated Report under the parent object in the tree.

Note:

If you are running on Windows 7, you must be using a Basic Theme for your desktop in
order to capture an image. If you are using an Aero Theme, a warning dialog box will appear
when inserting the Image or Image to File objects, and the image will not be properly
created.
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7.3.3. Figures

The Figure object allows you to capture a graphic displayed for a particular object in the Geometry
window. A Figure object can be further manipulated (rotated, for example), unlike an Image object
which is a static screen shot of the current model view, or an imported static figure. You can insert

a Figure object in the tree by clicking on the New Figure or Image button  in the toolbar. From
the drop down menu, select Figure.

Figure 7.4: New Figure or Image Menu

In the Details view, you can enter a Name for the Figure object. Figures will appear in a generated
Report under the parent object in the tree.

Figures allow you to capture result contours, mesh previews, graphs, etc. for later display in the Report.
Any object that displays 3D graphics may contain figures. View settings maintained by a figure include:

• camera settings

• result toolbar settings

• legend configuration

A figure's view settings are fully independent from the global view settings. Figures always display
the data of their parent object. For example, following a geometry Update and Solve, a result and its
figures display different information but reuse the existing view and graphics options.
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Chapter 8: Hydrodynamic Add-ons
Ansys provides Add-ons to provide additional functionality and system interoperability for the Mechan-
ical Application.

The following Add-ons are provided for hydrodynamic analyses:

8.1.The Hydrodynamic Pressure Add-on

8.2.The Offshore Add-on

8.3.The Aqwa Co-simulation Add-on

8.1. The Hydrodynamic Pressure Add-on

The external surface and internal tank pressures, Morison loads, and structural accelerations calculated
in a Hydrodynamic Diffraction or time domain Hydrodynamic Response analysis can be transferred to
panel and line elements in a Static Structural analysis, using the Hydrodynamic Pressure Add-on, through
a link on the Workbench Project Schematic page. This removes the need to create, manipulate, and run
files external to Workbench.

Note:

Moonpool pressures can also be transferred, but from Hydrodynamic Diffraction to Static
Structural only.

When mapping from a Hydrodynamic Diffraction system, multiple wave phase angles can be analyzed
in a single Static Structural calculation, to provide a clear picture of finite element results due to hydro-
dynamic loading over the whole wave cycle. Similarly, for a Hydrodynamic Diffraction analysis including
multiple Wave Frequencies or Wave Directions, pressures and loads can be transferred for some or all
of those frequency/direction pairs in a single Static Structural analysis.

For pressure mapping from a time domain Hydrodynamic Response system, external surface and internal
tank pressures, as well as Morison loads, can be transferred for: a single time step; a range of time steps;
or for all time steps for which time domain pressures have been calculated. In addition, cable forces,
joint forces/moments and tether forces/moments calculated in the hydrodynamic model can be applied
to the structural model.

8.1.1. Introduction

The Hydrodynamic Pressure Add-on is designed to facilitate the transfer of hydrodynamic pressures
and Morison loads calculated in a Hydrodynamic Diffraction or time domain Hydrodynamic Response
system to a Static Structural finite element analysis.

When mapping from a Hydrodynamic Diffraction system the hydrodynamic pressure terms are linear
(first order), and include incident (Froude-Krylov), diffracted, radiated and hydrostatic-varying com-
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ponents. Hydrostatic pressure may be added if required. The wave direction and frequency pairs are
selected from those included in the Hydrodynamic Diffraction calculation; an incident wave amplitude
is also specified. The load mapping can be carried out either at a single specified wave phase angle,
over multiple phase angles covering the whole of the wave cycle, or for real and imaginary components
(in linear cases). Similarly, the mapping may be performed either for a single frequency/direction pair
or, where the Hydrodynamic Diffraction system includes multiple Wave Frequencies or Wave Directions,
over some or all of those frequency/direction pairs. The summed pressure terms are mapped onto
triangular and quadrilateral panel elements in the Static Structural mesh, either by interpolation, or
by direct evaluation of the diffracting panel source strengths at the Static Structural mesh node pos-
itions.

The Hydrodynamic Pressure Add-on also allows the Hydrodynamic Diffraction first order (Froude-
Krylov, added mass) and second order (viscous drag) forces acting on Line Bodies (element types
BEAM188 and PIPE288) to be included in a Static Structural analysis. The effect of ocean current may
be accounted for in the drag calculation.

For pressure mapping from a time domain Hydrodynamic Response system, the hydrodynamic pressure
terms are linear for the diffracted and radiated components and nonlinear for the incident (Froude-
Krylov) and hydrostatic components. These latter terms are estimated under the instantaneous wave
surface in the time domain calculation. The first order (Froude-Krylov, added mass) and second order
(viscous drag) forces on Line Bodies, as well as the forces and moments on Morison disc elements,
can also be mapped from the hydrodynamic model. The pressure mapping can be carried out at a
single specified time step, over a range of time steps, or for all time steps included in the time domain
Hydrodynamic Response pressure output. The total pressure terms are mapped by interpolation on
to triangular and quadrilateral panel elements in the Static Structural mesh.

The Hydrodynamic Pressure Add-on allows the instantaneous cable forces, joint forces/moments and
tether forces/moments, calculated in a time domain Hydrodynamic Response system, to be mapped
on to selected locations of the structural model.

For both Hydrodynamic Diffraction and time domain Hydrodynamic Response pressure mapping, the
resultant translational and rotational accelerations about the structure center of gravity are determined
for the balance of inertial loads in the Static Structural analysis. Standard Earth Gravity is added to
the translational accelerations where hydrostatic pressure is included in the mapping.

8.1.2. Loading the Hydrodynamic Pressure Add-on

The Hydrodynamic Pressure Add-on is automatically loaded on the creation of a Hydrodynamic Dif-
fraction system or a Hydrodynamic Response system.

To make its capabilities available where the Add-on has been unloaded in a previous session, click
the Hydrodynamic Pressure icon in the Add-ons Ribbon. The icon will be highlighted in blue, indic-
ating that the Add-on is loaded.

Figure 8.1: Hydrodynamic Pressure Add-on Showing Loaded Status
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8.1.3. Setting up your Workflow in Workbench

The Solution cell of a Hydrodynamic Diffraction or Hydrodynamic Response system can be connected
to the Setup cell of a Static Structural system. Typical workflows are shown in Figure 8.2: Typical
Workflow for Hydrodynamic Diffraction Pressure Mapping (p. 275) and Figure 8.3: Typical Workflow
for Time Domain Hydrodynamic Response Pressure Mapping (p. 276). It is not necessary to have different
Geometry sources in each system, but for the typical use case the Static Structural model will include
internal and/or other structural components that are not required for the Hydrodynamic Diffraction
or time domain Hydrodynamic Response calculation.

Once the link has been created between the Hydrodynamic Diffraction/time domain Hydrodynamic
Response and Static Structural systems, it is always necessary to right-click the Hydrodynamic Solution
cell and select Update. This operation manages the transfer of data files between the analyses.

Note:

When some hydrodynamic data has already been imported into the Static Structural
system, and the Hydrodynamic Solution is subsequently updated, the Static Structural
Setup cell must be refreshed. In Mechanical, it is essential to click the Hydrodynamic
Pressure object after this Refresh operation to utilize the new hydrodynamic data.

Figure 8.2: Typical Workflow for Hydrodynamic Diffraction Pressure Mapping
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Figure 8.3: Typical Workflow for Time Domain Hydrodynamic Response Pressure Mapping

8.1.4. Importing Hydrodynamic Diffraction Pressures and Loads to Mechan-
ical

Opening the Static Structural system in the Mechanical editor, you will find an additional tab that
gives you access to the Hydrodynamic Pressure Add-on.

Clicking the  icon adds a Hydrodynamic Pressure object to the Static Structural analysis.

Alternatively, you can right-click the Static Structural analysis and select Insert → Hydrodynamic
Pressure from the context menu.

Note:

It is only possible to add one Hydrodynamic Pressure object to a Static Structural analysis.

8.1.4.1. Configuring the Hydrodynamic Pressure Object

The Details of Hydrodynamic Pressure panel provides options that allow you to configure the Hy-
drodynamic Pressure object. These are described below.
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Figure 8.4: Details of Hydrodynamic Pressure

The Activity field allows you to set the suppression state of the Hydrodynamic Pressure object. Set
to Suppressed if you want to exclude the object from the analysis.

The Structures in Hydrodynamic Model field displays the number of structures included in the
pressure database from the upstream Hydrodynamic Diffraction system. It is possible to transfer
pressures for one, several, or all of these structures. One Hydrodynamic Structure (p. 285) object is
automatically added to the analysis when you create the Hydrodynamic Pressure object, but you
can create additional Hydrodynamic Structure objects up to the number of structures in the hydro-
dynamic model.

8.1.4.1.1. Load Configuration

The Wave Case Definition option allows you to analyze either single or multiple wave conditions
within a single Static Structural analysis.

When Wave Case Definition is set to Single Wave Case, the Wave Direction and Wave Fre-
quency/Period fields are used to select a frequency/direction pair at which the hydrodynamic
pressures acting on the structure will be evaluated. If a forward speed has been defined in the
Hydrodynamic Diffraction analysis, the Encounter Frequency for this frequency/direction pair is
also shown.
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Setting Wave Case Definition to Single Frequency, All Directions, and selecting a single Wave
Frequency/Period value, causes the Static Structural analysis to be performed for all wave direc-
tions at that wave frequency. Similarly, a Wave Case Definition of Single Direction, All Frequencies
allows you to analyze over all wave frequencies for a given Wave Direction.

To perform the Static Structural analysis over all frequency/direction pairs in the Hydrodynamic
Diffraction analysis, set Wave Case Definition to All Frequencies, All Directions.

For all wave case configurations, an Incident Wave Amplitude should be specified.

The Wave Position allows you to choose between single or multiple wave phase angles in the
Static Structural analysis. When this option is set to Specified, use the Specified Phase Angle
field to define the (single) wave phase angle. When Wave Position is set to Sequence, the Static
Structural analysis will be carried out over multiple phase angles spaced equally over the wave
cycle (from 0° to 360°); use the Number of Phase Increments field to set the number of steps.
Alternatively, setting Wave Position to 0° (Real) and 90° (Imaginary) causes the analysis to be
carried out over only these two phase angles. This last option is only applicable to linear cases
(no beam loads). The phase angle is with respect to the COG of the first structure in each hydro-
dynamic interaction structure group.

Where multiple phase angles and/or multiple frequency/direction pairs are to be analyzed, the
Static Structural Analysis Setting Number of Steps field will be updated automatically. For example:
for a Hydrodynamic Diffraction analysis containing 20 wave frequencies and 13 wave directions,
with the Wave Case Definition set to All Frequencies, All Directions and Number of Phase In-
crements set to 12, the total Number of Steps in the Static Structural analysis will be 20 x 13 x
12 = 3120.

The additional options Display for Wave Case and Display Pressures/Accelerations At can be
used to set the wave case and wave phase angle at which the mapped pressures (in the graphical
window) and output values (in the Details panel, described in Output: Imported Pressures and
Loads (p. 279)) are shown.

When Model Type for Mapping includes Line Bodies, a constant or profiled current can be in-
cluded by creating an Ocean Current (p. 315) object in the Static Structural analysis and selecting
that object from the Include Current drop-down menu.

8.1.4.1.2. Mapping Configuration

Model Type for Mapping indicates the types of loads that will be mapped from the Hydrodynamic
Diffraction analysis to the Static Structural analysis. Generally, it is possible to map pressures onto
surfaces (Surface Bodies and the outer faces of Solid Bodies) and distributed loads onto beams
or pipes (Line Bodies).

The meshes in the Static Structural and Hydrodynamic Diffraction systems are generally not coin-
cident, which necessitates some approach to map the hydrodynamic pressures onto the structural
mesh. The Pressure Mapping option can be set to Interpolated or Direct.

Using the interpolated method, hydrodynamic pressures at each node of the selected surfaces
in the structural mesh are interpolated from the element-centered pressures calculated in the
Hydrodynamic Diffraction analysis. This method can be used for models that include Line Bodies
in the load mapping selection. However, the accuracy of the method is inherently limited by the
interpolation of the pressure data and is dependent on the resolution of the mesh in the Hydro-
dynamic Diffraction analysis. Furthermore, the interpolated method cannot be used for mapping
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onto the outer surfaces of Solid Bodies, or where the Hydrodynamic Diffraction analysis contains
more than one structure.

Where the direct method is used, hydrodynamic pressure components at the position of each
selected node are evaluated directly from the diffracting panel source strengths calculated in the
Hydrodynamic Diffraction analysis. The direct method permits mapping for multiple hydrodynamic
structures, as well as mapping onto the outer surfaces of Solid Bodies. This method avoids the
loss of accuracy due to interpolation, but it cannot be used to map loads onto Line Bodies.

Internal Tank Pressures always use an interpolation method for mapping between the hydro-
dynamic and structural models. Moonpool Pressures always use a direct mapping method. These
are independent of the Pressure Mapping setting described above, and are also valid for mapping
from multiple hydrodynamic structures.

Regardless of the selected method, the mapped hydrodynamic loads will always include incident,
diffracted and radiated components, as indicated by the Include Incident/Diffracted/Radiated
Wave fields. Hydrostatic pressure can be optionally added by setting Include Hydrostatic Pressure
to Yes. The hydrostatic-varying pressure component is always included when the interpolated
method is used but is optional for the direct method. Second order pressure terms on diffracting
panels are not calculated, but Line Body loads do include a second order viscous drag component.

8.1.4.1.3. Axis Transformation

Although you can share one Geometry source between the Hydrodynamic Diffraction and Static
Structural systems, in the typical use case, the Static Structural model will include internal and/or
other structural components that are not required for the Hydrodynamic Diffraction calculation.
Depending on the context, the geometries in the Static Structural and Hydrodynamic Diffraction
systems may therefore employ different axis systems. To account for this, it is possible to define
an axis transformation from the Static Structural analysis to the Hydrodynamic Diffraction analysis.

Where the axis systems are consistent between the two analyses, the Static Structural Position
may be set as Matches Hydrodynamic Diffraction Analysis. Otherwise, this option should be set
to Differs from Hydrodynamic Diffraction Analysis, and Structure Position/Rotation Offsets
should be defined for the translational and rotational freedoms. Offsets are defined relative to
the Hydrodynamic Diffraction global axis system (FRA).

8.1.4.1.4. Output: Imported Pressures and Loads

When Model Type for Mapping includes External Surfaces, the Minimum and Maximum Pres-
sures on diffracting panel elements are reported. When Model Type includes Internal Tanks, the
Minimum and Maximum Internal Tank Pressures are provided. When Model Type includes
Moonpools, the Minimum and Maximum Moonpool Pressures are stated. When Model Type
includes Line Bodies, the Minimum and Maximum Beam Loads (as Force per unit Length) are
also shown. These quantities are evaluated over all of the surfaces and line bodies included for
mapping (that is, across all structures); the Hydrodynamic Structure (p. 285) object shows maxima
and minima per structure.

Where applicable, values are displayed for the wave case and phase angle selected in Display
for Wave Case and Display Pressures/Accelerations At Phase Angle, respectively.
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8.1.4.1.5. Advanced Options

The Hydrodynamic Pressure object accesses the material properties of each Body so that it can
estimate the structural mass, inertia, and center of gravity (CoG) position, and compare these to
the corresponding properties from the hydrodynamic model. Generally, the force and moment
reactions on any defined boundary conditions should be relatively small in the Static Structural
system, and checking this helps ensure the applied loads and accelerations are well-balanced.

The Perform Mass/Inertia Check setting can be used to adjust the behavior of the Hydrodynamic
Pressure object in this respect. This setting has 4 options:

• Yes, Entire Assembly: The mass/inertia/CoG of the entire assembly, including all Bodies in the
Geometry, will be calculated and compared to the corresponding properties of the selected
structure in the upstream hydrodynamic analysis. This option is invalid if there is more than
one Hydrodynamic Structure in the analysis.

• Yes, Selected Bodies Only: The mass/inertia/CoG will be calculated and compared only for
the specific Bodies that are included in the Structural Acceleration Application scope for
each Hydrodynamic Structure.

• No, Use Hydrodynamic Model CoG Position: The mass/inertia/CoG will not be calculated.
The accelerations included by the Hydrodynamic Pressure object will be applied about the
CoG position of the selected structure(s) in the upstream hydrodynamic analysis (accounting
for any defined Axis Transformation (p. 279)). These accelerations will be applied to the specific
Bodies that are included in the Structural Acceleration Application scope for each Hydro-
dynamic Structure. You must ensure that the mass properties are consistent between the hy-
drodynamic and structural models.

• No, Exclude Accelerations: The mass/inertia/CoG will not be calculated, and the Hydrodynamic
Pressure object will not apply any accelerations in the structural analysis. You must ensure that
the mass properties are consistent between the hydrodynamic and structural models.

In some cases, a Body's material properties may be inaccessible. For example, where Ansys
Composite PrepPost (ACP) has been used to define a composite material, or where the structural
analysis employs a material with no density value defined. For these cases, the Perform
Mass/Inertia Check option must be set to No, Use Hydrodynamic Model CoG Position or No,
Exclude Accelerations. The force/moment reactions on any defined boundary conditions must
be checked carefully.

8.1.4.2. Generating Hydrodynamic Pressures and Inertial Loads

Once the Hydrodynamic Pressure object has been configured as required, and at least one Hydro-
dynamic Structure (p. 285) has been defined, right-click the Hydrodynamic Pressure object and select
Generate to start the load transfer process. This involves two main steps:

• Using the Ansys solver to determine the structural mass properties, which are compared to the
mass properties from the Hydrodynamic Diffraction calculation;
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• Reading the output of the Hydrodynamic Diffraction calculation to determine hydrodynamic
pressures at the structural mesh nodes and calculate translational and rotational accelerations
to balance inertial loads.

Note:

The Hydrodynamic Pressure Add-on will take into account any difference in the unit
systems that are employed in the Hydrodynamic Diffraction and Static Structural systems.

Where the attached Geometry includes a large number of parts or bodies (1000 or more),
the Mechanical UI may be noticeably unresponsive for some time during Hydrodynamic
Pressure Generate and Solve operations. If necessary, you can monitor progress via the
Log File, accessible through the Workbench menu bar: Add-ons → View Log File.

The transferred pressures are displayed in the graphical window when you select a Hydrodynamic
Structure in the Outline tree (Figure 8.5: Hydrodynamic Pressures in the Static Structural Sys-
tem (p. 282)), and can be compared to the Structure Panel Pressures (Figure 8.6: Hydrodynamic
Pressures in the Hydrodynamic Diffraction System (p. 283)) shown in the Pressures and Motions
result object in the upstream Hydrodynamic Diffraction system.

Note:

The pressure Component Selection in the Pressures and Motions object may need to
be matched to those included in the Hydrodynamic Pressure object for such a compar-
ison to be made.
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Figure 8.5: Hydrodynamic Pressures in the Static Structural System
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Figure 8.6: Hydrodynamic Pressures in the Hydrodynamic Diffraction System

Where the Wave Position option is set to Sequence, the minimum and maximum pressures (on
surfaces) and/or beam loads (on line elements) are shown over the wave cycle in graphical and
tabular form.

Figure 8.7: Minimum/Maximum Pressures and Beam Loads vs Phase Angle (Graph)
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Figure 8.8: Minimum/Maximum Pressures and Beam Loads vs Phase Angle (Table)

8.1.4.3. Structural Analysis Load Steps

When mapping frequency-domain hydrodynamic pressures from Aqwa to Mechanical, you can
choose to map for multiple wave frequencies, directions, and phase angles in a single structural
analysis. The analysis will include as many load steps as there are wave frequency/direction/phase
combinations.

The order of load cases in the structural analysis will be the same for both the Interpolated and
Direct pressure mapping methods. The cases are typically organized by wave frequency, direction,
then phase angle. For example, in a configuration with 2 frequencies, 3 directions, and 3 phase in-
crements, the load cases will be ordered as follows:

Step Number   Frequency No.   Direction No.    Phase Angle (degrees)
     1             1               1                0
     2             1               1               120
     3             1               1               240
     4             1               2                0
     5             1               2               120
     6             1               2               240
     7             1               3                0
     8             1               3               120
     9             1               3               240
    10             2               1                0
    11             2               1               120
    12             2               1               240
    13             2               2                0
    14             2               2               120
    15             2               2               240
    16             2               3                0
    17             2               3               120
    18             2               3               240

From this, you can then determine the association between the load step number and the wave
case.
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8.1.5. Associating a Hydrodynamic Structure from the Hydrodynamic Diffrac-
tion Analysis

A Hydrodynamic Structure object is automatically added to the Static Structural analysis when you
create a Hydrodynamic Pressure object.

Clicking the  icon creates an additional Hydrodynamic Structure object, and you can repeat
this up to the number of structures in the hydrodynamic model.

Alternatively, you can right-click the Static Structural analysis and select Insert → Hydrodynamic
Structure from the context menu.

8.1.5.1. Configuring the Hydrodynamic Structure Object

The Details of Hydrodynamic Structure panel provides options to configure the Hydrodynamic
Structure object. These are described below.

Figure 8.9: Details of Hydrodynamic Structure

The Activity field allows you to set the suppression state of the Hydrodynamic Structure object. If
you want to exclude the structure from the mapping, set this field to Suppressed.
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8.1.5.2. Structure Selection

When the Hydrodynamic Diffraction analysis contains more than one structure, you must select the
name of the structure (in the Hydrodynamic Diffraction system) that you intend to map loads from,
using the Name in HD Analysis option.

The fixity of the selected structure in the Hydrodynamic Diffraction analysis is indicated by Structure
Fixity. When this field shows Structure is Fixed in Place, the radiated wave pressure component
will be zero and no structure accelerations will be calculated. In this case, for consistency, the
structure should also be fixed in the Static Structural analysis (for example, by a Fixed Support). If
the Structure is Free to Move you are recommended to use the Weak Springs option (in the Static
Structural Analysis Settings) to mitigate rigid body motions.

If the selected structure has Internal Tanks associated with it in the Hydrodynamic Diffraction ana-
lysis, the number of tanks is shown in the read-only Number of Internal Tanks field.

If the selected structure has Moonpools associated with it in the Hydrodynamic Diffraction analysis,
the number of Moonpools is shown in the read-only Number of Moonpools field.

If a forward speed has been defined in the Hydrodynamic Diffraction analysis, this is shown in
Forward Speed in HD Analysis.

8.1.5.3. External Surfaces

When Model Type for Mapping includes External Surfaces, use the External Surfaces options to
select the surfaces that you want to map hydrodynamic pressures onto. Surfaces can be selected
either by Named Selection, or by Geometry Selection from the graphical window.

8.1.5.4. Line Bodies

When Model Type for Mapping includes Line Bodies, use the Line Bodies options to select the
beams that you want to map hydrodynamic loads onto. Line Bodies can be selected either by
Named Selection, or by Geometry Selection from the graphical window. You must also define viscous
drag and inertia coefficients for the different cross sections that are included in your selection.
These coefficients are used to calculate distributed loads on beams according to the Morison
equation described in Theory. The Hydrodynamic Properties table sets coefficients for each cross
section type. For non-cylindrical cross sections (solid rectangular and rectangular tube) you must
define separate viscous drag and inertia coefficients for each transverse direction.

8.1.5.5. Structural Acceleration Application

When Perform Mass/Inertia Check is set to ‘Yes, Selected Bodies Only’ or ‘No, Use Hydrodynamic
Model CoG Position’, you must select the bodies in the structural model on to which the hydro-
dynamic accelerations should be applied. Where relevant, these bodies will also be used in the
comparison of mass properties between the hydrodynamic and structural models. Bodies can be
selected either by Named Selection, or by Geometry Selection from the graphical window.
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8.1.5.6. Output: Structure Acceleration at Center of Gravity, Imported Pressures
and Loads

When Model Type for Mapping includes External Surfaces, the Minimum and Maximum Pressures
on diffracting panel elements are reported. When Model Type includes Internal Tanks, the Minimum
and Maximum Internal Tank Pressures are provided. When Model Type includes Moonpools, the
Minimum and Maximum Moonpool Pressures are stated. When Model Type includes Line Bodies,
the Minimum and Maximum Beam Loads (as Force per unit Length) are also shown. These
quantities are evaluated over this hydrodynamic structure only.

For all cases, the position of the structure's center of gravity (in the Static Structural axis system),
and the resultant translational and rotational accelerations about that center of gravity, are displayed.
Where applicable, values are displayed for the wave case and phase angle selected in Display for
Wave Case and Display Pressures/Accelerations At Phase Angle, respectively.

8.1.6. Importing Time Domain Hydrodynamic Response Pressures and Loads
to Mechanical

Opening the Static Structural system in the Mechanical editor, you will find an additional tab that
gives you access to the Hydrodynamic Pressure Add-on.

Clicking the  icon adds a Hydrodynamic Pressure object to the Static Structural analysis.

Alternatively, you can right-click the Static Structural analysis and select Insert → Hydrodynamic
Pressure from the context menu.

Note:

Only one Hydrodynamic Pressure object may be added to a Static Structural analysis.

Note:

Moonpool Pressures cannot be included in or mapped from Hydrodynamic Response sys-
tems.

8.1.6.1. Configuring the Hydrodynamic Pressure Object

You can configure the Hydrodynamic Pressure object using the options in its Details panel. The
fields are described below.
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Figure 8.10: Details of Hydrodynamic Pressure

The Activity field allows you to set the suppression state of the Hydrodynamic Pressure object. Set
to Suppressed if you want to exclude the object from the analysis.

The Structures in Hydrodynamic Model field displays the number of structures that are included
in the pressure database from the upstream time domain Hydrodynamic Response system. It is
possible to transfer pressures for one, several, or all of these structures. One Hydrodynamic Struc-
ture (p. 294) object is automatically added to the analysis when you create the Hydrodynamic
Pressure object, but you can create additional Hydrodynamic Structure objects up to the number
of structures in the hydrodynamic model.

8.1.6.1.1. Load Configuration

The Time Step Definition option allows you to analyze either a single or multiple time steps
from the time domain Hydrodynamic Response calculation within a single Static Structural ana-
lysis. The time steps available for pressure mapping are defined by the Time Domain Pressure
Output (p. 133) options in the time domain Hydrodynamic Response Analysis Settings.

When Time Step Definition is set to Single Time Step, use the Time Step option to select the
time step for pressure mapping.

Setting Time Step Definition to Range of Time Steps allows you to define a First Time Step and
Last Time Step for the pressure mapping.

To perform the Static Structural analysis over all available time steps, set Time Step Definition
to All Time Steps.
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Where multiple time steps are to be analyzed, the Static Structural Analysis Setting Number of
Steps field will be updated automatically.

The additional option Display for Time Step can be used to set the time step at which the
mapped pressures (in the graphical window) and output values (in the Details panel, described
in Output: Imported Pressures, and Loads (p. 290)) are shown.

8.1.6.1.2. Mapping Configuration

Model Type for Mapping indicates the types of loads that will be mapped from the Hydrodynamic
Response analysis to the Static Structural analysis. Generally, it is possible to map pressures onto
surfaces (Surface Bodies and the outer faces of Solid Bodies) and distributed loads onto beams
or pipes (Line Bodies).

The meshes in the Static Structural and Hydrodynamic Response systems are generally not coin-
cident, which necessitates some approach to map the hydrodynamic pressures and Morison loads
onto the structural mesh. For pressure mapping from a time domain Hydrodynamic Response
system, the Pressure Mapping option is automatically set to Interpolated.

Hydrodynamic pressures at each node of the selected surfaces in the structural mesh are inter-
polated from the element-centered pressures calculated in the time domain Hydrodynamic Re-
sponse analysis.

The mapped hydrodynamic loads will always include incident, diffracted, radiated and hydrostatic
components, as indicated by the Include Incident/Diffracted/Radiated Wave and Include Hy-
drostatic Pressure fields.

For distributed loads on Line Bodies, the forces per unit length along each line element
(BEAM188/189 or PIPE288/289) are interpolated from the element-centered Morison forces calcu-
lated in the time domain Hydrodynamic Response analysis.

Note:

Any moment acting about the centroid of each hydrodynamic line element is assumed
to be negligible. It is therefore recommended to use a relatively small element size
for Line Bodies in the hydrodynamic analysis.

Line body loads will only be transferred to line elements in the structural model that
are exactly collinear with the Line Bodies of the hydrodynamic model (though the
lengths of the line elements can be different between the hydrodynamic and structural
meshes).

For Morison discs in the time domain Hydrodynamic Response analysis, forces and moments are
directly applied to the nearest (ideally, coincident) mesh node in the structural model. You do
not need to scope the Morison discs to the structural geometry. The Hydrodynamic Pressure
object will automatically search through all the mesh nodes on Bodies that are included in the
load mapping selection.

8.1.6.1.3. Axis Transformation

Although you can share one Geometry source between the Hydrodynamic workflow and the
Static Structural system, in the typical use case the Static Structural model will include internal
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and/or other structural components that are not required for the Hydrodynamic calculations.
Depending on the context, the geometries in the Static Structural and Hydrodynamic systems
may therefore employ different axis systems. To account for this, it is possible to define an axis
transformation from the Static Structural geometry to the Hydrodynamic geometry.

Where the axis systems are consistent between the two analyses, the Static Structural Position
may be set as Matches Hydrodynamic Diffraction Analysis. Otherwise, this option should be set
to Differs from Hydrodynamic Diffraction Analysis, and Structure Position/Rotation Offsets
should be defined for the translational and rotational freedoms. Offsets are defined relative to
the Hydrodynamic Diffraction global axis system (FRA).

The position of the selected structure at the displayed time step is reported in the Instantaneous
Position/Rotation fields, expressed in the Static Structural axis system (that is, accounting for
any defined Structure Position/Rotation Offsets). For reference, the mean water surface is drawn
relative to the position of the structure.

8.1.6.1.4. Output: Imported Pressures, and Loads

The Minimum and Maximum Pressures on diffracting panel elements are reported.

When Model Type for Mapping includes Internal Tanks, the Minimum and Maximum Internal
Tank Pressures are displayed. When Model Type includes Line Bodies, the Minimum and
Maximum Beam Loads (as Force per unit Length) are also displayed. These quantities are evalu-
ated over all of the surfaces and line bodies included for mapping (that is, across all structures);
the Hydrodynamic Structure (p. 294) object shows maxima and minima per structure.

Where applicable, values are displayed for the time step selected in Display for Time Step.

8.1.6.1.5. Advanced Options

The Hydrodynamic Pressure object accesses the material properties of each Body so that it can
estimate the structural mass, inertia, and center of gravity (CoG) position, and compare these to
the corresponding properties from the hydrodynamic model. Generally, the force and moment
reactions on any defined boundary conditions should be relatively small in the Static Structural
system, and this check helps ensure the applied loads and accelerations are well-balanced.

The Perform Mass/Inertia Check setting can be used to adjust the behavior of the Hydrodynamic
Pressure object in this respect. This setting has 4 options:

• Yes, Entire Assembly: The mass/inertia/CoG of the entire assembly, including all Bodies in the
Geometry, will be calculated and compared to the corresponding properties of the selected
structure in the upstream hydrodynamic analysis. This option is invalid if there is more than
one Hydrodynamic Structure in the analysis.

• Yes, Selected Parts Only: The mass/inertia/CoG will be calculated and compared only for the
Bodies that are included in the Structural Acceleration Application scope for each Hydro-
dynamic Structure.

• No, Use Hydrodynamic Model CoG Position: The mass/inertia/CoG will not be calculated.
The accelerations included by the Hydrodynamic Pressure object will be applied about the
CoG position of the selected structure(s) in the upstream hydrodynamic analysis (accounting
for any defined Axis Transformation (p. 279)). These accelerations will be applied to the specific
Bodies that are included in the Structural Acceleration Application scope for each Hydro-
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dynamic Structure. You must ensure that the mass properties are consistent between the hy-
drodynamic and structural models.

• No, Exclude Accelerations: The mass/inertia/CoG will not be calculated, and the Hydrodynamic
Pressure object will not apply any accelerations in the structural analysis. You must ensure that
the mass properties are consistent between the hydrodynamic and structural models.

In some cases, a Body's material properties may be inaccessible. For example, where Ansys
Composite PrepPost (ACP) has been used to define a composite material, or where the structural
analysis employs a material with no density value defined. For these cases, the Perform
Mass/Inertia Check option must be set to No, Use Hydrodynamic Model CoG Position or No,
Exclude Accelerations. The force/moment reactions on any defined boundary conditions must
be checked carefully.

The Write APDL Commands option defines where the APDL commands (SFE, SFBEAM, etc.) as-
sociated with the mapped hydrodynamic loads are written. By default, these commands will be
written Into Separate Files, which are referred to within the Mechanical input file using the
/INPUT command. Alternatively, you can choose to write commands Direct to Mechanical Input
File, so that no new files are created, though the Mechanical input file may become very large
for an analysis with many load cases.

8.1.6.2. Generating Hydrodynamic Pressures and Inertial Loads

Once the Hydrodynamic Pressure object has been configured, and at least one Hydrodynamic
Structure (p. 294) has been defined, right-click the Hydrodynamic Pressure object and select
Generate to start the load transfer process. This involves two main steps:

• Using the Ansys solver to determine the structural mass properties, which are compared to the
mass properties from the time domain Hydrodynamic Response calculation.

• Reading the output of the time domain Hydrodynamic Response calculation to determine hydro-
dynamic pressures at the structural mesh nodes and calculate translational and rotational accel-
erations to balance inertial loads.

Note:

The Hydrodynamic Pressure Add-on will take into account any difference in the unit
systems that are employed in the time domain Hydrodynamic Response and Static
Structural systems.

Where the attached Geometry includes a large number of parts or bodies (1000 or more),
the Mechanical UI may be noticeably unresponsive for some time during Hydrodynamic
Pressure Generate and Solve operations. If necessary, you can monitor progress via the
Log File, accessible through the Workbench menu bar: Add-ons → View Log File.

The transferred pressures are displayed in the graphical window when you select a Hydrodynamic
Structure in the Outline tree (Figure 8.11: Hydrodynamic Pressures in the Static Structural Sys-
tem (p. 292)), and can be compared to the Structure Panel Pressures (Figure 8.12: Hydrodynamic
Pressures in the Time Domain Hydrodynamic Response System (p. 292)) shown in the Time Domain
Pressures result object in the upstream Hydrodynamic Response system.
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Figure 8.11: Hydrodynamic Pressures in the Static Structural System

Figure 8.12: Hydrodynamic Pressures in the Time Domain Hydrodynamic Response System
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Where the Time Step Definition option is set to Range of Time Steps or All Time Steps, the minimum
and maximum pressures (on surfaces) are shown over the mapping duration in graphical and tab-
ular form.

Figure 8.13: Minimum/Maximum Pressures vs Time (Graph)
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Figure 8.14: Minimum/Maximum Pressures vs Time (Table)

8.1.7. Associating a Hydrodynamic Structure from the Time Domain Hydro-
dynamic Response Analysis

A Hydrodynamic Structure object is automatically added to the Static Structural analysis when you
create a Hydrodynamic Pressure object.

Clicking the  icon creates an additional Hydrodynamic Structure object, and you can repeat
this up to the number of structures in the hydrodynamic model.

Alternatively, you can right-click the Static Structural analysis and select Insert → Hydrodynamic
Structure from the context menu.
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8.1.7.1. Configuring the Hydrodynamic Structure Object

The Details of Hydrodynamic Structure panel provides options that allow you to configure the Hy-
drodynamic Structure object. These are described below.

Figure 8.15: Details of Hydrodynamic Structure

The Activity field allows you to set the suppression state of the Hydrodynamic Structure object.
Set to Suppressed if you want to exclude the structure from the mapping.

295
Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

The Hydrodynamic Pressure Add-on



8.1.7.2. Structure Selection

When your time domain Hydrodynamic Response analysis contains more than one structure, you
must select the name of the structure (in the Hydrodynamic Response system) that you intend to
map loads from using the Name in HR Analysis option.

The fixity of the selected structure in the Hydrodynamic Diffraction analysis is indicated by Structure
Fixity. When this field shows Structure is Fixed in Place, the radiated wave pressure component
will be zero and no structure accelerations will be calculated. In this case, for consistency, the
structure should also be fixed in the Static Structural analysis (for example, by a Fixed Support). If
the Structure is Free to Move you are recommended to use the Weak Springs option (in the Static
Structural Analysis Settings) to mitigate rigid body motions.

If the selected structure has Internal Tanks associated with it in the Hydrodynamic Response ana-
lysis, the number of tanks is shown in the read-only Number of Internal Tanks field.

If the selected structure has Cables, Tethers or Joints attached to it in the Hydrodynamic Response
analysis, the numbers of these features are shown in the read-only Number of Cables/Tethers/Joints
on Structure fields.

If the selected structure has Morison Disc elements associated with it in the Hydrodynamic Response
analysis, the number of discs is shown in the read-only Number of Morison Discs on Structure
field.

8.1.7.3. External Surfaces

When Model Type for Mapping includes External Surfaces, use the External Surfaces options to
select the surfaces that you want to map hydrodynamic pressures onto. Surfaces can be selected
either by Named Selection, or by Geometry Selection from the graphical window.

8.1.7.4. Line Bodies

When Model Type for Mapping includes Line Bodies, use the Line Bodies options to select the
beams that you want to map hydrodynamic loads onto. Line Bodies can be selected either by
Named Selection, or by Geometry Selection from the graphical window.

8.1.7.5. Structural Acceleration Application

When the Perform Mass/Inertia Check option is set to ‘Yes, Selected Bodies Only’ or ‘No, Use Hy-
drodynamic Model CoG Position’, you must select the bodies in the structural model on to which
the hydrodynamic rotational velocities and accelerations should be applied. Where relevant, these
bodies will also be used in the comparison of mass properties between the hydrodynamic and
structural models. Bodies can be selected either by Named Selection, or by Geometry Selection
from the graphical window.

8.1.7.6. Output: Structure Velocity and Acceleration at Center of Gravity, Impor-
ted Pressures and Loads

The Minimum and Maximum Pressures on diffracting panel elements are reported.
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When Model Type for Mapping includes Internal Tanks, the Minimum and Maximum Internal
Tank Pressures are provided. When Model Type includes Line Bodies, the Minimum and Maximum
Beam Loads (as Force per unit Length) are also shown. These quantities are evaluated over this
hydrodynamic structure only. For all cases, the position of the structure's center of gravity (in the
Static Structural axis system), the translational and rotational velocities, and the resultant transla-
tional and rotational accelerations about that center of gravity, are displayed. Where applicable,
values are displayed for the time step selected in Display for Time Step.

8.1.8. Internal Tank Pressure from a Hydrodynamic Diffraction Analysis

Clicking the  icon adds an Internal Tank Pressure object to the Static Structural analysis.

Alternatively, you can right-click the Static Structural analysis and select Insert → Internal Tank
Pressure from the context menu.

You can only add an Internal Tank Pressure object after a Hydrodynamic Pressure object has been
added to the Static Structural analysis.

You must ensure that the number of Internal Tank Pressure objects in the Static Structural analysis
is the same as the number of Internal Tanks defined in the upstream Hydrodynamic Diffraction ana-
lysis to account for the weight of the Internal Tank fluid in the force balance in the Static Structural
system. Otherwise, there would be an imbalance of vertical forces resulting in an acceleration of the
structure out of the water.

Note:

In the Static Structural system the hydrostatic force on the external surfaces is included
via the Hydrodynamic Pressure object if the Include Hydrostatic Pressure option is set
to Yes, while the structure weight is calculated from the material properties and surface
body thicknesses defined under Geometry. For the forces to be correctly balanced, the
weight of the Internal Tank fluid must also be accounted for. This comes from the Internal
Tank hydrostatic force (integral of hydrostatic pressure over the Internal Tank surfaces),
which is included via the Internal Tank Pressure object when the Include Hydrostatic
Pressure option is set to Yes in the associated Hydrodynamic Pressure object. For this
reason, you must ensure that the Hydrodynamic Diffraction model and its linked Static
Structural system include the same number of Internal Tank Pressure objects.

8.1.8.1. Configuring the Internal Tank Pressure Object

You can configure options for the Internal Tank Pressure object in the details panel (see Fig-
ure 8.16: Details of Internal Tank Pressure (p. 298)).
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Figure 8.16: Details of Internal Tank Pressure

The Activity field allows you to set the suppression state of the Internal Tank Pressure object.
Set it to Suppressed if you want to exclude the object from the analysis.

8.1.8.1.1. Scope: Internal Tanks

Use Scope: Internal Tanks to select the surfaces that you want to map internal tank hydrodynamic
pressures onto. Surfaces can be selected either by Named Selection, or by Geometry Selection
from the graphical window.

8.1.8.1.2. Internal Tank Details

Once you have selected the internal tank surfaces in the Static Structural model, you must asso-
ciate them with the corresponding Internal Tank in the Hydrodynamic Diffraction analysis. Internal
Tank Name in HD Analysis lists the names of the Internal Tanks that are defined in the Hydro-
dynamic Diffraction analysis, and which are associated with the structure selected in the Hydro-
dynamic Pressure object. Select the appropriate Internal Tank from this list.

The Fluid Density and Free Surface Level that have been defined in the Hydrodynamic Diffraction
analysis for the selected Internal Tank, as well as the calculated Mass of Internal Fluid, are dis-
played for reference.

8.1.8.1.3. Displayed Pressures

In some instances the internal tank pressures shown in the graphical window may be out of date.
In this case, the Refresh Graphical Window option will appear, in an invalid state, and should
be changed from Required to Not Required. The option will then disappear, and the state of the
Internal Tank Pressure object will change to show that it requires an update. Right-click the
Internal Tank Pressure object and select Generate to display the correct internal tank pressures.

8.1.8.1.4. Imported Internal Tank Pressures

Once you have Generated the Internal Tank Pressure object, the Minimum and Maximum In-
ternal Tank Pressures on diffracting panel elements are reported. Where applicable, values are
displayed for the wave case and phase angle selected in Display for Wave Case and Display
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Pressures/Accelerations At Phase Angle, respectively, as defined in the associated Hydrodynamic
Pressure object.

8.1.8.2. Generating Internal Tank Pressures

Once the Internal Tank Pressure object has been configured, right-click it and select Generate to
start the pressure transfer process. The following parameters for the pressure transfer process are
copied from the Hydrodynamic Pressure object:

• Wave Case Definition

• Wave Frequency/Period

• Wave Direction

• Incident Wave Amplitude

• Wave Position

• Specified Phase Angle or Number of Phase Increments

• Include Radiated Wave

• Include Hydrostatic Pressure

• Include Hydrostatic Varying.

The output data files from the Hydrodynamic Diffraction calculation will be read to determine the
internal tank hydrodynamic pressures at the structural mesh nodes for the requested wave case(s).

Note:

The Hydrodynamic Pressure Add-on will take into account any difference in the unit
systems that are employed in the Hydrodynamic Diffraction and Static Structural systems.

The transferred pressures are displayed in the graphical window (Figure 8.17: Internal Tank Pressures
in the Static Structural System (p. 300)), and can be compared to the Internal Tank Panel Pressures
(Figure 8.18: Internal Tank Pressures in the Hydrodynamic Diffraction System (p. 300)) shown in the
Internal Tank Pressures result object in the upstream Hydrodynamic Diffraction system. The
pressure Component Selection in the Internal Tank Pressure object may need to be matched to
those included in the Hydrodynamic Pressure object for such a comparison to be made.
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Figure 8.17: Internal Tank Pressures in the Static Structural System

Figure 8.18: Internal Tank Pressures in the Hydrodynamic Diffraction System
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8.1.9. Internal Tank Pressure from a Time Domain Hydrodynamic Response
Analysis

Clicking the  icon adds an Internal Tank Pressure object to the Static Structural analysis.

Alternatively, you can right-click the Static Structural analysis and select Insert → Internal Tank
Pressure from the context menu.

You can only add an Internal Tank Pressure object after a Hydrodynamic Pressure object has been
added to the Static Structural analysis.

You must ensure that the number of Internal Tank Pressure objects in the Static Structural analysis
is the same as the number of Internal Tanks defined in the upstream time domain Hydrodynamic
Response analysis to account for the weight of the Internal Tank fluid in the force balance in the
Static Structural system. Otherwise, there would be an imbalance of vertical forces resulting in an
acceleration of the structure out of the water.

Note:

In the Static Structural system the hydrostatic force on the external surfaces is included
via the Hydrodynamic Pressure object, while the structure weight is calculated from the
material properties and surface body thicknesses defined under Geometry. For the forces
to be correctly balanced, the weight of the Internal Tank fluid must also be accounted for.
This comes from the Internal Tank hydrostatic force (integral of hydrostatic pressure over
the Internal Tank surfaces). For this reason, you must ensure that the timedomain Hydro-
dynamic Response model and its linked Static Structural system include the same number
of Internal Tank Pressure objects.

8.1.9.1. Configuring the Internal Tank Pressure Object

You can configure options for the Internal Tank Pressure object in the details panel (see Fig-
ure 8.19: Details of Internal Tank Pressure (p. 302)).
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Figure 8.19: Details of Internal Tank Pressure

The Activity field allows you to set the suppression state of the Internal Tank Pressure object.
Set it to Suppressed if you want to exclude the object from the analysis.

8.1.9.1.1. Scope: Internal Tanks

Use Scope: Internal Tanks to select the surfaces that you want to map internal tank hydrodynamic
pressures onto. Surfaces can be selected either by Named Selection, or by Geometry Selection
from the graphical window.

8.1.9.1.2. Internal Tank Details

Once you have selected the internal tank surfaces in the Static Structural model, you must asso-
ciate them with the corresponding Internal Tank in the time domain Hydrodynamic Response
analysis. Internal Tank Name in HR Analysis lists the names of the Internal Tanks that are defined
in the time domain Hydrodynamic Response analysis, and which are associated with the structure
selected in the Hydrodynamic Pressure object. Select the appropriate Internal Tank from this list.

The Fluid Density and Free Surface Level that have been defined in the time domain Hydro-
dynamic Response analysis for the selected Internal Tank, as well as the calculated Mass of In-
ternal Fluid, are displayed for reference.

8.1.9.1.3. Displayed Pressures

In some instances the internal tank pressures shown in the graphical window may be out of date.
In this case, the Refresh Graphical Window option will appear, in an invalid state, and should
be changed from Required to Not Required. The option will then disappear, and the state of the
Internal Tank Pressure object will change to show that it requires an update. Right-click the
Internal Tank Pressure object and select Generate to display the correct internal tank pressures.

8.1.9.1.4. Imported Internal Tank Pressures

Once you have Generated the Internal Tank Pressure object, the Minimum and Maximum In-
ternal Tank Pressures on diffracting panel elements are reported. Where applicable, values are
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displayed for the time step selected in Display for Time Step as defined in the associated Hydro-
dynamic Pressure object.

8.1.9.2. Generating Internal Tank Pressures

Once the Internal Tank Pressure object has been configured, right-click it and select Generate to
start the pressure transfer process. The time step(s) for the pressure transfer process are copied
from the Hydrodynamic Pressure object:

The output data files from the time domain Hydrodynamic Response calculation will be read to
determine the internal tank hydrodynamic pressures at the structural mesh nodes for the requested
time step(s).

Note:

The Hydrodynamic Pressure Add-on will take into account any difference in the unit
systems that are employed in the time domain Hydrodynamic Diffraction and Static
Structural systems.

The transferred pressures are displayed in the graphical window (Figure 8.20: Internal Tank Pressures
in the Static Structural System (p. 303)), and can be compared to the Internal Tank Panel Pressures
(Figure 8.21: Internal Tank Pressures in the Time Domain Hydrodynamic Response System (p. 304))
shown in the Time Domain Pressures result object in the upstream time domain Hydrodynamic
Response system.

Figure 8.20: Internal Tank Pressures in the Static Structural System
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Figure 8.21: Internal Tank Pressures in the Time Domain Hydrodynamic Response System

8.1.10. Moonpool Pressure from a Hydrodynamic Diffraction Analysis

Click the  icon to add a Moonpool Pressure object to the Static Structural analysis.

Alternatively, follow these steps:

1. Right-click the Static Structural analysis.

2. Select Insert > Moonpool Pressure from the context menu.

Note:

A Moonpool Pressure object may only be added after a Hydrodynamic Pressure object
has been added to the Static Structural analysis. Ensure that the number of Moonpool
Pressure objects in the Static Structural analysis is the same as the number of Moonpools
defined in the upstream Hydrodynamic Diffraction analysis.

8.1.10.1. Configuring the Moonpool Pressure Object

Configure options for the Moonpool Pressure object in the Details panel:
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Figure 8.22: Details of Moonpool Pressure

The Activity field sets the suppression state of the Moonpool Pressure object. Set it to Suppressed
to exclude the object from the analysis.

8.1.10.1.1. Scope: Moonpool

Use Scope: Moonpool to select the surfaces to map moonpool hydrodynamic pressures onto.
Surfaces are selected either by Named Selection, or by Geometry Selection from the Graphical
window.

8.1.10.1.2. Moonpool Details

After selecting the moonpool surfaces in the Static Structural model, you must associate them
with the corresponding Moonpool in the Hydrodynamic Diffraction analysis. Moonpool Name
in HD Analysis lists the names of the Moonpools that are defined in the Hydrodynamic Diffraction
analysis, which are associated with the structure selected in the Hydrodynamic Pressure object.
Select the appropriate Moonpool from this list.

The Number of Pressure Modes defined in the Hydrodynamic Diffraction analysis for the selected
Moonpool is displayed for reference.

8.1.10.1.3. Displayed Pressures

In some instances, the Moonpool Pressures shown in the Graphical window may be out of date.
In this case, the Refresh Graphical Window option will appear, in an invalid state, and should
be changed from Required to Not Required. The option will then disappear, and the state of
the Moonpool Pressure object will change to show that it requires an update. Right-click the
Moonpool Pressure object, and select Generate to display the correct Moonpool Pressures.

8.1.10.1.4. Imported Moonpool Pressures

After generating the Moonpool Pressure object, the Minimum and Maximum Moonpool
Pressures on diffracting panel elements are reported. Where applicable, values are displayed for
the wave case and phase angle selected in Display for Wave Case and Display Pressures/Accel-
erations At Phase Angle, respectively, as defined in the associated Hydrodynamic Pressure
object.
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8.1.10.2. Generating Moonpool Pressures

Once the Moonpool Pressure object is configured, right-click it and select Generate to start the
pressure transfer process. The following parameters for the pressure transfer process are copied
from the Hydrodynamic Pressure object:

• Wave Case Definition

• Wave Frequency/Period

• Wave Direction

• Incident Wave Amplitude

• Wave Position

• Specified Phase Angle or Number of Phase Increments

• Include Hydrostatic Pressure

The output data files from the Hydrodynamic Diffraction calculation are read to determine the
moonpool hydrodynamic pressures at the structural mesh nodes for the requested wave case(s).

Note:

The Hydrodynamic Pressure Add-on takes into account any difference in the unit systems
that are employed in the Hydrodynamic Diffraction and Static Structural systems.

The transferred pressures are displayed in the Graphical window, and can be compared to the
Moonpool Pressures shown in the Pressures and Motions result object in the upstream Hydro-
dynamic Diffraction system. The pressure Component Selection may need to be matched to those
included in the Hydrodynamic Pressure object for such a comparison to be made.

8.1.11. Cable Forces from a Time Domain Hydrodynamic Response Analysis

Clicking the  icon will add a Cable Force object to the Static Structural analysis.

Alternatively, you can right-click the Static Structural analysis and select Insert → Cable Force from
the context menu.

You can only add Cable Force objects after a Hydrodynamic Pressure object has been added to the
Static Structural analysis.

You must ensure that the number of Cable Force objects in the Static Structural analysis is the same
as the corresponding number of Cables attached to the selected structure in the upstream time domain
Hydrodynamic Response analysis. Otherwise, there would be an imbalance of forces resulting in an
acceleration of the structure in the Static Structural analysis.
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8.1.11.1. Configuring the Cable Force Object

You can configure options for the Cable Force object in the details panel (see Figure 8.23: Details
of Cable Force (p. 307)).

Figure 8.23: Details of Cable Force

The Activity field allows you to set the suppression state of the Cable Force object. Set it to Sup-
pressed if you want to exclude the object from the analysis.

8.1.11.1.1. Scope: Cable Attachment

Use Scope: Cable Attachment to select the topology that you want to map cable forces onto.
Topology can be selected either by Named Selection, or by Geometry Selection from the graph-
ical window. Cable forces can be mapped on to one or more faces, edges, vertices, mesh nodes
or mesh element faces.

When the topology selection type is faces or mesh element faces, the Applied By option can be
used to apply the imported force by Direct or by Surface Effect approach. The Surface Effect option
applies force using the surface effect elements created on the top of the scoped geometry. The
Direct option applies force directly onto the faces of solid or shell elements in 3D analyses.
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Once a topology selection has been made, the Selection X/Y/Z (Centroid) is reported and should
be checked against the Structure Connection Point X/Y/Z position displayed in the Cable Details
section.

Note:

A warning will be issued if there is a significant difference between the selection
centroid and the connection point position in the hydrodynamic model.

8.1.11.1.2. Cable Details

Once you have selected some topology in the Static Structural model, you must associate this
with the corresponding Cable in the time domain Hydrodynamic Response analysis. The Cable
Index in HR Analysis option lists the indices of the Cables that are defined in the upstream time
domain Hydrodynamic Response analysis, and which are attached to the structure selected in
the Hydrodynamic Pressure object. Select the appropriate cable index from this list.

Note:

• In the upstream Hydrodynamic system, when you select the Connections object
in the Outline tree, a Hydrodynamic Response Connections Summary (p. 100)
table will be displayed. This allows you to associate the connections in the hy-
drodynamic model with their corresponding indices in the analysis.

• For a cable in the upstream Hydrodynamic system that includes at least one
pulley attachment, each cable length between the attachments is assigned its
own cable index. Where both attachments for a given cable index are located
on the structure selected in the Hydrodynamic Pressure object, the Cable Index
in HR Analysis menu will include an option to select either the First or Second
Attachment.

Once a cable index has been selected, the Structure Connection Point X/Y/Z definition position
will be displayed for reference. The position is transformed into the Static Structural axis system,
using the Axis Transformation defined in the Hydrodynamic Pressure object.

Also displayed is the Cable Type, which is either ‘Linear’ or ‘Nonlinear’, depending on the defin-
ition in the hydrodynamic model; and Connected To, which will show ‘Ground’ for a cable
between a structure and a Fixed Point, or displays the name of the other structure in the Hydro-
dynamic Response analysis for a cable between two structures.

8.1.11.1.3. Displayed Forces

In some instances, the imported forces shown in the graphical window may be out of date. In
this case, the Refresh Graphical Window option will appear, in an invalid state, and should be
changed from Required to Not Required. The option will then disappear, and the state of the
Cable Force object will change to show that it requires an update. Right-click the Cable Force
object and select Generate to display the correct imported forces.
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8.1.11.1.4. Imported Cable Force

Once you have Generated the Cable Force object, the imported Force X/Y/Z components are
reported. Where applicable, values are displayed for the time step selected in Display for Time
Step as defined in the associated Hydrodynamic Pressure object.

8.1.11.2. Generating Cable Forces

Once the Cable Force object has been configured, right-click it and select Generate to start the
force import process. The time step(s) for this process are copied from the Hydrodynamic Pressure
object, which must be Generated first.

The output data files from the time domain Hydrodynamic Response calculation will be read to
determine the cable forces for the requested time step(s).

Note:

The Hydrodynamic Pressure Add-on will take into account any difference in the unit
systems that are employed in the time domain Hydrodynamic Diffraction and Static
Structural systems.

The transferred cable forces are displayed as yellow arrows in the graphical window (see Figure
8.20: Imported Forces in the Static Structural System).

Figure 8.24: Imported Forces in the Static Structural System
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8.1.12.Tether Forces/Moments from a Time Domain Hydrodynamic Response
Analysis

Clicking the  icon will add a Tether Force object to the Static Structural analysis.

Alternatively, you can right-click the Static Structural analysis and select Insert → Tether Force from
the context menu.

You can only add Tether Force objects after a Hydrodynamic Pressure object has been added to the
Static Structural analysis.

You must ensure that the number of Tether Force objects in the Static Structural analysis is the same
as the corresponding number of Tethers attached to the selected structure in the upstream time
domain Hydrodynamic Response analysis. Otherwise, there would be an imbalance of forces resulting
in an acceleration of the structure in the Static Structural analysis.

8.1.12.1. Configuring the Tether Force Object

You can configure options for the Tether Forceobject in the details panel (see Figure 8.25: Details
of Tether Force (p. 310)).

Figure 8.25: Details of Tether Force
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The Activity field allows you to set the suppression state of the Tether Force object. Set it to
Suppressed if you want to exclude the object from the analysis.

8.1.12.1.1. Scope: Tether Attachment

Use Scope: Tether Attachment to select the topology that you want to map tether forces/mo-
ments on to. Topology can be selected either by Named Selection, or by Geometry Selection
from the graphical window. Tether forces/moments can be mapped on to one or more vertices.

Once a topology selection has been made, the Selection X/Y/Z (Centroid) is reported and should
be checked against the Structure Connection Point X/Y/Z position displayed in the Tether Details
section.

Note:

A warning will be issued if there is a significant difference between the selection
centroid and the connection point position in the hydrodynamic model.

8.1.12.1.2. Tether Details

Once you have selected some topology in the Static Structural model, you must associate this
with the corresponding Tether in the time domain Hydrodynamic Response analysis. The Tether
Index in HR Analysis option lists the indices of the Tethers that are defined in the upstream
time domain Hydrodynamic Response analysis, and which are attached to the structure selected
in the Hydrodynamic Pressure object. Select the appropriate tether index from this list.

Note:

In the upstream Hydrodynamic system, when you select the Connections object in
the Outline tree, a Hydrodynamic Response Connections Summary (p. 100) table will
be displayed. This allows you to associate the connections in the hydrodynamic
model with their corresponding indices in the analysis.

Once a tether index has been selected, the Structure Connection Point X/Y/Z definition position
will be displayed for reference. The position is transformed into the Static Structural axis system,
using the Axis Transformation defined in the Hydrodynamic Pressure object.

For a Tether Force object, the Connected To field will always show ‘Ground’, reflecting the
connectivity of tether connections in a hydrodynamic model.

8.1.12.1.3. Displayed Forces

In some instances, the imported forces shown in the graphical window may be out of date. In
this case, the Refresh Graphical Window option will appear, in an invalid state, and should be
changed from Required to Not Required. The option will then disappear, and the state of the
Tether Force object will change to show that it requires an update. Right-click the Tether Force
object and select Generate to display the correct imported forces.
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8.1.12.1.4. Imported Tether Force/Moment

Once you have Generated the Tether Force object, the imported Force X/Y/Z and Moment
about X/Y/Z components are reported. Where applicable, values are displayed for the time step
selected in Display for Time Step as defined in the associated Hydrodynamic Pressure object.

8.1.12.2. Generating Tether Forces/Moments

Once the Tether Force object has been configured, right-click it and select Generate to start the
force/moment import process. The time step(s) for this process are copied from the Hydrodynamic
Pressure object, which must be Generated first.

The output data files from the time domain Hydrodynamic Response calculation will be read to
determine the tether forces/moments for the requested time step(s).

Note:

The Hydrodynamic Pressure Add-on will take into account any difference in the unit
systems that are employed in the time domain Hydrodynamic Diffraction and Static
Structural systems.

The transferred tether forces are displayed as orange arrows in the graphical window.

8.1.13. Joint Forces/Moments from a Time Domain Hydrodynamic Response
Analysis

Clicking the  icon will add a Joint Force object to the Static Structural analysis.

Alternatively, you can right-click the Static Structural analysis and select Insert → Joint Force from
the context menu.

You can only add Joint Force objects after a Hydrodynamic Pressure object has been added to the
Static Structural analysis.

You must ensure that the number of Joint Force objects in the Static Structural analysis is the same
as the corresponding number of Joints attached to the selected structure in the upstream time domain
Hydrodynamic Response analysis. Otherwise, there would be an imbalance of forces resulting in an
acceleration of the structure in the Static Structural analysis.

8.1.13.1. Configuring the Joint Force Object

You can configure options for the Joint Force object in the details panel (see Figure 8.26: Details
of Joint Force (p. 313)).
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Figure 8.26: Details of Joint Force

The Activity field allows you to set the suppression state of the Joint Force object. Set it to Sup-
pressed if you want to exclude the object from the analysis.

8.1.13.1.1. Scope: Joint Attachment

Use Scope: Joint Attachment to select the topology that you want to map joint forces/moments
on to. Topology can be selected either by Named Selection, or by Geometry Selection from the
graphical window. Joint forces/moments can be mapped on to one or more vertices.

Once a topology selection has been made, the Selection X/Y/Z (Centroid) is reported and should
be checked against the Structure Connection Point X/Y/Z position displayed in the Joint Details
section.

Note:

A warning will be issued if there is a significant difference between the selection
centroid and the connection point position in the hydrodynamic model.

8.1.13.1.2. Joint Details

Once you have selected some topology in the Static Structural model, you must associate this
with the corresponding Joint in the time domain Hydrodynamic Response analysis. The Joint
Index in HR Analysis option lists the indices of the Joints that are defined in the upstream time
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domain Hydrodynamic Response analysis, and which are attached to the structure selected in
the Hydrodynamic Pressure object. Select the appropriate joint index from this list.

Note:

In the upstream Hydrodynamic system, when you select the Connections object in
the Outline tree, a Hydrodynamic Response Connections Summary (p. 100) table will
be displayed. This allows you to associate the connections in the hydrodynamic
model with their corresponding indices in the analysis.

Once a joint index has been selected, the Structure Connection Point X/Y/Z definition position
will be displayed for reference. The position is transformed into the Static Structural axis system,
using the Axis Transformation defined in the Hydrodynamic Pressure object.

Also displayed is the Joint Type, which is ‘Rigid’, ‘Hinged’, ‘Universal’ or ‘Ball and Socket’, depend-
ing on the definition in the hydrodynamic model; and Connected To, which will show ‘Ground’
for a joint between a structure and a Fixed Point, or displays the name of the other structure in
the Hydrodynamic Response analysis for a joint between two structures.

8.1.13.1.3. Displayed Forces

In some instances, the imported forces shown in the graphical window may be out of date. In
this case, the Refresh Graphical Window option will appear, in an invalid state, and should be
changed from Required to Not Required. The option will then disappear, and the state of the
Joint Force object will change to show that it requires an update. Right-click the Joint Force
object and select Generate to display the correct imported forces.

8.1.13.1.4. Imported Joint Force/Moment

Once you have Generated the Joint Force object, the imported Force X/Y/Z and Moment about
X/Y/Z components are reported. Where applicable, values are displayed for the time step selected
in Display for Time Step as defined in the associated Hydrodynamic Pressure object.

8.1.13.2. Generating Joint Forces/Moments

Once the Joint Force object has been configured, right-click it and select Generate to start the
force/moment import process. The time step(s) for this process are copied from the Hydrodynamic
Pressure object, which must be Generated first.

The output data files from the time domain Hydrodynamic Response calculation will be read to
determine the joint forces/moments for the requested time step(s).

Note:

The Hydrodynamic Pressure Add-on will take into account any difference in the unit
systems that are employed in the time domain Hydrodynamic Diffraction and Static
Structural systems.

The transferred joint forces are displayed as red arrows in the graphical window.
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8.1.14. Ocean Current

Clicking the  icon adds an Ocean Current object to the Static Structural analysis.

Alternatively, you can right-click the Static Structural analysis and select Insert → Ocean Current
from the context menu.

You may define any number of Ocean Current objects in your analysis, provided that the Static
Structural system is linked to a Hydrodynamic Diffraction system (not a time domain Hydrodynamic
Response system). However, they will only have an effect on the calculation if they are selected in
the Include Current field of the Hydrodynamic Pressure object.

Use the Velocity and Direction property to set the way in which the current is defined. The available
options are:

• Simplified Definition: Current is defined by a constant current Speed and Direction

• Advanced Definition: Current is defined by varying Speed and Direction values at specified Depth

increments in the Advanced Current Definition tabular data input. Click the  icon to add more
rows to the table.

8.1.15. Theory

This section discusses the theory applicable to the Hydrodynamic Pressure Mapping Add-on for the
mapping of pressures from a Hydrodynamic Diffraction system.

8.1.15.1. Hydrodynamic and Hydrostatic Pressures on Surfaces

The real and imaginary parts of the incident, diffracted, radiated and hydrostatic-varying pressure
components calculated in the Hydrodynamic Diffraction analysis are used to evaluate the total hy-
drodynamic pressure at each structure node for the specified incident wave amplitude and phase
angle:

(8.1)

Where Pθ  is the total hydrodynamic pressure at the required phase angle θ, with θ=0° when the

incident wave crest passes the center of gravity of the structure;  is the specified incident wave
amplitude; and Pr  and Pi  are the real and imaginary parts, respectively, of the summed hydrodynamic

(incident, diffracted, radiated and hydrostatic-varying) pressure components.
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Where hydrostatic pressure is also included, the total pressure P is the summation of the hydro-
dynamic and hydrostatic parts:

(8.2)

Where the hydrostatic pressure Ps  is calculated as:

(8.3)

In which ρ and g are the water density and acceleration due to gravity, respectively, as specified
in the Hydrodynamic Diffraction analysis; and z is the depth of the structure node below the waterline
in the Static Structural axis system (after any Axis Transformation has been applied).

8.1.15.2. Inertia and Viscous Drag Forces on Line Bodies

Distributed loads on submerged Line Bodies are calculated using the Morison equation:

(8.4)

Where:

F is the total Morison force per unit length;

D is the Line Body diameter (which should take into account any marine growth);

Cd  is the viscous drag coefficient;

uf  is the flow velocity normal to the Line Body (comprising the diffracted wave particle velocity

and any defined current);

us  is the structure velocity normal to the Line Body;

 and  are the flow and structure accelerations, respectively, normal to the Line Body;

A is the cross-sectional area of the Line Body;

 is the added mass coefficient, from which:

(8.5)

Where Cm  is the inertia coefficient. Setting Cm =0.0 turns off loading due to the diffracted wave

and added mass effects (second and third terms of Equation 8.4 (p. 316)); otherwise the valid range
of values are Cm ≥1.0. Similarly, viscous drag (first term of Equation 8.4 (p. 316)) can be ignored by

setting Cd =0.0. For non-cylindrical cross sections, the Morison equation is applied separately in

each direction normal to the Line Body.

The Hydrodynamic Pressure Mapping Add-on determines whether the ends of each beam element
are above or below the local water surface and loads the Line Body accordingly. For elements that
cut the water surface the loading is applied over the wetted length only.

8.1.16. Limitations

There exist some limitations to the geometry and model that can be used with the Hydrodynamic
Pressure Mapping Add-on. These are described below.
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In general:

• In the structure mass checks, the only included mass is that which comes from:

– The structural material itself

– Point Masses (direct or remote attachment)

– Distributed Masses

– Additional Thickness definitions

Any other mass (for example, due to Layered Sections or Command objects that define additional
mass elements directly in APDL) will not be included. This may mean that the center of gravity
about which rotational accelerations are applied is incorrect.

Specific to pressure mapping from a Hydrodynamic Diffraction system:

• It is not possible to map loads onto Line Bodies from a Hydrodynamic Diffraction analysis that in-
cludes multiple structures.

• When the imported Geometry includes Line Bodies, it is not possible to map hydrodynamic loads
onto Cross Sections of Type: ASEC (arbitrary) or MESH (user-defined mesh).

• Line Bodies of Model Type: Link (element type LINK167) are not currently supported.

• Where the Pressure Mapping method is set to Interpolated, you are limited to less than five million
mesh nodes.

• When an internal Line Body is used to model the viscous drag acting on part of a structure, and
that part of the structure is also modelled by diffracting panels, the wave particle kinematics around
the Line Body will include the diffracted wave effects due to that part of the structure.

Specific to pressure mapping from a Hydrodynamic Response system:

• It is not possible to map loads from a frequency domain Hydrodynamic Response system (stability
analysis or frequency statistical analysis).

• Apart from cable forces, tether forces/moments and joint forces/moments, which can be mapped
using the Cable Force, Tether Force, and Joint Force objects, and Morison loads on Line Bodies
or disc elements, the structure selected for time domain Hydrodynamic Response pressure mapping
must not include features which will induce additional forces or moments on the structure, such
as buoyancy elements, fenders, thrusters, or other viscous drag effects.

• Pressure mapping cannot be performed for hydrodynamic models that include Moonpools.

8.2. The Offshore Add-on

The Offshore Add-on exposes the family of OCEAN commands that are offered in Mechanical APDL. In
this way the hydrodynamic loads on submerged beam and pipe elements – resulting from the motion
of the structure through the fluid, or from the fluid motion around the structure due to current or waves
– can be included in Static Structural, Transient Structural, Modal and Harmonic Response analyses.
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8.2.1. Introduction

The purpose of the Offshore Add-on is to expose the OCEAN Mechanical APDL commands in the
Mechanical application. The Add-on allows you to define:

• An Ocean Environment (p. 319) object consisting of general ocean properties, global structural
coefficients, and incident wave properties (OCTYPE, BASIC)

• Ocean Current (p. 326) objects with either simple or tabulated input of current speed and direction
(OCTYPE, CURR)

• User Defined Spectrum (p. 327) objects for non-formulated incident wave spectrum definitions

• Harmonic Wave Load (p. 327) objects for periodic waves in a Harmonic Response analysis (HROCEAN)

• Local adjustments to structural coefficients and member flooding, either by Geometry-Based Vari-
ation (p. 328) (OCZONE, ZLOC) or Component-Based Variation (p. 329) (OCZONE, COMP)

• Pipe-in-Pipe (p. 330) objects, where the internal and external pipes may be flooded or filled with
an internal fluid (OCZONE, PIP)

• Added Mass (p. 332) objects to define added mass due to hydrodynamic effects on selected surfaces

The Offshore Add-on can be used with the following Mechanical analysis types:

• Static Structural (A in Figure 8.27: Valid Workflows for the Offshore Add-on (p. 319))

• Transient Structural (B in Figure 8.27: Valid Workflows for the Offshore Add-on (p. 319))

• Modal (C in Figure 8.27: Valid Workflows for the Offshore Add-on (p. 319))

• Harmonic Response (using Full Solution Method only, D in Figure 8.27: Valid Workflows for the
Offshore Add-on (p. 319))

• Modal with Static Structural pre-stress condition (E-F in Figure 8.27: Valid Workflows for the Offshore
Add-on (p. 319))

• Harmonic Response with Static Structural pre-stress condition (G-H in Figure 8.27: Valid Workflows
for the Offshore Add-on (p. 319))
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Figure 8.27: Valid Workflows for the Offshore Add-on

8.2.2. Loading the Offshore Add-on

To make the capabilities of the Offshore Add-on available, click the Offshore icon in the Add-ons
Ribbon. The icon will be highlighted in blue, indicating that the Add-on is loaded.

Figure 8.28: Offshore Add-on Showing Loaded Status

Note:

Command Snippets may override the OCEAN commands that are written to the Mechan-
ical APDL input file. It is recommended to check the output Solution Information carefully
if you run an analysis which contains both Offshore objects and Command Snippets.

8.2.3. Defining an Ocean Environment Object

The first step in running a simulation with Offshore capabilities is to add an Ocean Environment object
to the analysis. Once the Ocean Environment is added, you will be able to add other Offshore-specific
objects. For a Harmonic Response analysis, you should set the Analysis Settings Solution Method
option to Full.

You can only have one active Ocean Environment object in an analysis. Additional Ocean Environment
objects may only be created once any existing Ocean Environment objects have been deleted or
suppressed.
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Figure 8.29: Ocean Environment Details

8.2.3.1. Definition Properties

The Activity field allows you to set the suppression state of the Ocean Environment object. Set it
to Suppressed if you want to exclude the object from the analysis.

8.2.3.2. General Properties

The ocean geometry is defined by the Ocean Mean Water Level (mean water surface Z position
with respect to the global origin) and the Ocean Depth (vertical distance from the Ocean Mean
Water Level to the seabed).
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Figure 8.30: Ocean Geometry

The material properties of the seawater are defined by the Ocean Density and Ocean Viscosity.
The latter is only used where the global structural coefficients are set to vary by Reynolds number
(see Structural Coefficients (p. 321)). The default values of Ocean Density and Ocean Viscosity are
set to 1025 kg/m³ and 0.00108 Pa s, respectively, which are applicable for seawater at a temperature
of 20°C and a salinity of 0.035 kg/kg.

The vertical acceleration due to gravity is defined by the Gravitational Acceleration property,
which defaults to the standard value of 9.80665 m/s².

8.2.3.3. Structural Coefficients

These coefficients apply to all submerged line bodies in the Geometry.

Default Member Flooding controls whether tubular line bodies are considered to be flooded by
the surrounding seawater or not. (An internal fluid for tubular line bodies can also be defined with
Component-Based Variation (p. 329) or Pipe-in-Pipe (p. 330) objects.)

Added Mass Coefficient in Y (CaY) and Added Mass Coefficient in Z (CaZ) control the ratio of
added mass to displaced mass, where the added mass is the mass of seawater that moves with the
line body in a dynamic analysis, in the two directions perpendicular to the line body axis.

Buoyancy Force Ratio can be used to adjust the buoyancy of line bodies relative to the buoyancy
force based on the line body displacement and the defined Ocean Density. This may be useful
when accounting for external pipe features that are not explicitly modelled.

Drag and inertia coefficients are also defined for all submerged line bodies. These coefficients can
be set to vary by vertical Z position, or by the Reynolds number of the relative fluid flow around
the line body; set Tabular Input Options to Z Level for the former, or Reynolds Number for the
latter.

Depending on your selection, you can then set Coefficients by Depth or Coefficients by Reynolds
Number using the tabular data input. The independent variable is entered in the first column, fol-
lowed by the Drag Coefficient in Y (CdY), Drag Coefficient in Z (CdZ), Drag Coefficient in X
(CtX), Inertia Coefficient in Y (CmY) and Inertia Coefficient in Z (CmZ). All coefficients are defined
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in the local line body axes. Click the  icon to add more rows to the table. Duplicate entries of Z
Level or Reynolds Number are ignored.

Note:

At least one row of tabular data must be defined.

The values for CaY/CaZ will be used as defined; there is no assumption that Ca = Cm -

1.0.

8.2.3.4. Soil-Pile Interaction

You can choose to Include Soil-Pile Interaction. Setting this option to Yes allows you to specify
a Soil-Pile Data File, which may be a Mechanical APDL macro (.mac) file or some other APDL code
snippet. The specified file is included in the solver input file via the  /INPUT command.

Examples of soil-pile interaction macros may be obtained through a Service Request on the Ansys
customer site.

8.2.3.5. Wave Options

The following options are used to define wave and current conditions for the simulation.

Wave Theory

In Static Structural and Transient Structural analyses, you can define a Wave Theory to be used in
the calculation. The available options are:

• No Water Motion: no fluid motion will be accounted for in the calculation

• Current Forces Only: no wave motion will be accounted for, but the effect of an Ocean Cur-
rent (p. 326) may be included

• Airy: small amplitude first-order periodic wave

• Wheeler: Airy wave with Wheeler stretching to account for the variation of water depth with
wave surface

• Stokes: fifth-order wave theory for periodic waves in intermediate or deep water

• Stream Function: stream function wave theory suited to periodic waves in shallower water

• Random: a random, but repeatable, non-periodic combination of Airy waves fitted to a selected
wave spectrum

• Shell New Wave: similar to a random wave, but with a modified surface coefficient to better
represent the most probable maximum condition of a real sea

• Constrained: embeds a Shell new wave into a random wave

• Diffracted: allows pressures and motions to be imported from a Hydrodynamic Diffraction (p. 33)
analysis
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• User Defined Wave: calls the Mechanical APDL subroutine userPartVelAcc for the input of user-
defined wave and current information

A more complete description of these wave theories is provided in Hydrodynamic Loads in the
Mechanical APDL Theory Reference .

In a Modal analysis, or where the imported Geometry contains only solid bodies, water motion is
not permitted. In a Harmonic Response analysis, the wave information is entered via the Harmonic
Wave Load (p. 327) object. Harmonic Response analyses are restricted to periodic waves (Airy,
Wheeler, Stokes, Stream Function or User Defined Wave).

For Static Structural and Transient Structural analyses, if the imported Geometry does not contain
any line bodies but does contain surface bodies, you can only choose between No Water Motion
or Diffracted. If the imported Geometry does contain line bodies, you are free to select from any
of the wave theories listed above.

Wave Spectrum

Where the Wave Theory is selected as Random, Shell New Wave or Constrained, an additional Wave
Spectrum option is shown. This is used to select a wave spectrum to which the combination of
linear waves is fitted. The available options are:

• Pierson-Moskowitz: a formulated spectrum defined by peak wave period and significant wave
height

• JONSWAP (Joint North Sea Wave Project): a formulated spectrum defined by peak period, signi-
ficant wave height and a peak enhancement factor

• User Defined: an unformulated spectrum defined by the frequency/spectral energy density data
in a User Defined Spectrum (p. 327) object

Wave Case Definition

For any Wave Theory other than No Water Motion, the Wave Case Definition tabular data input
is used to define the current and/or wave properties for the calculation. The number of rows in the
Wave Case Definition table will match the Number of Steps defined in the Static Structural or
Transient Structural Analysis Settings; a separate load case may be defined for each step of the
analysis.

Figure 8.31: Wave Case Definition Tabular Data Input

All wave theories require a Current Definition at every step. Use the drop-down menu to select
from any of the Ocean Current (p. 326) objects that you have defined in your analysis, or choose
Disable Current to exclude current effects for that step.
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For all wave theories that include wave motion, a Wave Direction may be defined at each step.
This sets the direction that the incident wave travels towards, relative to the direction of the global
X axis.

For wave theories of Airy, Wheeler, Stokes, Stream Function, Diffracted and User Defined Wave, the
wave properties are specified by the Wave Period, Wave Height and Phase Shift. Setting the
Wave Period or Wave Height to zero will disable the wave motion for a given step. For a Stream
Function wave, the Stream Function Order may also be defined; for a User Defined Wave, the
Wave Length may be defined.

For Random, Shell New Wave and Constrained waves, the wave property definitions depend on
the selected Wave Spectrum. These are summarized in Table 1.

Table 8.1: Wave Properties for Non-Periodic Wave Theories

Wave Spectrum

User DefinedJONSWAPPierson-Moskowitz

User Defined
Spectrum

Peak Period

Significant Wave
Height

Peak Period

Significant Wave
Height

RandomWave
Theory

Peak Enhancement
Factor

User Defined
Spectrum

Peak Period

Max Wave Crest
Amplitude

Peak Period

Max Wave Crest
Amplitude

Shell New
Wave

Peak Enhancement
Factor

User Defined
Spectrum

Peak Period

Significant Wave
Height

Peak Period

Significant Wave
Height

Constrained

Peak Enhancement
Factor

Where applicable, in the User Defined Spectrum column of the Wave Case Definition table, you
should use the drop-down menu to select from any of the User Defined Spectrum (p. 327) objects
that you have defined in your analysis.

Additional Options

For periodic waves (Airy, Wheeler, Stokes, Stream Function or User Defined Wave) the Force Applic-
ation option allows you to set the position/orientation of elements relative to the wave surface for
the force calculation. The available options are:

• Act on Elements at their Actual Location

• Use Wave Peak: elements are assumed to be positioned at the wave peak
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• Use Wave Trough: elements are assumed to be positioned at the wave trough

• Vertical Upward Force Only

• Vertical Downward Force Only

The Wave Details Output option indicates that a description of the defined wave should be written
to the Solution Information. For non-periodic waves, this includes details of the wave components.

For Airy, Wheeler, Stokes and Stream Function waves, the MacCamy-Fuchs Adjustment option
allows you to include or exclude a correction to the structural inertia coefficients to account for
diffraction effects. This is relevant for larger diameter line bodies in shorter wavelength waves.

For Random, Shell New Wave and Constrained waves:

• The Number of Wave Components allows you to set the number of constituent waves for the
wave combination

• The Apparent Period Adjustment option allows you to include or exclude a calculation of the
apparent period where a wave is superimposed over a current

• The Stretching Depth Factor is used to provide the wave kinematics under the wave crest, in
a form of Wheeler stretching known as delta stretching

• The Delta Stretching Parameter sets the shape of the delta stretching function

For Random and Constrained waves:

• The Wave Kinematics Factor is used to account for wave spreading by modifying the horizontal
wave kinematics, where a value of 1.0 corresponds to no spreading

• The Initial Seed sets the seed for random phase angle generation

For Shell New Wave and Constrained waves, the Time Offset and Position Offset set the time and
position offsets at which the maximum wave crest will occur.

For Shell New Waves the Wave Spread Angle is used to compute a wave spreading factor to
modify the horizontal wave kinematics for near-unidirectional seas, while the Use Evolving Wave
option may be used to modify the component wave phase angles over the simulation.

8.2.3.6. Pressure Mapping

Where the Wave Theory is set to Diffracted, additional pressure mapping options are displayed.
Use the Hydrodynamic Data File selection dialog box to choose an Aqwa-generated hydrodynamic
database (.ahd) file, which will be used to determine hydrodynamic loads on line body elements.
Where the imported Geometry includes surface bodies, use the Scoping Method and Geo-
metry/Named Selection options to define the surfaces onto which the hydrodynamic pressures
will be transferred.
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8.2.4. Ocean Current

You may define any number of Ocean Current objects in your analysis, but they will only have an
effect on the calculation if they are selected in the Current Definition column of the Ocean Environ-
ment Wave Case Definition (p. 323) table.

Figure 8.32: Ocean Current Details

Use the Velocity and Direction property to set the way in which the current is defined. The available
options are:

• Simplified Definition: Current is defined by a Velocity at Surface, a Velocity at Seabed and a
constant current Direction

• Advanced Definition: Current is defined by varying Velocity and Direction values at specified

Depth increments in the Advanced Current Definition tabular data input. Click the  icon to
add more rows to the table.

For both types of current definition the Current Stretching option allows adjustments to the current
profile to account for cases where the wave amplitude is large relative to the Ocean Depth, such
that significant wave-current interactions exist. The available options are:

• Off: no profile adjustment, with constant current velocity above the Ocean Mean Water Level.

• Linear: linearly stretch or compress the profile from the seabed to the wave surface.

• Linear and Flow Continuity: as for Linear, but with a further adjustment to maintain flow continuity.
This option requires the current direction to be constant with depth.

• Nonlinear: where Wave Theory is set to Random, Shell New Wave or Constrained, perform a non-
linear stretching or compression of the current profile from the seabed to the wave surface.

• Program Controlled: sets Current Stretching to:

– Nonlinear when the Wave Theory is Random, Shell New Wave or Constrained

– Linear and Flow Continuity if Velocity and Direction is set to Simplified Definition, or if current
direction is constant with depth in the Advanced Current Definition table

– Linear otherwise
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Figure 8.33: Current Stretching Formulations

8.2.5. User Defined Spectrum

You may define any number of User Defined Spectrum objects in your analysis, but they will only be
used in the calculation if they are selected in the User Defined Spectrum column of the Ocean En-
vironment Wave Case Definition (p. 323) table.

Use the Spectrum Data tabular data input to define Angular Frequency ordinates and their corres-

ponding Spectral Energy Density values. Click the  icon to add more rows to the table. The
Spectrum Data table must have at least two pairs of frequency/energy density values.

8.2.6. Harmonic Wave Load

In a Harmonic Response analysis, you should use a Harmonic Wave Load object to set up the peri-
odic incident waves to which the structure will be subjected.

You can only have one active Harmonic Wave Load object in an analysis. Additional Harmonic Wave
Load objects may only be created once any existing Harmonic Wave Load objects have been deleted
or suppressed.

Figure 8.34: Harmonic Wave Load Details

327
Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

The Offshore Add-on



The Activity field allows you to set the suppression state of the Harmonic Wave Load object. Set it
to Suppressed if you want to exclude the object from the analysis.

The Harmonic Wave Load Type specifies how the ocean wave information should be included in the
Harmonic Response analysis. The available options are:

• Harmonic: calculates real and imaginary loads by the Harmonic Ocean Wave Procedure. The Har-
monic Response analysis is performed at a frequency determined from the Wave Period specified
in the Wave Case Definition table (see below).

• Static: equivalent to a Harmonic analysis, but at a frequency of zero.

• Off: deactivates the Harmonic Wave Load.

When the Type option is set to Harmonic or Static, use the Number of Phases option to specify the
number of phases over which forces will be calculated. Select a Wave Theory from the periodic Airy,
Wheeler, Stokes, Stream Function or User Defined Wave options, as described in Wave Options (p. 322).

The Wave Case Definition tabular data input, Force Application option and MacCamy-Fuchs Ad-
justment provide the same functionality as described in Wave Options (p. 322).

Use the Harmonic Wave Force Output option to include or exclude additional Harmonic Ocean
Wave Procedure output in the Solution Information.

8.2.7. Geometry-Based Variation

You may choose to override the structural coefficients (p. 321) defined in the Ocean Environment
object, for a specified range of water depths, using the Geometry-Based Variation object. You may
add as many of these to the analysis as required.

Figure 8.35: Geometry-Based Variation Details

Set the Default Member Flooding option to True, False or Program Controlled, where the latter in-
herits the Default Member Flooding defined in the Ocean Environment Structural Coefficients (p. 321)
details. The Added Mass Coefficient in Y (CaY), Added Mass Coefficient in Z (CaZ) and Buoyancy
Force Ratio options described in Structural Coefficients apply only over the range of depths defined
in the Geometry-Based Variation table.

The Geometry-Based Variation tabular data input allows you to set the drag and inertia properties
at different vertical Z positions. The Z Level is entered in the first column, followed by the Drag
Coefficient in Y (CdY), Drag Coefficient in Z (CdZ), Drag Coefficient in X (CtX), Inertia Coefficient
in Y (CmY) and Inertia Coefficient in Z (CmZ). All coefficients are defined in the local line body axes.

Click the  icon to add more rows to the table. You may add duplicate Z Level values to create a
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discontinuous variation in structural coefficients with depth, but you should not have more than two
rows with the same Z Level. You may also define Bio-Fouling Added Mass and Bio-Fouling Added
Thickness for each water depth to account for the presence of marine growth.

In Static Structural and Transient Structural analyses, you may use the Load Step Number option to
set the steps at which the Geometry-Based Variation object is applied. By default the object is applied
for All steps; if required, change this to Range and specify the Starting Load Step and Ending Load
Step to define a range of steps.

8.2.8. Component-Based Variation

You may choose to override the structural coefficients (p. 321) defined in the Ocean Environment
object, for a selection of line bodies, using the Component-Based Variation object. You may add as
many of these to the analysis as required.

Figure 8.36: Component-Based Variation Details

Use the Scoping Method and Geometry/Named Selection options to select the component (line
body) to which the structural coefficient adjustments will be applied.

For the Component-Based Variation object, Default Member Flooding has four available options:

• True: the selected component is flooded with seawater.

• False: the selected component is not flooded.

• Program Controlled: the option inherits the Default Member Flooding defined in the Ocean Envir-
onment Structural Coefficients (p. 321) details.

• Internal Fluid: the selected component is flooded with a fluid, of a density defined by the Fluid
Density, up to the specified Free Surface Level. No other modifications to the structural coefficients
of the component may be made with this object.

The Added Mass Coefficient in Y (CaY), Added Mass Coefficient in Z (CaZ) and Buoyancy Force
Ratio options are described in Structural Coefficients (p. 321), but apply only to the selected component.

By default the variation is applied to the whole of the selected component, and the structural coeffi-
cients (Drag Coefficient in Y (CdY), Drag Coefficient in Z (CdZ), Drag Coefficient in X (CtX), Inertia
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Coefficient in Y (CmY), Inertia Coefficient in Z (CmZ), Bio-Fouling Added Mass and Bio-Fouling
Added Thickness) are defined in the Entire Component tabular data input.

However, the Variation Type can be changed from Entire Component to Piecewise Variation Over
Component. This allows you to define drag and inertia properties at different vertical Z positions
along the length of the component, in the Piecewise Variation Over Component tabular data input.
The Z Level is entered in the first column, followed by the drag and inertia coefficients, and the bio-

fouling properties. All coefficients are defined in the local line body axes. Click the  icon to add
more rows to the table.

The Variation Type can also be set to Program Controlled, which causes the drag and inertia prop-
erties to be inherited from those defined in the Ocean Environment Structural Coefficients (p. 321) or
any applicable Geometry-Based Variation (p. 328) object. This also applies to regions of the component
which lie outside of the range of vertical Z positions defined in the Piecewise Variation Over Com-
ponent table when the Variation Type is set to Piecewise Variation Over Component.

In Static Structural and Transient Structural analyses, you may use the Load Step Number option to
set the steps at which the Component-Based Variation object is applied. By default the object is applied
for All steps; if required, change this to Range and specify the Starting Load Step and Ending Load
Step to define a range of steps.

Precedence of Local Adjustments to Structural Coefficients

Where there are multiple definitions of structural coefficients applied to a range of water depths, the
order of precedence is:

• Component-Based Variation (most significant)

• Geometry-Based Variation

• Ocean Environment (least significant)

Figure 8.37: Precedence of Local Adjustments to Structural Coefficients

8.2.9. Pipe-in-Pipe

For the special case of a pipe with an internal pipe running through it, the flooding options defined
in the Ocean Environment (p. 321) object may be overridden by a Pipe-in-Pipe object. You may add
as many of these to the analysis as required.
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Figure 8.38: Pipe-in-Pipe Details

Under the heading of Internal Member, use the Scoping Method and Geometry/Named Selection
options to select the line body which represents the internal pipe.

Under the heading of External Member, use the Scoping Method and Geometry/Named Selection
options to select the line body which represents the external pipe.

Note:

The line bodies selected to represent the internal and external pipes must have their
Model Type property set to Pipe.

The Internal Member Flooding option sets the flooding state of the internal pipe. The available
options are:

• True: the internal pipe is flooded with a fluid, of a density defined by the External Pipe Fluid
Density

• False: the internal pipe is not flooded

• Internal Fluid: the internal pipe is flooded with a fluid, of a density defined by the Internal Pipe
Fluid Density, up to the specified Internal Pipe Free Surface Level

The External Member Flooding option sets the flooding state of the external pipe. Where the Default
Member Flooding option in the Ocean Environment object Structural Coefficients (p. 321) is set to
True, this option must also be True. Otherwise, the available options are:

• False: the external pipe is not flooded

• Internal Fluid: the external pipe is flooded with a fluid, of a density defined by the External Pipe
Fluid Density, up to the specified External Pipe Free Surface Level

In Static Structural and Transient Structural analyses, you may use the Load Step Number option to
set the steps at which the Pipe-in-Pipe object is applied. By default the object is applied for All steps;
if required, change this to Range and specify the Starting Load Step and Ending Load Step to define
a range of steps.
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8.2.10. Added Mass

Added Mass objects are used to define the added mass of surfaces due to hydrodynamic effects. You
may add as many of these to the analysis as required.

Figure 8.39: Added Mass Details

Use the Scoping Method and Geometry/Named Selection options to select the surfaces bodies to
which the added mass will be applied.

The Added Mass per Unit Area defines the amount of added mass that will be included over the
surface, while the In-Plane Force per Unit Length accounts for surface tension acting on the surface.
The four Thickness values define the thicknesses at the I, J, K and L nodes of each surface element,
as described in  SURF154  in the Mechanical APDL Element Reference.

In Static Structural and Transient Structural analyses, you may use the Load Step Number option to
set the steps at which the Added Mass object is applied. By default the object is applied for All steps;
if required, change this to Range and specify the Starting Load Step and Ending Load Step to define
a range of steps.

8.3. The Aqwa Co-simulation Add-on

A co-simulation system with Ansys Rigid Dynamics is available for the Aqwa solver. This combination
of the Rigid Dynamics and Aqwa solvers allows you to create a more powerful simulation. For example,
this co-simulation system can solve marine structures which have complex contact, shaft, and gear
components, such as a point absorber. This co-simulation system can also conduct Hydro-Aero-Multi-
body coupling analyses for floating offshore wind turbines by including AeroDyn, a third-party aerody-
namic module from OpenFAST v3.0.0, that provides the ability to compute wind turbine (horizontal
axis) aerodynamic responses.

Note:

To access the OpenFAST User Documentation for the version of AeroDyn included in the
Ansys installation, see Developing Documentation for more information on how to build the
documentation. If you encounter any errors, contact OpenFAST GitHub support for assistance.
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As the co-simulation system involves several products communicating simultaneously, some of the
setup procedures can be complex. Therefore, the Aqwa Co-simulation Add-on has been developed to
simplify the setup process for the co-simulation system.

8.3.1. Introduction

In the co-simulation system of Aqwa and Rigid Dynamics, the Rigid Dynamics solver is responsible
for solving the equations of motion and passes the motion responses (displacements, velocities, and
accelerations) to Aqwa (Aqwa-Naut, Hydrodynamic Response > Time Response Analysis > Regular/Ir-
regular Wave Response) to calculate the hydrostatic, hydrodynamic, and mooring loads based on the
updating motion responses. Aqwa will pass the total force and moment of hydrostatic, hydrodynamic
and mooring loads to Rigid Dynamics to calculate the motion responses. The data transfer between
the Rigid Dynamics and Aqwa solvers happens at each co-simulation time step, as presented in Fig-
ure 8.40: Aqwa-Rigid Dynamics Solver Relationship (p. 333). The transferred motion and load data are
with respect to each structure’s center of gravity (COG) in the Aqwa model.

Figure 8.40: Aqwa-Rigid Dynamics Solver Relationship

In the current version, the data transfer between Aqwa and Rigid Dynamics is conducted via the
Functional Mock-up Interface (FMI). Before running a co-simulation between Aqwa and Rigid Dynamics,
you must generate two Functional Mock-up Unit (FMU) packages, which contain the Aqwa and Rigid
Dynamics project data for the co-simulation analysis, respectively. These FMU packages can be created
via the Rigid Dynamics and Aqwa Workbench projects. The generation of these FMU packages is a
process of packaging and saving the current model data and setups in the Workbench project into
a compressed file.

For the co-simulation analysis, some special setups must be included in the Aqwa and Rigid Dynamics
projects. In the Aqwa Workbench project, the Output Aqwa FMU Package (p. 140) option must be
switched on while the unit and coordinate system information of the Rigid Dynamics model need to
be defined if they are different from the Aqwa model. In the Rigid Dynamics Workbench project, there
are extra setups which need to be included based on the Aqwa model data:

1. The initial positions and rotations of the Rigid Dynamics structures must be set the same as
the Aqwa structures.

2. The project should have co-simulation pins that are based on the COG positions of the Aqwa
structures.

3. The fluid added mass matrix of the Aqwa structures at the infinite frequency must be added
to the Rigid Dynamics model.

If AeroDyn is selected to be included in the co-simulation workflow, the connection with AeroDyn
also must be set up and activated in the Rigid Dynamics project. Between the AeroDyn program and
Rigid Dynamics, a wrapper program enables them to communicate directly, like wrapping AeroDyn
as a sub-module of Rigid Dynamics. Once the AeroDyn inputs are properly set in the Rigid Dynamics
model, AeroDyn will provide Rigid Dynamics with the aerodynamic forces and moments on the sec-
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tional nodes of the blades and tower during each time integration step of the Rigid Dynamics solver.
These forces and moments are calculated based on the motion responses obtained from the Rigid
Dynamics solver at each time integration step. The data exchange between the two solvers is
presented in Figure 8.41: Aerodyn-Rigid Dynamics Solver Relationship (p. 334).

Figure 8.41: Aerodyn-Rigid Dynamics Solver Relationship

When the Aqwa and Rigid Dynamics FMU packages are ready, Ansys Twin Builder or other platforms
which support the FMI (v1.0) system can be employed to load, connect, and run both FMU packages.
The Aqwa and Rigid Dynamics models packed in the FMU packages can have different numbers of
structures, but the Aqwa and Rigid Dynamics FMU packages should have matching input and output
co-simulation pins in order to connect properly. The output pins of the Rigid Dynamics FMU package
should transfer the motion responses (position, velocity, and acceleration on six degrees of freedom)
at each Aqwa structure's COG while its input pins are for the forces and moments on six degrees of
freedom with respect to each Aqwa structure's COG. Equally, the Aqwa FMU package's output pins
are for the total forces and moments of hydrostatic, hydrodynamic and mooring loads at each Aqwa
structure's COG while its input pins are for the motion responses at the Aqwa structure's COG.

In general, the steps to run the co-simulation analysis are as follows:

1. Set up an Aqwa project, solve the Hydrodynamic Diffraction analysis and generate the Output
Aqwa FMU Package (p. 140) by solving the Hydrodynamic Response analysis

2. Set up a Rigid Dynamics project:

a. Set up structures, connections, and other Rigid Dynamics basic settings

b. Set up the connection with the AeroDyn inputs (optional)

c. Map the Aqwa model data into the Rigid Dynamics project

d. Generate the Rigid Dynamics FMU package

3. Set up and run a Twin Builder project for the co-simulation analysis

Among these steps, the Aqwa Co-simulation Add-on is provided to automatically conduct the exclusive
steps to the co-simulation analysis, which are steps 2.b, 2.c and 3.

8.3.2. Loading the Aqwa Co-simulation Add-on

To make the capabilities of this Add-on available, click the Aqwa Co-simulation icon in the Add-ons
Ribbon. The icon will be highlighted in blue, indicating that the Add-on is loaded.
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Figure 8.42: Aqwa Co-simulation Add-on Showing Loaded Status

8.3.3. Aqwa Co-simulation Toolbar

The Aqwa Co-simulation toolbar includes four options:

1. Update/Import Aqwa File (p. 336)

2. Mapping Aqwa Data (p. 336)

3. Clear (p. 336)

4. Co-simulation Wizard (p. 337)

Figure 8.43: Aqwa Co-simulation Toolbar

Update/Import Aqwa Files and Mapping Aqwa Data can be used to write Aqwa model data into
the Rigid Dynamics project if the user chooses not to do so via the Co-simulation Wizard.

There are two steps to write the Aqwa model data into the Rigid Dynamics project:

1. Load the Aqwa input *.DAT file and *.ADM file by clicking Update/Import Aqwa Files.
Once the files have been successfully loaded, there is no need to further import them unless
the input files have been changed.

2. Click Mapping Aqwa Data for the Add-on to write the Aqwa data into the Rigid Dynamics
project.

Clear is used to remove any objects created by the Aqwa Co-simulation Add-on.

Co-simulation Wizard provides a three-step wizard, which guides you through the process of estab-
lishing the connection with the AeroDyn inputs and importing the Aqwa data into the Rigid Dynamics
project, setting up a co-simulation Twin Builder project and running the co-simulation analysis.

Note:

The Aqwa Co-simulation toolbar options are only active in the Rigid Dynamics project
when the project tree object (except the Solution branch and its subbranches) is selected.
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8.3.3.1. Update/Import Aqwa File

The Aqwa data needed by the Add-on are in the Aqwa *.ADM file and *.DAT file. The Add-on will
parse these two imported files. If any problem occurs, warnings or errors will be shown in both the
message panel and the Extensions Log File.

8.3.3.2. Mapping Aqwa Data

Mapping Aqwa Data can write Aqwa model data (including the COG positions and initial positions
of Aqwa structures, the fluid added mass matrix at the infinite frequency, etc.) into the Rigid Dy-
namics project and generate the co-simulation pins which match the Aqwa FMU package's co-
simulation pins. This requires that the data in the Aqwa input *.DAT file and *.ADM file have
already been imported into the Add-on (see Update/Import Aqwa File (p. 336)). If the Add-on does
not find the required Aqwa data files or sufficient Aqwa data, the Add-on will request a re-selection
of the Aqwa files. The Aqwa data will be mapped into the Rigid Dynamics project in the forms of:

• An added mass script and an Aqwa Co-simulation option script

• Pin joints for the co-simulation pins

• Co-simulation pins

The added mass and Aqwa Co-simulation option script will be written to the first Rigid Dynamic
system in the project tree.

The pin joints for the co-simulation pins are general joints, which have been set to Free in all degrees
of freedom. They are located at the Aqwa structures’ COGs. During the co-simulation analysis, the
hydrostatic, hydrodynamic and mooring loads on the COG of each Aqwa structure will be transferred
onto the pin joint at the corresponding Aqwa structure’s COG in the Rigid Dynamics model. The
initial displacements and rotations of each Aqwa structure are also applied through those pin joints,
and this Add-on will automatically set the scope of the pin joint on the surface of its corresponding
Aqwa structure. However, in some cases when the mesh data in the Aqwa input *.DAT file do not
match the geometry in the Rigid Dynamics project, you need to manually select the scope for the
pin joints. Apart from this case, it is strongly recommended not to change anything the Add-on
creates unless you are fully aware of the resulting effects.

Note:

If you plan to use the Co-simulation Wizard, the sequence of the co-simulation pins
created by this Add-on should not be changed, and any additional co-simulation pins
should be added at the end of the existing co-simulation pins created by this Add-on.

8.3.3.3. Clear

The Clear button can help you to remove unwanted objects created by this Add-on quickly. There
are three options:

1. Clear Aqwa Data: Removes the tree objects (added mass script, pin joints, and the co-simulation
pins) created by the Mapping Aqwa Data option or the Aqwa Modeling Data step of the
Aqwa Co-simulation Setup Wizard.
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2. Clear AeroDyn Marker: Removes all the coordinate systems created for the AeroDyn marker
in the Aerodyn Connection step of the Aqwa Co-simulation Setup Wizard.

3. Clear AeroDyn Scripts: Removes all the scripts created in the AeroDyn Connection step of
the Aqwa Co-simulation Setup Wizard.

Note:

The Clear button cannot remove the objects created by the Aqwa Co-simulation Add-
on during previous use (that is, before the Add-on has been previously unloaded).

8.3.3.4. Co-simulation Wizard

The Co-simulation Wizard opens the Aqwa Co-simulation Setup Wizard interface, when selected.
You can also continue with previous wizard progress, if it exists. The Aqwa Co-simulation Setup
Wizard is designed to automate some of the co-simulation steps.

A prerequisite for running a co-simulation via the Aqwa Co-simulation Setup Wizard is locally in-
stalling the Ansys Twin Builder.

8.3.4. Aqwa Co-simulation Setup Wizard

The Aqwa Co-simulation Setup Wizard comprises three steps:

8.3.4.1. AeroDyn Connection

8.3.4.2. Aqwa Modeling Data

8.3.4.3. Co-simulation Settings

8.3.4.4. Run Co-simulation

The wizard will go through the process of setting up the connection between the AeroDyn inputs
and the Rigid Dynamics project, creating Aqwa data objects in the Rigid Dynamics project, defining
the remaining information for the co-simulation analysis, establishing the co-simulation Twin Builder
project and finally, running the co-simulation.

8.3.4.1. AeroDyn Connection

This step aims to generate scripts in the Rigid Dynamics model to set up and activate the connection
between the Rigid Dynamics solver and the AeroDyn program. Aerodyn from OpenFAST version
3.0.0 is used for this feature. The Aerodyn input files must be prepared for this specific version, in-
cluding the AeroDyn primary input file, InflowWind input files, Blade Data input file, and Airfoil
Data input files. If you want to skip this process, select No for the Include AeroDyn Connection
option and proceed to the next step. If Yes is selected (see Figure 8.44: AeroDyn Connection
Setup (p. 340)), additional AeroDyn and turbine information must be provided. The required inform-
ation includes the following:

• AeroDyn Primary Input File: The path of the AeroDyn primary input file.

• InflowWind Input File: The path of the InflowWind input file. For more information, refer to the
InflowWind Users Guide.
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• Write AeroDyn Result Files: Choose whether to generate AeroDyn Result files.

• Turbine Data: The following parameters follow the same definition described in the Driver Inputs
and Options section of the AeroDyn User Guide:

– Number of Blades: The amount of blades which the turbine model has, with a selection
of 1 to 3.

– Hub Radius: The radius of the hub, measured from the center-of-rotation to the blade
root along the (possibly preconed) blade-pitch axis.

– Blade Length: The length of the blade, which is measured from the blade root to the
blade tip.

– Hub Height: The height of the hub center measured from the origin of the Global coordin-
ate system of the Rigid Dynamics project, which is the global Z-coordinate value of the
hub center.

– Overhang: The global X-coordinate value of the hub center. Overhang is positive down-
wind, so use a negative number for upwind rotors.

– Shaft Tilt: The angle between the rotor shaft and the horizontal plane. Positive shaft tilt
means the downwind end of the shaft is the highest.

– Precone: The angle between a flat rotor disk and the cone swept by the blades, positive
downwind (upwind turbines have negative Precone for improved tower clearance).

Note:

To ensure the consistency of the AeroDyn connection scripts and the AeroDyn input
files, the path of the AeroDyn primary input file must be re-selected if any settings in
the AeroDyn input files have been modified.

The data transfer between AeroDyn and Rigid Dynamics is conducted through the nodes, which
represent the turbine geometry parts in a condensed form. For each node, we use a marker to in-
dicate it. The marker consists of a position and an orientation. Namely, it is equivalent to the local
coordinate system of the geometry part represented. For example, the hub marker is located at
the hub center, and the shaft tilt will influence its orientation. The hub marker, blade marker and
blade node maker are determined using the work described by Jonkman & Jonkman [1].

When expressed in the coordinate system terms, the hub marker orientation is:

• X-axis: Pointing along the hub centerline in the nominally downwind direction

• Y-axis: Orthogonal with the x- and z-axes such that they form a right-handed coordinate system

• Z-axis: Perpendicular to the hub centerline with the same azimuth as Blade 1

Similarly, the blade marker is located at the intersection of the pitch axis and the blade root of
each blade. Its orientation is as follows:

• X-axis: Orthogonal with y- and z-axes such that they form a right-handed coordinate system
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• Y-axis: Pointing towards the trailing edge of the blade and parallel to the chord line at the zero-
twist blade station

• Z-axis: Pointing along the pitch axis towards the tip of the blade

The blade node marker is located at the aerodynamic analysis node listed in the Blade Data Input
file. Its orientation is as follows:

• X-axis: Orthogonal with y- and z-axes such that they form a right-handed coordinate system

• Y-axis: Aligned with the local chord line pointing towards the trailing edge

• Z-axis: Directed along the blade towards the tip

Note:

The turbine, which can be simulated by this Add-on, is limited to the single basic hori-
zontal axis wind turbine. The initial orientation of Blade 1 should have the same azimuth
of the global z-axis and should not have any rotation about the hub rotation axis. The
following blades (Blade 2 and Blade 3) spread equally in the rotation plane in an anti-
clockwise order, viewing towards the downwind direction. The nacelle and hub should
not have any yaw angle.

Three buttons are available to help the inspection of the correctness of the AeroDyn input being
set up. They are Show Hub Marker, Show Blade Markers, and Show Blade Node Markers. By
clicking on them, the coordinate systems of the corresponding markers will be generated in the
outline tree of the Rigid Dynamics project.

The setup scripts for AeroDyn will be written into the Rigid Dynamics project when the Next button
is clicked. The scripts will activate the connection between the AeroDyn program and the Rigid
Dynamics solver while the Rigid Dynamics project is being solved.

Note:

The AeroDyn primary input file specifies the path of the Blade Data Input file and the
Airfoil Data Input file while the InflowWind Input file specifies the path of the wind file
if necessary. All the AeroDyn and InflowWind files will not be embedded into the Rigid
Dynamics FMU package. However, they should be available and accessible in their claimed
directories while the Rigid Dynamics project or the co-simulation project is being solved.

Note:

The wizard assumes the blade and tower sectional nodes will follow the requirements
in the AeroDyn User Guide. The local elevation of the tower nodes must increase from
the lowest (tower-base) to the highest (tower-top) elevation. The first and last blade
nodes must be located at the most inboard (blade root) and most outboard (blade tip)
points, respectively. The tower nodes should not be located at the multiple structures
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that have relative motions, and neither should the blade nodes of each blade. Otherwise,
the AeroDyn connection scripts could be inaccurate.

Note:

As AeroDyn uses the SI system (kg, m, s, N), the Rigid Dynamics project must also use
the same unit system if the AeroDyn connection is included.

More notes about this step can be found in the Help section of the wizard.

Figure 8.44: AeroDyn Connection Setup

8.3.4.2. Aqwa Modeling Data

The Aqwa Modeling Data step is used to record the file location of the Aqwa FMU package file,
which will be used in the co-simulation analysis.

Based on the Aqwa input files in the Aqwa FMU package, if Yes is selected for Write Aqwa data
to the current project?, this step can map Aqwa data into the current Rigid Dynamics project
when Next is clicked, similar to the Mapping Aqwa Data (p. 336) option in the Aqwa Co-simulation
toolbar. If No is selected, there will be no changes to the current Rigid Dynamics project when
proceeding to the next step. No can be selected when a Rigid Dynamics FMU package file that
matches the selected Aqwa FMU Package File in this wizard step is already available or can be ob-
tained without writing the Aqwa data into the current project.
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Figure 8.45: Aqwa Modeling Data Setup

8.3.4.3. Co-simulation Settings

Use the Co-simulation Settings step to configure the Co-simulation Analysis Time (p. 342) and the
Aqwa Time Response Pressure Output (p. 343) for the co-simulation analysis. The settings defined
in this step will be written into the Aqwa FMU package file selected during the Aqwa Modelling
Data (p. 340) step or applied to the Rigid Dynamics project when you select the Next button of
the wizard.
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Important:

If the Aqwa Analysis Steps or the Aqwa Time Response Pressure Output options are
manually redefined during this step, the original values in the selected Aqwa FMU
package file will be overwritten with the new inputs when this step is executed. Ansys
recommends that you back up the original Aqwa-FMU package file if necessary.

8.3.4.3.1. Co-simulation Analysis Time

The Aqwa Analysis Steps option refers to both the Aqwa analysis time step and the Aqwa output
time step. The Aqwa analysis time step determines the analysis time interval for Aqwa as well as
the data transfer interval between the Rigid Dynamics analysis and Aqwa during the co-simulation
process. This time step sets the analysis time step for the co-simulation platform. Options include:
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• Manual: When selected, you can redefine the Aqwa Time Step and Aqwa Output Step
for the co-simulation properties. When this step is executed, these new settings will replace
the original values in the selected Aqwa-FMU package file.

• Use Aqwa-FMU package file settings: Use this option to retain the settings defined ori-
ginally in the Aqwa-FMU package file.

The Co-simulation Duration specified in the wizard determines the overall duration of the co-
simulation analysis. This setting automatically overrides any co-simulation duration previously
defined in the Aqwa FMU and Rigid Dynamics FMU package files. During co-simulation, the Rigid
Dynamics analysis will adhere to the analysis settings defined in the Rigid Dynamics project,
which generates the Rigid Dynamics FMU package file.

However, using the Rigid Dynamics Result Resample option, you can resample Rigid Dynamics
result points through a resample command. Settings for the Rigid Dynamics Result Resample
option include:

• Yes: This setting automatically inserts a Commands Snippet with a result resample com-
mand into the Rigid Dynamics project, that enables the application to select the closest
suitable result points among all of the initially computed result points based on the time
interval set by Rigid Dynamics Result Step option of the wizard. This occurs during post-
processing and does not involve recomputing or interpolating the results.

• No: This setting omits the result resample command written by the wizard from the Rigid
Dynamics project.

8.3.4.3.2. Aqwa Time Response Pressure Output

Specifying the Aqwa Time Response Pressure Output is equivalent to the Time Response
Pressure Output (p. 136) settings in Aqwa Workbench. The Aqwa-FMU package file initially contains
the pressure output settings from the Aqwa Workbench project that generated it. If you set the
Aqwa Pressure Output option to Depends on Aqwa-FMU package file settings, the original
settings will be retained, except the Output Finish Time (p. 136) that will be adjusted to match
the Co-simulation Duration, provided a structure was originally selected for pressure output.

If you use the Manual setting, you can redefine the Output for Structure, Output Start Time,
Output Time Step, and Output Finish Time options for the co-simulation analysis. When this
step is executed, these new inputs will replace the original values in the selected Aqwa-FMU
package file.

8.3.4.4. Run Co-simulation

The Run Co-simulation step sets up the remaining information required to run the co-simulation
and the result saving directories for co-simulation results. Once all the requested information is
provided, selecting the Run Co-simulation button will trigger the establishment of the co-simulation
project and the running of the co-simulation analysis. Upon completion, click Finish to close the
wizard, which will clear the values recorded or provided in the wizard.

8.3.4.4.1. Information Setup

The remaining information required to run the co-simulation includes:

343
Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

The Aqwa Co-simulation Add-on



• Rigid Dynamics FMU Package File Location: For the co-simulation with Aqwa and AeroDyn,
the Rigid Dynamics project should have the Aqwa data mapped and the connection with the
AeroDyn inputs established before generating the FMU package. The Rigid Dynamics FMU
package can then be generated using the Write Input File option.

• Co-simulation Platform: Select between Twin Builder and System Coupling as the co-simulation
running platform. If Twin Builder is selected, further Twin Builder project-related options will
appear.

• Twin Builder Project: The version of Twin Builder used to run a co-simulation analysis is the
same as Ansys Workbench. Selecting either Save the Twin Builder project file or Keep the
Twin Builder project open after the co-simulation can decide whether the Twin Builder co-
simulation project will be saved or kept open after the co-simulation ends, respectively. If Yes
is selected for the Keep the Twin Builder project open after the co-simulation option, the
Twin Builder project must be closed manually before continuing to work in the wizard. You
should keep the Twin Builder project open the first time you run the co-simulation to ensure
that no error messages show in the Twin Builder message panel.

Note:

System Coupling requires FMU version 2.0 for both Aqwa and Rigid Dynamics FMU
package files. Twin Builder supports both FMU version 1.0 and 2.0.

8.3.4.4.2. Result Saving Directory Setup

The co-simulation results files generated by the Aqwa and Rigid Dynamics solvers will be saved
respectively in the selected Aqwa Co-simulation Result Directory and Rigid Dynamics Co-
simulation Result Directory. These are the available directory options:

• Project Solving File Directory: Specifically for the Aqwa results, it refers to the solver files
directory of the Aqwa project where the Aqwa FMU package was created. For the Rigid Dynamics
results, it refers to the solver files directory of the first Rigid Dynamics system in the project
where the wizard is open. The full path of the directory will be shown underneath the option
once it is selected.

• FMU Package File Directory: It refers to the directory that contains the corresponding
(Aqwa/Rigid Dynamics) FMU package file. The full path of the directory will be shown underneath
the option once it is selected.

• Manual: It enables the manual selection for the result file saving directory.

Note:

Irrespective of the selected result saving option, the result files are saved in a folder
named ARACosimulation.Aqwa for Aqwa or ARACosimulation.RBD for Rigid Dynamics
inside the selected result directory.

8.3.4.4.3. Running the Co-simulation Analysis

The Run Co-simulation button can work on the condition that the first two wizard steps passed
without any error and all the requested information is provided in the current wizard step. In the
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Twin Builder or System Coupling project created by the wizard, the Aqwa FMU package and the
Rigid Dynamics FMU package selected in the wizard will be linked and run as a co-simulation
system. The System Coupling project will run via Command Prompt without a User Interface.
However, the Open Log File button can work after the co-simulation finishes. It shows the running
log file of the selected Co-simulation Platform (p. 344).

After the co-simulation analysis finishes successfully, the wizard will try to copy back the co-sim-
ulation results created by the Aqwa and Rigid Dynamics solvers from the Twin Builder or System
Coupling project temporary directory to the Aqwa and Rigid Dynamics project directories. When
Twin Builder is used, the detailed copying paths for the different solver result files will be shown
in the Twin Builder message panel and the Twin Builder running log file if the file copying process
succeeds.

The Rigid Dynamics results can be manually imported back into the Rigid Dynamics project via
Read Result Files while the Aqwa results can be accessed via AqwaGS, AqwaReader and Aqwa
Workbench where the Import Co-simulation Results (p. 191) option can be selected to import
the co-simulation results to the Hydrodynamic Response Solution. Once loaded, the Twin Builder
or System Coupling project can also show the co-simulation pin values along with the co-simulation
duration.

Note:

If you encounter any error messages or a stop in the progress bar while working in
the Twin Builder project, you should navigate to the Aqwa INPUTFILE.MES file and
Rigid Dynamics solve.out file under the subfolders of the temp folder in the Twin
Builder project directory and check the messages in them.

Note:

On the Windows system, the 'Opens with' application must be set with a text editor
for the .out and .log files first to enable the Open Log File button to function
properly. To set the 'Opens with' application on a Windows system, right-click an
*.out file, select Properties in the list, and in the General tab of the Properties window,
click the 'Change...' button in the 'Opens with' property, then select Notepad or any
other text editor application.
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Figure 8.46: Run Co-simulation Setup

8.3.5. Additional Notes

Messages

The message from the Add-on is issued in both the message window of the Rigid Dynamics project
and the Extensions Log File. If errors were seen, the Extensions Log File could include detailed inform-
ation about the problem. To open the Extensions Log File, go to the Workbench toolbar and select
Extensions > View Log File.

Co-simulation Time Integration Method

The time integration method for the co-simulation analysis can be chosen in the Rigid Dynamics
project before generating the Rigid Dynamics FMU package.
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Model Differences/Requirements

The Add-on and co-simulation program do not request the full consistency between the Aqwa and
Rigid Dynamics models except for the model-defined position and orientation. The Add-on can only
define the scope which represents the Aqwa structure correctly in the Rigid Dynamics project when
the Rigid Dynamics model contains the geometry surface of the Aqwa model. Otherwise, you must
manually define the scope of the pin joints, which represents the Aqwa structure.

Co-simulation Time

The time interval of the co-simulation analysis set in the Twin Builder project should be equivalent
to the time interval set for the Aqwa FMU package. The start time for the co-simulation analysis will
always be zero. The co-simulation time duration will be decided by the Twin Builder project. For more
information, see Co-simulation Duration in the Information Setup (p. 343) section.

Co-simulation Platform

Instead of Ansys Twin Builder, other platforms that support FMI 1.0 standards could be attempted to
run this co-simulation system while Aqwa and Rigid Dynamics FMU packages are already available.

Manual Definition of the Scope of Pin Joints

When the geometry shape of the model is irregular or you open a project of an older version in the
recent version of Workbench, the Aqwa Co-simulation Add-on may be unable to find the joint scope
for the pin joints created for the co-simulation. A warning message will pop up instructing you to
manually define the corresponding scope for the joint. For the pin joints that have automatically
defined joint scopes, it is also advisable to double-check if the scopes of those pin joints have been
defined correctly.
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Chapter 9: Aqwa Appendix

9.1. Information for Existing Aqwa Users

If you are familiar with the Aqwa data files and help system, then you can use this section to find where
an existing command is located in the Aqwa Editor tree objects.

Table 9.1: Cross reference of tree objects with Aqwa commands

Aqwa Editor Tree ObjectAqwa Manual Reference

4.0 - Deck 0 – Preliminary Deck

Project (p. 52)4.0.0 General Description

Analysis (p. 143)4.0.1 JOB Card

Project (p. 52)4.0.2 TITLE Card

Analysis Settings (p. 129)4.0.3 OPTIONS Card

Analysis (p. 143)4.0.4 RESTART Card

4.1 - Deck 1 – (COOR) – Coordinate Positions

4.1.0 General Description

4.1.1 Deck Header

Mesh (p. 46), Mesh Sizing (p. 52)4.1.2 COORDINATE Card

Not Supported4.1.3 COORDINATE Card with Rotation Node Generation

Parts (Structures) (p. 54)4.1.4 COORDINATE STRUCTURE Card

Not Supported4.1.5 COORDINATE OFFSET card

Not Supported4.1.6 COORDINATE card with TRANSLATION

Not Supported4.1.7 COORDINATE Card with Mirror Node Gen

Always enabled4.1.8 NOD5 card - 5-digit node numbers

4.2 Deck 2 (ELM*) – Element Topology

4.2.0 General Description

4.2.1 Deck Header

Mesh (p. 46), Mesh Sizing (p. 52), Line
Bodies (p. 58), Point Mass (p. 60), Point
Buoyancy (p. 63), Disc (p. 63)

4.2.2 ELEMENT TOPOLOGY Card

Not Supported4.2.3 SYMX and SYMY - X and Y Symmetry Cards

Structure Selection (p. 143)4.2.4 HYDI card - Hydrodynamic Interaction

Not Supported4.2.5 RMXS/RMYS cards - Remove Symmetry

Not Supported4.2.6 MSTR Card - Move Structure

Parts (Structures) (p. 54)4.2.7 FIXD Card - Fix Structure
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Aqwa Editor Tree ObjectAqwa Manual Reference

Parts (Structures) (p. 54), Surface
Bodies (p. 58)

4.2.9 VLID Card - Suppression of Standing Waves

Not Supported4.2.10 ASYM Axi-Symmetric Structure Generation

Surface Bodies (p. 58)4.2.11 ILID Card - Suppression of Irregular Frequencies

Geometry (p. 42)4.2.12 ZLWL Card - Waterline Height

4.3 Deck 3 (MATE) – Material Properties

4.3.0 General Description

4.3.1 Deck Header

Line Bodies (p. 58), Point Mass (p. 60),
Point Buoyancy (p. 63), Disc (p. 63)

4.3.2 MATERIAL PROPERTY Card

4.4 Deck 4 (GEOM) – Geometric Properties

4.4.0 General Description

4.4.1 Deck Header

Line Bodies (p. 58), Point Masses (p. 60),
Point Buoyancy (p. 63), Disc (p. 63)

4.4.2 GEOMETRIC Property and CONTINUATION Card

4.5 Deck 5 (GLOB) – Global Parameters

4.5.0 General Description

4.5.1 Deck Header

Geometry (p. 42)4.5.2 DPTH Card (Optional) - Water Depth

Geometry (p. 42)4.5.3 DENS Card (Optional) - Water Density

Geometry (p. 42)4.5.4 ACCG Card (Optional) – Gravitational Acceleration

4.6 Deck 6 (FDR*) – Frequencies and Directions Table

4.6.0 General Description

4.6.1 Deck Header

Wave Frequencies (p. 145)4.6.2 FREQ/PERD/HRTZ Card - Frequencies/Periods at which
the Parameters are Defined

Wave Directions (p. 144)4.6.3 DIRN Card - Directions at which the Parameters are
Defined

Not Supported4.6.4 MVEF Card - Move Existing Freq’ Parameters

Not Supported4.6.5 DELF Card - Delete Frequency Parameters

Not Supported4.6.6 CSTR Card - Copy from Structure Number

Not Supported4.6.7 FILE Card - Copy from File Unit

Not Supported4.6.8 CPYF/CPYP/CPYH Cards - Copy Freq’ Param’s

Not Supported4.6.9 CPYS Card - Copy Stiffness Matrix

Not Supported4.6.10 CPDB Card - Copy Data Base

Wave Directions (p. 144)4.6.11 FWDS Card - Define Forward Speed

Parts (Structures) (p. 54), Additional
Stiffness (p. 72), Additional

4.7 DECK 7 (WFS*) – Wave Frequency Dependent Parameters
and Stiffness Matrix

Damping (p. 73), Additional Added
Mass (p. 73), Connection Stiffness (p. 112)
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Aqwa Editor Tree ObjectAqwa Manual Reference

Not Supported4.8 DECK 8 (DRC*) – Drift Force Coefficients

Not Supported4.9 DECK 9 (DRM*) – Drift Motion Parameters

Current Force Coefficients (p. 77), Wind
Force Coefficients (p. 80)

4.10 DECK 10 (HLD*) – Hull Drag Coefficients and Thruster
Forces

Wind (non spectral definition) (p. 178),
Current (p. 172)

4.11 DECK 11 (ENVR) – Environmental Parameters

Not Supported4.12 DECK 12 (CONS) – Constraints

Irregular Wave (p. 156), Wind (spectral
definition) (p. 178)

4.13 Deck 13 (SPEC) – Spectral Parameters

Regular Wave (p. 155)4.13N Deck 13 (WAVE) – Regular Wave Parameters

Cables (p. 101), Cable Winch (p. 183), Cable
Failure (p. 187), Analysis Settings (p. 129)

4.14 Deck 14 (MOOR) – Mooring Lines Description

Not Supported4.15 Deck 15 (STRT) – Starting Conditions

Not Supported4.15N Deck 15 (STRT) – Starting Conditions (NAUT)

Not Supported4.15D Deck 15 (STRT) – Starting Conditions (DRIFT)

Not Supported4.16 Deck 16 (STRT) – Starting Conditions

Not Supported4.16L Deck 16 (STRT) – Starting Conditions (LINE)

Analysis Settings (p. 129)4.16B Deck 16 (STRT) – Starting Conditions (LIBRIUM)

Analysis Settings (p. 129), Parts
(Structures) (p. 54)

4.17 Deck 17 (HYDC) – Hydrodynamic parameters for non
diffracting elements

Not Supported4.18 Deck 18 (PROP) – Printing Options

Not Supported4.21 Deck 21 (ENLD) – Element and Nodal Loads

Not SupportedAll AqwaWave commands
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